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1 Meaning of symbols

There are several symbols in the document:

Symbol Description
w Not available for SPC42xx, SPC43xx.

Only available for SPC controller with IP interface
(SPC43xx/SPC53xx/SPC63xx).

Not available for installation type Domestic.
Only available in unrestricted mode.

Find further information about Security Grade, Region or Mode in text.

See Appendix for further information.

@@@@H
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2 Security

This chapter covers:

2. Target gGrOUD . o 11
2.2 General safety instructions ...l 1"
2.3 Meaning of written warning notices and hazard symbols _____.._ ... ... 12
2.1 Target group
The instructions in this documentation are directed at the following target group:
Target Qualification Activity Con.dltlon of the
readers equipment
Installation  Technical training for building or electrical Assembles and installs the Individual components
personnel installations. hardware components on site.  that need to be
assembled and
installed.
Operational Has appropriate technical training with Puts the device or system New, readily
startup regard to the tasks and the products, which is readily assembled and assembled and
personnel  devices or systems to be put in service. installed on site into service. installed device or
modified device.

2.2 General safety instructions

WARNING: Before starting to install and work with this device, read the Safety Instructions. This
device shall only be connected to power supplies compliant to EN60950-1, chapter 2.5 ("limited power
source").

2.2.1 General information

« Keep this document for later reference.
« Always pass this document on together with the product.

« Also take into account any additional country-specific, local safety standards or regulations
concerning project planning, operation and disposal of the product.

Liability claim
« Do not connect the device to the 230V supply network if it is damaged or any parts are missing.

« Do not make any changes or modifications to the device unless they are expressly mentioned in this
manual and have been approved by the manufacturer.

« Use only spare parts and accessories that have been approved by the manufacturer.
2.2.2 Transport

Unit damage during transport

« Keep the packaging material for future transportation.

« Do not expose the device to mechanical vibrations or shocks.

© Vanderbilt 2018 11 ABV10276959-d
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2.2.3 Setup

Radio interference with other devices in the environment/EMS

« When handling modules that are susceptible to electrostatic discharge, observe the ESD
guidelines.

Damage due to unsuitable mounting location

« The environmental conditions recommended by the manufacturer must be observed.
See Technical Data on page 31.

« Do not operate the device close to sources of powerful electromagnetic radiation.
Danger of electrical shock due to incorrect connection

« Connect the device only to power sources with the specified voltage. Voltage supply requirements
can be found on the rating label of the device.

« Ensure that the device is permanently connected to the electricity supply; a readily accessible
disconnect device must be provided.

« Ensure that the circuit that the device is connected to is protected with a 16A (max.) fuse. Do not
connect any devices from other systems to this fuse.

« This device is designed to work with TN power systems. Do not connect the device to any other
power systems.

« Electrical grounding must meet the customary local safety standards and regulations.

« Primary supply cables and secondary cables should be routed such that they do not run in parallel or
cross over or touch one anther inside the housing.

« Telephone cables should be fed into the unit separately from other cables.
Risk of cable damage due to stress

« Ensure that all outgoing cables and wires are sufficiently strain-relieved.

2.2.4 Operation

Dangerous situation due to false alarm

« Make sure to notify all relevant parties and authorities providing assistance before testing the
system.

« Toavoid panic, always inform all those present before testing any alarm devices.

2.2.5 Service and maintenance

Danger of electrical shock during maintenance
« Maintenance work must only be carried out by trained specialists.

« Always disconnect the power cable and other cables from the main power supply before performing
maintenance.

Danger of electrical shock while cleaning the device

« Do not use liquid cleaners or sprays that contain alcohol, spirit or ammonia.

2.3 Meaning of written warning notices and hazard symbols

2.3.1 Warning notices

Signal Word Type of Risk
DANGER Danger of death or severe bodily harm.
© Vanderbilt 2018 12 ABV10276959-d
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Signal Word Type of Risk

WARNING Possible danger of death or severe bodily harm.
CAUTION Danger of minor bodily injury or property damage
IMPORTANT Danger of malfunctions

2.3.2 Hazard symbols

P

WARNING: Warning of hazard area

/N

WARNING: Warning of dangerous electrical voltage

© Vanderbilt 2018
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3 Directives and standards

This chapter covers:

3 EU direCtiVes ... e 14
3.2 Overview of Conformity to EN50131 Standard ... ... . .. . ... ... 14
3.3 Compliance with EN 50136-1:2012 and EN 50136-2:2014 ... ... ... .. ..................... 22
3.4 Compliance with INCERT Approvals .. ... ... L 22
3.5 PD 6662:2010 Conformance Guidelines ........ ... ... ... 23
3.6 Compliance with VdS approvals ... ... ... 28
3.7 Compliance with NF and A2P approvals including CYBER requirements ... . ... 29

3.1 EU directives

This product complies with the requirements of the European Directives 2004/108/EC “Directive of
Electromagnetic Compatibility”, 2006/95/EC “Low Voltage Directive”, and1999/5/EC on Radio and
Telecommunications Terminal Equipment (R&TTE). The EU declaration of conformity is available to the
responsible agencies at http://pcd.vanderbiltindustries.com/doc/SPC

European Directive 2004/108/EC “Electromagnetic Compatibility”

Compliance with the European Directive 2004/108/EC has been proven by testing according to the
following standards:

emc emission EN 55022 Class B
emc immunity EN 501304

European Directive 2006/95/EC “Low-Voltage Directive”

Compliance with the European Directive 2006/95/EC has been proven by testing according to the
following standard:

Safety EN 60950-1

3.2 Overview of Conformity to EN50131 Standard

This section gives an overview of the SPC compliance to the EN50131 standard.

Address of Certifying Body

VdS (VdS A/C/EN/SES Approval)
AG Koéln HRB 28788

Sitz der Gesellschaft:
Amsterdamer Str. 174, 50735 KoIn
Geschéftsfihrer:

Robert Reinermann
JoérgWilms-Vahrenhorst (Stv.)

© Vanderbilt 2018 14 ABV10276959-d
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Directives and standards

SPC products listed have been tested according to EN50131-3:2009 and all relevant RTC specifications.

Product Type

Standard

SPC6350.320
SPC6330.320
SPC5350.320
SPC5330.320
SPCP355.300
SPCP333.300
SPCEG652.100
SPCK420.100
SPCK421.100
SPCE452.100
SPCE110.100
SPCE120.100
SPCA210.100
SPCK620.100
SPCK623.100
SPCN110.000
SPCN320.000

SPC5320.320
SPC4320.320
SPCP332.300
SPCW110.000
SPCW112.000
SPCW114.000
SPCW130.100

EN50131 Grade 3

EN50131 Grade 2

Specific information in relation to EN50131 requirements can be found in the following sections in this

document.

EN50131 Requirement (and relevant section)

Relevant Vanderbilt documentation

Operating temperature and humidity range

Weights and dimensions

Fixing details

Technical data:
o SPC4000 on page 31
« SPC5000on page 33
« SPC6000 on page 37

Technical data:
o SPC4000 on page 31
« SPC5000 on page 33
o SPC6000 on page 37

Mounting system equipment on page 43

© Vanderbilt 2018
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Directives and standards

EN50131 Requirement (and relevant section)

Relevant Vanderbilt documentation

Installation, commissioning and maintenance instructions,
including terminal identifications

Type of interconnections (see 8.8)

Details of methods of setting and unsetting possible (see 11.7.1
to 11.7.3 and Tables 23 to 26)

Serviceable parts

Power supply requirement if no integrated PS

Where PS is integrated, the information required by EN 50131-
6:2008, Clause 6

Maximum number of each type of ACE and expansion device.

Current consumption of the CIE and each type of ACE and
expansion device, with and without an alarm condition.

Maximum current rating of each electrical output

Mounting system equipment on page 43

Controller hardware on page 68

Technical data:
o SPC4000 on page 31
o SPC5000on page 33
o SPC6000 on page 37
Wiring the X-BUS interface on page 75

User programming via the keypad:
« Setting/Unsetting on page 275

« Configuring a Keyswitch Expanderon
page 242

« Configuring wireless fob devices on
page 110

« Triggers on page 288

Technical data:
o SPC4000 on page 31
« SPC5000on page 33
« SPC6000 on page 37
See installation instructions for SPCP33x and
SPCP43x Expander PSUs.
Technical data:
o SPC4000 on page 31
« SPC5000on page 33
o SPC6000 on page 37

Wiring the X-BUS interface on page 75
Technical data:

o SPC4000 on page 31

o SPC5000on page 33

o SPC6000 on page 37

See relevant installation instructions.

Technical data:
o SPC4000 on page 31
o SPC5000on page 33
o SPC6000on page 37

© Vanderbilt 2018 16
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Directives and standards

EN50131 Requirement (and relevant section)

Relevant Vanderbilt documentation

Programmable functions provided

How indications are made inaccessible to level 1 users when
level 2, 3 or 4 user is no longer accessing the information (see
8.5.1)

Masking/reduction of range signals/messages processed as
“fault” or “masking” events (see 8.4.1, 8.5.1 and Table 11)

Prioritization of signal and message processing and indications
(see 8.4.1.2,8.5.3)

Minimum number of variations of PIN codes, logical keys,
biometric keys and/or mechanical keys for each user (see 8.3)

Method of time-limiting internal WD for level 3 access without
level 2 authorization (see 8.3.1)

Number and details of disallowed PIN codes (see 8.3.2.2.1)

Details of any biometric authorization methods used (see
8.3.2.2.3)

Method used to determine the number of combinations of PIN
codes, logical keys, biometric keys and/or mechanical keys
(see 11.6)

Number of invalid code entries before user interface is disabled
(see 8.3.2.4)

Details of means for temporary authorization for user access
(see 8.3.2)

Engineer programming via the keypad on
page 112

Engineer programming via the browser on
page 172

Keypad user interface on page 93
LCD Keypad Settings on page 126
Comfort Keypad Settings on page 127

Configuring an Indicator Expander on page 240

System Options on page 252
Wiring the zone inputs on page 85
SIA Codes on page 368

PIR masking is always reported as a zone
masked event (SIA - ZM). Additionally, anti-
mask can cause an alarm, tamper, trouble or no
additional action depending on configuration

Current defaults of PIR addition effect:

Ireland
Unset - None
Set - Alarm

UK, Europe, Sweden, Swiss, Belgium
Unset - Tamper
Set - Alarm

Using the LCD keypad interface on page 95

Using the Comfort keypad interface - see About
the Comfort keypad on page 99

User PIN combinations on page 376

Not supported - Engineer cannot access system
without permission.

Automatic inhibits on page 376

Not applicable

User PIN combinations on page 376

Access PINs on page 377

User Menus — Grant Access

© Vanderbilt 2018 17
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Directives and standards

EN50131 Requirement (and relevant section)

Relevant Vanderbilt documentation

of set (see 8.3.3, 8.3.3.1)

components (see 8.2)

Number of events resulting in automatic inhibit

moveable (see 11.14)

Table 30, step 6)
Life of memory support battery (see 8.10.1)

Optional functions provided (see 4.1)

Additional functions provided (see 4.2, 8.1.8)

provided

8.3.10).

Other output configurations to interface with IKHAS

If automatic setting at pre-determined times provided, details of
pre-setting indication and any automatic over-ride of prevention

Details of conditions provided for the set state (see 8.3.3.4)

Notification of output signals or messages provided (see 8.6)

Criteria for automatic removal of “soak test” attribute (see 8.3.9)

If ACE is Type A or Type B (see 8.7) and whether portable or

Component data for non-volatile memory components (see

Access levels required to access such additional functions

Details of any programmable facility that would render an
I&HAS non-compliant with EN 50131-1:2006, 8.3.13 or
compliant at a lower security grade, with instruction on
consequent removal of compliance labeling (see 4.2 and

Setting/Unsetting on page 275

Setting/Unsetting on page 275

LCD Keypad Settings on page 126
Comfort Keypad Settings on page 127
Editing an output on page 231

Zone types on page 379

Editing an output on page 231
Setting/Unsetting on page 275
User rights on page 200

Editing an output on page 231
Zone types on page 379
Test on page 162

Keypad user interface on page 93
Timers on page 261
Automatic inhibits on page 376

All devices are hardwired and powered by
system PSUs. See the relevant technical data
on PSUs (separate documents).

See user documentation for SPCK420/421 and
SPCK620/623 keypads.

N/A. Stored in non-volatile memory.

Engineer programming via the keypad on
page 112

Engineer programming via the browseron
page 172

Unrestricted Grade on page 268
Options on page 252

Edit on page 135

User configuration (browser) - see
Adding/Editing a Useron page 196

Unrestricted Grade on page 268
Options on page 252

Compliance with EN50131 Approvals on
page 20

© Vanderbilt 2018
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Directives and standards

SPC products listed have been tested according to EN50131-6, and all relevant RTC specifications.

Product Type

Standard

SPC6350.320
SPC6330.320
SPC5350.320
SPC5330.320
SPCP355.300
SPCP333.300
SPCP355.300
SPCE652.100
SPCK420.100
SPCK421.100
SPCE452.100
SPCE110.100
SPCE120.100
SPCA210.100
SPCK620.100
SPCK623.100
SPCN110.000
SPCN310.000

SPC5320.320
SPC4320.320
SPCP332.300

EN50131-6

EN50131-6

© Vanderbilt 2018
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Directives and standards

3.2.1 Compliance with EN50131 Approvals

Software Requirements

System Options System Timers Identification Standards Clock Language
Continent
North South
@ Europe Asia At P QOceania

Installation Type:
Domestic
® Commercial

Financial

Region Compliance:

United Kingdom
® lreland

Europe General (EN)
Italy
(*} Sweden
(*) Switzerland
(*) Belgium
(*) Spain
(*) Germany
(*) France
Narway
Denmark
Paoland
Netherlands
Finland
Portugal

Czech Republic

which supersede EN50131 requirements

| Save |

Grade
0 EN50131 Grade 2
EN50131 Grade 3

Unrestricted

(*) Selecting this regional standard will implement local or national requirements

« Inthe Standards settings page, select Europe under Region to implement EN50131

requirements.

« Select Grade 2 or Grade 3 to implement the grade of EN50131 compliance.

« The Wireless setting Prevent Setting Time must be set to a value greater than 0 and less than

20.

« The Wireless setting Device Lost Time must be set to a value less than 120.
« The X-BUS Settings, Retries, must be set to a value of 10.

« The X-BUS Settings, Comms timer, must be set to a value of 5.

« Select Synchronization Time with Mains under Clock settings to use mains as clock master.

Hardware System

Inputs Outputs Doors 5 Calendars

System Options System Timers Identification Standards

Advanced

Hour Minute

Day Month

Current Time and Date

Second

Year

Date: 7~/ [Jul ]/ [2014 v

Synchronize Time with Mains:

Automatic Daylight Saving Time: [«

]
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DO NOT select the attribute Setting State in the Keypad configuration settings for Visual
indications.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Conroller Wireless
Keypads
Keypad Configuration
Keypad ID 1
SIN 558907
Description KEY 1 Enter keypad description_
Function Keys (in idle state)
Panic Disabled N Panic alarm by pressing the two Soft keys together.
Verification
Verification Verification will be triggerad on keypad for duress or alert activated from keypad
Visual indications
Backlight On when key is pressed v Select keypad LCD backlight option
Indicators 2] Enable visible indicators (LED's).
Setting State O Check if setting state should be indicated in idle mode (LED).
Audible Indications
Buzzer s Enable keypad buzzer
Partset buzzer O Enabling will sound exit fimer during Partset
Keypress O Check if keypress should be audible_
Deactivation
Calendar Check if keypad should be limited by calendar.
Mapping gate Check if keypad should be limited by a mapping gate.
Keyswitch Check if keypad should be limited by a keyswitch.
PACE Entry O Disable keys during entry time.
Areas
Location 1: Marketing v Select secured area where the keypad is located.
Areas Select which areas can be controlled through keypad.
[+ 1: Marketing [v] 3: Finance 5: Meeting Room
[ 2: Reception ] 4 Cafeteria
Options
Delay Fullset ] Will use exit timer across all area

Hardware Requirements

The back tamper kit (SPCY 130) must be installed for panels and power supplies for compliance with
EN50131 Grade 3.

EN50131 Grade 3 compliant components must be installed for EN50131 Grade 3 compliant
systems.

Either EN50131Grade 2 or 3 compliant components must be installed for EN50131 Grade 2
compliant systems.

It is not possible to enrol a wireless device with a signal strength lower than 3.

The recommended ratio of wireless receivers to transmistters is no more than 20 transmitters for
every one receiver.

Glassbreak must be used with an EN-compliant glassbreak interface.

To comply with EN50131-3:2009, do not set or unset the system using the SPCE120 (Indicator
Expander) or the SPCE110 (Keyswitch Expander).
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The SPCN110 PSTN module and SPCN320 GSM/GPRS module are tested with EN50131
approved Grade 2 and Grade 3 panels and can be used with these approved panels.

[

3.3 Compliance with EN 50136-1:2012 and EN 50136-2:2014

SPC products listed have been tested according to EN 50136-1:2012 and EN 50136-2:2014.

3.4 Compliance with INCERT Approvals

Software Requirements

Selecting Belgium (*) under Region implements local or national requirements which supercede
EN50131 requirements.

System Options System Timers Identification Standards Clock Language
Continent
Naorth South
& Europe Asia America et Oceania
Installation Type: Grade
Daomestic O ENS0131 Grade 2
® Commercial EN50131 Grade 3

Financial Unrestricted

Region Compliance:

United Kingdom
® lreland

Europe General (EN)
Italy
(*) Sweden
(*) Switzerland
(*) Belgium
(*) Spain
(*) Germany
(*) France
Norway
Denmark
Poland
Netherlands
Finland
Portugal
Czech Republic

(*) Selecting this regional standard will implement local or national requirements
which supersede ENS0131 requirements

| Save

Selecting Grade 2 or Grade 3 selects EN50131 compliance plus any additional INCERT requirements:

« Only an engineer can restore a tamper. For INCERT, this applies across all grades.
This is normally only a requirement for Grade |l En50131.

« Atamper on an Inhibited/Isolated zone must be sent to an ARC and displayed to the user.
For INCERT, tampers are processed for isolated zones. On all other standard variations,
tampers are ignored on isolated zones.

« UserPIN codes must be defined with more than 4 digits.
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Hardware Requirements

o The minimum battery capacity for SPC42xx/43xx/52xx/53xx/63xx is 10Ah/12V. If a 10Ah battery is
used, then the battery is biased to the left of the housing and the bottom flap is bent to meet the
battery.

« Fit jumper (J12) on the battery selector for 17/10Ah battery use and remove for 7Ah battery.
o The amount of current from Aux output using a 10Ah battery for SPC42xx/SPC52xx is:

COMMS
NONE (mA) PSTN (mA) GSM (mA) PSTN+GSM (mA)
Standby time
12h 568 543 438 413
24h 214 189 84 59
30h 143 118 13 N/A
60h 2 N/A N/A N/A

« The amount of current from Aux output using a 10Ah battery for SPC43xx/SPC53xx/ SPC63xx is:

COMMS
NONE (mA) PSTN (mA) GSM (mA) PSTN+GSM (mA)
Standby time
12h 538 513 408 383
24h 184 159 54 29
30h 113 88 N/A N/A
60 h N/A N/A N/A N/A

3.5 PD 6662:2010 Conformance Guidelines

This document contains all the criteria for the installation, and commissioning and maintenance of the SPC
System to enable it to conform to the PD 6662:2010 Standard.

3.5.1 Product scope

The scope of this document is aimed at the following components of the SPC system:

SPC4320.320-L1 Grade 2 Controller SPCEG652.100 Expander, 8 Inputs/2 Outputs
SPC5320.320-L1 Grade 2 Controller SPCP332.300 Smart PSU with 1/O Expander
SPC5330.320-L1 Grade 3 Controller SPCP355.300 Smart PSU with 8 Inputs/2 Outputs Expander
SPC5350.320-L1 Grade 3 Controller SPCP333.300 Smart PSU with 1/0 Expander
SPC6330.320-L1 Grade 3 Controller SPCN110.000 PSTN Module

SPC6350.320-L1 Grade 3 Controller SPCN320.000 GSM Module

SPCK420/421.100 LCD Keypad

SPCE452.100 Expander, 8 Relay Outputs
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3.5.2 Standards overview

Guidelines are provided for the implementation of PD 6662:2010 conformance for an SPC system to
the following relevant standards:

PD 6662:2010 BS EN 50136-1-5:2008

BS 4737-3.1:1977 BS EN 50136-2-1:1998 +A1:1998
BS 8243:2010 BS EN 50136-2-2:1998

BS 8473:2006+A1:2008 BS EN 50136-2-3:1998

BS EN 50131-1:2006+A1:2009 BS EN 50131-3:2009

BS EN 50136-1-1:1998+A2:2008 BS EN 50131-6:2008

BS EN 50136-1-2:1998 DD 263:2010

BS EN 50136-1-3:1998 DD CLC/TS 50131-7:2008

3.5.3 Methods for the completion of setting and unsetting

3.5.3.1 Methods of completion of setting (BS 8243:2010 - Clause 6.3)
Completion/Termination of the full setting procedure is achieved by any of the following methods:
a) Shunt lock fitted to the final exit door

A shunt lock must be installed by the installer as follows:

Lock - NC, open when locked

Tamper

4K7 4K7

Zone — EXIT TERMINATOR zone type

An EXIT TERMINATOR zone type must be configured for SPC.

See Zone types on page 379.

b) Push button switch mounted outside the supervised premises
Connect the push button into an SPC zone input as follows:

An EXIT TERMINATOR zone type must be configured for SPC.

See Zone types on page 379.
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c) Protective switch (that is, door contact) fitted to the final exit door of the alarmed premises or
area

Connect the switch to the SPC System as follows:

The contact is fitted to the final exit door and is connected to an ENTRY/EXIT zone with a ‘Final Exit’
attribute.

See Zone types on page 379 and Zone attributes on page 384.

A misoperation signal is possible using the alarm abort feature. This is enabled by default.
See Options on page 113 (Keypad) and Options on page 252 (Browser).

d) Digital key

Not supported by SPC.

e) In conjunction with an ARC

This method of setting is supported by using SPC COM XT or other third party ARC software using EDP
commands.

3.5.3.2 Methods of completion of unsetting (BS 8243:2010 - Clause 6.4)
Unsetting methods are complied with as follows:

6.4.1 For all the unsetting methods in the SPC system there is an audible indication to the user that the
system has been unset successfully. This is in the form of a beep sequence from the CIE.

6.4.2 Prevention of entry to the supervised premises before the intruder alarm system (IAS) is
unset:

a) Unlocking the initial entry door causes the IAS to be unset;

Compliance by SPC if KEYARM zone type is used with the UNSET attribute only. This zone type must
not be used for setting.

b) Unsetting the IAS by the user before entering the supervised premises causes or permits the initial entry
door to be unlocked.

Compliance by SPC by unsetting using an access card reader on an entry reader with the UNSET option,
or an input from a third party access system to a KEYARM zone with an UNSET attribute.

6.4.3 Prevention of entry to the supervised premises before all means of intruder alarm
confirmation have been disabled:

a) Unlocking the initial entry door causes all means of confirmation to be disabled
Operation not permitted by SPC.

b) Disabling all means of confirmation by the user before entering the supervised premises causes or
permits the initial entry door to be unlocked

Operation not permitted by SPC.

6.4.4 Opening the initial entry door disables all means of intruder alarm confirmation
Operation not permitted by SPC.

6.4.5 Completion of unsetting using a digital key

a) Operation of a digital key before entering the supervised premises (for example, via radio)

SPC satisfies this clause when the installer installs a PACE reader (for example, SPCK421) outside the
premises.

b) Operation of a digital key after entering the supervised premises from a location as near as practicable
to the initial entry door.

This functionality is provided by use of a PACE reader (for example, SPCK421) near the entry door of a
premises.
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See Zone types on page 379 and Zone attributes on page 384.

: WARNING: Your attention is drawn to the fact that by allowing this method of unsetting, if an
) intruder succeeds in forcing the initial entry door, the police will not be called, regardless of the
intruder’s further progress through the premises.

This method of unsetting the intruder alarm system might be unacceptable to your insurers.

6.4.6 Unsetting in conjunction with an alarm receiving centre (ARC)

Compliance by SPC using third party ARC software. Indication external to the building must be
provided by means of a timed buzzer/strobe, etc., that will operate on a system unset for a timed
period, for example, 30 seconds.

See Timers on page 117.

3.5.4 Configuration requirements for PD 6662:2010 conformance

Recommendations for the recording of remotely notified alarm conditions (BS 8243:2010 -
Annex G.1 and G.2)

Alarm conditions can be categorised for analysis in accordance with Annex G if the SPC system is
configured so that the entry timer is less than 30 seconds, and the dialer delay is set to 30 seconds.

See the following sections:
« Areas on page 121
« Adding/Editing an area on page 270
« Timers on page 117
Requirements for systems using dedicated alarm paths (BS EN 50136-1-2, 1998)
The SPC system should be configured to do an automated test call to the ARC.
The SPC system should be configured with a 'Fail to Communicate’ output.
See the following section:
« Adding/Editing an ARC using SIA or CID on page 324

Requirements for equipment used in systems with digital communicators using PSTN (BS EN
50136-2-2, 1998)

Fault Output
The SPC system should be configured with a 'Fail to Communicate’ output.
See the following sections:

« Outputs on page 152 (Keypad)

« Configuring controller inputs and outputs on page 229 (Browser)

« Adding/Editing an ARC using SIA or CID on page 324
Retransmission Attempts
Retransmission attempts (Dial Attempts) are configured in this manual:

« Adding/Editing an ARC using SIA or CID on page 324

« Editing EDP settings on page 333
A minimum of 1 and a maximum of 12 retransmissions are allowed.
Intrusion and hold-up - System design (DD CLC TS 50131-7, 2008)
Setting and unsetting
SPC system is configurable in such a way that the setting is completed by 'Final Exit'.

It is possible to configure the SPC so that a WD (Warning Device) is activated momentarily on setting.
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See the following sections:
o Timers on page 117
« Zone attributes on page 384
« Outputs on page 152 (Keypad)
« Editing an output on page 231 (Browser)

Intrusion and confirmed hold-up alarm (BS8243:2010 Designation of hold-up alarm (HUA) signals
for sequential confirmation)

SPC system is configurable in such a way that the following scenarios, when triggered more than two
minutes apart from any hold-up zone or hold-up device (HD), will report a confirmed hold-up alarm event
(HV for SIA and 129 for CID) to the CIE:

« two hold-up zone activations
« ahold-up zone and a panic zone activation

If a hold-up zone and a tamper zone or a panic zone and a tamper zone activation occurs within the two
minute period, this will also send a confirmed hold-up alarm event.

A confirmed hold-up will not require an engineer restore even if engineer restore is enabled. A confirmed
hold-up event is logged in the system log.

3.5.5 Additional commissioning requirements for PD 6662:2010 conformance

Information to be included in the system design proposal and as-fitted document (BS 8243:2010 -
Annex F)

« During the installation, configuration and commissioning of an SPC system, the installer must
adhere to the following guidelines as required in the above annex:

« Itis recommended that dual paths are used for signalling which are supported in the SPC system
using GSM, PSTN and Ethemet options.

« The SPC system must be installed and configured to provide an effective confirmation facility. Any
exceptions to this should be outlined in the ‘As Fitted’ document.

» Combinations and sequences which contribute to a confirmed alarm should be clearly notified to the
end user.

« Theintrusion confirmation time should be clearly notified to the end user.

« Methods of completion of setting and unsetting methods should be clearly described to the end user
as detailed in this document.

« Ensure written arrangements are supplied to the end user in the event of a lock failure.

[i]

It is recommended that the enclosed PD 6662:2010 label is affixed in an appropriate position on the
inside of the SPC housing beside the product type label.

3.5.6 Additional information

Transmission Network Requirements — Performance, Availability and Security Levels (BS EN
50136-1-2, 1998 and BS EN 50136-1-5, 2008)

The SPC System has been tested and approved to EN50136-1-1.

SPC levels are classified as follows:

Transmission time D2 as max.
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Transmission time, max. values MO — M4

Reporting time T3 as max.

Availability See ATS levels and attenuation specifications on page 388.
Signalling security level Tested to EN50136-1-1 and classified as ‘SO'.

3.6 Compliance with VdS approvals

This installation document encompasses the required product installation information for VdS
approvals.

Vanderbilt

SPC42xx/43xx/53xx/63xx : VdS Approval Nr. G 112104, G112124, and G112128. VdS EN Certificates
EN-ST000142, EN-ST000143, EN-ST000055, EN-ST000056, EN-ST000057, EN-ST000058, EN-
ST000061, EN-ST000062.

Siemens

SPC42xx/43xx/53xx/: VdS Approval Nr. G116035. VdS EN Certificates EN-ST000225, EN-
ST000226, EN-ST000227, EN-ST000228, EN-ST000229, EN-ST000230, EN-ST000231, EN-
ST000232.

This section describes the compliance of this system with VdS approvals.
Configuring software for VdS compliance
To set the system for VdS compliance, do the following:
1. Log on to the panel with the browser.
Click Full Engineer.
Click Configuration > System > Standards.
Select Europe in the Continent section of the page.

Select Germany in the Region Compliance section of the page.

o o~ W N

Select the VDS grade required by your installation type.

Hardware Fault reporting — in Configuration > System > System Options, you must select the
Enabled + Reporting (10s) option from the Watchdog Output Mode drop-down list.

[e]

Hardware faults are not reported if the Engineer is logged in to the system.

Hardware
VdS compliance requires the following:
« A G5 housing with Front tamper implemented as a minimum requirement.
« Keypads do not show status information if the system is armed.
« The number of supported zones is as follows:
—512 zones in ring configuration
— 128 zones per X-Bus in multi-drop (spur) configuration
« The following end of line resistance combinations do not comply with VdS standards:
—1k, 470 ohm
-1k, 1k, 6k6 ohm
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3.7 Compliance with NF and A2P approvals including CYBER require-
ments

Address of Certifying Body

CNPP Cert AFNOR Certification

Pble Européen de Sécurité - Vernon 11 rue Frangois de Pressensé
Route de la Chapelle Réanville 93571 Saint Denis La Plaine Cedex
CD 64 - CS 22265 www.marque-nf.com

F-27950 SAINT MARCEL

WWW.cnpp.com

[ To comply with NF and A2P installation regulations, this housing must be sealed by affixing the
l accompanying Tamper Label after installation.

3.7.1 Compliance with NF and A2P approvals including CYBER requirements

o To comply with the NF & A2P and CYBER requirements, the HTTP Web server must be disabled
l according to the following instructions.

The system configuration can only be done with the SPC Connect Pro tool via the USB socket of the SPC
control panel.

To disable the SPC panel web interface:
1. Enter programming mode and select the Communications option.
2. Onthe Services tab, uncheck the HTTP enabled box.

This will disable the SPC panel web interface.
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3.7.2 Compliance with NF and A2P approvals including CYBER requirements - SPC
Products

SPC products listed have been tested according to NF324 - H58, with reference to RTC50131-6 and
RTC50131-3 and current EN certifications. See Compliance with EN50131 Approvals on page 20.

Product Type Configuration Standard Logo
SPC6350.320 + SPCP355.300 60h, unmonitored NF Grade 3, L
(Cert. 1233700001 + Cert.8033700002) Class 1

SPC5350.320 + SPCP355.300 60h, unmonitored -
(Cert. 1233700001 + Cert.8033700002) H E ‘{
SPC6350.320 60h, unmonitored vVvVe
(Cert. 1233700001)

SPC5350.320 60h, unmonitored

(Cert. 1233700001)

SPC6330.320 + SPCP333.300 60h, unmonitored NF Grade 3, RO
(Cert. 1233700001) Class 1

SPC5330.320 + SPCP333.300 60h, unmonitored

(Cert. 1232200003)

SPC6330.320 30h, monitored
(Cert. 1233700001)

SPC5330.320 30h, monitored
(Cert. 1232200003)

SPC5320.320 36h, unmonitored NF Grade 2, I

O
-~
&

(Cert. 1232200003) Class 1 K
SPC4320.320 36h, unmonitored H EM
(Cert. 1232200003) VVGo
SPCN110.000 NF Grade 2
SPCN320.000 and 3,

Class 1

SPCK420.100 >
SPCK620.100 Had
SPCK623.100 A1)
SPCE652.100

SPCE452.100

SPCE110.100

SPCE120.100
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This chapter covers:

4.1 SPCA000 .. . 3
4.2 SPCS000 ... . 33
4.3 SPCO000 ... . 37
4.4 SPCP355.300 ... . 40
4.1 SPC4000
Programmable areas 4
Max. number of user PINs 100
Remote controls Up to 32
PACE Devices 32
Wireless Panic Alarm Upto 128
Event memory 1000 intrusion events, 1000 access events
Number of on-board zones 8
Max. number of hardwired zones 32
Max. number of wireless zones 32 (take away wired zones)
Max. number of Intrunet wireless 20
detectors per wireless receiver
(recommended)
EOL resistor Dual 4k7 (default), other resistor combinations configurable
Number of on-board relays 1 strobe (30V DC/1A resistive switching current)
Number of on-board open coll. 2 internal/external bell, 3 freely programmable (each max. 400mA resistive
switching current, supplied via auxiliary output)
Firmware V3.x
Door capacity Max. 4 entry doors or 2 entry/exit doors
Number of card reader Max. 4
Radio module o SPC4221: integrated SiWay RF receiver (868MHz)
« SPC4320.220: Optional (SPCW111)
» SPC4320.320: Optional (SPCW110)
Verification 4 verification zones with max. 4 IP-cameras and 4 audio devices.
Video Up to 16 pre/16 post event images (by JPEG resolution 320 x 240, max. 1
frame/sec.)
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Audio Up to 60sec. pre/60sec. post audio recording

Field bus 1) X-BUS on RS-485 (307kb/s)

Number of field devices 2) Max. 11 (4 keypads, 2 door-expanders, 5 input/output expanders)
Connectable field devices « Keypads: SPCK42x, SPCK62x

« Door expanders: SPCA210, SPCP43x
« Expanders with I/0: SPCE65x, SPCE45x, SPCP33x, SPCE110,
SPCE120, SPCV32x
Interfaces o 1X-BUS (1 spur)
« 1RS232
« USB (PC connection)
o SPC43xx: Additionally 1 Ethernet (RJ45)

Tamper contact Front spring tamper, 2 auxiliary tamper contact inputs
Power supply Type A (per EN50131-1)

Mains voltage 230V AC, + 10%/ -15%, S0Hz

Mains fuse 250mA T (replaceable part on mains terminal block)
Power consumption SPC42xx: Max. 160mA at 230V AC

SPC43xx: Max. 200mA at 230V AC

Operating current SPC42xx Controller: Max. 160mA at 12V DC
SPC43xx Controller: Max. 200mA at 12V DC

Quiescent current SPC42xx Controller:
Max. 140mA at 12V DC (165mA with PSTN, 270mA with GSM, 295mA with
PSTN and GSM)

SPC43xx Controller:
Max. 170mA at 12V DC (195mA with PSTN, 300mA with GSM, 325mA with
PSTN and GSM)

Output voltage 13—14V DC in normal conditions (mains powered and fully charged battery),
min. 10.5V DC when powered by secondary device (before system shut down
to battery deep discharge protection)

Low voltage trigger 7.5V DC

Overvoltage protection 15.7Vv DC

Peak to Peak ripple Max. 5% of output voltage

Auxiliary power (nominal) Max. 750mA at 12V DC

Battery type SPC422x/4320:

(Battery not supplied) o YUASA NP7-12FR (12V/7Ah) - NF

» PowerSonic PS1270 (12V/7Ah)
o YUASA Yucel Y7-12FR (12V/7Ah)

Battery charger SPC422x/4320: Max. 72h to 80% of battery capacity
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Battery protection Current limited to 1A (fuse protected), deep discharge protection at 10.5V DC
+/-3%

Software update Local and remote upgrade for controller, peripherals and GSM/PTSN modems.

Calibration No calibration checks required (calibrated at manufacturing)

Serviceable parts No serviceable parts

Operating temperature -10to +50°C

Relative humidity Max. 90% (non condensing)

Colour RAL 9003 (signal white)

Weight SPC422x/4320: 4.500kg

Dimensions (W x H x D) SPC422x/4320: 264 x 357 x 81mm

Housing SPC4320.320: Small metal housing (1.2mm mild steel)

SPC422x.220: Small housing with metal base (1.2mm mild steel) and plastic lid

Housing can contain up to SPC422x/4320: 1 additional expander (size 150 x 82mm)
IP rating 30

ATS 3

ATP 8

Event Profiles 5

Event Exceptions 10

Command Profiles 5

1) Max. 400m between devices/cable types IYSTY 2 x 2 x @ 0.6mm (min.), UTP cat5 (solid core) or
Belden 9829.

2) More I/0O expanders can be addressed instead of a keypad or door expander, but number of
programmable inputs/outputs cannot exceed specified system limits.

4.2 SPC5000

Programmable areas 16
Max. number of user PINs 500
Remote controls Upto 100
PACE Devices 250
Wireless Panic Alarm Upto 128
Event memory 10,000 intrusion events, 10,000 access events
Number of on-board zones » SPC5320/5330 —8
o SPC5350—16
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Max. number of hardwired 128
zones

Max. number of wireless zones 120 (take away wired zones)

Max. number of Intrunet 20

wireless detectors per wireless

receiver (recommended)

EOL resistor Dual 4k7 (default), other resistor combinations configurable

Relay Outputs « SPC5320/5330 — 1 strobe (30V DC/1A resistive switching current)

« SPC5350 —4 (single-pole changeover, 30V DC/ maximum 1A resistive
switching current)

Electronic Outputs « SPC5320/5330 — 5 outputs:
— 2 internal/external bells

— 3 programmable. Maximum 400mA resistive switching current per
output, supplied by auxiliary output.

« SPC5350 — 8 outputs. Maximum 400mA resistive switching current per
output

— 5 standard power outputs

— 3 supervised outputs

Firmware V3.x

Door capacity Max. 16 entry doors or 8 entry/exit doors

Number of card reader Max. 16

Radio module Optional (SPCW110)

Verification 16 verification zones with max. 4 IP-cameras and 16 audio devices.

Video Up to 16 pre/16 post event images (by JPEG resolution 320 x 240, max. 1
frame/sec.)

Audio Up to 60sec. pre/60sec. post audio recording

Field bus 1) X-BUS on RS-485 (307kb/s)

Number of field devices 2) Max. 48 (16 keypads, 8 door-expanders, 16 input/output expanders)

Connectable field devices « Keypads: SPCK42x, SPCK62x

« Door expanders: SPCA210, SPCP43x
« Expanders with I/O: SPCE65x, SPCE45x, SPCP33x, SPCP35x,
SPCE110, SPCE120, SPCV32x
Interfaces o 2X-BUS (2 spurs or 1loop)
« 2RS232
« 1USB (PC connection)
« SPC53xx: Additionally 1 Ethemet (RJ45)
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Tamper contact

Power supply
Mains voltage

Mains fuse

Power consumption

Operating current

Quiescent current

Output voltage

Low voltage trigger

Overvoltage protection

Peak to Peak ripple

Auxiliary power (nominal)

Type A (per EN50131-1)
230V AC, + 10%/-15%, 50Hz

SPC53xx Controller: Max. 170mA at 12V DC (195mA with PSTN, 300mA
with GSM, 325mA with PSTN and GSM)

13-14V DC in normal conditions (mains powered and fully charged battery),
min. 10.5V DC when powered by secondary device (before system shut
down to battery deep discharge protection)

11V DC

Max. 5% of output voltage

SPC5320/5330: Front spring tamper, 2 auxiliary tamper contact inputs
SPC5350: Front/back tamper switch

SPC5320/5330: 250mA T (replaceable part on mains terminal block)
SPC5350 : 800mA T (replaceable part on mains terminal block)

SPC5320/5330: Max. 200mA at 230V AC
SPC5350: Max. 500mA at 230V AC

SPC5320/5330: Controller: Max. 200mA at 12V DC
SPC5350: Max. 210mA at 12V DC

SPC5320/5330: 15.7V DC
SPC5350: 15V DC nominal

SPC5320/5330: Max. 750mA at 12V DC

SPC5350: Max. 2200mA at 12V DC (8 separately fused outputs, 300mA
per output)
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Technical Data

Battery type
(Battery not supplied)

Battery charger

Battery protection

Software update

Calibration

Serviceable parts

Operating temperature
Relative humidity
Colour

Weight

Dimensions (W x H x D)

SPC5320:

YUASA NP7-12FR (12V/7Ah) - NF
PowerSonic PS1270 (12V/7Ah)
YUASA Yucel Y7-12FR (12V/7Ah)

SPC5330:

YUASA NP17-12IFR (12V/17Ah) - NF
YUASA Yucel Y17-12FR (12V/17Ah)
PowerSonic PS12170 (12V/7Ah)

SPC5350:

FIAMM FGV22703 (12V/27Ah) - NF
PowerSonic PS12260FR (12V/26Ah)
PowerSonic PS12170 (12V/17Ah)
Alarmcom AB1227-0 (12V/27Ah)
YUASA NPL24-12IFR (12V/24Ah)
YUASA Yucel Y17-12IFR (12V/17Ah)
YUASA Yucel Y24-12FR (12V/24Ah)

SPC5320: Max. 72h,

SPC5330/5350: Max. 24h to 80% of battery capacity

SPC5320/5330: Current limited to 1A (fuse protected), deep discharge
protection at 10.5V DC +/- 3%

SPC5350: Current limited to 2A (protected by PTC resettable fuse),
deep discharge protection at 10.5V DC

Local and remote upgrade for controller, peripherals and GSM/PTSN
modems.

No calibration checks required (calibrated at manufacturing)

SPC5320/5330: No serviceable parts
SPC5350: 8 glass fuses (400mA AT) for 12V DC outputs

-10to +50°C

Max. 90% (non condensing)

RAL 90083 (signal white)

SPC5320: 4.500kg
SPC5330: 6.400kg
SPC5350: 18.600kg

SPC5320: 264 x 357 x 81mm
SPC5330: 326 x 415 x 114mm
SPC5350: 498 x 664 x 157mm
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Housing « SPC5320: Small metal housing (1.2mm mild steel)
« SPC5330: Hinged metal housing (1.2mm mild steel)
o SPC5350: Metal housing (1.5mm mild steel)

Housing can contain up to « SPC5320: 1 additional expander
« SPC5330: 4 additional expanders (size 150 x 82mm)
o SPC5350: 4 additional expanders (150 x 82mm)

IP/IK Rating 30/06
ATS 5
ATP 15
Event Profiles 10
Event Exceptions 50
Command Profiles 8

1) Max. 400m between devices/cable types IYSTY 2 x 2 x & 0.6mm (min.), UTP cat5 (solid core) or
Belden 9829.

2) More 1/0O expanders can be addressed instead of a keypad or door expander, but number of
programmable inputs/outputs cannot exceed specified system limits.

4.3 SPC6000

Programmable areas 60

Max. number of user PINs 2500

Remote controls Upto 100

PACE Devices 250

Wireless Panic Alarm Upto 128

Event memory 10,000 intrusion events, 10,000 access events
Number of on-board zones « SPC6320/6330 — 8

» SPC6350—16

Max. number of hardwired 512

zones

Max. number of wireless 120 (take away wired zones)
zones

Max. number of Intrunet 20

wireless detectors per
wireless receiver

(recommended)
EOL resistor Dual 4k7 (default), other resistor combinations configurable
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Technical Data

Relay Outputs

Electronic Outputs

Firmware

Door capacity
Number of card reader
Radio module
Verification

Video

Audio
Field bus 1)
Number of field devices 2)

Connectable field devices

Interfaces

Tamper contact

Power supply
Mains voltage

Mains fuse

« SPC6320/6330 — 1 strobe (30V DC/1A resistive switching current)

« SPC6350 —4 (single-pole changeover, 30V DC/ maximum 1A resistive
switching current)

« SP6320/6330 — 5 outputs:
— 2 internal/external bells

— 3 programmable. Maximum 400mA resistive switching current per
output, supplied by auxiliary output.

« SPC6350 — 8 outputs. Maximum 400mA resistive switching current per
output

— 5 standard power outputs

— 3 supervised outputs
V3.x
Max. 64 entry doors or 32 entry/exit doors
Max. 64
Optional (SPCW110)
32 verification zones with max. 4 IP-cameras and 32 audio devices.

Up to 16 pre/16 post event images (by JPEG resolution 320 x 240, max. 1
frame/sec.)

Up to 60sec. pre/60sec. post audio recording
X-BUS on RS-485 (307kb/s)
Max. 128 (32 keypads, 32 door-expanders, 64 input/output expanders)

« Keypads: SPCK42x, SPCK62x

« Door expanders: SPCA210, SPCP43x

« Expanders with I/O: SPCE65x, SPCE45x, SPCP33x, SPCP35x,
SPCE110, SPCE120, SPCV32x

o 2X-BUS (2 spurs or 1 loop)

« 2RS232

« 1USB (PC connection)

« SPC63xx: Additionally 1 Ethernet (RJ45)

« SPC6330: Front spring tamper, 2 auxiliary tamper contact inputs
« SPC6350: Front/back tamper switch

Type A (per EN50131-1)
230V AC, +10%/-15%, 50Hz

« SPC6330: 250mA T (replaceable part on mains terminal block)
« SPC6350: 800mA T (replaceable part on mains terminal block)
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Power consumption

Operating current

Quiescent current

Output voltage

Low voltage trigger

Overvoltage protection

Peak to Peak ripple

Auxiliary power (nominal)

Battery type
(Battery not supplied)

Battery charger

Battery protection

Software update

Calibration

» SPC6330: Max. 200mA at 230V AC
« SPC6350: Max. 500mA at 230V AC

» SPC6330: Max. 200mA at 12V DC
« SPC6350: Max. 210mA at 12V DC

SPC63xx Controller: Max. 170mA at 12V DC (195mA with PSTN, 300mA
with GSM, 325mA with PSTN and GSM)

« SPC6330: 13—14V DC in normal conditions (mains powered and fully
charged battery), min. 10.5V DC when powered by secondary device
(before system shut down to battery deep discharge protection)

« SPC6350: 13—14V DC in normal conditions (mains powered and fully
charged battery), min. 10.5V DC when powered by secondary device
(before system shut down to battery deep discharge protection)

11V DC

« SPC6330: 15.7v DC
« SPC6350: 15V DC nominal

Max. 5% of output voltage

« SPC6330: Max. 750mA at 12V DC
o SPC6350: Max. 2200mA at 12V DC (8 separately fused outputs, 300mA
per output)
SPC6330:
o YUASA NP17-12FR (12V/17Ah) - NF
o YUASA Yucel Y17-12IFR (12V/17Ah)
o YUASA Yucel Y24-12FR (12V/24Ah)
« PowerSonic PS12170 (12V/7Ah)
« PowerSonic PS12260 (12V/26Ah)
SPC6350:
o YUASA NP17-12FR(12V/17Ah) - NF
« FIAMM FGV22703 (12V/27Ah) - NF
o YUASA NPL24-12IFR (12V/24Ah)
« Alarmcom AB1227-0 (12V/27Ah)
« PowerSonic PS12260 (12V/26Ah)

SPC63xx: Max. 24h to 80% of battery capacity

o SPC6330: Current limited to 1A (fuse protected), deep discharge
protection at 10.5V DC +/- 3%

« SPC6350: Current limited to 2A (protected by PTC resettable fuse), deep
discharge protection at 10.5V DC, low voltage indicator at 11V DC

Local and remote upgrade for controller, peripherals and GSM/PTSN modems.

No calibration checks required (calibrated at manufacturing)
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Serviceable parts « SPC6330: No serviceable parts
« SPC6350: 8 glass fuses (400mA AT) for 12V DC outputs

Operating temperature -10to +50°C

Relative humidity Max. 90% (non condensing)
Colour RAL 9003 (signal white)
Weight « SPC6330: 6.400kg

« SPC6350: 18.600kg

Dimensions (W x H x D) « SPC6330: 326 x 415 x 114mm
o SPC6350: 498 x 664 x 157mm

Housing « SPC6330: Hinged metal housing (1.2mm mild steel)
o SPC6350: Metal housing (1.5mm mild steel)

Housing can contain up to « SPC6330: 4 additional expanders (size 150 x 82mm)
« SPC6350: 6 additional expanders (150 x 82mm) or 1 additional controller +
4 expanders
IP/IK Rating 30/06
ATS 10
ATP 30
Event Profiles 20
Event Exceptions 100
Command Profiles 10

1) Max. 400 m between devices/cable types IYSTY 2 x 2 x @ 0.6mm (min.), UTP cat5 (solid core) or
Belden 9829.

2) More 1/0O expanders can be addressed instead of a keypad or door expander, but number of
programmable inputs/outputs cannot exceed specified system limits.

4.4 SPCP355.300

Number of on-board zones 8

EOL resistor Dual 4k7 (default), other resistor combinations selectable

Relay Outputs 3 (single-pole changeover, 30V DC/max. 1A resistive switching current)

Electronic Outputs 3 supervised (each max. 400mA resistive switching current),

Interfaces X-BUS (in, out, branch)

Mains Voltage 230V AC, +10to-15%, 50Hz

Operating Current Max. 245mA at 12V DC (all relays activated)

Quiescent Current Max. 195mA at 12V DC

Output voltage 13-14V DC in normal conditions (mains powered and fully charged battery),
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Technical Data

Auxiliary power (nominal)

Battery type
(Battery not supplied)

Tamper contact
Operating temperature
Housing

Colour

Dimensions

Weight (without batteries)

IP/IK Rating

Max. 2360mA at 12V DC (8 separately fused outputs, max. 300mA per output)

o FIAMM FGV22703 (12V/27Ah) - NF

o YUASA NP17-12FR (12V/17Ah)

o YUASA NPL24-12IFR (12V/24Ah)

« Alarmcom AB1227-0 (12V/27Ah)

o PowerSonic PS12170 (12V/17Ah)

« PowerSonic PS12260 (12V/26Ah)

o YUASA Yucel Y17-12IFR (12V/17Ah)
o YUASA Yucel Y24-12FR (12V/24Ah)

Front/back tamper switch

0to+40°C

Metal housing (1.5mm mild steel)

RAL 9003 (signal white)

498 x 664 x 157mm

18.400kg (housing incl. cover), 11.300kg (housing without cover)
30/06
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5 Introduction

The SPC series controller is a true hybrid controller with 8 on-board wired zones that communicate with
intruder devices.

The flexible design of the controller allows the functional components (PSTN/GSM/RF) to be mixed and
matched, improving the capability of the system. Using this approach, an installer can ensure that an
efficient installation with minimal wiring is achieved.

10|

12<0

15
Overview
Number Description Number Description
1 PSTN 13 Wireless expander
2 GSM 14 PSU
3 Ethernet 15 Loop configuration
4 Wireless Receiver 16 PSTN network
5 AC mains 17 GSM network
6 Battery 12V 18 Broadband router
7 RF 19 Network
8 Wired outputs (6) 20 Central
9 Wired inputs (8) 21 LAN/WLAN
10 Keypads 22 Service desk
11 10 expander 23 Remote user
12 Output Expander 24 Mobile interfaces
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6 Mounting system equipment

This chapter covers:

6.1 Mounting a G2 housing ... ... .. 43
6.2 Mounting a G3 housing ... ... ... 44
6.3 Mounting a G5 housing ... ... ... 51
6.4 Mounting a keypad .. ... .. . 56
6.5 Mounting an expander .. 56

6.1 Mounting a G2 housing

The SPC G2 housing is supplied with a metallic or plastic cover. The cover is attached to the base of the
housing by 2 securing screws located on the top and bottom of the front cover.

To open the housing, remove both screws with the appropriate screwdriver and lift the cover directly from
the base.

The G2 housing contains the controller PCB (Printed Circuit Board) mounted on 4 support pillars. An
optional input/output module can be mounted directly beneath the controller PCB. A battery with capacity
of 7Ah max. can be accommodated below the controller.

An optional external antenna must be fitted to housings with metallic lid if the wireless functionality is
required. If an antenna is fitted to the unit, it must be enabled in the firmware.

The SPC G2 housing provides 3 screw holes for wall mounting the unit.

To wall mount the housing, remove the cover and locate the initial fixing screw hole at the top of the
housing. Mark the position of this screw hole on the desired location on the wall and drill the initial screw
hole. Screw the unit to the wall and mark the position of the bottom 2 screw hole positions with the unit
vertically aligned.

Screws with a 4-5mm shank, a minimum head diameter of 8mm and a minimum length of 40mm are
recommended for mounting the housing. Additional expansion plugs or fixings may be required depending
on the construction of the wall.
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Standard housing
Number Description
1 Wireless antenna
2 SPC controller
3 Wall mounting screw holes

6.2 Mounting a G3 housing

The SPC G3 housing is supplied with a metallic front cover. The cover is attached to the base of the
housing by hinges and secured with one screw on the right hand side of the front cover.

To open the housing, remove the screws with the appropriate screwdriver and open the front cover.

The G3 housing contains the controller PCB (Printed Circuit Board) mounted on a hinged mounting
bracket. Expanders and PSUs can be mounted on the underside of the hinged mounting bracket and also
on the back wall of the housing underneath the mounting bracket.
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© ©

Number Description

1 Expanders/PSU
2 Controller

3 Expanders/PSU
4 Battery

An optional external antenna must be fitted to housings with metallic lid if the wireless functionality is
required. If an antenna is fitted to the unit, it must be enabled in the firmware.

The SPC G3 housing provides 3 screw holes for wall mounting the unit (see item 1 below).

Screws with a 4-5mm shank, a minimum head diameter of 8mm and a minimum length of 40mm are
recommended for mounting the housing. Additional expansion plugs or fixings may be required
depending on the construction of the wall.
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To wall mount the housing:

1. Open the cover and locate the initial fixing screw hole at the top of the housing.

2. Mark the position of this screw hole on the desired location on the wall and drill the initial screw hole.

3. Screw the unit to the wall and mark the position of the bottom 2 screw hole positions with the unit
vertically aligned.

Back Tamper Requirements

A back tamper switch may be required by your local approval.

The back tamper switch is delivered with SPC panels in G3 housings or is available as an optional extra
with a mounting kit (SPCY130). EN50131 G3 panels (SPCxx3x.x20) are supplied with a back tamper kit

as standard.

6.2.1 Mounting a Back Tamper Kit

The SPC back tamper kit provides SPC control panels and power supplies with the option of having back
tamper as well as front tamper.

The back tamper kit comprises the following parts:

« Tamper switch

« Leads for connecting the back tamper switch to the controller

« Wallfixing plate
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Mounting the Wall Fixing Plate

1.

o o &

Mount the SPC in the appropriate position on the wall using all three fixings (see item 1 below).

%]

o0 [0

Draw a line around the inside of the back tamper cut out (see item 2 above) to provide a guide for
the wall plate on the fixing wall. Remove the housing from the wall.

Place the wall plate (see item 1 below) on the wall centering it precisely around the rectangle
previously drawn (see item 2 below).

— B 4

4 o

T
|
Ra— -
|
|

Ensure all four flanges on the wall plate are flush with the wall.
Mark the four fixings on the wall plate.
Drill and use suitable screws (max. 4mm) for the wall substrate.

Fit the wall plate to the wall.

Fitting the Back Tamper Switch

1.

Insert the tamper switch (see item 2 below) into the back of the housing so that the plunger faces
outwards (see item 1 below).
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2. Fit the housing back onto the wall using the three fixings previously removed (see item 2 below).
Visually check to ensure there is a flush finish between the wall plate and the housing
metalwork.

Number Description

1 Housing

2 Wall

3 Wall Fixing Plate
4 Tamper Switch

WARNING: If the walll fixing plate is not accurately aligned then the housing will not sit properly on
its fixings.
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Wiring the Back Tamper Switch to the Control Panel

All control panels have spare inputs configured as tamper inputs that are designed for wiring the tamper
switch and do not require any programming.

This tamper switch will be referred to as ‘Aux Tamper 1’ by the system.
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1. Connect NO on the tamper switch to T1 on the controller.
2. Connect COM on the tamper switch to C on the controller. Ensure the T2 jumper is not removed.

3. When the tamper switch is wired, the controller can be commissioned in the normal manner.

6.2.2 Battery installation for EN50131 compliance

For EN50131 compliance the battery needs to be retained within the housing to stop movement. This is
achieved by bending out the flaps in the rear of the Hinged Housing so that the battery is retained.

If a 7Ah battery is used then the battery is biased to the left of the housing and bottom flap is bent to meet

the battery.
If a 17Ah battery is used then the battery is biased to the right of the housing and middle flap is bent to
meet the battery.
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battery exist or any leakage of the electrolyte then the battery should be discarded as per the

E The battery flaps should be bent carefully as not to damage the battery. If any signs of a damaged
l current regulations and a new battery fitted.

6.3 Mounting a G5 housing

The SPC G5 housing comprises of a metallic base and front cover. The cover is attached to the base of
the housing by 4 securing screws located on the top and bottom of the front cover.

To open the housing, remove all the screws with the appropriate screwdriver and lift the cover directly
from the base.

The G5 housing contains the controller PCB (Printed Circuit Board) and the SPCP355.300 Smart PSU,
both mounted on 4 support pillars. An 8 In/2 Output Expander is mounted on top of the PSU. Four extra
pillars are included to give you the option to mount the 8 In/2 Output Expander below the PSU board in
the G5 housing. Additional expanders can be installed in the housing as shown.

g L—10
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Number Description Number Description
1 Battery 6 Battery temperature leads
2 Battery strap 7 PSU
3 Fixing tabs 8 Optional expander positions
4 Strap holes 9 Controller
5 Battery leads 10 Antenna
Two batteries, with a maximum capacity of 27Ah, can be accommodated in the battery compartment at
the bottom of the housing.
An optional external antenna must be fitted to a metallic housing if wireless functionality is required.
Knockout holes are available in three positions on the top of the housing where the antenna can be
installed. If an antenna is fitted to the unit, it must be enabled in the firmware.
The SPC G5 housing provides 4 screw holes for wall mounting the unit.
1
O
ol
7 ?’
2\ | WTETTR wl
3| +BD" —
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1
Number Description
1 Corner fixings
2 Tamper cutout
3 Shelf separating battery compartment
4 Telecom socket cutout

6.3.1 Tamper protection

The tamper switch and back tamper bracket are fitted to the housing. The switch is used on its own for
front tamper purposes only or used with the back tamper bracket for both front and back tamper protection.
Either back or front tamper protection is required depending on local approval.
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The tamper bracket is held firmly in place with a securing screw. Remember to remove this screw if
commissioning the system for back tamper protection. Do not remove this screw if using front tamper
only.

6.3.2 Mounting the housing with tamper protection

To mount the housing:
1. Using the supplied mounting template, mark the 4 drill positions for fixing the housing to the wall.

2. Drill and install suitable screws (see enclosed template) into the wall. Leave the screws
protruding 1.5cm from the wall.

3. The G5 housing is pre-configured for front tamper only. To configure the housing for both front
and back tamper, remove the front tamper securing screw (item 1).

The tamper bracket swings to the far right of the orientation slot (item 6).

4. Mount the G5 housing in the appropriate position on the wall and tighten the 4 mounting screws.
Ensure that the housing is flush with the wall surface.

5. Move the tamper bracket to the far left of the orientation slot and tighten the back tamper screw
(item 5) to the wall. The tamper bracket should be perpendicular to the back wall of the housing.

6. Install the lid on the housing to test the tamper switch connection. Lift the lid by approximately
1mm to activate the tamper switch.

Number Description Number Description

1 Front tamper securing screw 5 Back tamper screw

2 Tamper bracket 6 Orientation slot

3 Tamper switch 7 Shelf separating battery compartment
4 Back tamper cutout
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WARNING: If the back tamper screw is not secure against the wall, then tamper protection is
compromised. If the housing is removed from the wall or displaced, the back tamper contact needs to
be tested again for proper functionality and re-adjusted if required.

6.3.2.1 Tamper operation

Tamper switch - normal

4

3

T

7]
7
|
1
Number Description
1 Wall
2 Back tamper screw
3 Back wall of housing
4 Housing lid
5 Tamper switch contact closed

Tamper switch — displaced

4

5_

3

Number Description

1 Wall

2 Back tamper screw
3 Back wall of housing
4 Housing lid
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Number Description

5 Tamper switch contact open

If the housing is removed from the wall or displaced, the tamper bracket screw is no longer secure
against the wall, causing the bracket to pivot. This in turn causes the tamper switch to swivel away
from the lid and opens the switch contact.

WARNING: If the tamper bracket screw is not secure against the wall, then tamper protection is
compromised.

If using two batteries in the G5 housing, it is recommended that both batteries should be the same
Ah rating.

7
6
b
2
Number Description Number Description
1 Battery 6 Battery temperature lead
2 Fixing strap 7 PSU
3 Battery fixing tabs 8 Optional expander positions
4 Strap holes 9 Controller
5 Battery leads 10 Antenna
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To install the batteries:

1.
2.
3.

Place the batteries into the battery compartment.
Press the metal tabs at the top and either side of the batteries in towards the batteries.

Secure each battery to the housing using a battery strap. Ensure that the strap is thread through the
battery strap holes at the back of the battery compartment and around the battery, with the two ends
of the strap at the front of the battery.

Fasten the two ends of the strap firmly using the Velcro strip. Ensure that the strap is tight around
the battery.

Connect one end of the battery leads to the battery + and - terminals and the other ends to the
corresponding + and - inputs of the PSU.

the battery first before connecting the negative (-) lead. When removing the

CAUTION: When installing the battery, always connect the positive (+) lead to
A battery, always remove the negative (-) lead first before removing the positive (+).

Connect the loose ends of the attached temperature monitoring leads to the battery temperature
monitoring inputs on the PSU.

6.4 Mounting a keypad

See the corresponding installation instruction.

Installation guides are available at http://www.spcsupportinfo.com/connectspcdata/userdata.

6.5 Mounting an expander

See the corresponding installation instruction.

Installation guides are available at http://www.spcsupportinfo.com/connectspcdata/userdata.
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7 Smart PSU

This section describes the components and wiring of the Smart PSU.

7.1 SPCP355.300 Smart PSU

The SPCP355.300 Smart PSU is a power supply combined with an 8-input/2-output expander, contained
in a G5 housing. The PSU is backed up by either 2x24Ah, or 2x27Ah batteries, and provides eight power
and four logical outputs

The expander monitors the PSU for overcurrent, fuse failures, AC voltage, communications, and battery
output. The expander is powered by, and receives data from, the PSU via a connector cable. It also
interfaces with the SPC controller over the SPX X-BUS.
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Number Description

SPCP355.300 Smart PSU

1 Mains input and fuse block

2 Input transformer

3 AC IN — AC power input

4 MAINS — Mains power LED

BATT1 — Battery 1 charge state LED

6 BATT2 — Battery 2 charge state LED
7 FUSE — Fuse fail LED
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Number Description

8 LIMIT — Current limit LED
9 STATUS — Status LED
10 A2 — 14.5V power output.

« Not backed up by battery
« Protected by PTC resettable fuse, rated at 300mA (Item 23 in image above)

11 A1 — Connects to the power input (+/-) on the SPC5350/6350.

12 COMM1 — Expander 4-pin interface. Connects to item 32, power and data connection, in image above,
with a straight-through cable.

13 Clock Reference — Connects to Clock Reference on SPC5350/6350.

14 T1, T2— Tamper switch inputs. Connect these to the Front/Back tamper switch.

See Mounting the housing with tamper protection on page 53.

15 Front back tamper switch. See Mounting the housing with tamper protection on page 53.

16 NO/NC — Configurable NO/NC logical relay output. See Wiring the Outputs on page 64 for more
information.

17 Glass fuses — 400mA T fuses for outputs 1-8.

18 OP 6-8 and SW 6-8 — Combined power outputs (OP) and logical outputs (SW).

Standard 12V DC power outputs combined with configurable, open-drain, logical outputs (4k7 EoL
supervised/unsupervised).

19 OP 1-5 — Standard 12V DC power outputs.

See warning note below this table for more information.

20 BTE2 — Battery 2 temperature monitoring input.

21 BATT1 and BATT2 — Battery 1 and 2 connectors.

22 BTE1 — Battery 1 temperature monitoring input.

23 PTC fuses — Fuses rated at 300mA. Protecting the A1 and A2 outputs.

For more information see System Recovery on page 66.

24 PTC fuse — Fuse rated at 5A. Protects the AC power input (item 3 in image above).

For more information see System Recovery on page 66.

25 PSU Kickstart Switch — For more information see System Recovery on page 66.
Expander
26 NO/NC — Logical relay outputs. The expander provides two configurable NO/NC logical relay outputs.

For more information, see Wiring the Inputs on page 63.

27 | 1-8 — Inputs. The expander has 8 on-board inputs which can be configured as intruder alarm zones on
the SPC system.

For more information, see Wiring the Inputs on page 63.
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Number Description

28 Auxiliary power supply 12V — Do not use.
Expander is powered through COMM1 on the SPCP355.300 Smart PSU.

29 X-BUS Input power — Do not use.
Expander is powered through COMM1 on the SPCP355.300 Smart PSU.

30 X-BUS Interface — The communications bus connects expanders on the SPC system.

31 Termination Jumper — This jumper is always fitted, by default.

For more information, see Wiring the X-BUS Interface on page 62.

32 PSU 4-pin interface — Connects to COMM1 on the SPCP355.300 Smart PSU (item 12 in image
above), power and data connector, with a straight-through cable.

33 Front tamper switch — Not used. The Front/Back tamper connected to T1 and T2 of the SPCP355.300
Smart PSU is the only tamper required by this installation.

34 JP1— Front tamper bypass must be fitted.

35 Buzzer — Activated to locate the expander. See Locate on page 125 for more information.

36 JP6 — Back tamper bypass. Must be fitted.

37 Manual addressing switches — Enable manual setting of the ID of the expander.

38 X-BUS Status LED — Indicates the X-BUS status, when the system is in Full Engineer mode, as
follows:

« Slow flash (every 1.5 seconds) — X-BUS communications status is OK.
« Quick flash (every 0.2 seconds) — Indicates one of the following:
— Indicates the last-in-line expander for spur configurations.

— Indicates a communications problem between two expanders. If two adjacent expanders are
flashing quickly, the problem exists between those two expanders.

39 LED — Not used.
40 PSU Status LED.

WARNING: The combined maximum load current drawn from all 12V DC outputs (OP 1-8) plus
COMM1, should not exceed 2.4A. Each individual output, and output A2, should not exceed
300maA. If the device current requires more than 300maA, it is recommended to parallel the outputs.

Adding extra expanders

If adding extra expanders to the G5 housing, you must ensure the front and back tampers are
deactivated by fitting the appropriate jumpers. In a G5 housing, the front and back tamper is handled by
the housing itself and the SPCP355.300 Smart PSU.

7.1.1 Supervised Outputs

The SPCP355.300 Smart PSU supports three, open-drain, logical outputs, which can be supervised for
tamper detection. Output tamper detection is enabled by configuration. Output tamper detection is
enabled by connecting a 4k7 EoL resistor in parallel with the load device, such as an external bell. A
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power diode (1N4001 for example, or similar) is also required, if not already present in the external device.

SWE-SW8 | (O
ov|(O o—
PIR 1
P&6-0F
OP6-0P8 | O oo
r——— - - - - - - - 7 = 1
| |
| " |
SW6-sSwa O i |
ov| o | 7 Ext. Bell | —2
| |
- |
OP6-0P8 | O | o |
| |
N |
Number Description
1 Standard 12V Power output
2 Configurable, supervised, 12V DC logical switched output.

7.1.2 Batteries

This section covers:
« Installing Batteries on the facing page
« Testing Battery Voltage on page 62
« Deep Discharge Protection on page 62
« Battery Stand-By Times on page 62
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7.1.2.1 Installing Batteries
This section describes the battery installation for the SPCP355.300 Smart PSU and G5 Housing.

[ +

Number

Description

o N o o »~ w DN

Battery

Battery strap

Fixing holes

Strap holes

Battery leads

Battery temperature leads

PSU/Expander

Mounting positions for additional expanders.
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i It is recommended that two batteries are used. These batteries must be of the same type and
| capacity.

1. Install the batteries in the battery compartment.

2. Secure each battery using the battery straps provided, ensuring the strap is threaded through the
battery strap holes at the back of the battery and around the battery.

3. Secure the two ends of the battery strap at the front of the battery, ensuring the battery strap is
firmly tightened.

4. Connect the leads from the SPCP355.300 Smart PSU to the batteries in the following order:
- Connect the positive (red) wire first.

- Connect the negative (black) wire second.

DANGER: When removing the battery leads, always disconnect the negative (black) lead before
disconnecting the positive (red) lead.

7.1.2.2 Testing Battery Voltage

The SPCP355.300 Smart PSU performs a load test on each battery by placing a load resistor across the
battery terminals and measuring the resultant voltage. This battery test is performed every five seconds.
7.1.2.3 Deep Discharge Protection
If mains power to the SPCP355.300 Smart PSU fails for a prolonged period, each battery supplies power
to the PSU 12V DC power outputs for a finite time. The batteries eventually discharge. To prevent a
battery discharging beyond recovery, the SPCP355.300 Smart PSU disconnects the battery if the
measured voltage drops below 10.5V DC. The battery can then be recharged after the mains power is
restored.

7.1.2.4 Battery Stand-By Times
See Calculating the battery power requirements on page 364 for the battery stand-by information.
7.1.3 Wiring the X-BUS Interface

The X-BUS interface connects expanders and keypads to the SPC controller. The X-BUS can be wired in
a number of different configurations, depending on the installation requirements.

The following table lists the cable types and distances recommended:

o Maximum cable length = (number of expanders and keypads in the system) x (maximum cable
1 distance for each cable type)

Cable Type Distance
CQR Standard Alarm Cable 200m
UTP Cat-5 Solid core 400m
Belden 9829 400m
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IYSTY 2x2x0.6(min) 400m

The following diagram shows an example of wiring the X-BUS:

1 2
SPC Contraller 3 4 5
afEe
SPCPas5S
CIPIHIW — —
LT 1 | OUT 14 14
I 1 —ouT 123 ﬁ —our j?ﬁ % » 123 ﬁ
e —
X T % 28 % ST %
11 3A 38 34
Il k] 3B 1B
I a4, 4 48,
i 48 4B 4B
| Pm——————— ovile @ L b | X ov|a B
b —— 12via e P P I ] [
| e A e e e e e = _FJ' =
e e — A 4
1 SPCP355.300 Smart PSU outputs
2 SPC Controller
3 SPCP355.300 Input/Output expander
4 Next expander
5 Next expander

7.1.3.1 Wiring the Inputs
The expander has 8 on-board zone inputs which can be configured as one of the following:
« NoEndofLine
« Single End of Line
o Dual End of Line
« Anti-Masking PIR
Default Configuration

The following diagram shows the default configuration, Double EOL 4k7:

3 4
. | [ —"
| 1o
2@
1 Input 1
2 CoM
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Number Description
3 Tamper

4 Alarm

5 4k7

6 EOL 4k7

Anti-Masking PIR

The following diagram shows the Anti-Masking PIR configuration:
3 1 ] l? f
1@
B
72—

12

Number Description

1 Input 2

COM

Tamper
Alarm

4k7

Detector Fault

2K2

0 N o o b~ W DN

EOL 4k7

7.1.3.2 Wiring the Outputs

The expander and PSU relay logical outputs can be assigned to any of the SPC system outputs. The relay
outputs can switch a rated voltage of 30V DC at 1A (non-inductive load).

When the relay is activated, the Common terminal connection (COM) is switched from the Normally
Closed (NC) to the Normally open (NO) terminal.
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The following diagram shows the wiring of an active, high output:
1 2 3
| | |

o (LHE‘U

ov
——i
1 Normally Open terminal
2 Common terminal connection (COM)
3 Normally Closed terminal (NC)

7.1.4 Compliance with NF and A2P approvals including CYBER requirements

CNPP Cert AFNOR Certification

Pdle Européen de Sécurité - Vernon 11 rue Francgois de Pressensé
Route de la Chapelle Réanville 93571 Saint Denis La Plaine Cedex
CD 64 - CS 22265 www.marque-nf.com

F-27950 SAINT MARCEL

www.cnpp.com
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L)

To comply with NF and A2P installation regulations, this housing must be sealed by affixing the
accompanying Tamper Label after installation.

SPC products listed have been tested according to NF324 - H58, with reference to RTC50131-6 and
RTC50131-3 and current EN certifications, see Compliance with EN50131 Approvals on page 20.

Product Type Configuration Standard Logo

SPC6350.320 + SPCP355.300 60h, unmonitored NF Grade 3, «‘;o?ce“““‘”m”

(Cert. 1233700001 + Cert.8033700002) Class 1 5

SPC5350.320 + SPCP355.300 60h, unmonitored H Eg

(Cert. 1233700001 + Cert.8033700002) VYV@

SPC6330.320 + SPCP333.300 60h, unmonitored NF Grade 3, @oﬁcﬁ“““m"’”

(Cert. 1233700001) Class 1 5

SPC5330.320 + SPCP333.300 60h, unmonitored H Eg

(Cert. 1232200003) VYV
7.1.5 PSU LED Status

The following table lists the Smart PSU LED status information:

LED MAINS ::;T-Zr L FUSE LIMIT STATUS

COLOUR Green  Green Red Red Green

Condition

Normal On On Off Off On

Mains OK, battery charging On Flash On

Mains Fail, Battery OK Off On On

Mains OK, battery faulty or not present On Off On

Mains OK, battery faulty, not present, orin deep discharge All LEDs Off.

protection mode

Fuse Fail On On

Total Load Current exceeded On On

PSU switcher failure Off Off Off Off Flash

7.1.6 System Recovery

Mains and Battery Failure

In the event of both mains and battery power failure, the PSU kickstart switch (item 25 in SPCP355.300
Smart PSU on page 57) enables the system to be restarted if only battery power is reinstated. To kickstart

the system, do the following:
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Prerequisites
o Mains power has failed
o Battery power has failed
o New batteries are available
1. Attach the battery leads.
2. Press and hold the PSU Kickstart button.
All LEDs flash.
3. Hold the PSU Kickstart button until the LEDs stop flashing.
4. Release the PSU Kickstart button.
PTC Fuse Reset

In the event of one of the PTC fuses resetting, you must manually disconnect then reconnect the mains
and battery connections.
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8 Controller hardware

This section describes the controller hardware.

See also

Powering expanders from the auxiliary power terminals on page 363
Wiring the X-BUS interface on page 75

Wiring an internal sounder on page 89

Wiring the zone inputs on page 85

Controller status LEDs on page 362

8.1 Controller Hardware 42xx/43xx/53xx/63xx

This section describes the controller for the SPC42xx, 43xx, 53 xx and 63xx models. The SPC5350 and
6350 are described in Controller Hardware SPC5350 and 6350 on page 71.

The SPC controller provides 8 on-board wired zones and optional wireless zones.
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Number Name Description
1 Optional The controller PCB can be factory fitted with a wireless module for use with wireless
wireless (868MHz) sensors.
module
© Vanderbilt 2018 68 ABV10276959-d

11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Controller hardware

Description

Number Name

2 SPC status
LEDs

3 AC power
input

4 Reset
button

5 Earth
connection
terminal

6 Aucxiliary
12V output

7 X-BUS
interface

8 On-board
outputs

9 Relay
output

10 Internal
bell/external
bell

These 7 LEDs display the status of various system parameters as described in Controller
status LEDs on page 362.

A/C Mains Input:

The mains AC input voltage is applied to this 2-pin connection via a transformer
contained in the SPC housing. The earth lead from the mains supply is wired to a
connection point on the metal housing.

Clock Reference™:

A clock reference signal can also be applied to this 2-pin connector to maintain accurate
system time.

« Toreset the controller:
— Press this switch once.

» Toreset the programming settings to default and reboot the controller:
—Hold down the button until you are asked if a factory reset is desired.
— Select YES to reset to factory defaults.

Warning: Defaulting the controller to factory settings deletes all configuration files,
including backups, stored on the controller. All isolates and inhibits are also deleted. It is
recommended you backup your configuration to a PC before defaulting the controller.

Note: This feature is not available if engineer lockout is enabled.

This terminal is not required and should not be connected.

The SPC controller provides an auxiliary 12V DC output that can be used to supply power
to expanders and devices such as latches, bells, etc. See Powering expanders from the
auxiliary power terminals on page 363. The maximum deliverable current is 750mA.

Note: The amount of current drawn is subject to the amount of time to be held up under
battery conditions.

This is the SPC communications bus used to network expanders together on the system.
See Wiring the X-BUS interface on page 75. SPC4000 only has 1 X-BUS interface.

Outputs OP4, OP5, and OP6 are 12V open collector resistive outputs that share a 400mA
current rating with the auxiliary 12V output. If the outputs are not connected to the 12V of
the controller and are powered from an external power source the OV of the power source
needs to be connected to the controller 0V and the external power source cannot exceed
12V.

The SPC controller provides a 1A, single-pole, changeover relay that can be used to drive
the strobe output on the external bell.

Internal and external bell outputs (INT+, INT-, EXT+, EXT-) are resistive outputs with a
400mA current rating. The BHO (Bell Hold Off), TR (Tamper Return), and EXT outputs
are used to connect an external bell to the controller. The INT+ and INT- terminals are
used to connect to internal devices such as an internal sounder. See Wiring an internal
sounder on page 89.

© Vanderbilt 2018

69 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Controller hardware

Number Name

Description

11

12

13

14

15

16

17

18
19

20

21

22

Zone inputs

Tamper
terminals

Serial port 2
terminal
block

EET

Ethernet
connectivity
LEDs

Ethernet
interface

USB
interface

Serial port 2

Serial port 1

Optional

plug-in
modules

Front
tamper

Battery
selector

Aucxiliary
power input

The controller provides 8 on-board zone inputs that can be monitored using a variety of
supervision configurations. These configurations can be programmed from system
programming. The default configuration is Dual End of Line (DEOL) using resistor values
of 4k7. See Wiring the zone inputs on page 85.

The controller provides 2 additional tamper input terminals that can be connected to
auxiliary tamper devices to provide increased tamper protection. These terminals should
be shorted when not in use.

Serial port 2 terminal block (TX, RX, GND) may be used to interface to an external
modem or PC terminal program. Serial port 2 shares a communications channel with the
back-up modem. If a back-up modem is installed, ensure that no devices are connected
to this serial port.

The 2 Ethernet LEDs indicate the status of the Ethernet connection. The left LED
indicates data activity on the Ethemnet port; the right LED indicates the Ethernet link is
active.

The Ethernet interface provides for the connection of a PC to the controller for the
purposes of programming the system.

This USB interface is used to access browser programming or a terminal program.

This RS232 serial port may be used to interface to an external modem or PC terminal
program. Serial port 2 shares a communications channel with the back-up modem. If a
back-up modem is installed, ensure no devices are connected to this serial port.

This RS232 serial port may be used to interface to an X10 protocol device.

A primary (left slot) and back-up (right slot) module can be connected to the controller.
These modules can be GSM or PSTN modems offering increased communication
functionality. The back-up modem should not be connected if serial port 2 interface is
connected to an external modem or other device.

This on-board front tamper (switch and switch) provides the housing tamper protection.

Note: The front tamper is not used in the G5 housing.

J12: Fit jumper for 17Ah battery use and remove for 7Ah battery.

Please Note: This selector is only available on 2.3 revision controller PCB.
(Not applicable for SPC5350 and SPC5360 panels.)

12V input from battery or PSU**.

* Default setup for SPC5350 and SPC5360 panels
**PSU only applies to SPC5350 and SPC6350 panels.
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8.2 Controller Hardware SPC5350 and 6350

This section describes the SPC5350 and SPC6350.

[ The expander that is connected to the power supply within the G5 is set to ID1 by default. This setting
1 should not be changed.
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Number Name Description
1 Optional The controller PCB can be factory fitted with a wireless module for use with wireless
wireless (868MHz) sensors.
module
2 SPC status These 7 LEDs display the status of various system parameters as described in
LEDs Controller status LEDs on page 362.
3 Clock A clock reference signal can also be applied to this 2-pin connector to maintain accurate
Reference  system time.
Connect to Clock Reference CN17 on SPCP355.300 Smart PSU.
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Number Name

Description

4

10

11

12
13

14

Reset
button

Earth
connection
terminal

X-BUS
interface

On-board
outputs

Relay
output

Bell Hold-
Off (BHO)
and Tamper
Return (TR)

Internal Bell
(negative)

External
Bell
(negative)

Do not use.

Zone inputs

Tamper
terminals

« Toreset the controller:
— Press this switch once.

« Toreset the programming settings to default and reboot the controller:
—Hold down the button until you are asked if a factory reset is desired.
—Select YES to reset to factory defaults.

Warning: Defaulting the controller to factory settings deletes all configuration files,
including backups, stored on the controller. All isolates and inhibits are also deleted. It is
recommended you backup your configuration to a PC before defaulting the controller.

Note: This feature is not available if engineer lockout is enabled.

This terminal is not required and should not be connected.

This is the SPC communications bus used to network expanders together on the
system. See Wiring the X-BUS interface on page 75.

Terminals 1B and 1A must be connected to SPCP355.300 I/O Expander terminals 2B
and 2A, respectively

Terminals 2A and 2B must be connected to terminals 2A and 2B, respectively, of the
next expander on the X-BUS.

Outputs OP4, OP5, and OP6 are 12V open collector resistive outputs with a 300mA
current rating.

The OP4 load must be connected to the SPCP355.300 Smart PSU.

The SPC controller provides a 1A, single-pole, changeover relay that can be used to drive
the strobe output on the external bell.

The BHO (Bell Hold Off) and TR (Tamper Return) (and EXT output) are used to connect
an external bell to the controller. See Wiring an internal sounder on page 89.

The INT-terminal is used to connect to internal devices such as an internal sounder. The
power for the internal sounder must be connected to the SPCP355.300 Smart PSU.

The Ext- terminal is used to connect to external devices such as an external bell. The
power for the external sounder must be connected to the SPCP355.300 Smart PSU.

Do not use.

The controller provides 8 on-board zone inputs that can be monitored using a variety of
supervision configurations. These configurations can be programmed from system
programming. The default configuration is Dual End of Line (DEOL) using resistor values
of 4k7. See Wiring the zone inputs on page 85.

The controller provides 2 additional tamper input terminals that can be connected to
auxiliary tamper devices to provide increased tamper protection. These terminals should
be shorted when not in use.
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Number Name Description

15 Serial port 2  Serial port 2 terminal block (TX, RX, GND) may be used to interface to an external
terminal modem or PC terminal program. Serial port 2 shares a communications channel with the
block back-up modem. If a back-up modem is installed, ensure that no devices are connected

to this serial port.

16 Ethernet The 2 Ethernet LEDs indicate the status of the Ethernet connection. The left LED
connectivity indicates data activity on the Ethernet port; the right LED indicates the Ethernet link is
LEDs active.

17 Ethernet The Ethernet interface provides for the connection of a PC to the controller for the
interface purposes of programming the system.

18 USB This USB interface is used to access browser programming or a terminal program.
interface

19 Serial port 2 This RS232 serial port may be used to interface to an external modem or PC terminal

program. Serial port 2 shares a communications channel with the back-up modem. If a
back-up modem is installed, ensure no devices are connected to this serial port.

20 Serial port 1 This RS232 serial port may be used to interface to an X10 protocol device.

21 Optional A primary (left slot) and back-up (right slot) module can be connected to the controller.
plug-in These modules can be GSM or PSTN modems offering increased communication
modules functionality. The back-up modem should not be connected if serial port 2 interface is

connected to an external modem or other device.

22 Real-time Battery for real-time clock (RTC).
clock
battery

23 Auxiliary 12V input from A1 on SPCP355.300 Smart PSU.
power input
See also

Powering expanders from the auxiliary power terminals on page 363
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9 Door Expander

The two door expander can handle up to two doors and two card readers. Configuration of the operation
mode is done via the two door I/Os. Each of the two door I/Os is responsible for the functionality of two
inputs and one output of the door controller. A specific door number can be assigned to a door I/O, which
gives the inputs and output predefined functionality. If no door number is assigned to neither of the door
I/Os (option “Zones” is selected), the inputs and outputs of the door controller can be used like inputs and
outputs on the control panel. Thus, no access functionality is available on this two door controller.

If a door number is assigned only to the first door 1/0 of the two door controller, the first reader is used as
entry reader for this door. If a second reader is available, it is used as exit reader for the configured door.
Two inputs and one output have predefined functionality and two inputs and one output can be configured
by the user. Additionally, the door position sensor input of the first door can be used as intrusion zone but
only with limited functionality.

If a door number is assigned to each of the two door I/Os, the two doors are handled independently. The
first card reader is used as entry reader for the first door and the second card reader is used as entry reader
for the second door. All inputs and outputs have predefined functionality. The door position sensor inputs of
the two doors can additionally be used as intrusion zones but only with limited functionality.

See Supported card readers and card formats on page 388 for details of currently supported card readers
and card formats.

Each free zone number can be assigned to the zones. But the assignment is not fixed. If number 9
was assigned to a zone, the zone and an input expander with the address 1 is connected to the X-Bus
(which is using the zone numbers 9—16).The assigned zone from the two door controller will be moved
to the next free zone number. Configuration will be adapted accordingly.

[
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10 Wiring the system

This chapter covers:

10.1 Wiring the X-BUS interface ... . .. 75
10.2 Wiring of branch expander ... ... 83
10.3 Wiring the system ground . il 84
10.4 Wiring the relay output . ... 84
10.5 Wiring the zone inputs il 85
10.6 Wiring an external SAB bell ... 88
10.7 Wiring an internal sounder . il 89
10.8 Wiring Glassbreak ... .. 89
10.9 Installing plug-in modules ... .. 90

10.1 Wiring the X-BUS interface

The X-BUS interface provides for the connection of expanders to the controller. The X-BUS can be wired in
a number of different configurations depending on the installation requirements. The X-BUS interface baud
rate is 307kb.

NOTICE: The X-BUS is an RS-485 bus with a baud rate of 307kb. The full performance is only
supported in loop (see Loop configuration on the next page) and spur (see Spur configuration on
page 77) wiring configuration (best signal quality due to daisy chain of isolated sections with 1
transmitter/1 receiver and balanced terminating resistors on each end).

The performance in star or multi-drop configuration wiring (see Star and muilti-drop configuration on
page 78)is limited due to non-optimal conditions of the RS-485 bus specification (reduced signal
quality due to multiple receivers/transmitters in parallel with unbalanced terminating resistors).

NOTICE: It is strongly recommended to use loop (see Loop configuration on the next page) or spur
(see Spur configuration on page 77) configuration.

The table below shows the maximum distances between controller/expander or expander/expander for all
cable types in loop and spur configuration.

Cable Type Distance
CQR standard alarm cable 200 m
UTP Category: 5 (solid core) 400 m
Belden 9829 400 m
[YSTY 2x 2x 0.6 (min) 400 m

Each device has 4 terminals (1A, 1B, 2A, 2B) for connection to expanders via the X-BUS cable. The
controller initiates a detection procedure on power up to determine the number of expanders connected on
the system and the topology in which they are connected.
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2A 2B 1A 18

L

1\\ B
&= 02
B TN
[Ej‘lh
N Q|18

O D D &
27 2B

1A 1B
Wiring expander
Number Description
1 Previous expander
2 Next expander
3 SPC controller

Most expanders are equipped with additional terminals 3A/3B and 4A/4B for branch expander wiring. See
Wiring of branch expander on page 83 for instructions on branch expander wiring.

10.1.1 Loop configuration

| o
1 NOTICE: [E] The SPC42xx/43xx doesn’t support loop configuration (only 1 X-BUS port).

o NOTICE: All expanders/keypads are fitted with a termination jumper by default. In loop configuration
1 it’s imperative to have these jumpers fitted.
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Wiring the system

The loop (or ring) cabling method offers the highest security by providing fault tolerant communications
on the X-BUS. All keypads and expanders are supervised and in case of a X-BUS fault or break, the
system continues to operate and all detectors are monitored. This is achieved by connecting 1A, 1B on
the controller to 2A, 2B on the first keypad or expander. The wiring continues with connection 1A, 1B to
2A, 2B on the next expander etc. to the last keypad or expander. The last connection is 1A, 1B of the
last expander to 2A, 2B of the controller. See wiring configuration in the figure below.

1
2 3 4
LOUT 1A [0 @] LOUT 1A [0 ® 1A |[@ @]
OUT ¢ |[¢ OUT 18 |[@ ® w . 18|[@6]
Ny 2A ([ Ny 2A|[@ © »2A |0 O
INy, 28 |[@ O] INy, 28 |[@ ©] Ny.28 [[@ O]
SHLD |[© @] SHLD |[©@ @] SHLD |[© @]
Number Description
1 Controller
2-4 Expanders

10.1.2 Spur configuration

.
l SPC42xx/43xx supports 1 spur (1 X-BUS port).

NOTICE: SPC52xx/53xx/63xx supports 2 spurs (2 X-BUS ports).

i

NOTICE: All expanders/keypads are fitted with a termination jumper by default. In spur
configuration it is imperative to have these jumpers fitted.

The spur (or open loop) cabling method offers a high level of fault tolerance and may be more
convenient on certain installations. In the case of a X-BUS fault or break, all expanders and detectors

up to the fault continue to be supervised.

In this configuration, the SPC controller uses a single the X-BUS port (1A/1B or 2A/2B) to support a
group of expanders. See wiring configuration in the figure below. The last expander in an open loop
configuration is not wired back to the controller and can be identified by the fast LED flashing light (one
flash every 0.2 seconds approx) when in Full Engineer programming.

In automatic mode, the expander numbering commences at the expander nearest to the controller and
ends with the expander connected farthest from the controller. For example, if 6 expanders are
connected in an open loop configuration, then the nearest expander on the X-BUS connection is
expander 1, the second nearest expander is 2, etc., ending with the expander wired farthest from the

controller, which is expander 6.
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All expanders/keypads are fitted with termination jumpers, as default, allowing termination on all the
devices. This is imperative for the spur (chain) configuration, as the jumper acts as a resisting terminator
cancelling echoes on the line.

Within the loop wiring configuration all expanders/keypads are fitted with a jumper, as default, allowing
termination on the device.

a 1
—
5 g9se
e| [ele]e]e] 2 3 4
2| D282
OUT1A|[@ @] OUT 1Al ® 1Al @
OUT18|[@ ® OuT 18 |[@ @ N 1Bll@@
Ll MNyoall@® Ny 2all@ @ » 240 ©
INy 2B|[@ @ Ny 2B|[@ @ Ny2B|[@@
SHLD ||© @ e SHLD |[&2 & - SHLD ||© @
_____________________________________ L
Spur configuration
Number Description
1 Controller
24 Expanders

10.1.3 Star and multi-drop configuration

o NOTICE: See Examples of correct wiring on page 81, Examples of incorrect wiring on page 82 and
l Shielding on page 83 before starting the installation.

The star and multi-drop cabling methods enables takeover of existing wirings with four-core cables in small
buildings (typically homes) with low electrical noise environment. These wiring methods are limited to the
specifications below:

SPC42xx/SPC43xx SPC52xx/SPC53xx/SPC63xx
Max. expanders/keypads 8 16 (8 per X-BUS port)
Total cable length 200 m 200 m

NOTICE: The performance in star or multi-drop configuration wiring is limited due to non-optimal
conditions of the RS-485 bus specification (reduced signal quality due to multiple
receivers/transmitters in parallel with unbalanced terminating resistors).

L)
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Star configuration

NOTICE: All expanders/keypads are fitted with a termination jumper by default. In star
configuration it's imperative to remove these jumpers.

[

A star configuration is established when multiple expanders are wired back to the same X-BUS port on

the SPC controller. Depending on controller type 2 ports may exist (1A/1B, 2A/2B), however only one
port (1A/1B) is to be used on each keypad or expander.

In the case of a X-BUS break the single will be disconnected, all other expanders and detectors
continue to be supervised. A short in the cable renders all expanders disabled.

]
SPC

[m]

T

5Rg2

FEEEE

1] )

2 3 4

Star configuration 2
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Number Description
1 SPC Controller
2-4 Expanders

Multi-drop configuration

jmie

NOTICE: All expanders/keypads are fitted with a termination jumper by default. In multi-drop
configuration it’s imperative to remove these jumpers with exception of last keypad or expander.

The multi-drop configuration varies in that each expander uses the same communication channel as it
wires onto the next expander, with all expanders using the same input channel. See multi-drop
configuration in the second figure.

In the case of a X-BUS break, all expanders and detectors up to the fault continues to be supervised. A
short in the cable renders all expanders disabled.

1

Multi-drop configuration 2

Number Description
1 SPC controller
2-4 Expanders
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10.1.3.1 Examples of correct wiring
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20m

20m

1A|@ 3|

L 1Bll@a @

2All2 @ B
2B||2 @
SHLD| 2 @
Star wiring
SPC
SH:'E gg 2m| L qpl@ @ \_“:-m
1Blo ® —1B||l2 @ 1B
2Alm @ 2All@ @] 1 28
2B|& ® 2Bl @ 2B
SHLD| & & SHLD
20 m

Multi-drop wiring
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Wiring the system

20 m 20m
30"“L1A 00 __Lm 2 Lm 0o
/ 18|[0 @ L —1B|[@ @ — 1B|[@ ®
2A|[0 ® 1 2|0 @ 2A|0 @
2B|[0 e 2B|[@ @ 2B|[@ @
/ SHLD|[@ @ SHLD|[@ @ SHLD||@ ©
SPC 2m _ L 20m
SHLD [
mg}gj 3'3"“‘ 1A|[@ ® ‘ 1A[[@® L— 1A|[0®
1B [A\o 1B|[0 @ L—1B|[@ @ L 1B|[O0 ®
2A [0 oy 2A|[@ @] 2 2A|[@ © 2A|0 ©
280 0 |\ 2B|[0 ® 2B|[0 © 2B|[0 ®
\ SHLD|[@ @ SHLD|.©@ © SHLD||@ @
Y
\\h
\ 20m
\\_35"“_L1A L 1A|[@@
—— 1B L 1B|[@®
2A 2All@ @ B
2B 2Bl[o @
SHLD SHLD| @ @
Mixed wiring

10.1.3.2 Examples of incorrect wiring

. NOTICE: A mix of star and multi-drop configuration is only allowed if the star point is at the controller
l X-BUS port. In this case, all expanders/keypads must be wired in multi-drop configuration without any
other star points in the wiring.

f,m_ 1A|[@ @] — 1A([2©
— 1B|[@ @l 1B|[0 ®
;f'}’ 2Al[0 @ 1 2A|[© | 4
J,{, 2B|l@ @ 2B|[@ ® 1Al
// SHLD|[© © SHLD|[© © Dﬁfﬂfi‘m 506
SPC |/ - 50
SHLD (&% 7& ©e
1A @{
1B]®§ L/
2A 18 @\
2B[8 @l \
'\\\
Y
\\ 20 m
\35m | i) 5
\ | “—1aA|[@® U 1al@®
18[00 4 L 1B|Ce 6
2l 2150
0 © 0 ©
SHLD|[@ @ sHLD|[@ @

Not allowed wiring with a second star point
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[

NOTICE: If the mix of star and multi-drop configuration is not properly wired the reduced signal
quality may lead to slow reaction time of connected devices (for example, keypad operation) or
even loss of communication to devices. If such behavior is observed a wiring in loop OR star
configuration is strongly recommended.

10.1.4 Shielding

The shielding terminals (SHLD) should only be used for cables types with shielding (for example,
Belden 9829). If shielding is required (that is, sites with high electric field interference): connect the
cable shield to the SHLD terminals on the controller and all networked expanders. If the shield
needs to be connected to earth then a cable needs to be connected from the SHLD terminal on the
controller to the chassis earth stud. Do NOT earth the SHLD terminal on any of the expanders.

|- [

NOTICE: For star and multi-drop wiring

It is not recommended to use shielded cables due to disadvantageous electrical characteristics
(higher capacitance) in star and multi-drop wiring configuration. However, if shielding is required
(that is, sites with high electric field interference) a new wiring in proper spur or loop configuration
with appropriate installation cable configuration has to be done.

10.1.5 Cable Map

Identification and numbering order for expanders and keypads differ depending on automatic or manual
addressing of the expanders. For information on manual and automatic configuration, see X-BUS on
page 123.

For a system with manual addressing, expanders and keypads have a separate numbering sequence
and are defined by the engineer manually. That is, expanders are numbered 01, 02, 03, etc. as desired.
Using same numbers, keypads may be numbered as desired.

In the manual configuration, the system automatically allocates zones to each expander. For this
reason, devices with no zones, such as 8 output expanders should be addressed last.

For a system with automatic addressing, expanders and keypads belong to the same numbering group
and are assigned by the controller. That is, expanders and keypads are together numbered 01, 02, 03,
in the order that they are detected relative to the location of the controller.

10.2 Wiring of branch expander

The wiring of the X-BUS interface with 8 terminals 1A/1B to 4A/4B provides for the connection of an
additional branch expander.

If the branch is not used then the terminals 1A/1B are used to connect to the next expander/keypad.
Terminals 3A/3B and 4A/4B are then not used.

The following modules have branch expander wiring capability (additional terminals 3A/B and 4A/B):
o 8Input/2 Output Expander
« 8 Output Expander
« PSU Expander
« Wireless Expander

o 2-door Expander
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! (71| 2P

SN - o=

28| (7) | | 1A

M) | 1B
@EI—IL[I

m@ };@M

1B » () | 4B

| A

3 I I

(

QO O Q)
1A 1B 2A A

Wiring of a branch expander

Number Description

1 Previous expander

2 Expander connected to branch
3 Next expander

4 Expander with branch

10.3 Wiring the system ground

0V of Smart PSU's, Keypads and Expanders must be connected to the SPC controller OV (System GND).

10.4 Wiring the relay output

The SPC controller has one on-board 1A single pole changeover relay that can be assigned to any of the
SPC system outputs. This relay output can switch a rated voltage of 30V DC (non-inductive load).

When the relay is activated the common terminal connection (COM) is switched from the Normally Closed
terminal (NC) to the Normally Open terminal (NO).

© Vanderbilt 2018 84 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Wiring the system

SPC
N0

11
0 QO Q

o o—H12V
ov
_|::|
Standard wiring
NO Normally open terminal
COM Common terminal connection
NC Normally closed terminal

10.5 Wiring the zone inputs

The SPC controller has 8 on-board zone inputs. By default these inputs are monitored using end of line
supervision. The installer can choose from any of the following configurations when wiring the inputs:

« NoEndof Line (NEOL)

« Single End of Line (SEOL)
o Dual End of Line (DEOL)
« Anti-masking PIR

SPC o

11 N
O |
COM 50
Default configuration (DEOL 4k7)
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Number Description
1 Tamper
2 Alarm
3 EOL 4k7
4 EOL 4k7
1
SPC
O~

" =~
)

Anti-Masking PIR configuration

Number

Description

1

2
3
4
5
6

Tamper
Alarm
EOL 4k7
Fault
EOL 2K2
EOL 4k7

The following table shows the resistance ranges associated with each configuration.

Single EOLs
Quiescent Alarm
EOL Type
Min Nom Max Min Nom Max
NONE 0Q 150Q 3000 300Q N/A Infinite
(-100%) (+100%) (+100%)
SINGLE_1K 700Q 1kQ 1.3kQ 23kQ N/A Infinite
(-30%) (+30%)
SINGLE_1K5 1.1kQ 1.5kQ 2.1kQ 23kQ N/A Infinite
(-27%) (+40%)
SINGLE_2K2 1.6kQ 2.2kQ 2.9kQ 23kQ N/A Infinite
(-28%) (+32%)
SINGLE_4K7 3.1kQ 4.7kQ 6.3kQ 23kQ N/A Infinite
(-22%) (+24%)
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SINGLE_10K 7kQ 10kQ 13kQ 23kQ N/A Infinite
(-30%) (+30%)

SINGLE_12K 8.5kQ 12kQ 15.5kQ 23kQ N/A Infinite
(-30%) (+30%)

Dual EOLs with PIR Masking and Fault

Mask_1K_1K_6K8 700Q 1KQ 1.3kQ 1.5kQ 2kQ 2.5kQ
(1K / 1K / 6K8) (-30%) (+30%) (-25%) (+25%)
Mask_1K_1K_2K2 700Q 1kQ 1.3kQ 1.5kQ 2kQ 2.6kQ

(1K / 1K / 2K2) (-30%) (+30%) (-25%) (+30%)
Mask_4K7 4K7_2K2 3.9kQ 47kQ  5.6kQ 8.4kQ 9.4kQ 10.3kQ
(4KT7 ] 4K7 | 2K2) (-18%) (+20%) (-11%) (+10%)

Mask_1K_1K_6K8 27000 8.8kQ 12.6kQ - - -
(-69%) (+20%)

Mask_1K_1K_2K2 2.8k 3.2k 3.6k 3.8k 4.2k 4.8k
(-13%) (+13%) (-10%) (+15)

Mask_4K7_4K7_2K2 6k 6.9k 7.8k 10.8k 11.6k 12.6k
(-14%) (+14%) (-7%) (+9%)

Dual EOLs

DUAL_1K0_470 4000 470Q 700kQ 1.1kQ 1.5kQ 2Q
(-20%) (+40%) (-27%) (+34%)
DUAL_1KO_1KO 700Q 1kQ 1.3kQ 1.5kQ 2kQ 2.6kQ
(-30%) (+30%) (-25%) (+30%)
DUAL_1k0_2k2 1.6kQ 2.2kQ 2.9kQ 2.3kQ 3.2kQ 4.2kQ
(-28%) (+32%) (-29%) (+32%)
DUAL_1k5_2k2 1.6kQ 2.2kQ 2.9kQ 2.7kQ 3.7kQ 4.8kQ
(-28%) (+32%) (-28%) (+30%)
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Quiescent Alarm
EOL Type
Min Nom Max Min Nom Max
DUAL _2K2 2K2 1.6kQ 2.2kQ 2.9kQ 3.4kQ 4.4kQ 5.6kQ
(-28%) (+32%) (-23%) (+28%)
DUAL 2k2_4k7 4.1kQ 4.7kQ 5.4kQ 6kQ 6.9kQ 7.9kQ
(-13%) (+15%) (-14%) (+15%)
DUAL 2K7 8K2 7.2kQ 8.2kQ 9.2kQ 9.9kQ 10.9kQ 11.9kQ
(-13%) (+13%) (-10%) (+10%)
DUAL 3K0 _3KO0 2.1kQ 3.0kQ 3.9kQ 4.5kQ 6kQ 7.5kQ
(-30%) (+30%) (-25%) (+25%)
DUAL 3K3 3K3 2.3kQ 3.3kQ 4.3kQ 4.9kQ 6.6kQ 8.3kQ
(-26%) (+31%) (-26%) (+26%)
DUAL_3K9 8K2 7.0kQ 8.2kQ 9.5kQ 10.5kQ 12.1kQ 13.8kQ
(-15%) (+16%) (-14%) (+15%)
DUAL 4K7 2K2 1.6kQ 2.2KQ 2.9kQ 5kQ 6.9kQ 8.8kQ
(-28%) (+32%) (-28%) (+28%)
DUAL 4K7_4K7 3.3kQ 4.7kQ 6.1kQ 7kQ 9.4kQ 11.9kQ
(-30%) (+30%) (-26%) (+27%)
DUAL 5K6 5K6 4.0kQ 5.6kQ 7.2kQ 8.3kQ 11.2kQ 14.1kQ
(-26%) (+29%) (-26%) (+26%)
DUAL 6K8 4K7 3.3kQ 4.7kQ 6.1kQ 8.1kQ 11.5kQ 14.9kQ
(-30%) (+30%) (-30%) (+30%)
DUAL 2k2 10K 9.2kQ 10kQ 10.8kQ 11.3kQ 12.2kQ 13.2kQ
(-8%) (+8%) (-8%) (+9%)
DUAL_10k_10k 7.5kQ 10kQ 12.5kQ 17kQ 20kQ 23kQ
(-25%) (+25%) (-15%) (+15%)

L For all EOL types, a resistance below 300Q is considered a short. If the resistance is not within the
1 thresholds stated, this is treated as a disconnection.

10.6 Wiring an external SAB bell

On an external bell to the SPC controller board the relay output is wired to the strobe input with Bell Hold
Off (BHO) and Tamper Return (TR) connected to their respective inputs on the external bell interface.

A resistor (2K2) is pre-fitted on the controller board between the BHO and TR terminals. When wiring an
external bell, connect this resistor in series from the TR terminal on the controller to the TR terminal on the
external bell interface.
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SPC GHND +12V 'I,]
— A
|
COM %) | () TF .
NOD ') % T"F’_ c
BHO @) or~ o
R —Q) KO
EX- - @ @ ] ,
|2 T"ff_
External bell wiring
Label Description
A Strobe +
B Strobe —
C Hold off
D Tamper return
E Bell -
F Bell +

10.7 Wiring an internal sounder

To wire an internal sounder to the SPC controller connect the IN+ and IN— terminals directly to the 12V
sounder input.

|~

1=

SIS

Internal sounder wiring (12V)

IN- IN— (SPC controller)
IN+ IN+ (SPC controller)

10.8 Wiring Glassbreak

SPC supports the RI S 10 D-RS-LED glassbreak interface in combination with GB2001 glassbreak
detectors.
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The following diagram shows how the glassbreak interface is wired to the SPC controller for power, or to
an 8-in/2-out expander:

SPC

NO[OD ©
coM[O ©
NC|O ©

+12V 1 RIs10
GND | D-RS-LED

) ©
O ©

+12V

GND

For information on wiring the glassbreak interface to a zone, see the product-specific documentation.

For information on wiring the glassbreak sensors to the glassbreak interface, see the product-specific
documentation.

10.9 Installing plug-in modules

2 modems (PSTN or GSM) may be installed on the controller board to increase functionality. The picture
below shows the 2 slots available for each modem, the primary (left) slot and the back-up (right) slot.

If both modem slots are available, always install the plug-in module in the primary slot; the system always
attempts to make PSTN or GSM calls on a modem installed on the primary slot before attempting to use

the back-up slot.
WARNING: Modems are not plug and play. You must log on to the panel as Full Engineer, then power
the controller board down before installing, removing or moving modems from one position to the

other. After completing the modem task, reconnect the system to the power supply and log on to the
controller as Full Engineer again. Configure and save the configuration. Failure to follow this process

results ina CRC error.
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o

Plug-in modules

1

Wireless receiver slot

Primary modem slot

Back-up modem slot

L

For installation details, see the corresponding Installation Instruction.

Installation guides are available at http://www.spcsupportinfo.com/connectspcdata/userdata.
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11 Powering up the SPC controller

The SPC controller has two power sources, the mains supply and the integral standby battery. A qualified
electrician should undertake connection to the mains and the mains supply should be connected from a

spur that can be isolated. See Wiring of mains cable to the controller on page 377 for full details of
conductor sizes/fuse ratings, etc.

The SPC should be powered from the mains first and then the internal standby battery. For compliance to
EN only one battery should be fitted of the appropriate capacity.

11.1 Powering from battery only

It is recommended that when powering a system from battery only, the battery should be in a fully charged

state (>13.0V). The system will not power up when using a battery with less than 12V and no mains is
applied.

[

NOTICE: The battery will continue to power the system until deep discharge level (10.5V to 10.8V)
has been detected. The time duration that the system will hold up on battery will depend on the
external loading and Ah rating of the battery.
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12 Keypad user interface

The following keypad models are available:
o SPCK420/421 — referred to throughout this document as the LCD Keypad
o SPCK620/623 — referred to throughout this document as the Comfort Keypad

12.1 SPCK420/421

This section covers:

12.1.1 About the LCD keypad .. ... . 93
12.1.2 Using the LCD keypad interface ... . . 95
12.1.3 Dataentry on the LCD Keypad ... ..., 98

12.1.1 About the LCD keypad

The LCD keypad is a wall-mounted interface that allows:

« Engineers to program the system through the Engineer Programming menus (password protected)
and to set/unset the system; a user can control the system on a day-to-day basis.

« Users to enter User Programming menus (password protected), and to perform operational
procedures (set/unset) on the system. (See the SPCK420/421 User Manual for more details of user
programming.)

The LCD keypad unit includes an integral front tamper switch and has a 2 line x 16 character display. It
features an easy-to-use navigation key to assist in locating required programming options, and has 2
context sensitive soft keys (left and right) for selecting the required menu or program setting. 3 LEDs on
the keypad provide an indication of AC power, system alerts, and communications status.

The LCD keypad may be factory fitted with a Portable ACE (PACE) proximity device reader (see
Overview of keypad types on page 375).
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LCD keypad
Number Name Description
1 LCD display  The keypad display (2 lines x 16 characters) shows all alert and warning messages and
provides a visual interface for programming the system (engineer programming only).
The display can be adjusted for contrast and under which conditions the backlight
comes on.
2 Alphanumeric  Alphanumeric keypad allow for both text and numeric data entry during programming.
keys Alphabetic characters are selected by applying the appropriate number of key presses.
To switch between upper and lower case characters, press the hash (#) key. To entera
numeric digit, hold down the appropriate key for 2 seconds.
3 Leverage The leverage access tabs provide access to the keypad back assembly clips. Users

access tabs

4 Back
assembly
securing
screw

5 LED status
indicators

6 Soft function
keys

can unhinge these clips from the front assembly by inserting a 5mm screwdriver into the
recesses and pushing gently.

This screw secures the front and back assemblies on the keypad. This screw must be
removed to open the keypad.

The LED status indicators provide information on the current status of the system as
detailed in the table below.

The left and right soft function keys are context sensitive keys to navigate through
menus/programming.
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Number Name Description
7 Proximity If the keypad has been fitted with a proximity device receiver (see Overview of keypad
device types on page 375), users should present the Portable ACE Fob to within 1 cm of this
receiverarea areato SET/UNSET the system.
8 Multi- The multi-functional navigation key in combination with the keypad display provides an
functional interface for programming the system.
navigation
Key
LED Status
AC Indicates the presence or failure of the mains supply
mains FLASHING: AC mains fault detected
(Green) STEADY: AC mains OK
System A Indicates a system alert
alert FLASHING: System alert detected; display indicates the location and nature of alert. If the
(Yellow) systemis SET, then NO indication is given of system alerts
OFF: No alert detected; If a keypad is assigned to more than one area, LED does not indicate an
alert condition if any of those areas is SET
X-BUS © Indicates the status of the X-BUS communications when in FULL ENGINEER programming
Status Flashes regularly: (once every 1.5 seconds approx) indicates communications status is OK
(Red) Flashes quickly: (once every 0.25 seconds approx) indicates the keypad is the last expander on
the X-BUS
If the keypad is being installed for the first time and power is supplied to it before a connection to
the controller X-BUS interface is made, the LED remains in the ON state

12.1.2 Using the LCD keypad interface

|

BT SETUP SYSTEM

ﬂ—“ EXIT SELECT
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6 (/_h 2

5 ek - 3
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Keypad display
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Description

Number Name

1 RIGHT
SOFT KEY

2 OK

3 =3

4 v

5 =]

6 A

7 LEFT
SOFT KEY

8 BOTTOM
LINE OF
DISPLAY

9 TOP LINE
OF
DISPLAY

This key is used to select the option presented on the right side of the bottom line display.
Possible values are:

« SELECT to select the option displayed on the top line

« ENTER to enter the data displayed on the top line

« NEXT toview the next alert after the one displayed on the top line

o CLEAR to clear the alert displayed on the top line

« SAVE to save a setting

The OK button acts as a SELECT key for the menu option displayed on the top line and
also as an ENTER/SAVE key for data displayed on the top line.

In Programming mode, the right arrow key advances the user through the menus in the
same way as pressing the SELECT option (right soft key).

In data entry mode, press this key to move the cursor one position to the right.

In Programming mode, the down arrow key moves the user to the next programming
option in the same menu level. Continually press this key to scroll through all
programming options available on the current menu level.

In alphanumeric mode, press this key over an upper case character to change the
character to lower case.

When alerts are displayed, the down arrow key moves the user to the next alert message
in the order of priority. (See Prioritization of display messages on the facing page.)

In Programming mode, the left arrow key returns the user to the previous menu level.
Pressing this key when in the top menu level exits the user from programming.

In data entry mode, press this key to move the cursor one position to the left.

In Programming mode, the up arrow key moves the user to a previous programming option
in the same menu level. Continually press this key to scroll through all programming
options available on the current menu level.

In Alphanumeric mode, press this key over a lower case character to change the
character to upper case.

This key is used to select the option presented on the left side of the bottom line display.
Possible values are:
« EXIT to exit programming

« BACK to return to previous menu

In the IDLE state, this line is blank.

In Programming mode, this line displays options available to the user. These options align
over the left and right soft keys for selection as required.

In the IDLE state, displays the current date and time. In Programming mode, this line
displays one of the following:

« The programming feature to be selected
« The current setting of the selected feature

« The nature of the current alert during an alert condition. (See Prioritization of display
messages on the facing page.)
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Prioritization of display messages
Trouble messages and alerts are displayed on the keypad in the following order:
« Zone
—Alarms
— Tamper
— Trouble
« AreaAlerts
— Fail to set
— Entry time out
— Code tamper
« System Alerts
—Mains
— Battery
—PSU fault
— Aux fault
— External bell fuse
— Internal bell fuse
— Bell tamper
—Housing tamper
— Aux tamper 1
— Aux tamper 2
— Wireless jamming
—Modem 1 fault
—Modem 1 line
—Modem 2 fault
—Modem 2 line
— Fail to communicate
—User panic
— XBUS cable fault
— XBUS communications fault
— XBUS mains fault
—XBUS battery fault
—XBUS power supply fault
— XBUS fuse fault
—XBUS tamper fault
— XBUS antenna fault
— XBUS wireless jamming
—XBUS panic
— XBUS fire
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— XBUS medical
—XBUS Power supply link
— XBUS output tamper
—XBUS Low voltage
— Engineer restore Required
—Autoarm

o System information
— Soaked zones
—Open zones
— Area state
—Low battery (sensor)
— Sensor lost
—WPA* low battery
—WPA* lost
—WPA* test overdue
— Camera offline
— Fob low battery
— Xbus over current
— Installer name
— Installer phone
— Engineer enable
— Manufacture enable
— Reboot
— Hardware fault
— Aux over current
— Battery low
— Ethernet link
— System name

*A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

12.1.3 Data entry on the LCD keypad

Entering data and navigating the menus on the LCD keypad is facilitated through the use of the
programming interface. The use of the interface for each type of operation is detailed below.

Entering numeric values
In Numeric Entry mode, only the numeric digits (0—9) can be entered.

« Tomove the position of the cursor one character to the left and right respectively, press the left and
right arrow keys.

« To exit from the feature without saving, press the BACK menu key.

» Tosave the programmed setting press ENTER or OK.
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Entering text
In Text Entry mode, both alphabetic characters (A—Z) and numeric digits (0—9) can be entered.
« Toenter an alphabetic character, press the relevant key the required number of times.

« Toenter alanguage specific special character (8, U, 6...) press button 1 to cycle through the
special characters.

« Toenteraspace + special characters (+, -./[ ]...) press button 0.
« Toenter adigit, hold the relevant key down for 2 seconds and release.

« Tomove the position of the cursor one character to the left and right respectively, press the left
and right arrow keys.

« To exit from the feature without saving, press BACK.
« Tosave the programmed setting press ENTER or OK.

« Tochange the case of an alphabetic character, press the up/down arrow keys when the
character is highlighted by the cursor.

« Totoggle between upper and lower case for all subsequent characters, press the hash (#) key.
« Todelete character to the left of the cursor, press the star key(*).
Selecting a programming option

In navigation mode, the Engineer/User selects one of a number of pre-defined programming options
from alist.

« Toscroll through the list of options available for selection, press the up and down arrow keys.
« To exit from the feature without saving, press BACK.

« Tosave the selected option, press SAVE or OK.

12.2 SPCK620/623

This section covers:

12.2.1 About the Comfort keypad .. ... .. .. 929
12.2.2 LED descCription ... 103
12.2.3 Viewing mode description ... ... .. 103
12.2.4 Function keys inidle state ... ... ... .. ... 104

12.2.1 About the Comfort keypad

The Comfort keypad is a wall-mounted interface that allows:

« Engineers to program the system through the Engineer Programming menus (password
protected) and to set/unset the system; a user can control the system on a day-to-day basis.

« Users to enter User Programming menus (password protected), and to perform operational
procedures (set/unset) on the system. (See the SPC620/623 User Manual for more details of
user programming)

The SPCK620 is equipped with soft keys and large graphical LCD for easy operation. The functionality
can be enhanced with key switch expander SPCE 110 or indication expander SPCE120.

The SPCK623 is equipped with a proximity card reader (125 kHz EM 4102) for easy user access, soft
keys, large graphical LCD and voice annunciation support. The functionality can be enhanced with key
switch expander SPCE 110 or indication expander SPCE120.
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Number Name Description
1 LED status The LED status indicators provide information on the current status of the system as
indicators detailed in LED description on page 103.

2 LCD display  The keypad display shows all alert and warning messages and provides a visual
interface for programming the system (engineer programming only). (See Prioritization
of display messages on the facing page.) The display can be configured under which
conditions the backlight comes on.

3 Soft function  Context sensitive keys to navigate through menus/programming.

keys
4 Enter key Confirm display or input.
5 Back menu Go back in the menu.
key Reset buzzers, siren and alarms in the memory.
6 Proximity Only SPCK 623: If the keypad has been fitted with a proximity device receiver, users
device should present the Portable ACE Fob to within 1 cm of this area.
receiver area
7 Alphanumeric  Alphanumeric keypad allow for both text and numeric data entry during programming.
keys Alphabetic characters are selected by applying the appropriate number of key presses.
To switch between upper and lower case characters, press the hash (#) key. Toentera
numeric digit, hold down the appropriate key for 2 seconds.
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Number Name Description
8 Multi- Navigation through menus and to scroll through alert messages. (See Prioritization of
functional display messages below.)
navigation
key
9 Information Displays information.
key

Prioritization of display messages
Trouble messages and alerts are displayed on the keypad in the following order:

o Zone
—Alarms
—Tamper
— Trouble

o AreaAlerts
— Fail to set
— Entry time out
— Code tamper

« System Alerts
—Mains
— Battery
—PSU fault
— Aux fault
— External bell fuse
— Internal bell fuse
—Bell tamper
—Housing tamper
—Aux tamper 1
— Aux tamper 2
— Wireless jamming
—Modem 1 fault
—Modem 1 line
—Modem 2 fault
—Modem 2 line
— Fail to communicate
— User panic
— XBUS cable fault
— XBUS communications fault
— XBUS mains fault
—XBUS battery fault
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—XBUS power supply fault
— XBUS fuse fault
—XBUS tamper fault
— XBUS antenna fault
— XBUS wireless jamming
—XBUS panic
—XBUS fire
— XBUS medical
— XBUS Power supply link
— XBUS output tamper
—XBUS Low voltage
— Engineer restore Required
—Autoarm

o System information
— Soaked zones
— Open zones
— Area state
—Low battery (sensor)
— Sensor lost
—WPA* low battery
—WPA* lost
—WPA* test overdue
— Camera offline
— Fob low battery
— Xbus over current
— Installer name
— Installer phone
— Engineer enable
— Manufacture enable
— Reboot
— Hardware fault
— Aux over current
— Battery low
— Ethernet link
— System name

*A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.
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12.2.2 LED description

Description Symbol Color Operation Description
Information l Blue On The system or area cannot be set. Forced setting is possible
(faults or open zones can be inhibited).
Flashing The system or area cannot be set or forced set (faults or open
zones cannot be inhibited).
Off The system or area can be set.
Amber Flashing Engineer is on site.
User l Green On Assigned area is unset.
Flashing  Assigned area is Partset A/B
Off Assigned area is fullset
Alarm 0 Red On Alarm
Flashing -
Off No alarm
Alert A Amber On -
Flashing  Trouble
Off No trouble
Mains Green On System ok
Flashing  Mains fault
Off No bus connection

[i

NOTICE: The LED indications for information, area status, alarm and fault is deactivated in idle
state of the keypad. A valid user PIN has to be entered. It is configurable if the power indication
can be seen inidle state.

12.2.3 Viewing mode description

There are 2 viewing modes (automatic):

« Multi area view: User has access to several areas. Displaying the areas is done via area groups.
If no area group is configured, only the general group “All my areas” is displayed.

« Single area view: The user has only rights for 1 area. In the single area view, only one area is
displayed in large fonts and can be controlled directly.

(i

The rights of a user can be restricted by the user settings or the settings of the keypad the user is
logging in to. Only if the user and the keypad that is being used for logging in have the right for an

area, the area is displayed. If the user has the right for several areas but the keypad has only the

right for one area, the user will also see the single area view.
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12.2.4 Function keys in idle state

Emergency Keys

4 A

r.|6|‘7

Depending on configuration, emergency keys are displayed. A simultaneous pressing of the keys
activates an emergency call.

Panic Alarm

Fire alarm

Medical Alarm

= o &

The activated process depends on the system configuration. Ask the installer for details.

Direct Settings

T i

i O E

b A

Depending on configuration, the direct set option is displayed. A forced set/partset without PIN is possible
of the area the keypad is assigned to.
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13 Software support tools

The following PC-based software tool is available to remotely manage an SPC panel:
« SPC Manager

Enables the remote creation, control and modification of access based functionality within the SPC
system.
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14 Starting the system

CAUTION: The SPC system must be installed by an authorised installation engineer.

1. Wire the keypad to the X-BUS interface on the controller.

2. Enter Engineer Programming by entering the default Engineer PIN (1111). For more details, see
Engineer PINs below.

14.1 Engineer modes

The SPC system works under 2 programming modes for authorised installation engineers: Full and Soft. In
the browser, log off is only permitted in Soft Engineer mode.

Full Engineer Mode

All alerts, faults and tampers must first be isolated or cleared before exit from the Full Engineer mode
is allowed.

L]

Full Engineer mode provides extensive programming functionality. However, programming in Full Engineer
mode disables all alarm settings, reports and output programming for the system. For a full review of Full
Engineer menu options, see Engineer programming via the keypad on page 112.

[Soft] Engineer mode

Soft Engineer mode provides fewer programming functions and does not affect any outputs programmed in
the system. For a full review of [Soft] Engineer menu options, see Soft Engineer programming via the
keypad on page 111.

14.1.1 Engineer PINs
The start up Engineer default programming PIN is ‘1111’

If aninstallation is changed from Grade 2 to Grade 3 at any time after start-up, all PINs are prefixed with a
0. Therefore, the default Engineer PIN will be ‘01111’.

Increasing the number of digits for the PIN (see Options on page 252) will add the relevant number of zeros
to the front of an existing PIN (for example, 001111 for a 6 digit PIN).

%, NOTICE: If the default PIN 1111 is enabled, for example, a new SPC installation, you must change
the engineer PIN at the panel. If you do not change your PIN, you will get an information message
forcing you to change your default PIN before logging out of full engineer mode.

14.2 Programming with the keypad

The keypad provides quick onsite access to system menus and programming. The authorised installation
engineer must set initial default configurations using the keypad. Programming of proximity card/device
reader and assignment to users also must be done using the keypad.
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14.3 Configuring start-up settings

The following start-up settings can be changed at a later time when programming the system functionality.

| i If powering up the panel the version number of the SPC system will be displayed on the keypad.

Prerequisite
o Toinitialize the start-up configuration press the reset button on the PCB for at least 6 seconds.
1. Press akey on the keypad.
- Press NEXT after each setting to move to the next setting.
2. Choose the LANGUAGE in which the configuration wizard will be displayed.
3. Choose the appropriate REGION.

-EUROPE, SWEDEN SWITZERLAND, BELGIUM SPAIN UK IRELAND ITALY, ,,, CANADA,
USA

4. Choose a TYPE of installation:
- DOMESTIC: is appropriate for home use (houses and apartments).

- COMMERCIAL.: provides additional zone types and commercial zone default descriptions for the
first 8 zones.

- FINANCIAL.: is specific for banks and other financial institutions and includes features such as
auto-setting, time locks, interlock groups and a seismic zone type.

o For more details of default zone descriptions see Domestic, Commercial and
1 Financial mode default settings on page 366.

5. Choose the Security Grade of your installation.

6. LANGUAGE View the default languages available on the system. The following shows the default
languages available for each region:

- IRELAND/UK -English, French, German

- EUROPE/SWITZERLAND/SPAIN/FRANCE/GERMANY - English, French, German, Italian,
Spanish

- BELGIUM — English, Dutch, Flemish, French, German
- SWEDEN - English, Swedish, Danish, French, German

NOTICE: If the system is defaulted, and the REGION is changed on start up, only
the languages that are currently on the system for the previous REGION will be
available for the new REGION.

b

7. Select the languages you require for your installation. Selected languages are prefixed with an
asterisk (*). Toremove, or select, alanguage, press hash (#) on the keypad.

The unselected languages are deleted from the system and will be unavailable if you default the
system.
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To add other languages to the panel, see Upgrading Languages on page 340. To add other
languages to a keypad, see the documentation for that keypad. Installation guides are available
at http://www.spcsupportinfo.com/connectspcdata/userdata.

8. Enterthe DATE and TIME.
The system scans the X-BUS for modems.

9. Enable SPC CONNECT to allow a panel to communicate with https://www.spcconnect.com
once the panel IP address is configured.

10. Enable DHCP to automatically assign an available network IP address to the panel. If you've
enabled SPC CONNECT and DHCP, an SPC CONNECT ATS is now added to the panel to
complete the connection to https://www.spcconnect.com

11. For DHCP enabled panels, the automatically assigned IP address displays in the IP ADDRESS
menu. If DHCP is not enabled, the default IP address displays. Choose SELECT to continue. In
Engineer Programming mode, under COMMUNICATIONS, you must manually enter the static
IP address for the panel.

12. Choose the X-BUS addressing mode:

- MANUAL: is recommended for most installation types, especially when doing a
preconfiguration.

-AUTO: is recommended only for very small installations.
13. Choose the installation topology: LOOP (Ring) or SPUR (Chain).

The system scans for the quantity of keypads, expanders, door controllers and available zone
inputs.

14. Press NEXT to scan all X-BUS devices.
PROGRAMMING MODE will be displayed.
The Start-up setting is complete.

15. Check the alerts in the menu SYSTEM STATUS > ALERTS. Otherwise you will not be allowed
to exit the Engineer Mode.

16. Configure the system by keypad or web browser.
See also

Domestic, Commercial and Financial mode default settings on page 366

14.4 Creating system users

By default the SPC system only allows engineer access on the system. The engineer must create
Users to allow on-site personnel to set, unset, and perform basic operations on the system as required.
Users are restricted to a set of panel operations by assigning them to specific User Profiles.

The system allows all user PINs within the allowed PIN range, that is, if a 4 digit PIN is used then all
user PINs between 0000 and 9999 would be permissible.

See Users on page 135 or Users on page 196.

i

The ability to grant manufacturer access to the system (for example, allow a firmware upgrade of
the panel) is configured as a user right for a user profile. If a user is going to be enabling firmware
upgrades, ensure that the user has the correct profile for this purpose.

See also

Engineer PINs on page 106
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14.5 Programming the portable ACE

The SPC keypad can be configured with a proximity card/device reader. Users whose profiles are
configured as such may remotely set or unset the system, as well as conduct programming, depending on
the level of profile. When a proximity device has been programmed on the keypad, the user has the ability
to set or unset the system or enter the user programming by presenting the device within 1 cm of the
receiver area on the keypad.

,, \

Receiver area on the keypad

To program a portable ACE on the keypad:

1.

o o M 0 N

Enter the Engineer Programming PIN. (Default PIN is 1111. See Engineer PINs on page 106.)
Scroll to USERS.

Press SELECT.

Select EDIT and select USER1 from the list.

Scroll to PACE and press SELECT.

Toggle for ENABLE and DISABLE of the PACE functionality.

The keypad flashes PRESENT PACE on the top line display.

Position the PACE fob within 1 cm of the receiver area on the keypad.

The keypad indicates that the device has been registered by displaying PACE CONFIGURED.

To disable a portable ACE on the system:

1.

o o M 0 N

Enter the Engineer Programming PIN. (Default PIN is 1111. See Engineer PINs on page 106.)
Scroll to USERS.

Press SELECT.

Select EDIT and select USER1 from the list.

Scroll to PACE and press SELECT.

Toggle to DISABLED.

The keypad indicates UPDATED.
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14.6 Configuring wireless fob devices

If an 868MHz wireless receiver module is installed on the keypad or controller, a wireless fob device
can be programmed via the keypad.

To program a wireless fob device on the system:

1.

N o gk~ w0

Enter the Engineer Programming PIN. (Default PIN is 1111. See Engineer PINs on page 106.)
Using the up/down arrow keys, scroll to the USERS option.

Press SELECT.

Select the EDIT option and press SELECT.

Scroll to the preferred user and press SELECT.

Scroll to the RF FOB option and press SELECT.

Toggle the setting to ENABLED and press SELECT.

The message PRESS KEY ON FOB flashes on the top line.

Position the fob to within 8 meters of the keypad and press one of the keys.

The message FOB CONFIGURED displays to indicate that the device has been registered.

To disable the wireless fob device on the system:

1.

o o b~ v D

Enter the Engineer Programming PIN. (Default PIN is 1111. See Engineer PINs on page 106.)
Using the up/down arrow keys, scroll to the USERS option.

Select the EDIT option and press SELECT.

Scroll to the preferred user and press SELECT.

Scroll to the RF FOB option and press SELECT.

Toggle to DISABLED and press SAVE.

[i

If no 868MHz wireless receiver is detected on the system, the RF FOB option is not displayed in
the keypad menu.

[i

Number of RF fobs per user: Only one fob device can be programmed for each user. To change
fob devices among users, repeat the programming procedure for any new devices. Old fob devices
become available for use by different users.

14.6.1 Clearing alerts using the fob

Alerts on the SPC system are normally cleared using the keypad RESTORE option. Clearing alerts
can also be performed by using the wireless fob device.

If an active alert is displayed on the keypad when the system is UNSET, the alert can be cleared or
restored by pressing the UNSET key on the wireless fob five seconds after the system has been unset.

To enable this functionality, the KEYFOB RESTORE option must be enabled in System Options:

1.
2
3
4.
5. Toggle the settingto ENABLED and press SAVE.

Login to the keypad with an Engineer PIN.

. Scroll to FULL ENGINEER > OPTIONS.

Press SELECT.
Scroll to KEYFOB RESTORE and press SELECT.
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15 Soft Engineer programming via the keypad

This section provides [Soft] Engineer programming options using the LCD keypad.

For each menu option, the keypad must be in Engineer programming:

1. Enter avalid Engineer PIN. (Default Engineer PIN is 1111. For more details, see Engineer PINs on

page 106.)

2. Using the up/down arrow keys, scroll to the desired programming option.

3. ltis also possible to select a programming option using the keypad digits, enter the Engineer
programming PIN plus the digit as shown in the table below.

If you change one of the programming options, the keypad displays UPDATED momentarily.

Number Name Description
1 SETTING Performs an Unset, Fullset or Partset on the system.
2 INHIBIT Displays a list of the Inhibited zones on the system.
3 ISOLATE Allows the engineer to isolate zones on the system. See Isolate on
page 166.
4 EVENTLOG  Displays alist of the most recent events on the system. See
Event Log on page 166.
5 ACCESS LOG Displays a list of the most recent access to the system. See
Access Log on page 166.
6 ALARMLOG Displays alist of recent alarms. See Alarm Log on page 166.
7 CHANGE Allows the engineer to change the Engineer PIN. See Change
ENGPIN Engineer Pin on page 167.
8 USERS Allows the engineer to add, edit or delete users. See Users on
page 135.
9 SMS Allows the user to add, edit or delete SMS details for users. See
SMS on page 167.
See also
Test on page 162
Door Control on page 170

Engineer programming via the keypad on page 112

Installer Text on page 170
Set Date/Time on page 169
SMS on page 167
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16 Engineer programming via the keypad

This section provides [Full] Engineer programming options using the LCD keypad

For each menu option, the keypad must be in Full Engineer programming:

1.

Enter a valid Engineer PIN. (Default Engineer PIN is 1111. For more details, see Engineer PINs on
page 106.)

Press SELECT for FULL ENGINEER programming.

Using the up/down arrow keys, scroll to the desired programming option.

4. A quick select function is implemented. Press # to select a parameter (for example, a zone

attribute). The selected parameter is displayed with a * (for example, *Inhibit).

Upon completion of the programming options, the keypad displays UPDATED momentarily.

[i]

Please note that a * at the start of a menu item indicates that the item is already selected.

16.1 System Status

The System Status feature displays all faults on the system.

To view these faults:

1.

Scroll to SYSTEM STATUS.

2. Press SELECT.
The status of the following items is displayed.
Click each item to display further details.

OPEN Displays all open zones.

ZONES

ALERTS Displays current alerts on the system.

SOAK Displays all zones on soak test.

ISOLATIONS Displays zones that are isolated.

FAILTO SET Displays all areas that have failed to set. Select each area to display details of why the area failed
to set.

BATTERY Displays remaining battery time, voltage and current of battery. You must enter the Battery
capacity and Max current values in OPTIONS to view the remaining battery time on the keypad in
the event of mains failure. This is indicated under the STATUS > BATTERY > BATT TIME menu.
This menu also indicates if there is a battery fault.

AUX Displays voltage and current of auxiliary power.

[i]

NOTICE: Users cannot exit from FULL ENGINEER programming if any fault conditions exist. The
first fault will display on the keypad when you attempt to leave engineer mode. You can view and
isolate all faults within the System Status menu under Alerts and Open Zones.

© Vanderbilt 2018

112 ABV10276959-d
11.2018




SPC4xxx/5xxx/6xxx — Installation & Configuration Manual

Engineer programming via the keypad

16.2 Options

1. Scroll to OPTIONS and press SELECT.

2. Scroll to the desired programming option:

The programming options displayed in the OPTIONS menu vary depending on the security grade of
the system (see right column).

\ WARNING: To change the region on your panel, it is strongly recommended that you default your

panel and select a new region as part of the start up wizard.

Variable Description Default

SECURITY Determines the Security Grade of the SPC Installation. Grade: 2

GRADE « Irish and European Regions: Country:
—EN50131 Grade 2 n/a

—EN50131 Grade 3
—Unrestricted

UK Region:

—-PD6662 (EN50131 Grade 2 based)
—-PD6662 (EN50131 Grade 3 based)
—Unrestricted

Swedish Region:
—SSF1014:3 Larmclass 1
—SSF1014:3 Larmclass 2
—Unrestricted

Belgium Region:

—TO-14 (EN50131 Grade 2 based)
—TO-14 (EN50131 Grade 3 based)
—Unrestricted

Switzerland Region:
—SWISSI Cat 1
—SWISSI Cat 2
—Unrestricted

Spanish Region
—EN50131 Grade 2
—EN50131 Grade 3

German Region
-VdS Class A
-VdS Class C
—Unrestricted

France
—NFtyp2
—NFtyp3
—Unrestricted
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Variable Description Default

REGION Determines the specific regional requirements that the installation complies with.
Options are UK, IRELAND, EUROPE, SWEDEN, SWITZERLAND, BELGIUM,

GERMANY and FRANCE

APPLICATION Determines whether SPC is being installed for use in a commercial business or a Domestic
private residence. Choose between COMMERCIAL (see Commercial mode
operation on page 348), DOMESTIC (see Domestic mode operation on page 349) or

FINANCIAL.

See Options on page 252 for more details of the following OPTIONS.

PARTSETA RENAME

TIMED

ACCESS to E/EXIT
E/EXIT to ALARM

LOCAL

PARTSETB RENAME

TIMED

ACCESS to E/EXIT
E/EXIT to ALARM

LOCAL

CALLARC
MESSAGE

DISPLAY MESSAGE (ENABLED/DISABLED)

CONFIRMATION VDS

DD243:

GARDA

EN50131-9
CONFIRM Select NO. OF ZONES.
ZONES

AUTORESTORE ENABLED/DISABLED

STROBE ON FTS

KEYFOB ENABLED/DISABLED
RESTORE
USER DURESS DISABLED

PIN +1

PIN +2
RETRIGGER ENABLED/DISABLED
BELL
BELL ON 1ST ENABLED/DISABLED
BELLON FTS ENABLED/DISABLED

ENABLED/DISABLED
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ALARM ON EXIT

LANGUAGE

PIN DIGITS

CODED
RESTORE

WEB ACCESS

OPEN ZONES

ALLOW
ENGINEER

ALLOW
MANUFACT. *

SHOW STATE

ENABLED/DISABLED

Only available in ENGINEER CONFIG mode as setting is not in accordance with
ENS50131.

SYSTEM LANGUAGE
IDLE STATE :LANGUAGE

4DIGITS
5DIGITS
6 DIGITS
7DIGITS
8DIGITS

ENABLED/DISABLED

ENABLED/DISABLED

Allows/restricts access to the web browser.
ENABLED/DISABLED
ENABLED/DISABLED

ENABLED/DISABLED

ENABLED/DISABLED
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EOL NONE

RESISTANCE SINGLE 1K
SINGLE 1K5
SINGLE 2K2
SINGLE 4K7
SINGLE 10K
SINGLE 12K
DUAL 1K/ 470R
DUAL 1K/ 1K
DUAL 2K2/ 1KO
DUAL 2K2/ 1K5
DUAL 2K2/ 2K2
DUAL 2K2/ 4K7
DUAL 2K7/ 8K2
DUAL 2K2/ 10K
DUAL 3K0/ 3K0
DUAL 3K3/ 3K3
DUAL 3K9/ 8K2
DUAL 4K7 / 2K2
DUAL 4K7/ 4K7
DUAL 5K6 / 5K6
DUAL 6K8/ 4K7
DUAL 10K / 10K
MASK_1K_1K_6K8
MASK_1K_1K_2K2
MASK_4K7_4K7_2K2

SMS AUTH PIN ONLY

MODE CALLER ID ONLY
PIN + CALLER ID
SMS PIN ONLY
SMS PIN + CALLER ID

PACE AND PIN ENABLED/DISABLED

RESTORE ON ENABLED/DISABLED
UNSET

ENGINEER ENABLED/DISABLED
RESTORE

OFFLINE ENABLED/DISABLED
TAMPER

ENGINEER LOCK ENABLED/DISABLED

PIN is input on the keypad.

SECURE PIN ENABLED/DISABLED
CLOCK AUTOMATIC DST
SETTINGS

MAINS TIME SYNC

Note: To comply with PD6662, you must disable this option.

If enabled, system cannot be reset using yellow button on controller unless an Engineer
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SUSPICION
AUDIBLE

SHOW
CAMERAS

SEISTESTON
SET

ALERT FORBID
SET

ANTIMASK SET

ANTIMASK
UNSET

RETRIGGER
DURESS

RETRIGGER
PANIC

SILENCE AUD
VER.

ENGINEER EXIT

ENABLED/DISABLED

ENABLED/DISABLED

ENABLED/DISABLED

ENABLED/DISABLED

DISABLED
TAMPER
FAULT
ALARM

DISABLED
TAMPER
FAULT
ALARM

ENABLED/DISABLED

ENABLED/DISABLED

ENABLED/DISABLED

ENABLED/DISABLED

* Not available for SPC42xx, SPC43xx.

16.3 Timers

1. Scroll to TIMERS and press SELECT.

2. Scroll to the desired programming option:

Timers

Designation of the functions in the following order:

o 1strow: Web

e 2ndrow: Keypad

Timer Description Default
Audible

Internal Bells Duration that internal sounders will sound when alarm is activated. (0999 minutes; 15min.
INTBELLTIME 0= Never)
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Timer

Description Default

External Bells

EXT BELL
TIME

External Bell
Delay

EXT BELL
DELAY

Chime
CHIME TIME

Confirmation

Confirm

CONFIRM
TIME

Confirmed
holdup

Dialer Delay

DIALER
DELAY

Alarm abort
ALARM ABORT

Setting

Setting
Authorisation

SETTING
AUTH

Final Exit
FINAL EXIT

Bell on Fullset
FULLSET BELL

Fail To Set
FAILTO SET

Duration that external sounders will sound when alarm is activated. (0999 minutes; 15min.
0= never)

This will cause a delayed activation of the external bell. (0—999 seconds) Osec.

Number of seconds that a chime output will activate, when a zone with chime 2sec.
attribute opens. (1-10 seconds)

Note: This option is only available for certain Grade and Confirmation option 30min.
combinations. (See Options on page 252 and Standards on page 266.)

This timer applies to the alarm confirmation feature and is defined as the maximum
time between alarms from two different non overlapping zones that will cause a
confirmed alarm. (0—60 minutes)

Note: This option is only available for certain Grade and Confirmation option 480min.
combinations. (See Options on page 252 and Standards on page 266.)

This timer applies to the confirmed holdup feature and is defined as the maximum
time between alarms from two different non-overlapping zones that will cause a
confirmed alarm. (480—1200 minutes)

When programmed, the dialler delay initiates a predefined delay period before the 30sec.
system dials out to an Alarm Receiving Centre (ARC). This is specifically designed to

reduce unwarranted responses from Alarm Receiving Centres and the constabulary.

In the event of a subsequent zone being tripped the dialler delay period is ignored and

the dialler dials out immediately. (0-999 seconds)

Time after a reported alarm in which an alarm abort message can be reported. (0999  30sec.
seconds)

Period for which Setting Authorisation is valid. (10-250 seconds) 20secs

The Final Exit time is the number of seconds that arming is delayed after a zone 7sec.
programmed with the final exit attribute is closed. (1—45 seconds)

Activates the external bell momentarily to indicate a full set condition. (0—10 seconds) Osec.

Number of seconds to display fail to set message on keypads (0 until valid PIN is 10sec.
entered). (0999 seconds)
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Timer Description Default
Strobe on Activates the strobe on the external bell momentarily to indicate a full set condition. Osec.
Fullset (010 seconds)
FULLSET
STROBE
Alarm
Double Knock The maximum delay between activation’s of zones with the double attribute, which 10sec.
DKNOCK will cause an alarm. (1-99 seconds)
DELAY
Soak The number of days a zone remains under soak test before it automatically returns to 14 days
SOAK DAYS normal operation. (1-99 days)
Seismic Test The average period between seismic sensor automatic tests. (12—240 hours) 168
Interval Note: To enable automatic testing, the Automatic Sensor Test attribute must be hours
SEISMIC enabled for a seismic zone.
AUTOTEST
Seismic Test Maximum time (in seconds) that a seismic sensor takes to trigger an alarmin 30sec.
Duration response to the 'Seismic Test' output. (3—120 seconds)
SEISMIC TEST
DUR
Auto Restore Time to delay auto restore after zone state returns to normal. (09999 seconds) Osec.
Delay
Lockout Post The duration of time after an alarm before the user can gain access. (1-120 minutes)  Omin.
Alarm
LOCKOUT
POST ALARM
Access Time The duration of time the system can be accessed by an alarm access user after the
Lockout Time has elapsed. (10-240 minutes)

External Bell Duration that the strobe output will be active when an alarm is activated. (1-999 15min.
Strobe minutes; 0 = indefinitely)
STROBE TIME
Alerts
Mains Delay The time after a mains fault has been detected before an alert is activated by the Omin.
MAINS SIG system. (0—60 minutes)
DELAY
RF Jamming The time after RF Jamming has been detected before an alert is activated by the Omin.
Delay system. (0999 seconds)
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Timer Description Default
Engineer

Engineer The timer for the Engineer access starts as soon as the user enables the Engineer Omin.
Access Access. (0999 minutes; 0 indicates no time limitation for system access)

ENGINEER

ACCESS

Engineer auto Duration of inactivity after which the engineer will be automatically logged out. (0-300  Omin.
log out minutes)

ENGAUTO
LOG OUT

Keypad

Keypad Timeout The number of seconds that an RKD will wait for key entry before it leaves the current  30sec.
KEYPAD menu. (10-300 seconds)

TIMEOUT

Keypad The duration a keypad will wait in idle before switching language to default. (0-9999 10sec.
Language seconds; 0 = never)

KEYPAD
LANGUAGE

Fire

Fire Pre-alarm Number of seconds to wait before reporting fire alarm for zones with ‘Fire pre-alarm’ 30sec.
FIRE PRE- attribute set. See Editing a zone on page 270. (1-999 seconds)

ALARM

Fire recognition  Extra time to wait before reporting file alarm for zones with ‘Fire pre-alarm’ and ‘Fire 120sec.
FIRE Recognition’ attributes set. See Editing a zone on page 270. (1-999 seconds)

RECOGNITION
PIN

PIN Valid Period for which pinis valid. (1-330 days) 30 days
PIN VALID

PIN Changes Number of changes within a valid period. (1-50) 5
Limit

PIN CHANGES

LIMIT

PIN Warning Time before PIN expiry after which a warning will be displayed. (1-14 days) 5 days
PIN WARN

General Settings

RF Output Time The time that the RF output will remain active on the system. (0-999 seconds) Osec.
RF OUTPUT
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Timer Description Default

Time Sync Limit  Time limit within which time synchronization will not take place. Time synchronization Osec.
TIME SYNC only takes place if system time and update time are outside this limit. (0-300
LIMIT seconds)

Link Timeout Timeout for Ethernet link fault. (0-250 seconds; 0 = Disabled) Osec.

LINK TIMEOUT

Camera Offline  Time for camera to go offline. (10-9999 seconds) 10sec.

CAMERA

OFFLINE

Frequent This attribute only applies to remote services. The number of hours within which a 336h (2

FREQUENT zone must open if the zone is programmed with the Frequent attribute. (1-9999 weeks)
hours)

9

Duress silent Time when duress will remain silent and not restorable from keypad. (0999 minutes)  Omin.
Holdup/panic Number of minutes that a holdup/panic will remain silent and cannot be restored from  Omin.
silent the keypad. (0999 minutes)

Default times are dependent upon the Engineer configuration. The default times denoted may or may
| ® not be allowable and is dependent on the configuration by the engineer.

Valid settings/ranges may be dependent on the security grade specified under Configuration >
System > Standards.

16.4 Areas

1. Scroll to AREAS and press SELECT.

2. Scroll to the desired programming option:

ADD For Domestic and Commercial Mode, the area type defaults to Standard.
In Financial Mode, select area type STANDARD, ATM, VAULT or ADVANCED.

Enter the name of the area and the preferred entry/exit time.
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EDIT Edit the following settings:
« DESCRIPTION

« ENTRY EXIT
—ENTRY TIMER
—-EXIT TIMER
—NOEXIT TIMER
—FOB ENTRY ACTIVE

« PARTSETA/B
—ENABLED/DISABLED
- TIMED
—ACCESS TOE/EXIT
—E/EXIT TO ALARM
—LOCAL
—NO BELLS

« LINKED AREAS
—AREA
—FULLSET
—FULLSET ALL
—PREVENT FULLSET
—PREVENT FULLSET ALL
—UNSET
—UNSET ALL
—PREVENT UNSET
—PREVENT UNSET ALL

« SCHEDULE
—CALENDAR
—AUTOMATIC SET/UNSET
—TIME LOCKED
—VAULT ACCESS

« REPORTING
—EARLY TO SET
—LATE TOSET
—EARLY TOUNSET
—LATE TOUNSET

o SET/UNSET
—AUTO SET WARNING
—AUTO SET CANCEL
—AUTO SET DELAY
—-KEYSWITCH
—DELAY INTERVAL
—DELAY COUNTER
— DELAYED UNSET
—UNSET DURATION
—INTERLOCK
—DUAL PIN

« RFOUTPUT

DELETE Select the area to be deleted.

See Adding/Editing an area on page 270 for further details on these options.
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16.5 Area Groups

1. Scroll to AREA GROUPS and press SELECT.

2. Scroll to the desired programming option:

ADD
EDIT

Enter the name of the area group.

GROUP NAME - Rename the group as required.

part of the group.

AREAS - Scroll to an area and select it. Choose ENABLED or DISABLED as
required to add it or remove it from the group. An asterisk (*) indicates if an area is

DELETE Select the area to be deleted.

16.6 X-BUS

1. Scroll to XBUS and press SELECT.

2. Scroll to the desired programming options.

16.6.1 X-BUS Addressing

Expanders, keypads and subsequent zones may be configured, located and monitored, with the steps
provided in this section. X-BUS settings such as type, communication times and retries are also accessed

within this menu.

The figures below show the location of the rotary switches, and each rotary switch with an arrow symbol
pointing to a number for identification (that is, 3, 8). The right switch is the first unit digit and the left switch
is the 10s digit. The expander in the figure below is identified as 38.

()
) & O
2® gl
0 &
0e® U 1
o e U
o @ A EENE
5o O SO05 HADE
@@ g 2 g 2 -
) @
) &
) &
| (SIS DN QDN | D] (@&
@] (el e i telleloy o e e fe o [l ke | Fel o fe) g e ke T
Rotary switches
Number Description

1

Rotary switches identifying expander as 38.
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For a system with automatic addressing, expanders and keypads belong to the same numbering
sequence. For example, expanders and keypads are automatically numbered 01, 02, 03, etc., by the
controller in the order in which they are detected, for example, its relevant location to controller. In this
configuration, zones are allocated to each input expander.

| .
l Automatically addressed expanders are not supported by SPC41xx.

16.6.2 XBUS Refresh

The X-Bus Refresh utility performs a discovery of the current status of the X-Bus and displays the
current X-Bus configuration.

To refresh the X-Bus status:
1. Scroll to XBUS REFRESH.
2. Press SELECT.
The number of online keypads is displayed.

3. Press theright soft key on the keypad after each display to view expanders, zones and offline
items.

4. Press this key again to exit.

] Refresh makes no changes to the system, but is useful for detecting system faults, such as loose
l connections, or inactive expanders, before performing a Reconfigure.

16.6.3 Reconfigure

NOTICE: A reconfigure only applies to wired zones on an expander. Wireless zones on an
L expander and controller zones will not be brought online after a reconfigure. To bring controller
l zones online, you must apply a zone type other than ‘Unused’ using the zones menu on the
keypad or web browser.

If the system has a mixture of expander types (with and without rotary switches) then the system can
only be automatically reconfigured. If the system has all expanders with rotary switches, the system
can still be automatically reconfigured and the system will ignore the rotary switches and auto
addresses all the expanders on the system.

| ®
l It is recommended that you perform a Refresh before a Reconfigure.

To reconfigure keypads/expanders:
1. Scroll to RECONFIGURE.
2. Press SELECT.
The number of online keypads is displayed.
3. Press NEXT.
The number of online expanders is displayed.
4. Press NEXT

© Vanderbilt 2018 124 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the keypad

5.

The number of online zones is displayed.
Press BACK to exit.

16.6.4 Keypads/Expanders/Door Controllers

16.6.4.1 Locate

To locate a keypad/expander/door controller:

1.
2.
3.

16.6.4.2 Monitor

Scroll to KEYPADS, EXPANDER or DOOR CONTROLLER and press SELECT.
Scroll to LOCATE and press SELECT.

Scroll to the expander/keypad/door controller to be located and press SELECT.
The selected device beeps and the LED flashes allowing Engineer to locate it.
Press BACK to exit.

Locate keypads using the same menus and following the keypad choice instead of expander.

To obtain an overview of the keypads/expanders/door controller connected to the system:

1.

6.

Scroll to KEYPADS, EXPANDER or DOOR CONTROLLER and press SELECT.

2. Scroll to MONITOR and press SELECT.
3.
4

Scroll to desired Monitor programming option.

Press SELECT.

A list of detected keypads/expanders is displayed.

Scroll through the list and press SELECT on preferred expander/keypad/door controller.

Parameters and details, if applicable, are displayed for editing as shown in the table below.

STATUS Online or offline

S/N Serial number (used to track and identify)

VER Firmware version

POWER Power parameters: real-time voltage and current readings

ADDRESS The addressing mode and the address of the keypad/expander/door controller.
INFO

AUX FUSE The status of the auxiliary fuse on the expander/door controller

PSU The type and status of the PSU. (PSU expanders only) Scroll to display the
voltage and current load on the outputs, the battery status. The Mode Link option
is also available, which shows the jumper setting on the panel for the Ah setting.
7Ah and 17Ah are the available options. (This jumper is not present on the 5350
or 6350 models)

If you are using the SPC 5360 or 6350, this menu displays the battery status, and
the status of the fuses on the outputs.

BATTERY Battery voltage: battery voltage level (PSU expanders only)

INPUT State of each zone input associated with an expander as follows:
STATE C: Closed, O: Open, D; Disconnected, S: Short (Expanders with inputs only)

Press BACK to exit.
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16.6.4.3 Edit Keypads
To edit keypads:
1. Scroll to KEYPADS > EDIT.
2. Press SELECT.
3. Scroll to the device to be edited and press SELECT.

The configuration settings for a standard keypad and comfort keypad are described in the
sections below.

4. Press BACK to exit the menu.
LCD Keypad Settings

Configure the following settings for the keypad.

Setting Description

Description Enter a unique description to identify the keypad.
Function Keys (in idle state)

Panic Select Enable, Disable or Enabled Silent. If enabled, panic alarm is activated by pressing the 2
soft keys together.

Verification If you assign a verification zone to the keypad, when a panic alarm is triggered by pressing 2 soft
keys together or by entering a duress code, audio and video events are activated.

Visual Indications
Backlight Select when keypad backlight is on. Options are: On after key is pressed; Always on; Always off.
Indicators  Enable or disable the LED’s on the keypad.

Setting Select if setting state should be indicated in idle mode.
state

Audible Indications

Buzzer Enable or disable the buzzer on the keypad.
Partset Enable or disable buzzer during exit time on Partset.
Buzzer

Keypress Select if the speaker volume for the key presses should be activated.
Deactivation
Calendar Select if the keypad should be limited by calendar. See Calendars on page 284.

Mapping Select if keypad should be limited by a mapping gate.
gate

Keyswitch  Select if keypad should be limited by a keyswitch.

PACE Tick this box to disable the keys on the keypad during the entry time when a PACE is configured
Entry on the keypad.
Areas
Location Select the secured area where the keypad is located.
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Setting Description

Areas Select which areas can be controlled through keypad.

Options

Delay Select to configure a delayed set across all keypads. The location of the keypad is ignored and all
Fullset areas will perform a full exit time count down.

[i]

NOTICE: An area should be assigned to a keypad only if the keypad is inside the assigned area, and
if an entry/exit route is defined. If an area is assigned, when the particular area is set or unset then
entry and exit timers are used (if configured). Other features related to entry/exit routes also become
available. If no area is assigned, the area is set or unset immediately and other entry/exit features are
not available.

Comfort Keypad Settings

Configure the following settings for the comfort keypad.

Setting

Description

Description

Panic

Fire
Medical
Fullset
Partset A
Partset B

Verification

Backlight

Backlight
Level

Indicators
Setting state
Logo

Analog
Clock

Emergency

Function Keys (in idle state)

Visual indications

Enter a unique description to identify the keypad.

Select Enable, Disable or Enabled Silent. If enabled, panic alarm is activated by pressing F1 and
F2 soft keys together.

Enable to allow fire alarm to be activated by pressing F2 and F3 soft keys together.
Enable to allow medical alarm to be activated by pressing F3 and F4 soft keys together.
Enable to allow Fullset to be activated by pressing F2 key twice.

Enable to allow Partset A to be activated by pressing F3 key twice.

Enable to allow Partset B to be activated by pressing F4 key twice.

If you assign a verification zone to the comfort keypad, when a Medical, Panic or Fire event is
triggered, or if a user enters a duress code, then audio and video events are activated.

Select when keypad backlight is on. Options are: On after key is pressed; Always on; Always off.

Select the intensity of illumination of the backlight. Range 1-8 (High).

Enable or disable the LED’s on the keypad.
Enable if setting state should be indicated in idle mode. (LED)
Enable if logo should be visible in idle mode.

Select position of clock if visible in idle mode. Options are Left Aligned, Center Aligned, Right
Aligned or Disabled.

Enable if Panic, Fire and Medical function keys should be indicated in the LCD display.
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Setting Description
Direct Set Enable if Fullset/Partset function keys should be indicated in the LCD display.

Alarms
Entry/Exit
Chime
Keypress

Voice
Annunciation

Partset
Buzzer

Deactivation
Calendar

Mapping
gate

Keyswitch
PACE Entry

Areas
Location
Areas
Options

Delay Fullset

Audible indications

Select speaker volume for alarm indications or disable sound.

Range is 0—7 (max volume).

Select speaker volume for entry and exit indications or disable sound.
Range is 0—7 (max volume).

Select speaker volume for chime or disable sound.

Range is 0—7 (max volume).

Select if the keypad should be limited by calendar.

Select if keypad should be limited by a mapping gate.

Select if keypad should be limited by a keyswitch.

Tick this box to disable the keys on the keypad during the entry time when a PACE is configured on
the keypad.

Select the secured area where the keypad is located.

Select which areas can be controlled through keypad.

Select to configure a delayed set across all keypads. The location of the keypad is ignored and all
areas will perform a full exit time count down.

(i

NOTICE: An area should be assigned to a keypad only if the keypad is inside the assigned area,
and if an entry/exit route is defined. If an area is assigned, when the particular area is set or unset
then entry and exit timers are used (if configured). Other features related to entry/exit routes also
become available. If no area is assigned, the area is set or unset immediately and other entry/exit
features are not available.

16.6.4.4 Edit Expanders

To edit expanders:

1.
2.
3.

Scroll to EXPANDERS > EDIT.

Press SELECT.

Scroll to the device to be edited and press SELECT.
Parameters and details, if applicable, are displayed for editing.

Press BACK to exit the menu.
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identities of 1 to 512. (The greatest number in zone identification is 512.) Therefore, any expander

E For naming and identifying, expanders are allocated zones (in groupings of 8) with subsequent
1 named or identified by a number greater than 63 has no allocated zones.

Editing 10 Expanders

The following table lists the available options for 10 expanders:

Function Description

Description Edit the description of the expander.

Editing Audio Expanders

The following table lists the options available in the Edit menu for Audio Expanders:

Name Description

DESCRIPTION Enter or edit a description for the audio expander.
INPUT Select the zone’s input.

VOLUME LIMIT Select the volume limit.

Editing Wireless Expanders

The following table lists the available options for Wireless expanders:

Function Description

Description Edit the description of the expander.

Editing Analysed 10 Expanders

The following table lists the available options for IOA expanders:

Name Description

Description Edit the description of the expander.

Editing Indicator Expander Modules

The following table lists the available options for Indicator Expander modules:

Name Description

DESCRIPTION Enter or edit a description for the expander.

LOCATION Select a location for the expander from the list of available areas.
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Name Description

FUNCTION Enables you to assign behaviour to specific keys for specific areas.
KEYS Select an area and assign one of the following options to that area:

« None

« Unset

« Partset A

« PartsetB

« Fullset

« Toggle Unset/Fullset

« Toggle Unset/Partset A

« Toggle Unset/Partset B

« All Okay

« Setting Authorisation

VISUAL Enables you to assign specific behaviour to each LED on the indicator module. Each of the
INDICATIONS LEDs has the following options:

(Flexible Mode « FUNCTION — the following options are available:

only) —KEYSWITCH — select a keyswitch and the position of the key.

—DISABLED — select to disable the LED.

— SYSTEM — select the alarm type which triggers the LED.

—AREA — select the area which triggers the LED.

—ZONE — select the zone which triggers the LED

—DOOR — select the door and the door option which triggers the LED.

« ON — COLOR — specify the activation colour

« ON - FLASH — specify the behaviour of the LED in active state. Available options are:
— Permanent — always on.
— Flash Fast/Medium/Slow — varying speed of the flashing.

« OFF — COLOR — specify the deactivation colour.

« OFF —FLASH — specify the behaviour of the LED in the inactive state. Available options
are:
— Permanent — always on.
—Flash Fast/Medium/Slow — varying speed of the flashing.

LED ALWAYS Enable if LED indicators remain active when keys are deactivated.

AUDIBLE IND. Select the audible indicators for alarms, entry/exit, and keypresses,

(Flexible Mode
only)

DEACTIVATION  Choose one, or more, of the following deactivation options:

(Flexible Mode « Calendar — select a calendar from the available options.

only) « Keyswitch —select a keyswitch from the available options.
« Keypad - select a keypad from the available options.

« Card Reader —enable or disable deactivation using a keypad.
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Name Description

MODE Select Linked or Flexible. Linked mode reduces the number of options available in the
Expander Edit menu.

INPUT Select the zone

Editing Keyswitch Expanders

The following table lists the available options for keyswitch expanders:

Name Description

DESCRIPTION Enter or edit a description for the expander.

LOCATION Select a location for the expander from the list of defined areas.

LATCH Enable or disable the latch on the key position.

VISUAL Enables you to assign specific behaviour to each LED on the keyswitch expander. Each of
INDICATIONS the LEDs has the following options:

(Flexible mode o FUNCTION — the following options are available:

only) —KEYSWITCH — select a keyswitch and the position of the key.

— DISABLED — select to disable the LED.

— SYSTEM — select the alarm type which triggers the LED.

— AREA — select the area which triggers the LED.

—ZONE — select the zone which triggers the LED

—DOOR — select the door and the door option which triggers the LED.

o ON —COLOR — specify the activation colour

« ON - FLASH — specify the behaviour of the LED in active state. Available options are:
— Permanent — always on.
— Flash Fast/Medium/Slow — varying speed of the flashing.

o OFF — COLOR — specify the deactivation colour.

o OFF —FLASH — specify the behaviour of the LED in the inactive state. Available options
are:
— Permanent — always on.

« Flash Fast/Medium/Slow — varying speed of the flashing.

DEACTIVATION Select a deactivation method from the available options:

(Flexible mode o Calendar — select a calendar.
only)
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Description

KEY POSITIONS Enables you to assign behaviour to specific key positions for specific areas.

Select an area for the key position, and assign one of the following options to that area:
« None
« Unset
o Partset A
« PartsetB
« Fullset
« Toggle Unset/Fullset
« Toggle Unset/Partset A
« Toggle Unset/Partset B
« All Okay

« Setting Authorisation

16.6.4.5 Edit Door Controllers

For further information about Door controllers, see Door Expander on page 74.

1.
2.
3.

Scroll to DOOR CONTROLLERS > EDIT.
Press SELECT.
Scroll to the device to be edited and press SELECT.

Parameters and details, if applicable, are displayed for editing as shown in the table below.

Engineer programming via the keypad

DESCRIPTION Name of the door controller
DOORS Configuration of Door I/0O 1 and Door I/0O 2.
READERS Configuration of Reader Profiles

ToeditaDOOR I/0O:

1.
2.
3.

If the option “ZONES” is selected for a DOOR /0 the two inputs of this door I/O must be configured:

Scroll to DOORS.
Press SELECT.
Scroll to the DOOR 1/0 to be edited and press SELECT.

Parameters and details, if applicable, are displayed for editing as shown in the table below.

ZONES No access functionality is realized. The inputs and outputs can be
used normally.

DOOR 1—-DOOR The selected door number is assigned to the DOOR 1/0.
64

To edit the two zones of a DOOR 1/0:

1.

Scroll to the DOOR 1/0 to be edited and press SELECT
The option “Zones” is selected.

Press SELECT.

Select which Zone should be edited (DPS or DRS zone).
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4. Press SELECT.

Parameters and details, if applicable, are displayed for editing as shown in the table below.

UNASSIGNED This zone is not assigned and can not be used.

ZONE 1- The zone which is edited is assigned to this zone number. If the zone is
ZONE 512 assigned to a specific zone number, it can be configured like a normal zone.

The zones can be assigned to each free zone number. But the assignment is not fixed. If the zone
was assigned to zone number 9 and an input expander with the address 1 is connected to the X-Bus
(which is using the zone numbers 9—-16) the assigned zone from the two door controller will be moved
to the next free zone number. The configuration will be adapted accordingly.

e

To edit a READER PROFILE:
1. Scroll to READERS.
2. Press SELECT.
3. Scroll to the READER to be edited and press SELECT.

Select any of the following profiles for the reader:

1 Forreaders with a green and ared LED.
2 For VANDERBILT readers with a yellow LED (AR618X).

3 Profile 3 is used with HID readers that send a PIN to the panel as a card reading with a
predefined site code (0)

4 Profile 4 is used with HID readers that send a PIN to the panel as a card reading with a
predefined site code (255).

5 Select to enable Sesam readers. For VdS compliance, ensure you select the Override
Reader Profile option on the browser to provide feedback on the setting process.

See also

Door Expanderon page 74
16.6.5 Addressing Mode

X-BUS addressing can be configured in one of the 2 following ways:

Automatic addressing

With automatic addressing, the controller over-rides rotary switches and automatically assigns expanders
and keypads in the system unique IDs in sequential order.

Manual addressing

Manual addressing allows manual determination of each expander/keypad ID in a system. All devices
should be installed where required and each ID set manually using the rotary switches. The zones to ID
can be calculated using the following formula: ((ID value X 8)+1)= first zone number and then the next 7
sequential zones. For example ((ID2 x 8)+1)=17. Zone 17 is allocated to input 1 on ID2. Each input has the
next sequential zone allocated to it, in this case up to zone 24.

Note: ID limit for zone allocation SPC 4000: Expander ID 1-3. SPC 5000: Expander ID 1-15. SPC 6000:
Expander ID 1-63.

ID Zone ID Zone ID Zones ID Zones ID Zones
1 9-16 14 113-120 27 217-224 40 321-328 53 425-432
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ID Zone ID Zone ID Zones ID Zones ID Zones
2 17-24 15 121-128 28 225232 41 329-336 54 433440
3 25-32 16 129-136 29  233-240 42  337-344 55  441-448
4 33-40 17 137-144 30  241-248 43  345-352 56  449-456
5 41-48 18 145-152 31 249-256 44  353-360 57  457-464
6 49-56 19 153-160 32 257-264 45  361-368 58 465472
7 57-64 20 161-168 33  265-272 46  369-376 59  473-480
8 65-72 21 169-176 34 273-280 47  377-384 60  481-488
9 73-80 22 177-184 35  281-288 48  385-392 61 489-496
10 81-88 23 185-192 36  289-296 49 393400 62  497-504
11 89-96 24 193-200 37 297-304 50  401-408 63  505-512
12 97-104 25 201-208 38  305-312 51 409-416

13 105-112 26 209-216 39  313-320 52 417424

(i

If 2 devices of a kind (for example, expanders) are set to same ID, upon configuration, both
expanders beep and the flashing LED indicates conflict. Reset the switches and the system

rescans.

On a device, if both rotary switches are set to zero (0, 0), the full configuration becomes an

automatic addressing configuration.

To select the ADDRESS MODE:

1.

2
3.
4

Scroll to ADDRESS MODE.
Press SELECT.

Toggle for appropriate address mode: AUTOMATIC or MANUAL

Press SELECT to update the setting.

16.6.6 XBUS Type

To program the X-BUS type from the keypad:

1.
2.
3.

4.

Scroll to XBUS TYPE.
Press SELECT.

Scroll to select desired configuration:
-LOOP
-SPUR

Press SELECT to update the setting.

16.6.7 Bus Retries

To program the number of times the system attempts to retransmit data on the X-BUS interface before
a communications fault is generated:

1.
2.

Scroll to BUS RETRIES.
Press SELECT.
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3. Enterthe preferred number of times the system retransmits data.
4. Press SELECT to update the setting.

16.6.8 Comms Timer

To designate the length of time before a communication fault is recorded:
Scroll to COMMS TIMER.

1.

2
3.
4

16.7 Users

Press SELECT.

Enter the preferred time setting.
Press ENTER to update the setting.

Only users with the appropriate user right enabled in their profile have the ability to add, edit, or delete

users.

16.7.1 Add

To add users to the system:
Scroll to USERS>ADD.

1.

4.

Select a user ID from the available IDs on the system and press OK.

Press ENTER to accept the default user name or enter a customized user name and press ENTER.

Scroll to the preferred user profile type and press ENTER to select.

The system generates a default PIN for each new user.

Press ENTER to accept the default user PIN or enter a new user PIN and press ENTER.

The keypad confirms that the new user has been created.

16.7.2 Edit

To edit users on the system:
Scroll to USERS>EDIT.

1.
2.

Press OK.

3. Edit the desired user setting shown in the table below.

CHANGE
NAME

USER
PROFILE

DATE LIMIT

PACE
RF FOB

MAN-
DOWN
(MDT)

Edit the current user name

Select the appropriate profile for this user.

Enable this if the user can only access the system for a specified period of
time. Entera FROM and TO date and press ENTER.

Enable or disable PACE capability
Enable or disable RF Fob access (wireless keypad, remote control)

Enables the man-down test.
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ACCESS If no card assigned to the user:
CONTROL | ApD cARD
« LEARN CARD
If a card assigned to the user:

- EDIT CARD
— CARD NUMBER
—CARD ATTRIBUTES

« RESET CARD
« DELETE CARD

LANGUAGE Select alanguage for this user that will be displayed on the system.

16.7.2.1 Access Control
One access card can be assigned to each of the users on the control panel.
To configure the access control for a user:
1. Scroll to USERS>EDIT.
2. Press OK.
3. Select the user which should be configured and press OK.
4. Scrollto ACCESS CONTROL and press OK.
The following sections provide programming steps found within the access control option of the
selected user.

Add Card manually

If the card format of the card number is known, the card can be created manually.

The site code of the card is configured for the user profile that is assigned for this user.
1. Scroll to ADD CARD.
2. Press OK.

An empty card has been added and can now be edited.

Learn Card

| .
l NOTICE: Only cards with supported card formats can be learned.

If the card number or the card format is not known, the card can be read and its information learned.
1. Scrollto LEARN CARD.
2. Press OK.
3. Select the door that the card will be presented.
4. Press OK.

o NOTICE: The new card can be presented at the entry or the exit reader of the
l selected door.
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5. Present the card at a card reader at the selected door.

The information for the new card is learned.
Edit Card

If an access card is already assigned to a user it can be changed via the keypad:
1. Scroll to EDIT CARD.
2. Press OK.
3. Edit the desired user setting shown in the table in Access Control below.
4. Press BACK to exit.

Access Control

Attribute Description

Card Enter card number. Enter 0 to unassign this card.
Number

Void Card Check to temporarily disable this card.

Extended Extend doortimers when this card is present.

Time
PIN Access a door without PIN on a door with PIN reader.
bypass
Priority Priority cards are stored locally in the door controllers and will grant access in case of a technical fault
where the door controller cannot communicate with the control panel.
The maximum number of priority users is:
o SPC4xxx —all users
o SPCbhxxx —-512
o SPC6xxx—512
Escort The escort feature enforces privileged card holders to escort other card holders through specific doors.

If this feature is enabled on a door, a card with the “escort” right has to be presented first, to allow other
cardholders without this right to open the door. The time period in which cardholders are able to
present their cards after a card with escort right was presented, can be configured per door.

Custodian The custodian feature enforces a card holder with custodian privilege to always be inside a room (door
group) when other card holders are inside.

The custodian must be the first to enter the room. Only if a custodian is in the room other cardholders
are allowed to enter. The cardholder with the custodian right will not be allowed to exit until all non-
custodian cards left the room.

Identifies this card holder as a custodian. The user with the custodian attribute has to be the first who
enters a door group which requires a custodian card holder and has to be the last that is leaving this
door group.

Delete Card

If an access card is no longer needed it can be deleted via the keypad.
1. Scrollto DELETE CARD.
2. Press OK.
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Reset Card

If the ‘Prevent Passback’ feature is activated in a room and a user leaves this room without using the
exit reader, he is not allowed to enter this room again. The user’s card can be reset to allow him to
present his card once without a passback check.

Toreset the card via the keypad:

1.

2
16.7.3 Delete

Scroll to RESET CARD.

. Press OK.

To delete users on the system:

1.
2.

Scroll to USERS>DELETE.
Press OK.

A prompt displays, confirming command to delete.

Press YES to delete the user.

16.8 User Profiles

See

also

Adding/Editing User Profiles on page 199

16.8.1 Add

To add user profiles to the system:

i

The creator must be a user profile type MANAGER.

16.8.2 Edit

. Scroll to USERS PROFILES >ADD.

The option NEW NAME is displayed. Press OK.

Enter a customized user profile name and press ENTER.

The keypad confirms that the new user profile has been created.

To edit user profiles on the system:

1.
2.

Scroll to USER PROFILES>EDIT.

Press OK.
3. Edit the desired user profile setting shown in the table below.
CHANGE NAME Edit the name of the profile if required.
CHANGE AREAS Select the areas relevant to this profile.
CALENDAR Select a configured calendar or NONE.
RIGHT Enable or disable system features for this
profile. See User rights on page 200.
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DOOR Select the type of access available to this profile
for the configured doors. Options are NONE, NO
LIMIT or CALENDAR.

SITE CODE Enter a site code for all cards using this profile.

16.8.3 Delete
To delete user profiles on the system:
1. Scroll to USER PROFILES>DELETE.
2. Scroll through the user profiles to the required profile.
3. Press OK.

You are prompted to confirm deletion.

4. Press OK to delete the user profile.

16.9 Wireless

Wireless sensor detection (868MHz) on the SPC panel is provided by wireless modules. There are two
types of wireless modules: one-way SiWay RF Kit (SPCW110, 111, 112, 114 ) and two-way SPCW120
Wireless Transceiver. The SiWay RF Kit is fitted in the controller, on the keypad, or by installing a wireless
expander. The SPC two-way wireless module is fitted into modem slot 2 of the control panel. See the table
below for information on which devices can be enrolled with each type of transceiver.

For CE regulatory compliance, the SPCW120 product can only be fitted to the following products:
« SPC5330.320-L1
« SPC6330.320-L1
E « SPC4320.320-L1
« SPC5320.320-L1
« SPC5350.320-L1
« SPC6350.320-L1

Devices compatible with a one-way transceiver

Wireless sensors ADM-112WA1 Wireless Fresnel PIR detector, 12m wide angle
IR160W6-10 Wireless PIR detector with black triplex mirror, 18m wide angle,
868MHz
IMKW®6-10 Wireless magnet contact, 868MHz
IMKW6-10B Wireless magnet contact, 868MHz (brown)

OPZ-W1-RFM®6 SiWay radio module (plug-in to smoke alarm)

IRCW6-11 Remote control FOB with 4 button control
IPAWG6-10 Personal transmitter
WPA Wireless personal alarm
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Devices compatible with a two-way transceiver

Wireless sensors WPIR Wireless 12m PIR detector with pet immunity option
WPIR-CRT Wireless curtain PIR detector
WMAG Wireless magnetic contact (slim)
WMAG-| Magnetic contact with additional input
WRMT Remote control FOB with 4 button control
WPAN Wireless personal alarm button

L For instructional videos on wireless devices and transceivers please go to
l http://van.fyi?Link=Wireless_devices

16.9.1 Select a wireless programming option

To select a wireless programming option:
1. Scroll to WIRELESS and press OK.

2. Scroll to the desired programming option. Options are described in the following table:

SENSORS It may be necessary to change the type of sensor enrolled on the system if the sensor type
was incorrectly identified in the enrolment process.

The following options are available for sensors:
. ADD
See Wireless Sensors on page 145.
« EDIT (Change zone assignment)
See Edit Sensors (Zone Assignment) on page 146
. REMOVE
Select the device or sensor to be deleted.
WPA' Add, edit or remove a WPA (Wireless Personal Alarm).
. ADD
See Add a WPA on page 142.
. EDIT
See Edit a WPA on page 142.
. REMOVE
Select the WPA to be deleted.

EXTERNAL Enable or disable the external antenna.
ANTENNA

SUPERVISION Enable or disable tamper supervision.

FILTER LOW Enable or disable the filter low signal (RF strengths 0 and 1).
SIGNL
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DETECT RF Enable or disable the RF JAM.
JAM.

RF FOB SOS Disable the RFFOB SOS or enable PANIC, PANIC SILENT, USER MEDIC, USER
HOLDUP, or RF OUTPUT.

WPA TEST Enter a maximum period (in days) between WPA tests. Max is 365 days.
SCHED.

PREVENT SET Enter atime in minutes after which, if the sensor or WPA fails to report, setting is prevented
TIME for the area where the wireless zone is. Max is 720 minutes.

DEVICE LOST Enter the number of minutes after which the wireless device is reported as lost if it fails to
TIME report within this time frame. (Min is 20 and max is 720 minutes)

WIRELESS Enable or disable wireless lost.
LOST

2 WAY Enable or disable two-way wireless depending on the transceiver you are using.

WIRELESS Enable two-way wireless if you are using SPCW120 Wireless Transceiver. Disable two-way

wireless if you are using SiWay RF Kit (SPCW110, 111, 112, 114 ).

1A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

16.9.2 One-way wireless

The following devices can be enrolled on a one-way wireless transceiver:
« Wireless sensors
« Wireless Personal Alarm (WPA)
« IPAW6G-10
o IRCW6-11
You must disable two-way wireless before enrolling these devices.
To disable two-way wireless:
1. Scroll to WIRELESS and press OK.
2. Scrollto2 WAY WIRELESS.
3. Select DISABLE.

16.9.2.1 Wireless Sensors
Add Sensors

To add a wireless sensor device:
1. Scroll to WIRELESS > SENSORS > ADD and press OK.
A menu of enrolment options opens. Options are:
« ENROL
« TAMPER ENROL
o ACTIVATE ENROL
2. Scroll to your desired option and press OK.
The display flashes the text ENROL DEVICE.

3. Activate the wireless device by inserting the battery/batteries to allow the keypad receiver to detect
the wireless transmission of the device.

© Vanderbilt 2018 141 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the keypad

When the device has been detected the text FOUND SENSOR is displayed on the keypad. The
device ID, TYPE, and SIGNAL information is displayed beneath FOUND SENSOR.

4. Press OK.
A prompt to select the area is displayed.

5. Scroll to the desired option and press OK.
A prompt to select a zone type is displayed.

6. Scroll to the required zone type and press OK.
Edit Sensors (Zone Assignment)

It may be necessary to change the zone assignment of a sensor enrolled on the system.
To change the zone assignment of a wireless detector:

1. Scroll to EDIT and press OK.

2. Scroll to the sensor to be changed and press OK.
3. Scroll to ZONE and press OK.
4

. Scroll to the appropriate zone number (only unoccupied zone numbers are displayed) and press

OK.
16.9.2.2 WPA
« You can only configure a WPA or check WPA status on the keypad if there is a wireless
| i module fitted on the panel or any of the panel expanders.

« AWPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

A WPA is not assigned to a user. Usually, a WPA is shared by several people, for example, security
guards working in shifts. Alternatively a WPA may be permanently attached to a surface such as under
a desk or behind aftill.

You can connect up to 128 WPAs per SPC panel.
Add a WPA

To add a WPA with the keypad:
1. Select WIRELESS > WPA > ADD.
2. Select MANUALLY to manually entera WPA ID.

Alternatively, the ID can be entered automatically by the panel by selecting the LEARN WPA
option. Press any button on the WPA when the ACTIVATE WPA message is displayed, for the
panel to identify the WPA. The panel will not accept a WPA if the WPA ID is a duplicate of a
currently configured WPA.

Exit the ADD menu.
4. Select the EDIT menu to configure the WPA.

Edit a WPA

To edit a WPA, select WIRELESS > WPA > EDIT and edit the relevant fields.
Editable fields for WPA

DESCRIPTION Enter adescription to uniquely identify the WPA.
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TRANSMITTER Enterthe WPA ID. The panel will not accept a WPA if the WPA ID is already in use.
ID

FUNC. TO Use this section to assign functions to button combinations. Available functions are Panic,
BUTTONS Panic Silent, Holdup, Suspicion, RF User Output, Medical. More than one button
combination can be selected for the same function. For example:
« Yellow = Suspicion
« Red + Green = Holdup
« For Commercial or Domestic installations, the default is: Red + Green = Panic

Note: If no function is assigned to a button combination, it is still possible to use that
combination by using a trigger. See Triggers on page 288.

SUPERVISION The WPA may be configured to send periodic supervision signals. If supervision is enabled
on the WPA (with the jumper), the WPA sends out a supervision message about every 7.5
minutes. The time between messages is randomized to decrease the chances of collision
with other WPAs.

The supervision function must be enabled on the panel for the particular WPA for correct
supervision operation. If the panel does not get a supervision signal, it raises an alarm that is
shown in the keypad and logged.

If supervision is not enabled, the WPA sends out a supervision message about every 24
hours to transmit the WPA battery status to the panel. The message interval is randomized
to decrease the chances of collision with other WPAs.

Select ENABLE if supervision has been enabled for that particular WPA.
TEST Enables testing of the WPA signal.

See also
« Triggers on page 288
o Wireless on page 139
o WPA Test below

WPA Test

NOTICE: The test can only be performed by an engineer or a user that has a WPA Test right assigned
to them. See User rights on page 200.

To test the WPA from the keypad:
1. Scroll to TEST > WPA TEST and press OK.
2. When prompted with ACTIVATE WPA, press the three buttons on the WPA simultaneously.

If the test succeeds, a WPA n OK message is shown, where n is the number of the WPA being
tested.

3. Repeat the test if required.
4. Press BACK or X to end the test.
16.9.2.3 IPAWG6-10 personal alarm button

The IPAWG-10 personal alarm button is a device that is used to transmit Panic Alarm messages to the
SPC system.
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The user can wear the IPAW6-10 in one of two ways:

« IPAWG-10 can be worn as a wrist watch (by inserting the wrist band into the two slits of the
appropriate ring holder).

« IPAWG6-10 can be worn as a pendant by removing the wrist ring holder and replacing it with the
pendant ring holder.

Enrol a IPAW6-10 personal alarm button

To enrol the IPAW6-10 and assign it to User(n):
1. Select USERS > EDIT > USER(n) > RF FOB > ENABLED.

The keypad displays the ADD screen with a flashing ENROL DEVICE message.
2. Onthe IPAWG-10, press and hold the button.
The LED lights up for 1.5 seconds.

Disable a IPAW6-10 personal alarm button

To disable the IPAW6-10:
Select USERS > EDIT > USER(n) > RF FOB>DISABLED.

A message appears on-screen saying UPDATED.
16.9.2.4 IRCW6-11 remote control

The IRCWB6-11 4-button Remote is a device that allows a user to remotely operate the SPC system.

The device supports ARM, STAY, and DISARM functionality, as well as the operation of defined
outputs and an SOS feature.
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3 Disarm
4 Additional Function
5 Panic/SOS
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Enrol a IRCW6-11 remote control

To enrol an IRCW6-11 and assign it to User (n):
1. Select USERS > EDIT > USER (n) > RF FOB>ENABLED.
The keypad displays the ADD screen with a flashing ENROL DEVICE message.
2. Onthe IRCW6-11, press and hold any button.
The LED on the remote control lights. A message appears on the keypad screen saying FOB
CONFIGURED. The IRCW®6-11 is assigned to the User (n).
Disable a IRCW6-11 remote control

To disable a IRCW6-11:
o Select USERS > EDIT > USER (n) > RF FOB > DISABLED.

A message appears on-screen saying UPDATED.

16.9.3 Two-way wireless

The following devices can be enrolled on a two-way wireless transceiver:
» Wireless sensors
o WPAN personal alarm button
o WRMT remote control
Please note that you must enable two-way wireless before enrolling these devices.
To enable two-way wireless:
1. Scroll to WIRELESS and press OK.
2. Scrollto2 WAY WIRELESS.
3. Select ENABLE.

16.9.3.1 Wireless Sensors
Add Sensors

To add a wireless sensor device:
1. Scroll to WIRELESS > SENSORS > ADD and press OK.
A menu of enrolment options opens. Options are:
« ENROL
« TAMPER ENROL
. ACTIVATE ENROL
2. Scroll to your desired option and press OK.
The display flashes the text ENROL DEVICE.

3. Activate the wireless device by inserting the battery/batteries to allow the keypad receiver to detect
the wireless transmission of the device.

When the device has been detected the text FOUND SENSOR is displayed on the keypad. The
device ID, TYPE, and SIGNAL information is displayed beneath FOUND SENSOR.

4. Press OK.
A prompt to select the area is displayed.

5. Scroll to the desired option and press OK.
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A prompt to select a zone type is displayed.

6. Scroll to the required zone type and press OK.
Edit Sensors (Zone Assignment)

It may be necessary to change the zone assignment of a sensor enrolled on the system.
To change the zone assignment of a wireless detector:

1. Scroll to EDIT and press OK.

2. Scroll to the sensor to be changed and press OK.
3. Scroll to ZONE and press OK.
4

. Scroll to the appropriate zone number (only unoccupied zone numbers are displayed) and press
OK.

16.9.3.2 WPAN personal alarm button

The WPAN personal alarm button is a device that is used to transmit Panic Alarm messages to the
SPC system.

The user can wear the WPAN in one of two ways:

« WPAN can be worn as a wrist watch (by inserting the wrist band into the two slits of the
appropriate ring holder).

« WPAN can be worn as a pendant by removing the wrist ring holder and replacing it with the
pendant ring holder.

Enrol a WPAN personal alarm button

To enrol the WPAN and assign it to a User(n):
1. Select USERS > EDIT > USER(n) > RF FOB > ENABLED.
The keypad displays the ADD screen with a flashing ENROL DEVICE message.
2. Onthe WPAN, press and hold the button.
The LEDs on the fob light in the following pattern: Red lights for 3 seconds, then no LED, then
Red lights for 1 second, and then Green lights for 1 second. The WPAN is assigned to User (n).

Disable a WPAN personal alarm button

To disable the WPAN:
Select USERS > EDIT > USER(n) > RF FOB > DISABLED.

A message appears on-screen saying UPDATED.
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16.9.3.3 WRMT remote control
The WRMT 4-button Remote is a device which allows a user to remotely operate the SPC system. The
device supports UNSET, FULLSET, and PARTSET functionality, as well as the operation of defined

outputs and an SOS feature.
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Enrol a WRMT remote control

To enrol the WRMT and assign it to a User (n):
1. Select USERS > EDIT > USER (n) > RF FOB > ENABLED.
The keypad displays the ADD screen with a flashing ENROL DEVICE message.
2. Onthe WRMT, press and hold the two SOS buttons.

The LED blinks Red once and then Green to confirm enrolment. A message appears on the keypad
screen saying FOB CONFIGURED. The WRMT is assigned to the User (n).

Disable a WRMT remote control
To disable a WRMT:
« Select USERS > EDIT > USER (n) > RF FOB > DISABLED.
A message appears on-screen saying UPDATED.
When you disable a WRMT from your system, you must also clear the internal registration in the WRMT
before you can re-use the WRMT.
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To clear the internal registration:
« Onthe WRMT, press and hold the PARTSET and UNSET buttons.

The LED blinks Red and Orange to confirm that registration is cleared.

16.10 Zones

1. Scroll to ZONES and press OK.
2. Scroll to the desired zone (ZONE 1-x).

3. Scroll to the desired programming option:

DESCRIPTION Used to help identify the zone: enter a specific and descriptive name.
ZONE TYPE Determines the zone type. See Zone types on page 379.
ATTRIBUTES  Determines the attributes of the zone. See Zone attributes on page 384.

TO AREA Determines which zone is mapped to which area. This menu option is
only displayed if multiple areas are defined on the system. Selecting this
feature allows users to build a set of zones that are identified with a
particular area in the building.

The number and type of attributes displayed in the keypad menus for a particular zone vary
depending on the type of zone that is selected.

i

16.11 Doors

1. Scroll to DOORS and press SELECT.
2. Scroll to the door to be programmed and press SELECT.

Parameters and details, if applicable, are displayed for editing as follows:
- Description

- Door Inputs

- Door Group

- Door Attributes

- Door Timers

- Reader Information (Display only - format of last card used with configured reader)
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Door inputs

Each door has 2 inputs with predefined functionality. These two inputs, the door position sensor and the
door release switch can be configured.

Name Description

Zone The door position sensor input can be used for the intrusion part as well. If the door position sensor
input is used also for the intrusion part, the zone number it is assigned to has to be selected. If the
door position sensor is used only for the access part, the option “UNASSIGNED” has to be selected.
If the door position sensor is assigned to an intrusion zone, it can be configured like a normal zone
but only with limited functionality (for example, not all zone types are selectable).
If an area or the system is set with the card reader, the door position sensor input has to be assigned
to a zone number and to the area or the system which have to be set.

Description Description of the zone the door position sensor is assigned to.

(Web only)

Zone Type Zone type of the zone the door position sensor is assigned to (not all zones types are available).

(Web only)

Zone The attributes for the zone the door position sensor is assigned to can be modified.

attributes

(Web only)

Area The area the zone and the card reader are assigned to. (If the card reader is used for setting and

(Web only) unsetting, this area will be set/unset).

Door The resistor used with the door position sensor. Choose the used resistor value/combination.

Position

(Web)

DPS End

Of Line

(keypads)

DPS Select if the door release switch is to be a normally open or normally closed input.

Normal

Open

Door The resistor used with the door release switch. Choose the used resistor value/combination.

Release

(Web)

DRS END

OF LINE

(Keypads)

DRS Select if the door release switch is a normally open input or not.

Normal

Open

No DRS Select toignore DRS.

(Webonly) IfaDC2is used on the door, this option MUST be selected. If not selected, the door will open.
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Name Description

Reader Select the location of the entry and exit readers.
Location
(Entry/Exit)

(Web only)

Reader Displays format of last card used with each configured reader.
formats
(Web)

READER
INFO
(Keypads)

Each free zone number can be assigned to the zones but the assignment is not fixed. If the
L number ‘9’ is assigned to a zone, the zone and an input expander with the address ‘1’ is connected
l to the X-Bus (which is using the zone numbers 9—16). The assigned zone from the two door
controller will be moved to the next free zone number. Configuration will be adapted accordingly.

Door Groups

The different doors can be assigned to door groups. This is needed if one of the following functionalities
is activated:

« Custodian

« Soft Passback

« Prevent Passback
« Interlock

Door attributes

| @
l If no attribute is activated, a valid card can be used.

Attribute Description

Void The card is temporarily blocked.

Door Group Used when multiple doors are assigned to the same area and/or anti-passback, custodian, or
interlock functionality is required.

Card and Card and PIN are required to gain entry.
PIN

PIN Only PIN is required. No card will be accepted.

PIN Code  PIN orcard are required to gain entry
or Card

PIN to Exit PIN is required on exit reader. Door with entry and exit reader is required.
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Attribute Description

PIN to PIN is required to set and unset the linked area. The card has to be presented before the PIN is
Set/Unset  entered.

Unset Panel/area will unset, when card is presented at entry reader.
outside
(Browser)

Unset Panel/area will unset, when card is presented at exit reader.
inside
(Browser)

Bypass Access is granted if an area is set and the door is an alarm or an entry zone type.
alarm

Fullset Panel/area will fullest, when card is presented twice at entry reader.
outside
(Browser)

Fullset Panel/area will fullest, when card is presented twice at exit reader.
inside

Force If the user has rights, they can force set from entry reader.
Fullset

Emergency Door lock opens if a fire alarm is detected within the assigned area.

Emergency Firein any area will unlock the door.

any

Escort The escort feature enforces privileged card holders to escort other card holders through specific
doors. If this feature is assigned to a door, a card with the “escort right” has to be presented first,
to allow other cardholders without this right to open the door. The time period in which cardholders
are able to present their cards after a card with escort right was presented, can be configured per
door.

Prevent Anti-passback should be enforced on the door. All doors must have entry and exit readers and

Passback* must be assigned to a door group.

In this mode, cardholders must use their access card to gain entry into and exit from a defined
door group. If a valid cardholder has presented his access card to enter a door group and not
presented the card to exit it, the cardholder is in breach of the anti-passback rules. Next time the
cardholder attempts to enter the same door group, a hard anti-passback alarm will be raised and
the cardholder will not be permitted entry to the door group.

Soft Anti-passback violations are only logged. All doors must have entry and exit readers and must be
Passback* assigned to a door group.

In this mode, cardholders must use their access card to gain entry to and exit from a defined door
group. If a valid cardholder has presented his access card to enter a door group and not presented
the card to exit it, the cardholder is in breach of the anti-passback rules. Next time the cardholder
attempts to enter the same door group, a soft anti-passback alarm will be raised. However, the
cardholder will still be permitted entry to the door group.
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Attribute Description

Custodian* The custodian feature allows a card holder with custodian right (the custodian) to give other
cardholders (non-custodians) access to the room.

The custodian must be the first to enter the room. The non-custodians are only allowed to enter if
the custodian is in the room. The custodian will not be allowed to exit until all non-custodians have
left the room.

Door Door controller PCB mounted sounder sounds on door alarms.
Sounder

Ignore Door forced open is not processed.

Forced

Interlock™ Only one door in an area will be allowed open at a time. Requires Door Group.
(Browser)

Setting Authorisation with prefix (A,B,* or #) key to set system
Prefix
* Require door group
Door timers
Timer Min. Max. Description
Access 1s  255s Thetime the lock will remain open after granting access.
granted
Access 1s  255s The duration after which the controller will be ready to read the next event after a
deny invalid event.

Dooropen 1s  255s Duration within which the door must be closed to prevent a “door open too long”
alarm.

Door left 1 180 Duration within which the door must be closed to prevent a “door left open” alarm.
open min  min

Extended 1s 255s Additional time after granting access to a card with extended time attribute.

Escort 1s 30s Time period after presenting a card with escort attribute within a user without
escort right can access the door.

16.12 Outputs

Each zone type on the SPC system has an associated output type (an internal flag or indicator). When
a zone type is activated, that is, a door or window opens, smoke is detected, an alarm is detected, etc.,
the corresponding output is activated.

1. Scroll to OUTPUTS and press SELECT.
2. Scrollto CONTROLLER or EXPANDER and press SELECT.
3. Scroll to the expander/output to be programmed and press SELECT.

If the output activations are recorded in the system event log (that is, enabled, items
recorded/disabled, items) the programming options are available as shown in the table below.

NAMES Used to help identify the output; enter a specific and descriptive name.
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OUTPUT Determines the output type; see the table in Outputs types and output ports
TYPE below, for a description of output types.

OUTPUT Determines the style of the output: continuous, momentary or pulsed.
MODE

POLARITY Determines whether the output is activated on a positive or negative polarity.

LOG Determines if system log is enabled or disabled.

[i]

For the output test procedure, see Output Test on page 164.

16.12.1 Outputs types and output ports

Each output type can be assigned to one of the 6 physical output ports on the SPC controller or to an
output on one of the connected expanders. Output types that are not assigned to physical outputs act as
indicators of events on the system and may be logged and/or reported to remote central stations if
required.

The output ports on the expanders are all single pole relay type outputs (NO, COM, NC); therefore, output
devices may need external power sources to activate if they are wired to expander outputs.

The activation of a particular output type depends on the zone type (see Zone types on page 379) or alert
condition that triggered the activation. If multiple areas are defined on the system then the outputs on the
SPC are grouped into system outputs and area outputs; the system outputs are activated to indicate a
system wide event (for example, mains fault) whereas the area outputs indicate events detected in one or
more of the defined areas on the system. Each area has its own set of area outputs; if the area is a
common area for other areas, then its outputs will indicate the state of all the areas it is common for,
including its own state. For example, if Area 1 is common for Area 2 and 3, and Area 2 Ext. Bell is active,
then the Area 1 Ext Bell output is also active.

H

Some output types can only indicate system wide events (no specific area events). See the table
below for further information.

Output Type Description

External Bell ~ This output type is used to activate the system external bell and is active when any Area External

Bell is active. By default, this output is assigned to the first output on the controller board (EXT+,
EXT-).

Note: An external bell output is automatically activated whenever a zone programmed as an Alarm
zone triggers an alarm in Fullset or Partset modes.

External Bell ~ This output type is used to activate the strobe on the system external bell and is active when any

Strobe area strobe is active. By default, this output is assigned to the strobe relay output (Output 3) on the
Controller board (NO, COM, NC).
Note: An external bell strobe output is automatically activated whenever a zone programmed as an
alarm zone triggers an alarm in Fullset or Partset modes. The external bell strobe activates on a 'Fail
to Set’ condition if the strobe on the 'Fail to Set’ option is checked in system options.
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Output Type Description

Internal Bell This output type is used to activate the internal bell and is active when any area Internal Bell is
active. By default, this output is assigned to the second output on the controller board (INT+, INT-).
Note: Aninternal bell output is automatically activated whenever a zone programmed as an Alarm
zone type triggers an alarm in Fullset or Partset modes. The internal Bell activates on a 'Fail to Set’
condition if the Bell on the ’Fail to Set’ option is checked in system options.

Alarm This output turns on following alarm zone activation on the system or from any area defined on the
system.

Alarm This output turns on when an alarm has been confirmed. An alarm is confirmed when 2 independent

Confirmed zones on the system (or within the same Area) activate within a set time period).

Panic* This output turns on following activation of panic alarm zone types from any area. A panic alarm
output is also generated if a user duress event is generated or if the panic option for the keypad is
enabled.

Hold-up This output turns on whenever a zone programmed as a Hold-up type zone triggers an alarm from any
area.

Fire This output turns on following a fire zone activation on the system (or from any area).

Tamper This output turns on when a tamper condition is detected from any part of the system.

For a grade 3 system, if communication is lost to an XBUS device for greater than 100s, a tamper is
generated and SIA and CIR reported events will send a tamper.

Medical This output turns on when a medic zone is activated.

Fault This output turns on when a technical fault is detected.

Technical This output follows tech zone activity.

Mains Fault*  This output activates when Mains power is removed.

Battery Fault* This output activates when there is a problem with the backup battery. If the battery voltage drops
below 11V this output activates. The 'Restore’ option for this fault is only presented when the voltage
level rises to above 11.8V.

Partset A This output is activated if the system or any area defined on the system is in Partset A mode.

Partset B This output is activated if the system or any area defined on the system is in Partset B mode.

Fullset This output is activated if the system is in Fullset mode.

Fail to set This output activates if the system or any area defined on the system failed to set; it clears when the
alert is restored.

Entry/Exit This output activates if an Entry/Exit type zone has been activated; that is, a system or area Entry or
Exit timer is running.

Latch This output turns on as defined in the system latch output configuration (see Configuring system
latch and auto set outputs on page 236).

This output can be used to reset latching sensors as smoke or inertia sensors.
Fire Exit This output turns ON if any Fire-X zones on the system are activated.
Chime This output turns on momentarily when any zone on the system with chime attribute opens.
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Communicate

Man Down
Test

Unset

Alarm Abort

Seismic Test

Local Alarm

RF Output

Modem 1 Line
Fault

Modem 1
Failure

Output Type Description

Smoke This output turs on momentarily( 3 seconds) when a user unsets the system; it can be used to reset
smoke detectors.
The output will also activate when the zone is restored.
When using the zone to reset latched smoke detectors the first code entry will not activate the
smoke output but will silence bells, on the next code entry if the fire zone is in the open state the
smoke output will activate momentarily. This process is repeatable until the fire zone is closed.

Walk Test* This output turns on momentarily when a walk test is operational and a zone becomes active. This
output can be used, for example, to activate functional tests of connected detectors (if available).

Auto Set This output turns on if the Auto Set feature has been activated on the system.

UserDuress  This output tums on if a user duress state has been activated (PIN code + 1 has been entered on the
keypad).

PIR Masked  This output tums on if there are any masked PIR zones on the system. It generates a fault output on
the keypad led.
This output is latched so it will remain active until restored by a level 2 user.
PIR Masking is logged by default. The number of log entries do not exceed 8 between arming
periods.

Zone Omitted This output turns on if there are any inhibited, isolated, or walk test zones on the system.

Fail to This output turns on if there is a failure to communicate to the central station.

This output turns on a ‘Man Down’ wireless device which is activated during a ‘Man Down’ test.

This output is activated if the system is in Unset mode.

This output activates if an alarm abort event occurs, that is, when a valid user code is entered via the
keypad after a confirmed or unconfirmed alarm. It is used, for example, with external dialers (SIA,
CID, FF).

This output is used to activate a manual or automatic test on a seismic zone. Seismic sensors have
a small vibrator that will be attached to the same wall as the sensor and is wired to an output on the
panel or one of its expanders. During the test, the panel waits up to 30 seconds for the seismic zone
to open. If it does not open, the test fails. If it opens within 30 seconds the panel then waits for the
zone to close within 10 seconds. If that doesn’t happen, the test fails. The panel then waits a further
2 seconds before reporting the test result. The result of the test, either manual or automatic, is stored
in the system event log.

This output activates on alocal intrusion alarm.

This output activates when a Fob or WPA1 button is pressed.

This output activates when there is a line fault on the primary modem.

This output activates when the primary modem fails.
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Blockschloss
1

Blockschloss
2

Lock Element

Unlock
Element

Code Tamper
Trouble
Ethernet Link
Network Fault

Glass Reset

Output Type Description

Modem 2 Line This output activates when there is a line fault on the secondary modem.

Fault

Modem 2 This output activates when the secondary modem fails.

Failure

Battery Low  This output activates when the battery is low.

Entry Status  This output activates if an ‘All Okay’ entry procedure is implemented and there is no alarm generated,
that is, the ‘All Okay’ button is pressed within the configured time after the user code is entered.

Warning This output activates if an ‘All Okay’ entry procedure is implemented and a silent alarm generated,

Status that is, the ‘All Okay’ button is not pressed within the configured time after the user code is entered.

Ready to Set  This output activates when an area is ready to set.

Setting ACK  This output signals the setting status. The output toggles for 3 seconds to signal that the setting has
failed. The output remains on for 3 seconds if setting is successful.

Fullset Done  This output activates for 3 seconds to signal that the system has been fullest.

Used for normal Blockschloss devices.

When all zones in an area are closed, and there are no pending faults, the ‘Blockschloss 1° output is
activated. If the lock on the Blockschloss is closed, a ‘Keyarm® input is activated, the relevant area is
set and the ‘Setting Ack’ output is activated for 3 seconds to signal that the setting was successful.
‘Blockschloss 1‘is not deactivated.

If the Blockschloss is unlocked, the Blockschloss device deactivates the Keyarm input to the unset
state (closed) and the area is unset. ‘Blockschloss 1°is then deactivated.

Used for Blockschloss device type - Bosch Blockschloss, Sigmalock Plus, E4.03.

When all zones in an area are closed, and there are no pending faults, the ‘Blockschloss 2‘ output is
activated. If the lock on the Blockschloss is closed, a ‘Keyarm® input is activated, the relevant area is
set and the ‘Setting Ack’ output is activated for 3 seconds to signal that the setting was successful.
‘Blockschloss 2 is then deactivated.

If the Blockschloss is unlocked, the Keyarm zone is switched to unset (closed) and the area is unset.
‘Blockschloss 2 is activated (if area is ready to set).

Activates if the Lock Element is in the ‘locked’ position.

Activates if the Lock Element is in the ‘unlocked’ position.

Activates if there is a code tamper in the area. Clears when state is reset.
Activates if any zone is in trouble state.

Activates if there is a fault on the Ethernet link.

Activates if there is an EDP communications fault.

Used to switch on the power for the glassbreak interface module and to remove power in order to
reset the device. The output is reset if a user enters their code, the zone is not in the closed state,
and the bells deactivated.

© Vanderbilt 2018

156 ABV10276959-d
11.2018




SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the keypad

Output Type Description

Confirmed Activates in the following scenarios for PD6662 compliance:
holdup « two hold-up zone activations more than two minutes apart
« ahold-up zone and a panic zone activation more than two minutes apart

« if a hold-up zone and a tamper zone or a panic zone and a tamper zone activation occurs within
the two minute period

Full Engineer  Activates if an engineer is on site and the system is in full engineer mode.

* This output type can only indicate system wide events (no area specific events).
TA WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114) only.
See also

Configuring system latch and auto set outputs on page 236

16.13 Communication

1. Scroll to COMMUNICATION and press SELECT.

2. Scroll to the desired programming option.

16.13.1 Serial Ports

The serial ports allow older style PCs to be connected to the system or other peripheral equipment like
printers.

1. Scroll to SERIAL PORTS.
Press SELECT.

2
3. Scroll to the serial port to be programmed.
4

Select the desired programming option shown in the table below.

TYPE Determines if type is TERMINAL (system information) or PRINTER (SPC event
log).

BAUD Determines the speed of the communication between the panel and the

RATE peripheral equipment. Note that the baud rate must be set the same as both items

of equipment.

DATA Determines the length of data packet to be transferred between the panel and the
BITS peripheral equipment. Note that the data bits must be set the same for both items
of equipment.

STOP Determines the number of stop bits at the end of the data packet. Note that the
BITS stop bits must be set the same for both items of equipment.

PARITY Determines the parity (odd/even) of the data packet. Note that the parity must be
set the same for both items of equipment.

FLOW Determines if the data is under hardware (RTS, CTS) or software control (None).
CONTROL Note that the flow control must be set the same for both items of equipment.

5. Press BACK to exit.
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16.13.2 Ethernet Ports

To program the Ethernet port:

1.

Scroll to ETHERNET PORT.

2. Press SELECT.

The IP ADDRESS option displays, XXX.XXX.XXX.XXX For single digits, leading zero(s) are
required, for example, 001.

3. Press SELECT and enter the preferred IP address.

When the ENTER key is operated, the system beeps twice and states UPDATED if the IP
address is valid. If the IP address is allocated manually, then this must be unique on the LAN or
VLAN, connected to panel. A value is not entered if the DCHP option is used.

4. Scroll to IP NETMASK.

Press SELECT and enter the IP NETMASK format XXX. XXX. XXX.XXX. (For single digits,
leading zero(s) are required, for example, 001.) When the ENTER key is operated, the system
beeps twice and states UPDATED if the IP NETMASK is valid.

6. Scroll to GATEWAY. Note the gateway needs to be programmed for access outside the network
(for use with the Portal).

7. Press SELECT and enter the GATEWAY format XXX. XXX. XXX.XXX. (For single digits, leading
zero(s) are required, for example, 001.) When the ENTER key is operated, the system beeps
twice and states UPDATED if the GATEWAY is valid.

8. Scroll to DHCP. The DHCP is enabled if the LAN has a DHCP server to allocate the IP address.
The IP address is to be enabled manually. Note the gateway needs to be programmed if the
panel needs access outside the network (for Portal service).

9. Press SELECT and enter the GATEWAY format XXX. XXX.XXX.XXX. (For single digits, leading
zero(s) are required, for example, 001.)

When the ENTER key is operated, the system beeps twice and states UPDATED if the
GATEWAY is valid.
The DHCP option is displayed.
10. Toggle between DHCP ENABLED and DISABLED for preferred option.
11. Press SELECT.
16.13.3 Modems

The SPC system supports SPC intelli-modems for communications with analogue lines and mobile
network interfacing for enhanced communications and connectivity. The SPC system must be
configured accordingly.

16.13.3.1 Monitoring the transmission network interface

The SPC Alarm System sends a poll to SPC Com XT, which responds with a poll acknowledge (ACK).
On receipt of a valid poll ACK the SPC Alarm System updates its status to OK and resets its polling
interval timer (depending on the ATP category).

If the SPC Alarm System does not receive a polling ACK within the timeout (depends on ATP
category), the SPC Alarm System updates its status to DOWN.

SPC supports the following transmission interfaces:
« Ethernet
« GSM with GPRS enabled
o PSTN modem.
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NOTICE: Before changing PIN or new SIM card, ensure all power sources are disconnected (AC
mains and battery) or card will not be activated.

NOTICE: After a factory default, during the process of initial setup of the system with the keypad, the
L panel detects if it has a primary or backup modem fitted, and if so, it displays its type and
1 automatically enables it (or them) with the default configuration. No other modem configuration is
allowed at this stage.

16.13.3.2 Configuring Modems
To configure a GSM or PSTN modem:
1. Scroll to MODEMS and press SELECT.
2. Toggle between PRIMARY and BACKUP for correct modem slot and press SELECT.
The ENABLE MODEM option is displayed.
ENABLE or DISABLE the modem as required.

4. Scrollto MODEM STATUS, TYPE, FIRMWARE VERSION and SIGNAL LEVEL and press
SELECT to view details of the modem.

5. Configure the following modem settings from the menu as follows and press ENTER after each
selection:

Menu Option  Description

COUNTRY Select a country from the list.

CODE

GSM PIN (GSM modem only) Enter a GSM PIN for the SIM card.

ANSWER Select to select the mode in which the modem answers incoming calls: NEVER ANSWERS or
MODE ALWAYS ANSWERS.

ANSWER Select ENABLE to only answer when engineer access is granted.

ENG. ACC.

SETUP SMS Select ENABLE SMS to enable SMS for this modem.
PSTN modem only

Select SMS SERVER to enter an appropriate phone number of the SMS service provider that is
accessible in your location, if required. This number automatically displays the default number for
SMS for the country selected.

To manually test SMS, select TEST SMS and enter the SMS NUMBER.
To automatically test SMS at specific time intervals, select
AUTOMATIC TEST, select a TEST INTERVAL and enter the SMS NUMBER.

PREFIX PSTN modem only

DIALLING Enter a prefix number to include before the SMS number, if required.
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Menu Option  Description

LINE PSTN modem only

MONITORING Enable this feature to monitor the voltage of the line connected to the modem.

GSM Modem only

Enable this feature to monitor the signal level from the GSM mast connected to the modem.
Select a monitoring MODE (ALWAYS ON, FULLSET, DISABLED). The FULLSET option only
enables this feature while the system is Fullset.

Enter the number of seconds for the monitoring TIMER (0-9999 sec).

Note: EN 50131-9 Confirmation configuration
In order for EN50131-9 Confirmation to operate correctly, line monitoring must be enabled. (See
System Options on page 252.)

USSD GSM Modem only

Enter the Unstructured Supplementary Service Data (USSD) code for your service provider in
order to enable SMS-free credit checking for Pay As You Go SIMs. Note: This feature is not
universally available. Please check with your service provider.

CHECK SIM Enable this feature to receive information on remaining credit balance for Pay As You Go SIMs
CREDIT (where available from your service provider).

GSM Modem only

If SMS enabled and anincorrect PIN is sent to the SIM card three times, the SIM is blocked. In
e this case, Vanderbilt recommend that the SIM is removed and unblocked using a mobile phone. If
| l the SIM is changed on the GSM module or if a SIM is used with a PIN, Vanderbilt recommend that
the PIN code is programmed before the SIM is placed in the SIM holder. This ensures that
incorrect PINs are not sent to to the SIM. All power should be removed (AC mains and battery)
when loading the SIM card into the SIM holder.

16.13.4 Central Station

This section covers how to add, edit, and delete a central station , and how to make a test call.

See:
« Add below
« Edit on the next page
« Delete on page 162
« Make Test Call on page 162
16.13.4.1 Add
To program the central station settings:
1. Scroll to CENTRAL STATION > ADD.
2. Press SELECT.

3. Select the desired programming option shown in the table below.

ACCOUNT  This information should be available from the receiving station and is used to
ID identify users each time a call is made to the ARC.
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ACCOUNT  Description of the Remote Alarm Receiving Centre.
NAME

PROTOCOL The communication protocol to be used (SIA, Contact ID, Fast Format).
1ST PHONE The first number to be dialled to contact the ARC.

NUMBER

2ND The second number to be dialled to contact the ARC; the system only
PHONE attempts to contact the ARC on this number if the first contact number did
NUMBER not successfully connect.

PRIORITY  The modem (primary or back-up) to be used to communicate with the ARC.

4. After programming is complete, the option to make a test call to the station is displayed on the
keypad.

16.13.4.2 Edit
To edit the central station settings:
1. Scroll to CENTRAL STATION > EDIT.
2. Press SELECT.

3. Select the desired programming option shown in the table below.

ACCOUNT This information should be available from the receiving station and is used to
ID identify users each time a call is made to the ARC.

ACCOUNT Description of the Remote Alarm Receiving Centre.
NAME

PROTOCOL The communication protocol to be used (SIA, Contact ID, Fast Format).

1ST PHONE The first number to be dialled to contact the ARC.
NUMBER

2ND PHONE The second number to be dialled to contact the ARC; the system only
NUMBER attempts to contact the ARC on this number if the first contact number did not
successfully connect.

DIAL Enter the number of times that the system will attempt to make a call to the
ATTEMPTS  receiver.

DIAL Enter the number of seconds to delay between failed dial attempts. (0-999)
INTERVAL

ASSIGN Assign the areas for which events are reported to the ARC.

AREA

REPORTED Define the types of events reported to the ARC.
EVENTS

PRIORITY The modem (primary or back-up) to be used to communicate with the ARC.

AUTOMATIC Defines a schedule for testing the connection to the ARC. Possible values
TEST range from every hour to once every 30 days.

4. After programming is complete, the option to make a test call to the station is displayed on the
keypad.
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16.13.4.3 Delete

Enables you to delete a configured ARC.
16.13.4.4 Make Test Call

Enables you to test the connection with the ARC.
To make a test call, do the following:

1. Select MAKE TEST CALL.

2. Select the ARC name.

3. Click SELECT.

4. Select the modem to use for the text call.

The test call is performed.

16.13.5 SPC Connect PRO

SPC Connect PRO is a desktop application designed to support the installation and maintenance of
SPC systems. Using SPC Connect PRO, you can create installations and configure them prior to
arriving at site. The tool can also be used in conjunction with the SPC cloud service SPC Connect to
remotely connect to customer sites and support them.

To enable and configure SPC Connect PRO support:
1. Scroll to SPC CONNECT PRO and press SELECT.
2. Enable the SPC CONNECT PRO option.
3. Scrollto INTERFACES and press SELECT.
4. Enable/disable the ETHERNET, USB, SERIAL (X10) and MODEM interfaces as required.
5. Toenable the TCP interface, select TCP PORT then enter the port number and press SELECT.

16.14 Test
1. Scrollto TEST and press SELECT.

2. Scroll to the desired programming option.

16.14.1 Bell Test
To perform a bell test:
1. Scroll to TEST > BELL TEST.
2. Press SELECT.

When BELL TEST is selected, the following options available: EXTERNAL BELLS, STROBE,
INTERNAL BELLS and BUZZER. When each of these options is selected, the device sounds to
verify it is operating correctly.

16.14.2 Walk Test

A walk test ensures that the sensors are operating correctly on the SPC system.

To perform a walk test:
1. Scroll to TEST > WALK TEST.
2. Press SELECT.

3. Thedisplay indicates the number of zones to be tested on the system with the text TO TEST XX
(where XX is the number of valid walk test zones). Locate the sensor on the first zone and
activate it (open the door or window).
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The keypad buzzer sounds continuously for approximately 2 seconds to indicate that the zone
activation has been detected and the number of zones left to test (displayed on the keypad)
decreases.

4. Continue with the remaining zones on the system until all zones have been tested. If a zone
activation does not get acknowledged by the system, check the wiring of the sensor and/or replace
with another sensor if necessary.

| o
1 NOTICE: All zones can be included in an Engineer walk test.

16.14.3 Zone Monitor

The Zone Monitor option displays status information on each of the zones on the system.

To view zone status information:
1. Scroll to TEST > ZONE MONITOR.
2. Press SELECT.
3. Scroll to a preferred zone and press SELECT.
The status of the zone and its associated resistance value is displayed.
4. Press NEXT to locate the zone (for example, CONTROLLER 1 = first zone on Controller).

See the table below for correlating status information (valid for Dual EOL resistors).

Zone status Abbreviation
UNKNOWN UK
CLOSED CL
OPEN OP
SHORT SH
DISCONNECTED DI
PULSE PU
GROSS GR
MASKED AM
FAULT FA
DC SUB DC
OUT OF BOUNDS OB
UNSTABLE us

All zones on a system can be monitored for correct operation by performing a monitoring test.
To perform a zone monitoring test:

1. Scroll to ZONE MONITOR.

2. Press SELECT.

3. Scroll to a preferred zone and press SELECT, or enter the zone number directly.

© Vanderbilt 2018 163 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the keypad

If the zone is located close to the keypad, the status of the keypad can be viewed as it changes.
The Zone status and resistance value displays on the top right.

4. Change the state of the sensor; for example, for a door contact sensor, open the door.

The keypad buzzer beeps and the status of the sensor changes from CL (Closed) to OP (Open).
The corresponding resistance value changes to a value that depends on the EOL resistance
scheme.

. It is advisable to check the operation of all zones on the system after installation is complete. To
l locate the zone select NEXT (bottom right) on the keypad. A zone status value of SH or DI
indicates that the zone is shorted or disconnected.

16.14.4 Output Test
To perform an output test:
1. Scroll to OUTPUT TEST.
2. Press SELECT.
3. Toggle between CONTROLLER and EXPANDER for preferred option.
4

If testing the controller outputs, scroll to the preferred output and press SELECT. If testing the
expander outputs, select the expander and then the output.

The keypad display indicates the current state of the output on the top line.
5. Toggle the output state ON/OFF.

6. Check that the device connected to the selected output changes state accordingly.

16.14.5 Soak Test

A Soak Test provides a method of putting selected zones on test. Zones on soak test do not cause any
alarms but are recorded in the event log. Zones on soak test will remain on soak test until the soak test
timer expires as in the timers default (14 days).

To perform a soak test:
1. Scroll to SOAK TEST and press SELECT.
2. Toggle between ENABLE SOAK and CANCEL SOAK for preferred option.
3. Scroll to preferred zone and press SELECT.

A message confirming that the zone is in soak is displayed.

.
l NOTICE: All zone types can be included in a Soak test.

16.14.6 Audible Options

The audible options are applied as indicators within a walk test.

To set the audible options:
1. Scroll to AUDIBLE OPTIONS.
2. Press SELECT.
3. Scroll to one of the following options: ALL, INT BELL, EXT BELL, KEYPAD.
4. Press SAVE.
5. Press BACK to exit.
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16.14.7 Visual Indicators

This test is used to test all the pixels on the LCD Keypad and all the pixels and LED indicators on the
Comfort Keypad, Indicator module and Keyswitch.

To test a keypad:

1.

Scroll to VISUAL IND.

2. Press SELECT.
3. Press ENABLE.

On the LCD keypad, two rows of continuously changing characters are displayed.

On the Comfort keypad, all the LED indicators are lit and all screen pixels are displayed.

1.
2.

Press BACK to disable the test.
Press BACK to exit.

16.14.8 Seismic Test

To perform a seismic test:

1.

2
3.
4

Scroll to TEST > SEISMIC TEST.
Press SELECT.
Select TEST ALL AREAS, or select an individual area to test.

If you select an individual area to test, you can select either TEST ALL ZONES or select a specific
seismic zone to test.

The message ‘SEISMIC TEST is display on the keypad while the test is being performed.

the failed zones is displayed which can be scrolled through.
If the test succeeds, ‘SEISMIC OK'’ is displayed.

See also

Seismic Sensor Testing on page 354.

16.15 Utilities

1.
2.

Scroll to UTILITIES and press SELECT.

Scroll to the desired programming option:

SYSTEM To view the current software version.

SOFTWARE

DEFAULTS To reset users or return the system to factory setting.

BACKUP To back-up a configuration.

CONFIG

RESTORE To restore a configuration.

CONFIG

SYSTEM Torestart the system.

RESTART

LICENSE Enter a license number to change the SPC license key. The system does
not log or report a license change.
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16.16 Isolate

Zones, system alerts or alerts from X-BUS devices can be manually isolated from the keypad. Isolating
a zone removes that zone from the system until the user de-isolates it.

Toisolate zones, system alerts or alerts from X-BUS devices:
1. Scroll to ISOLATE and press SELECT.
2. Scroll to the desired option in the table below and press SELECT.

ZONE Select the required zone and toggle the setting from NOT ISOLATED to
ISOLATED.

SYSTEM Isolate the desired system alert.

XBUS Isolate the desired alert from EXPANDERS or KEYPADS:

« XBUS COMMS LOST
o XBUS FUSE FAULT (Expanders only)
« X-BUS TAMPER

VIEW Toview allist of the isolated zones, system alerts and X-BUS devices
ISOLATIONS alerts.

16.17 Event Log

Recent events on the system are displayed in the EVENT LOG option. Events flash in one second
intervals.

1. Scroll to EVENT LOG and press SELECT.

2. Toview an event from a particular date, enter the date with the numeric keys.

The most recent events are displayed on the bottom line of the display. All previous events are
displayed for one second in tumn.

16.18 Access Log

Zone access on the system is displayed in the ACCESS LOG option.
1. Scroll to ACCESS LOG and press SELECT.

2. Select a door on the system for which you want to display access events.

The most recent access events are displayed with a date and time.

3. Scroll down through the access events or enter a date and press ENTER to find a particular
access event.

16.19 Alarm Log
The ALARM LOG displays a list of alarm events.

« Select Log > System Log > Alarm Log.
The following types are displayed in this log:
« Zones
—Alarm

—Panic
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o System Events
— Confirmed Alarm
—UserDuress
— XBus Panic
— User Panic
— RPA Panic

16.20 Change Engineer Pin

To change the Engineer PIN:
1. Scroll to CHANGE ENG PIN and press SELECT.
A randomly generated PIN appears.
2. Enteranew PIN if required by overwriting the displayed PIN and press ENTER.

The minimum number of digits required for this code depends on the security setting of the system
or on the selected length of the PIN Digits in the browser (Panel Settings > System Settings >
Options) The system will not accept a PIN with fewer numbers than it is set to receive.

3. Confirm the new PIN, press SAVE.
4. Press BACK to return to the previous screen to amend the PIN.

If the display times out during the process, the old PIN remains valid.

16.21 SMS

The SPC system support the communication of SMS alerts from the panel to the engineer and selected
users’ mobile phones (SMS events) in addition to allowing users to control the SPC system remotely via
SMS (SMS control). These two features work hand in hand as it allows the user to respond to a SMS
notification without the need to be physically at the premises.

A maximum of 32 (SPC4xxx), 50 (SPC5xxx) or 100 (SPC6xxx) SMS IDs can be configured for each
panel. An SMS-enabled modem and an appropriate system and user configuration are required to enable
SMS communications.

Depending on the SMS AUTHENTICATION mode selected (see Options on page 113), SMS user
authentication can be configured to use various combinations of the user's PIN and Caller ID or SMS PIN
and Caller PIN.

L)

The SMS notification can operate with a PSTN modem if the PSTN operator supports SMS over
PSTN whereas SMS control will need a GSM modem at the panel. A GSM modem will support both
SMS notification and control.

SMS control

The SMS control can be set up so that a remote user can send an SMS message to perform the following
actions at the panel:

» Setting/unsetting
« Enable/disable engineer
« Enable/disable manufacturer access

» Mapping gate on/off
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SMS events
The SMS notification can be set up to send a range of events that occur on the system such as:
« Alarm activation
« Confirmed alarms
« Fault and tamper
« Setting and unsetting
« Inhibit and isolate

« All other types of events

16.21.1 Add

To add a user

Prerequisites

o A modem is installed and identified by the system.

o The function SMS Authentication is activated in OPTIONS (see Options on page 113).
1. Scroll to SMS > ADD and press SELECT.
2. Select a userto add for SMS operation.
3. Enteran SMS NUMBER for this user and press ENTER.
4. Enter an SMS PIN for this user and press ENTER.

Keypad indicates that SMS details are updated.

16.21.2 Edit

Prerequisites

o A modem is installed and identified by the system.
o The function SMS Authentication is activated in OPTIONS (see Options on page 113).
1. Scroll to SMS > EDIT and press SELECT.

2. Select an engineer or user SMS ID to edit.

SMS NUMBER Enter the number to which the SMS will be sent (requires three-digit country code
prefix).
Note: Engineer SMS number can deleted by resetting it 0. User SMS numbers cannot
be deleted.

EDIT USER Select a new user for this SMS ID if required.

EVENT FITLTER Select the panel events which the user or engineer will receive via SMS. Select

ENABLED or DISABLED. Events that are enabled are indicated with an asterisk *
before the event in the list.

CONTROL RIGHTS Select the operations that the user or engineer can perform remotely on the panel
through SMS. See SMS Commands on page 204

NOTICE: HOLDUP alarm events are not transmitted via SMS.
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. If the phone line is connected to the PSTN network via a PBX, the appropriate line access digit should
1 be inserted before the called party number. Ensure that Calling Line Identity (CLI) is enabled on the
line selected to make the call to the SMS network. Consult the PBX administrator for details.

16.21.3 Delete
1. Scroll to SMS > DELETE.
2. Scroll to the required SMS ID.
3. Press SELECT.
The keypad indicates that the SMS information is updated.

16.22 X-10

As of version 3.4, X-10is in maintenance. The functionality remains in the product for backward
compatibility.

L)

X10is a technology that allows peripheral devices, such as lights or appliances, to be controlled by the
system and system events can be used to trigger outputs on the X10 devices. The SPC controller
provides a dedicated serial port (serial port 1) for interfacing directly with standard X10 equipment.

1. Scroll to X-10 and press SELECT.

2. Scroll to the desired programming option:

ENABLE X-10 To enable or disable the X-10 functionality on the system.
DEVICES To add, edit, delete or test X-10 devices.
LOGGING To enable or disable the X-10 logging.

16.23 Set Date/Time

The date and time can be manually entered on the system. The time and date information is displayed on
the keypad and browser and is used on time-related programming features.

1. Scroll to SET DATE/TIME and press SELECT.

The date displays on the top line of the display.

2. Toenteranew date, press the required numeric keys. To move the cursor to the left and right, press
the left and right arrow keys.

3. Press ENTER to save the new date.

If an attempt is made to save an invalid date value, the text INVALID VALUE is displayed for 1
second and the user is prompted to enter a valid date.

4. Toenteranew time, press the required numeric keys. To move the cursor to the left and right, press
the left and right arrow keys.

5. Press ENTER to save the new time.

If an attempt is made to save an invalid time value, the text INVALID VALUE is displayed for 1
second and the user is prompted to enter a valid time.
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16.24 Installer Text

This setting allows the engineer to enter system information and engineer contact information.
1. Scroll to INSTALLER TEXT and press SELECT.

2. Scroll to the desired programming option:

SYSTEM NAME Used to help identify the system; use a clear and descriptive name for
the installation.

SYSTEMID Used to help identify the installation when connected to a central station
(max. 10 digits).

INSTALLER Used for contact purposes.

NAME

INSTALLER Used for contact purposes.

PHONE

DISP. Setting to display installer details can during the idle state.
INSTALLER

® The installer contact details programmed in these menu options should also be entered on the
l keypad pull-down label on completion of the installation.

16.25 Door Control

This option allows you to control all the doors of the system.
1. Scroll to DOOR CONTROL and press SELECT.
2. Select the door which should be controlled and press SELECT.

3. Select one of the door states listed below as new door state and press SELECT.

NORMAL The door is in normal operation mode. A card with the corresponding
access rights is needed to open the door.

MOMENTARY The door is opened only for a timed interval to allow access.

LOCKED The door is locked. The door remains closed even if a card with the
corresponding access rights is presented.

UNLOCKED The door is unlocked.
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16.26 SPC Connect

Add an SPC Connect ATS to set up a connection between a panel and the SPC Connect website
https://www.spcconnect.com. This enables a panel user to register and access their panel remotely using
the SPC Connect website. If SPC Connect is not enabled during the start up wizard sequence, you can
use this menu to add an SPC Connect ATS. If SPC Connect was enabled during start up, this menu
shows the Registration ID for a panel.

ADD If SPC CONNECT was disabled during the start up wizard, the ADD menu displays. Select
ADD to create an SPC Connect ATS. This allows a panel user to register their panel and
access their panel remotely using the SPC Connect website, https://www.spcconnect.com

REGISTRATION If SPC CONNECT was enabled during the start up wizard, the panel registration ID displays.
ID Provide this information to an end user to allow them to register their panel with the SPC
Connect website, https://www.spcconnect.com, for remote access to their panel.

COMPANY ID For future use.

DELETE Toremove an SPC Connect ATS from a panel, select DELETE.
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Engineer programming options on the SPC panel can be accessed via any standard web browser ona PC
and is PIN protected.

You can access Engineer Programming via the browser by entering the default Engineer PIN (1111). For
more details, see Engineer PINs on page 106.

This web server provides access to the complete set of programming features used to install and configure
the SPC system.

This programming option should only be provided to authorized installers of the SPC system.

[e]

Engineer Programming features on the SPC are divided into the following categories:
Soft Engineer Features

These features can be programmed without requiring the alarm system to be deactivated; they are
accessible directly upon entering Engineer mode.

Full Engineer Features

These features require the alarm system to be deactivated before programming can commence; these
features are accessible under the Full Engineer menu.

NOTICE: If ‘Engineer Exit’ option is enabled in System Options, the engineer is allowed leave Full
Engineer mode with alerts active but must acknowledge all alerts listed on the keypad orin the
browser before switching from Full Engineer mode to Soft Engineer mode.

The web server on SPC controller can be accessed using either the Ethernet or USB interface.

& If programming with a browser interface, click Save when making changes.
l Click Refresh to view the current programming values on a web page.

17.1 System Information

Click the ? icon to view the Help menu which provides up-to-date information about the panel and the
functionality that is currently licensed on the system.

17.2 Ethernet interface
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If the SPC Ethernet interface is connected to an existing Local Area Network (LAN), consult the
network administrator for that LAN before connecting to the panel. Default IP Address:
192.168.1.100.

[t

Connect the cable

« Connect an Ethernet cable from the Ethernet interface on the PC to the Ethemnet port on the
controller board

—OR-

If connecting directly from a PC then a cross over-cable must be used. See Network cable
connections on page 361.

The LEDs to the right of the Ethernet interface indicate a successful data connection (right LED on)
and Ethernet data traffic (left LED flashing).

Determine the IP address of the SPC controller
1. Entering the Engineer mode (see Engineer PINs on page 106).
2. Using the up/down arrow keys, scroll down COMMUNICATION option and press SELECT.
3. Scroll to ETHERNET PORT and press SELECT.
4. Scroll to IP ADDRESS and press SELECT.
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17.3 Connecting to the panel via USB

[i]

If the panel is reset while the USB cable is connected, the cable must be unplugged and plugged in
again.

The USB port on the controller connects to a PC via a standard USB type A or type B cable. Drivers
must be installed to make a USB connection from the controller to the PC.

Prerequisites

o

1.

You must have a USB cable connecting your PC to the panel.

Connect the USB cable from the controller to a USB interface on the PC.
The Found New Hardware wizard is displayed.

Click Next.

Windows XP detects a Generic USB hub.

Click Finish.

Windows XP detects the SPC — Advanced Security System on COM port N, where N is the
number of the COM port assigned to the device.

Make a note of the COM port assigned to the device, it is required later in the process.

The Found New Hardware wizard is displayed again.

5. Select Install the software automatically.

If the Windows XP driver installation wizard asks you to select the best match from a list,
choose the following option:

Vanderbilt Intrunet SPC USB Local Connection
Click Next.

A dialog box regarding Windows certification appears. Vanderbilt deems this acceptable to
continue. For further queries, contact your network administrator or a Vanderbilt technician.

Click Continue Anyway.
The installation finishes.
Click Finish.

The driver is installed.

Configuring the connection on Windows XP

To set up the new connection on the PC:

1.

N o o kM 0w N

Click the Start command.

Select Connect To > Show All Connections > Create A New Connection.

In the New Connection Wizard, select Setup an advanced connection.

Select the Advanced Connection Option, Connect directly to another computer.
Select Guest as the role for this PC.

Enter a name for the connection.

Select an available serial port for use with the connection. This port should be the COM port that
the USB device is using.

Select if this connection is available to all users or just yourself.
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10.

11.

12.

13.

14.

On the last dialog of the wizard, click Finish.

The PC prompts for username and password for the USB connection. Enter the following details:
- Username: SPC

- Password: password (default)

Click Connect.

The PC initiates a data link with the controller. When the link has been established, a connection
icon appears on the task bar at the bottom of the PC screen.

Right-click the link and select Status.
A server |IP address is displayed in the details window.

Enter this address into the address bar of an internet browser using the hyper text transfer protocol
secure (for example, https://192.168.5.1).

Login into the SPC browser application using your user PIN.

=

Your default PIN should be changed immediately and noted. Forgotten PINs are remedied only by a
factory default of the system, resulting in a reset of the system configuration. The configuration can
be restored if a backup is available.

Windows 7

Prerequisites

1.
2.

© © N o o»

10.
11.
12.
13.
14.

15.
16.

You must have Local Administrator rights to perform the actions in this task.
Open the Windows 7 Control Panel.

Select Phone and Modem.

The Phone and Modem page is displayed.

Select the Modems tab and click Add.

The Add Hardware Wizard — Install New Modem page is displayed.
Click Next twice.

The Add New Hardware wizard displays a list of modems.

Select Communications cable between two computers.

Click Next.

Click Next, then Finish.

Return to the Modems tab of the Phone and Modem page.

Select the new modem and click Properties.

The Communications cable between two computers Properties page is displayed.
In the General tab, click Change Settings to allow editing of the properties.
Select the Modem tab.

Change the value in the Maximum Port Speed to 115200 and click OK.
From the Control Panel, open the Network and Sharing Center.

Click Change Adapter Settings. If a new modem is present in the list of available connections,
proceed to step 22. If the modem is not present, perform the following steps.

In the Network and Sharing Center, click Set up a new connection or network.

Select Set up a dial-up connection and click Next.
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17. Enter any values in the phone number, User name and Password fields and enter a name in
the Connection Name field.

18. Click Connect.
Windows 7 creates the connection.
19. Skip the Testing Internet Connection process.
20. Click Close.
21. Inthe Network and Sharing Center, click Change adapter settings.
22. Double-click the new modem.

The Connect Connection Name page opens, where Connection Name is the name you defined
for the modem.

23. Click Properties.

24. Ensure the Connect using: field contains the correct information, Communications cable
between two computers (COM3), for example.

25. Open your browser and enter the IP address of the Controller using https as the connection
protocol.

26. Click Continue Anyway if the browser displays a certificate error page.

27. Log on to the panel.

17.4 Logging into the browser

To log into the browser:

1. When an Ethernet or USB link is established and the IP address of the controller determined,
open the PC browser.

2. Enterthe IP address in the address bar of the browser using the hyper text transfer protocol
secure. (For example, https://192.168.1.100.) See the table in Default settings for WEB server
address on the next page.

A page with a security message is displayed.
3. Click Continue to this website.

The login page is displayed.

\/ANDERBILT

o SPC6300

User ID:

Password

User logged off

User language v
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4. Enterthe following:
- User ID: user or engineer name
- Password: User or Engineer PIN.

5. Select alanguage in which to display the browser pages. The default language setting ‘Auto’ will
automatically load the language assigned to this user ID.

6. Click Login.
Default settings for WEB server address

Connection IP address Web server
Ethernet 192.168.1.100 (default)
RS232 192.168.2.1 (fixed)
Backup Modem/RS232 192.168.3.1 (fixed)
Primary Modem 192.168.4.1 (fixed)

uUSB 192.168.5.1 (fixed)

17.5 SPC Home

The SPC Home page has a System Summary tab, Alarms tab and Video tab.
17.5.1 System Summary

The System Summary tab is divided into the following three sections:

« System: shows the status of all areas, active system alerts and warnings and information for the
system.

« Areas: shows the status of each area defined on the system with up to 20 alarm events. You can
set or unset an area and the area status displays here.

« Inhibits and Isolates: Lists all the isolated zones and allows you to deisolate or bypass before

System Summary Alarms Video
System
All Areas Partial Set
Active System Alerts
None
Areas
[ Area 1: Marketing Fullset
Preventing Setting
Area-Vault 7 Information
Area 2: Cafeteria Unset Fullset
Area 3: Finance Unset Fullset
Area 7: Vault Unset Fullset
Inhibits and Isolates
Zone: Front door - Isolated Isolated
Zone: Vaut - Isolated Isolated
Zone: Window 2 - Isolated Isolated Deisolate

NOTICE: If there are alarms on the system, the information message See alarm tab displays.
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17.5.2 Alarms Overview

The Alarms tab shows the following system information:

« Alarm Set State - shows whether the system was partial or fullset at the time the alarm was
triggered.

« Alarm Status - shows the type of alarm (alarm, confirmed alarm, etc.).
« Bells active - shows if the alarm activated the bells. Click the Silence Bells button to cancel.

For each area, the Alarm Set State, Alarm Status, Alarm Activations and Alarm log displays. The
Alarm Activations show a list of zones in alarm state ordered by activation. Click the Restore button
to clear. The Alarm log shows up to 20 events.

System Summary Alarms Video

System
Alarm Set State Fuliset Unset
Alarm Status Alarm
Bells active Bells active Silence Bells

Area 1: Marketing

Alarm Set State Fullset

Alarm Status Alarm

Area 1 Alarm Activations

Activation Time Zone Zone Type Input Status Action
Today 12:52:37 35: Zone 35 Alarm Open Alarm Restore

Area 1 Alarm log

17.5.3 Viewing Video

The Video tab displays images from up to 4 IP cameras.

« InFull Engineer, Soft Engineer and User mode, select SPC Home > Video.

All the configured and operational cameras (up to the maximum of four) are displayed in the
Video Cameras page. Only two cameras are available in the following example.

System Summary Alarms Video

Video cameras

Camera 1 Camera 2
OK oK

B‘?‘*‘:‘: - .

Camera 3 Camera 4
Offline Offline

]

The images are automatically refreshed as per the interval settings for the camera. (See Configuring
Video on page 291.)

Click the Pause Refresh button to retain the current image on the screen and pause refreshing. Click
the Resume Refresh button to enable the panel to resume refreshing the images.

Note: Ensure that a resolution of 320 x 240 is selected for the cameras that will be displayed in the
browser otherwise images may not be displayed correctly. The higher resolution of 640 x 480 can be
used for operation with SPC Com.
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Video Fault Reporting

A video fault report is displayed above the camera image. The following table lists the possible messages:

Message Description

OK The camera is behaving normally

Timeout Camera connection timed out.

Socket Invalid Internal socket handling error

Image too small Received image too small

Buffer too small Received image is too large. Lower the resolution in the Camera configuration.
Format incorrect Invalid format received.

Abort TCP connection disconnected

Internal Alarm panel has insufficient memory to complete the request.

Bad request A badly formed request was sent to the camera. Check your camera configuration settings.
Client error The camera returned a client error. Check your camera configuration.
Authorization error  User name and/or password are incorrect

Unknown An unknown error was returned. The camera may be an unsupported model.

17.6 Panel status

This section covers:

17.6.1 Status ... 179
17.6.2 X-Bus Status ... ... . L 180
17.6.3 Wireless ... e 187
17.6.4 ZONES ... 189
17.6.5 D00 ... 191
17.6.6 FlexC Status ... .. ... 192
17.6.7 System alerts ... .. L 194

17.6.1 Status

This page displays the status and summary of the main SPC components, including system, power, X-
BUS and communications.

1. Select Status > Hardware > Controller Status.

See following sections for further information.
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Hardware Inputs Qutputs Doors FlexC System Alerts
Controller Status X-Bus Slatus Wireless Siatus
System Ethernet
System Time: Mon, 07 Jul 2014 10:24:53 MAC Address: 00:0F:B6:03:1AF1
Cabinet Tamper: Isolate IP Address: 10.100.82.181
Aux. Tamper 1: oK Metmask: 255.255.0.0
Auw. Tamper 2 0K Gateway 0.0.0.0
Eell Tamper. Isolate Receive: 21 M Packets, 3199 M Bytes
Wireless Module Siway - Va Transmit: 4 M Packets, 366 M Bytes
Antenna Tamper: OK
Power Modem 1
ma!“'t 8; i Modem Status Line Fault
ains time sync.: Z
Battery 4 |50|(ﬂ|9 ) Type fitted: IntelliModem PSTN
Battery Voltage: NIA Line S.talus ] Fault
Battery Current. NIA Incoming Calls: 0 (0 Seconds)
Aux. Voltage 136V ‘0“‘9“!”9 g;'g 3‘0 Seconds)
Au. Current: 200mA NEOMING Je:
Rk P oK QOutgoing SMS: 0
Ext Bell Fuse oK Failed Dial Attempts: 0
Int. Bell Fuse: oK
X-BUS Modem 2
Cable status: 0K Modem Status Fault: E51 [Iselate]
Devices: Online: 1 . )
Devices: Comms: OK Ppesﬂﬁd' I\me‘lll:ﬂodem e
Devices- Lid t Isolat ine Status solate
nev!ces. " 5 ?mper _ 5? e Incoming Calls: 0 (0 Seconds)

Performable actions

The following actions are only possible if a connection has been established.

Restore All Alerts Restores all active alerts on the panel. These alerts messages are displayed in
red text opposite the relevant item.

Refresh Updates any changes in panel status. You must refresh the status page to
display the actual panel status at any particular moment.

Full Engineer/Soft Engineer To toggle between Soft- and Full Engineer modes. Full Engineer mode disables
alarms and prevents reporting of events to a central station.

17.6.2 X-Bus Status

1. Select Status > Hardware > X-Bus Status.

The following page with the status of the different X-Bus devices is displayed. All detected
expanders are listed as default.

Hardware Inputs Outpuls Doors FlexC System Aleris

Controller Status Wireless Status

Expanders
ID  Description Type SIN Version Comms. Status Psu

1 IND1 Indicator [1 Input] 223387801 1.03 [13MAR13] Online oK Not Fitted
2 Ksw2 Keyswitch [1 Output] 226593801 1.01 [11NOV10] Online Isolate Not Fitted
3 103 1/O [8 Output] 443907 1.11 [07AUG13] Online oK Not Fitted
4 1084 /O Analyzed [8 Input / 2 Output] 165074801 2.00 [09Apri4] Online Isolate Not Fitted
5 WRS Wireless 489907 1.11 [07AUG13] ©Online Isolate Not Fitted
6 AEX6 Audio [4 Input / 1 Output] 37070907 1.03 [13MAR13] Online oK Not Fitted
T AEXT Audio [4 Input] 1434900 1.03 [13MAR13] Online, oK Not Fitted
8 108 \/O [8 Input / 2 Output] 11327907 1.11 [07AUG13] Online Isolate Type 1-V4

2. Select one of the following tabs.
- Expanders (for programming expanders, see Expanders on page 238).
- Keypads (for programming keypads, see Keypads on page 244).
- Door controllers (for programming door controllers, see Door Controllers on page 249).

3. Click any of the keypad/expander/door controller identifying parameters (ID, description, type,
serial number) to displayed further status details.

17.6.2.1 Expander Status
1. Select Status > Hardware > X-Bus Status.

2. Select the Expanders tab.

© Vanderbilt 2018 180 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual

Engineer programming via the browser

A list of detected expanders and any associated PSUs is displayed.

Hardware Inputs Outputs Doors FlexC System Alerts
Controller Status Wireless Status
Expanders
ID Description Type SIN Version Comms. Status PSU
1 IND1 Indicator [1 Input] 223387801 1.03 [13MAR13] Online OK Not Fitted
2 Ksw2 Keyswitch [1 Output] 226593801 1.01 [11INOV10] Online Isolate Not Fitted
3 103 /O [8 Output] 443907 1.11[07AUG13] Online 0K Not Fitted
4 I0A4 /O Analyzed [8 Input / 2 Qutput] 165074801 2.00 [09Apri4] Online Isolate Not Fitted
5 WRS5 Wireless 439907 1.11[07TAUG13] Online Isolate Not Fitted
6 AEX6 Audio [4 Input / 1 Output] 37070907 1.03 [13MAR13] Online OK Not Fitted
7 AEXT Audio [4 Input] 1434900 1.03 [13MAR13] Online 0K Not Fitted
8 108 1O [8 Input / 2 Output] 11327907 1.11 [07TAUG13] Online Isolate Type 1-V4
Expander ID  This ID number is a unique identifier for the expander.
Description  Text description of the expander. This text will also appear on the browser and keypad.
Type The type of expander detected (I/0, PSU, keypad, etc.).
S/N The serial number of the expander.
Version The firmware version of the expander.
Comms The status of the expander (online or offline).
Status The status of the expander (OK, Fault, OP Tamper).
PSU The type of PSU that is fitted to the expander, if applicable. Click the PSU to view the PSU status.

Performable actions

Refresh Click the button to update the status of the X-BUS.

To view more status information:

« Click any of the expander’s identifying parameters (1D, description, type, serial number) to display
further status details.

Hardware Inputs Outputs Doors FlexC System Alerts

Controller Status Wireless Status

Expanders

Expander Status
Expander ID 2108
Type 17O [8 Input / 2 Output]
SIN 11327907
Firmware Version 1.11 [07AUG13)]
Voltage 135V
Current 0 mA
Input Status Action
Communication oK OK Inhibit | Isclate
Cabinet Tamper Fault Isolate
Fuse Fault oK OK Inhibit | Isclate
Mains Fault oK OK Inhibit | Isclate
Battery Fault Fault Isolate
PSU Fault Fault Isolate
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Name Description

Communication The physical status (OK, Fault) and the programmed status (OK, Isolated, Inhibited) of the X-
BUS cable connection to the expander.

Housing The physical and programmed status of the expander housing tamper.
Tamper

Fuse Fault The physical and programmed status of the expander fuse.

Controller The physical and programmed status of the mains supply to the controller.
Mains Fault

Battery Fault The physical and programmed status of the battery.

PSU Fault The physical and programmed status of the PSU.
OP Tamper The physical and programmed status of the tamper outputs on the PSU.
Low Voltage Indication of battery low voltage status.

Performable actions

Name Description

Restore Click the button to restore all alerts on the panel.
Alerts

Inhibit Click this button to inhibit a fault condition. The inhibit operation will disable that fault or zone for one

arming period only.
@ Inhibit operation is not available in Security Grade EN 50131 Grade 3.

Isolate  Click this button to isolate that zone. Isolating a zone will de-activate that zone until such time as the
zone is explicitly de-isolated again. It is recommended that you exercise caution when isolating
zones as those zones will not be active every time the system is SET.

See also

PSU status below
17.6.2.2 PSU status

The PSU Status page displays details of the current status of the PSU and its outputs in addition to the
status of any connected batteries.

The following PSU types are supported:
« SPCP332/333 Smart PSU
« SPCP355.300 Smart PSU
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SPCP332/333 Smart PSU Status

The following image shows the Smart PSU status:

Hardware Inputs Outputs Doors FlexC System Alerts
Controller Status X-Bus Status Wireless Status
Expanders Keypads Door Controllers
PSU Status
Type 1
Version 4
Mains status OK
Battery link TAh Battery
Battery status Fully charged
Battery Voltage 13.4Y
Battery Current 0mA
Type The type of power supply unit (PSU).
Version The version of the PSU.

Mains Status Displays the condition of the mains connection. Possible values are Fault or OK.

Battery Link  Displays the type of battery connected.

Battery Displays the condition of the battery connection. Possible values are Fault or OK.
Status
Battery Displays the voltage reading of the battery.
Voltage
Battery Displays the current taken from the battery.
Current
Outputs Displays the voltage on the outputs, the current drawn by the output and the condition of the fuse
on the output.
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SPCP355.300 Smart PSU Status
The following image shows the SPCP355.300 Smart PSU status.

Hardware

Inputs

Outpuis

Doors

FlexC System Aleris

Controller Status

Wireless Status

Mains Status
Temperature
Load voltage
Load Current

Charge
Status

Primary
Circuit

Charge
Circuit

Battery
Outputs

Expanders
PSU Srarus
Type Vds PSU
: Hardware Version: 1

MEnshon Firmware Version: 1.1 [04JUL1 3]

Mains status OK

Temperature 23°C

Load Voltage 14.4V

Load current 16 mA

Charge status NIA

Primary Circuit OK

Charge Circuit OK

Battery

Voltage Current
Fault or

Battery 1 Missing 0.0v omA

Battery 2 Fallt o 0.0V OmA
Name Description
Type The type of power supply unit (PSU).
Version The version of the PSU.

Displays the condition of the mains connection. Possible values are Fault or OK.
Displays the temperature of the PSU.

The voltage on the PSU

The current drawn by the PSU.

Displays the condition of the battery charge.

Displays the condition of the primary circuit which supplies power when the mains is
connected.

Displays the condition of the charge circuit which charges the batteries when the mains is
connected.

Displays the charge status, voltage and current available from the batteries.

Displays the voltage, fuse condition and tamper condition of the PSU outputs.
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17.6.2.3 Keypad Status
1. Select Status > Hardware > X-Bus Status.
2. Select the Keypads tab.
A list of detected keypads is displayed.

Hardware Inputs Outputs Doors FlexC System Alerts

Coniroller Status Wireless Status

Keypads

ID  Description Type SIN Version Comms. Status

2 oo st o2 AR e o
==
Name Description
Expander ID This ID number is a unique identifier for the keypad.
Description Text description of the keypad (max. 16 characters).
Type The type of expander detected (=keypad).
S/N The serial number of the keypad.
Version The firmware version of the keypad.
Comms The status of the keypad (online or offline).
Status The status of the keypad (OK, Fault).
Performable actions
Refresh Click the Refresh button to update the list of detected keypads and their status.

To view more status information:

« Click a keypad's identifying parameters (ID, description, type, serial number) to display further
status details.

Hardware Inputs Outputs Doors FlexC System Alerts
Controller Status Wireless Status
Keypads
Keypad Status
Keypad 2CKP2
Type Comfort Keypad
S/N 227361801
Firmware Version 1.02 [13MAR13]
Voltage 132v
Input Status Action

Communication oK oK
Cabinet Tamper oK oK
Panic OK OK
Fire OK oK
Medical OK 0K
Code Tamper oK oK

Communication The physical status (OK, Fault) and the programmed status (OK, Isolated, Inhibited) of the
keypad cable connection to the expander.
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Housing The physical and programmed status of the expander housing tamper.
Tamper

PACE Applies only to Keypads with a PACE receiver installed.

Panic Keypad panic alarm status.

Fire Keypad Fire alarm status.

Medical Keypad medical alarm status.

Code Tamper Keypad PIN tamper alarm status

Performable actions

Restore Click the button to restore all alerts on the panel.
Alerts

Inhibit Click this button to inhibit a fault condition. The inhibit operation will disable that fault or zone for one
@ arming period only.
Inhibit operation is not available in Security Grade EN 50131 Grade 3.

Isolate  Click this button to isolate that zone. Isolating a zone will de-activate that zone until such time as the
zone is explicitly de-isolated again. It is recommended that you exercise caution when isolating
zones as those zones will not be active every time the system is SET.

17.6.2.4 Door Controller Status
1. Select Status > Hardware > X-Bus Status.
2. Select the Door Controllers tab.

A list of detected door controllers is displayed.

Hardware Inputs Outputs Doors FlexC System Alerts

Controller Status Wireless Status

Door Centrollers

ID Description Type SIN Version Comms. Status PSuU
1 DC21 DC-2 [4 Input / 2 Output] 195309801 2.00 [0TAPR14] Online Isolate Not Fitted

Name Description

Expander ID This ID number is a unique identifier for the door controller.

Description Text description of the door controller (max. 16 characters).

Type The type of expander detected (=door controller).

S/N The serial number of the door controller.

Version The firmware version of the door controller.

Comms The status of the door controller (online or offline).

Status The status of the door controller (OK, Fault).

PSU Specifies if the door controller has a PSU.

Performable actions

Refresh Click the Refresh button to update the status of the system alerts.
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To view more status information:

« Click a door controller’s identifying parameters (ID, description, type, serial number) to display
further status details.

Hardware Inputs Outputs Doors FlexC System Alerts
Coniroller Status Wireless Status
Door Controllers
Expander Status
Door Controller 1DC21
Type DC-2 [4 Input / 2 Output]
SIN 195309801
Firmware Version 2.00 [0TAPR14]
Voltage 109V
Current NiA
Input Status Action

Communication oK OK Inhibit
Cabinet Tamper Fault Isolate
Fuse Fault oK oK Inhibit
Code Tamper 0K OK Inhibit

Communication The physical status (OK, Fault) and the programmed status (OK, Isolated, Inhibited) of the

Housing The physical and programmed status of the expander housing tamper.
Tamper
Fuse Fault The physical and programmed status of the door controller fuse.

Code Tamper Status of the user’'s PIN. Multiple failed attempts result in an alert.

keypad cable connection to the expander.

Performable actions

Restore Click the button to restore all alerts on the panel.
Alerts
Inhibit  Click this button to inhibit a fault condition. The inhibit operation will disable that fault or zone for one
arming period only.
@ Inhibit operation is not available in Security Grade EN 50131 Grade 3.
Isolate  Click this button to isolate that zone. Isolating a zone will de-activate that zone until such time as the
zone is explicitly de-isolated again. It is recommended that you exercise caution when isolating zones
as those zones will not be active every time the systemis SET.
17.6.3 Wireless
Wireless sensor detection (868MHz) on the SPC panel is provided by wireless modules. There are two
types of wireless modules: one-way SiWay RF Kit (SPCW110, 111, 112, 114 ) and two-way SPCW120
Wireless Transceiver. The SiWay RF Kit is fitted in the controller, on the keypad, or by installing a wireless
expander. The SPC two-way wireless module is fitted into modem slot 2 of the control panel. See the table
below for information on which devices can be enrolled with each type of transceiver.
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For CE regulatory compliance, the SPCW 120 product can only be fitted to the following products:

[

SPC5330.320-L1
SPC6330.320-L1
SPC4320.320-L1
SPC5320.320-L1
SPC5350.320-L1
SPC6350.320-L1

Devices compatible with a one-way transceiver

Wireless sensors

IRCW6-11
IPAWG6-10
WPA

ADM-112WA1
IR160W6-10

IMKW6-10
IMKW6-10B
OPZ-W1-RFM6

Wireless Fresnel PIR detector, 12m wide angle

Wireless PIR detector with black triplex mirror, 18m wide angle,

868MHz

Wireless magnet contact, 868MHz

Wireless magnet contact, 868MHz (brown)
SiWay radio module (plug-in to smoke alarm)
Remote control FOB with 4 button control
Personal transmitter

Wireless personal alarm

Devices compatible with a two-way transceiver

Wireless sensors WPIR Wireless 12m PIR detector with pet immunity option
WPIR-CRT Wireless curtain PIR detector
WMAG Wireless magnetic contact (slim)
WMAG-| Magnetic contact with additional input
WRMT Remote control FOB with 4 button control
WPAN Wireless personal alarm button
L For instructional videos on wireless devices and transceivers please go to
l http://van.fyi?Link=Wireless_devices.

17.6.3.1 View a list of wireless sensors

Toview allist of wireless sensors and information about the sensors, select Configuration >
Hardware > Wireless .

Total Wireless Active 3
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2418826 Magnetic contact
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Wireless sensor information

Wireless  The number of the sensor enrolled on the system (1 = first, 2 = second, etc.).

Sensor

ID A unique identity number for that sensor.

Type The type of wireless sensor detected (magnetic contact, inertia/shock, etc.).

Zone The zone to which the sensor has been enrolled.

Battery The status of the battery in the sensor.

Supervise The status of the supervisory operation (OK = supervisory signal received, Not Supervised = no
supervisory operation).

Signal The signal strength received from the sensor (01 = low, 09 = high).Note: Although it is not possible to
enroll a device with a signal strength less than 3, devices whose signal drops below 3 after enrolment are
not dropped.

Version The version details of the sensor.

Performable actions

Log Click to view the wireless sensor Log. See Log - Wireless sensor X below.

Enrol New Sensor Click to enrol a new sensor.

Refresh Click to refresh the list of enrolled sensors.

Edit Click to edit the sensor attributes.

Remove Click to remove the sensor from the enrolled sensors list.

17.6.3.2 Log - Wireless sensor X

To view a quick log of events for a wireless sensor:
1. Click the Log button in the table row for that sensor.
2. The Message log for the sensor displays.
3. Optionally, you can create a text file of the log by clicking Text File.

Information provided in the message log

Time The date and time of the logged event.
Receiver The wireless receiver location, that is, wireless module mounted on the keypad, controller or wireless
expander.
Signal The signal strength received from the sensor (01=low, 09=high).
Status The physical status of the sensor.
Battery  The status of the battery connected to the sensor (OK, Fault).
17.6.4 Zones
For configuration, see Editing a zone on page 270.
1. Toview all zones, select Status > Inputs > All Zones. To view X-Bus only zones, select the X-
Bus Zones tab or to view wireless zones only, select the Wireless Zones tab.
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Fi System Alerts

Hardware Inputs QOutputs Doors
All Zones X-Bus Zones Wireless Zones
Zones Active 37, Max Zones 512
Zone Area Zone Type EOL Quality Input Status Log Action
1 Front door 2 Reception Entry/Exit Good [4.7kQ] Closed Isolate
2 Fire Exit 4 Catsteria Entry/Exit Good [4.7k0] Closed Isolate
3 Window 2 5 Meeting Room Alarm Good [4.7k0] Closed Isolate
4PIR1 1 Marketing Alarm Good [4.7k0)] Closed Isolate e
5PIR2 3 Finance Alarm -[=) DISCON Isolate
5 Fire Exit 1 Marketing Fire Exit [ DISCON Isolate
7 Fire alarm 1 Marketing Fire -[=] DISCON Isolate e
& Panic Button 1 Marketing Panic [ DISCON Isolate
9Zone @ 1 Marketing Alarm Good [4.8k0)] Closed Normal
10 Entry 1 Marketing Entry/Exit Good [4.7k0] Closed Normal Inhibit | Isolate | Soak
12DO0R 2 1 Marketing Entry/Exit Good [4.7k0)] Closed Normal Inhibit | Isolate | Soak
33 Zone 33 1 Marketing Alarm Good [4.7k0)] Closed Isolate Deisolate
34 Zone 34 1 Marketing Alarm Good [4.7k0)] Closed Isolate Deisolate
35 Zone 35 1 Marketing Alarm Good [4.7k0)] Closed Post alarm m Restore
36 Zone 36 1 Marketing Alarm Good [4.7k0)] Closed Normal Log Inhibit | Isolate | Soak

See tables below for further information.

Auto
Status
Refresh

Zone
Description

Area
Zone Type

EOL
Quality

Input

Tick this button to activate an automatically refreshing of the zone summary. This can only be
done for all zones, and not for filter zones.

Text description of the zone (max. 16 characters).

Areas to which this zone is assigned.
The type of zone (Alarm, Entry/Exit, etc.).

Displays the EOL quality for the zone state resistance range. Possible values are:
« Good — Nominal value +/-25% of the defined range.
o OK—Nominal value +/- 50% of the defined range.
o Poor— Nominal value +/- 75% of the defined range.
« Unsatisfactory — any other value.

« Noisy —indicates a problem detecting the signal. The cabling may be in close proximity to a
mains cable or other source of interference.

This column is only visible in Engineer mode.

For more information on nominal resistance values and their defined ranges, see Wiring the zone
inputs on page 85.

The detected input state of that zone (Unknown, Open, Closed, Disconnect, Short, Pulse, Gross,
Masked, Fault, Out of bounds, Unstable, DC Sub, Noisy).

DC Sub s an input tamper alert. DC substitution performs a periodic check to ensure that no
external voltages are being applied to that circuit.

Unstable: An unstable state occurs when the zone input resistance value is not stable over a
defined sampling period.

Noisy: A Noisy state occurs when an external interference is induced onto the input circuit over a
defined sampling period.

Out Of Bounds: An Out of Bounds state will occur when the resistance value on the zone input
does not come within accepted tolerances of the present EOL values.
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Status The programmed status of that zone. A status value of Normal means that the zone is
programmed to operate normally. The following is a complete list of possible values:
Isolate, Soak, Inhibit, Tamper, Alarm, Fire Exit, Warning Fault, Holdup Fault, Detector Fault, Line
Fault, Panic, Hold Up, Tech, Medic, Lock, Fire, Trouble, PIR Masked, Normal, Actuated,
Tamper, Post Alarm. A zone is in the post alarm status if an alarm occurred and the confirmed
alarm timed out. This reinstates the zone, however it also flags that an alarm did occur.
Performable actions
Refresh  Updates the status information displayed for the panel.
Log Click the Log button to view a log of the input status of that zone.
Inhibit Click this button to inhibit a fault or open zone. The inhibit operation will disable that fault or zone for one
@ arming period only.
Inhibit operation is not available in Security Grade EN 50131 Grade 3.
Restore  Click this button to restore the alarm condition of the panel.
Isolate Zone . Isolating a zone will deactivate that zone until such time as the zone is explicitly deisolated
again.
It is recommended that you exercise caution when isolating zones as those zones will not be active
every time the systemis SET.
Soak Highlight a zone and click this button to perform a Soak test on that zone.
Seismic  Click this button to initiate a test of the selected seismic sensor. For more information on seismic
Test sensors, see Seismic Sensors on page 353.
Hide Click this button to hide all closed inputs.
Closed
Filter Select a zone type from the dropdown menu. Only the summary of this zone type will be displayed.
Zones
17.6.5 Doors
1. Select Status > Doors.
Hardware Inputs Outputs FlexC System Alerts
Door Zone Area DPS DRS Status Log Action
1 1DEnty 1 Marketing Closed Short Door Normal Log [ Lock | Unlock | Momentary |
2 12D00R 2 1 Marketing Closed Closed Door Normal Log | Lock | Unlock | Momentary |
See tables below for further information.
Door This ID number is a unique identifier for the door.
Zone The zone number the door position sensor is attached to (only if the door position sensor input is also
used as intrusion zone).
Area The area the door position sensor input and the card reader are assigned to.
DPS Status of the door position sensor.
DRS Status of the door release switch.
Status The status of the door (OK, fault).
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Door Specifies the door operate mode.
Mode
Performable actions
Refresh Updates the door summary.
Log Displays a log of events for the selected door.
Lock Locks the selected door.
Unlock Unlocks the selected door.
Normal Returns the door to normal system control.
Momentary Unlocks the door for one timed interval.

17.6.6 FlexC Status

This page displays the status of each ATS configured on your system.

1. Toview the status of an ATS, go to Status > FlexC.

Hardware Inputs Outputs Doors FlexC System Aleris
FiexC Status
FlexC ATS: ATS 1
ATS Registration 1D T578-G5R9-92XG-SP2G The unigue registration ID of the ATS allows the panel to be uniquely identified at the RCT.
ATS Status Fault The Status of the ATS
Time since last Poll 4 Days 17hr 30min 51s The time since the Iast poll on any ATP in the ATS.
Event Queue Count 250 No. of events in the event queue waiting to be transmitied

Status of ATPs within ATS

s ATP Name

Communications  ayp gianc

Event Queue List of the events cumrently in the Event Queue
Event Log Event Log Event Iog history for all the events that have occured on the ATS
Network Log Network Log Network Log for the ATS

1| Primary ATP 1 Ethernet Fault [ Networklog ||[ ATPLog ||| ManualTest |
2 | Backup ATP 2 Ethernet Fault [ Neworklog ||| ATPLog ||[ ManualTest |
2. Thetable below describes the status criteria available for each ATS.
ATS The unique registration ID of the ATS allows the panel to be uniquely
Registration identified at the RCT.
ID
ATS Status The status of the ATS, for example, initializing.
Time since  The time since the last poll on any ATP in the ATS.
last poll
Event Number of events in the event queue waiting to be transmitted.
Queue
Count
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Event
Queue

Event Log

Network
Log

Status of
ATPs within
ATS

List of the events currently in the Event Queue. The tables shows the
following:

« Event Seq No.

« Event Timestamp

« Event Description

« Additional Event Info
« Start Timestamp

« Report Duration

Event log history for all the events that have occurred on the ATS. The table
shows the same fields as Event Queue above and the following additional
field:

o Event SeqNo.

« Event Timestamp

« Event Description

« Additional Event Info
o Result

o Reported ATP

o Start Timestamp

o ACK/Fail Timestamp

« Report Duration

Network log for the ATS showing the configured polling interval.

This table shows each ATP inthe ATS. For each ATP, the table shows the
ATP sequence number, the ATP name, the communications interface, ATP
Status, Last successful transmission, Network Log, ATP Log and Test Call
button.

Network Log: Click this button to show the network log.

ATP Log: Shows a list of poll transmissions. Click the Refresh button to
update the log. Click the Most Recent Last button to change the viewing
order. By default the most recent event displays first.

Manual Test button: Click this button to force a test call. The Event is added
to the event queue.
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17.6.7 System alerts

1. Select Status > System Alerts.
Hardware Inputs Outputs Doors FlexC System Alerts

Alert Input Status Action
Controller Mains Fault 0K oK
Controller Battery Faul Fault Isolate
Controller PSU Fault OK 0K Inhibit | Isolate
Controller Aux. Fuse Fault OK oK Inhibit | Isolate
Controller External Bell Fuse Fault OK oK Inhibit | Isolate
Controller Internal Bell Fuse Fault 0K oK Inhibit | Isolate
Bell Tamper Fault Isolate Deisolate
Controller Cabinet Tamper Fault Isolate Deisolate
Controller Aux. Tamper 1 oK OK Inhibit | Isolate
Controller Aux. Tamper 2 OK oK Inhibit | Isolate
Controller Antenna Tamper OK oK Inhibit | Isolate
Controller RF Jamming oK oK
Modem 1 Fault oK oK
Modem 2 Fault Fault Isolate
Fail to communicate OK Isolate
User Duress OK OK
User RF FOB Panic OK 0K
User Man Down Alarm 0K oK

See tables below for further information.

Alert
Input

Status

@

Description of the system alert.
The actual state of the alert that was detected on the panel (OK, Fault).

The programmed status of the system alert, that is, whether the alert has been isolated or inhibited. A
status value of OK is displayed if the alert condition has not been disabled in any way.

Performable actions

Refresh
Restore
Inhibit

9

Click this button to update the status of the system alerts.
Click this button to restore an alert on the panel

Click this button to inhibit a fault condition. The inhibit operation will disable that fault or zone for one
arming period only.

Inhibit operation is not available in Security EN 50131 Grade 3.

Isolate  Click this button to isolate the zone. Isolating a zone will de-activate that zone until such time as the
zone is explicitly de-isolated again. It is recommended that you exercise caution when isolating
zones as those zones will not be active every time the system is SET.
17.7 Logs
This section covers:
7. 7.1 SyYSteM LOg 194
17,72 ACCESS LOg . L 195
17.7.3 ALARM LOG .l 195
17.7.1 System Log
This log displays all the system events of the SPC system.
1. Select Log > System Log > System Log.
2. Create atext file of the log by clicking Text File.
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3. Thelogging of individual zone state changes is enabled by setting the log attribute for that zone in
the Zone Attributes configuration page.

System log Access log Modem 1

System log

Alarm log WPA Log

System log

04/07/2014 11:03:38 FlexC ATS Event Timeout. [ATS=1

04/07/2014 11:23:37 FlexC ATS Event Timeout. [ATS=1

04/07/2014 12:19:58 Panel in Soft eng mode
04/07/2014 12:19:58 Configuration changed
04/07/2014 12:20:01 WWW END, User 9999 Engineer

04/07/2014 10:33:39 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 10:43:39 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 10:53:39 FlexC ATS Event Timeout. [ATS=1,

Modem 2

Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down]]

. Event ID=6002 (FlexC ATP Down]]
04/07/2014 11:13:38 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 11:22:29 User 9999 WEB PASSWORD ADDED By User 9993 Engineer

, Event ID=6002 (FlexC ATP Down)]
04/07/2014 11:33:37 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 11:43:36 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 11:53:36 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 12:03:35 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 12:13:35 FlexC ATS Event Timeout. [ATS=1,

Event ID=6002 (FlexC ATP Down]]

Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down)]

04/07/2014 12:20:08 WWW LOGIN FAILED INVALID ENTRY, IF 10.100.82.253
04/07/2014 12:20:17 WWW LOGIN FAILED INVALID ENTRY, IP 10.100.82.253
04/07/2014 12:20:23 WWW LOGIN OK, User 9999 Engineer, IP 10.100.82.253
04/07/2014 12:23:35 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 12:33:34 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 12:43:34 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 12:53:34 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 13:03:34 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 13:13:34 FlexC ATS Event Timeout. [ATS=1,
04/07/2014 13:23:34 FlexC ATS Event Timeout. [ATS=1,

Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down)]
Event ID=6002 (FlexC ATP Down]]
Event ID=6002 (FlexC ATP Down]]

L In order to avoid multiple events from the same source filling the log, the SPC system, in accordance
l with standards, permits the logging of only 3 activations of the same zone in one set period.

17.7.2 Access Log

The log provides all the access events of the SPC system.

1. Select Log > Access log.

The following page will be displayed:

System log Access log Modem 1 Modem 2

Access log

Time Event Door User
26/07/2012 16:01:17 Unknown card 1- Entry

26/07/2012 16:01:17 Entry Denied - CARD NOT ON SYSTEM 1- Entry

26/07/2012 16:01:36 Unknown card 1- Entry

26/07/2012 16:01:36 Entry Denied - CARD NOT ON SYSTEM 1- Entry

26/07/2012 16:02:07 User 11 Card added By User 1 1User1
26/07/2012 16:02.11 Entry Granted 1- Entry n
08/08/2012 12:43:17 User 9 Card added By User 1 1User1
08/08/2012 15:57:42 Unknown card 2-DOOR 2

08/08/2012 15:567.42 Entry Denied - CARD NOT ON SYSTEM 2-DOOR 2

08/08/2012 15:57:46 Unknown card 1- Entry

08/08/2012 15:57:46 Entry Denied - CARD NOT ON SYSTEM 1- Entry

08/08/2012 16:02:27 User 7 Card added By User 1 1User1

08/08/2012 16:02:55 Unknown card 1- Entry

08/08/2012 16:02:55 Entry Denied - CARD NOT ON SYSTEM 1- Entry

08/08/2012 16:03:11 User 8 Card added By User 1 1User1
10/08/2012 12:37:29 Entry Granted 2-DOOR 2 n
10/08/2012 12:37:34 Entry Granted 2-DOOR 2 "

2. Create atext file of the log by clicking on the Text File button.

17.7.3 ALARM LOG

The ALARM LOG displays a list of alarm events.
« Select Log > System Log > Alarm Log.
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The following types are displayed in this log:

« Zones
—Alarm
—Panic

« System Events
— Confirmed Alarm

—UserDuress

— XBus Panic

—User Panic

— RPA Panic

17.8 Users
The following table shows the maximum number of users, user profiles and user devices for the panel:

Maximum No. SPC4xxx SPC5xxx SPC6xxx
Users 100 500 2500
User Profiles 100 100 100
User Profiles per User 5 5 5
PACE Devices 32 250 250
SMS IDs 32 50 100
Web Passwords 32 50 100
RF Fobs 32 50 100
MDT Devices 32 32 32

WARNING: If upgrading from a firmware version prior to version 3.3, note the following:

- The Engineer web password, if configured, is deleted and must be reentered after upgrade.

- All existing users will be assigned to new user profiles corresponding to their previous user
access levels. If max. number of user profiles is exceeded, no profile is assigned (see
Adding/Editing User Profiles on page 199). Review all user configuration after a firmware upgrade.

- The default Engineer ID is changed from 513 to 9999.

17.8.1 Adding/Editing a User

To add or edit a user:

1.

Select Users>Users.

A list of configured users is displayed.

Users User Profiles Users SMS Wireless FOB Web Passwords Engineer

Edit

g

User Name

Alerts

Card number

FOB

Pace

User Profiles

Add User Profile

/ i ! et oK Ao pAEY] et 4

419 ; e | o

A | E 3 User3 0K mi:::;::fg][” ﬂ

A E 4 Userd oK miﬂg;&%ﬁf{]m ﬂ

ﬁ E 5 GemUser 0K - Manager [2] ﬂ
mmeEo
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2. Click the Add User button or click the Edit button of the required user.
The following page is displayed.

Us
Add a new user to the system

User Settings

User b: e ]

User Name: [Users ] Name of User on system

User PIN: 000000 Generate PIN PIN used by User for intrusion and access system. Use 0 if PIN is not required

Language: [System Language | Language used by the user

Date Limit: [08 ]/ [May ~]/[2018 -] - [08 -]/ [May -] /[2018

Alarm Access: Select fuser is alamm access only

User Alerts

None

User Profiles

[ O Je—— 2 wnzger 5 Lited ser 4 ocess User

User SMS

Add User SMS

3. EnteraUser ID that is not currently being used. If you enter an ID that is already used, an 'Invalid
ID’ message is displayed when you select Generate PIN.

4. Provide a User Name (maximum 16 characters and case sensitive).

To automatically generate a User PIN for a new user, click the Generate PIN button. Change the
PIN if required. Enter O if PIN is not required.

Note: To comply with INCERT approvals, the user's PIN code must contain more than 4 digits.

6. You can also limit access to the system for this user by ticking the Date Limit box and entering a
To and From date in the date fields.

User Alerts displays the status of the user's PIN. For example, It displays the number of days
remaining before the PIN expires, if Periodic changes are enabled in the system PIN Policy.

7. You can enable the Alarm Access option to grant time-limited access to the system for this user
within a specific window.

The time limits for this option are set in the System Timers page. Go to
Configuration>System>System Timers to configure this option. See Timers on page 261.

i In normal mode any user with this attribute selected is unable to access the
system.

8. Select the appropriate user profile (see Adding/Editing User Profiles on page 199) for this user.

9. Select Duress Enable for this user if required. The number of PINs allocated for duress (PIN +1 or
PIN+2) is set in system options (see Options on page 252).

The Duress option is only available on this page if User Duress is enabled for the system in System
Options. If Duress is enabled for this user, then consecutive user PINs for other users (for example,
2906, 2907) are not permitted, as entering this PIN from the keypad would activate a user duress
event.

L)

Access Control

Attribute Description

Card Enter card number. Enter 0 to unassign this card.
Number

Void Card Check to temporarily disable this card.
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Attribute Description
Extended Extend doortimers when this card is present.
Time
PIN Access a door without PIN on a door with PIN reader.
bypass
Priority Priority cards are stored locally in the door controllers and will grant access in case of a technical fault
where the door controller cannot communicate with the control panel.
The maximum number of priority users is:
o SPC4xxx —all users
o« SPCb5xxx—512
o« SPC6xxx—512
Escort The escort feature enforces privileged card holders to escort other card holders through specific doors.
If this feature is enabled on a door, a card with the “escort” right has to be presented first, to allow other
cardholders without this right to open the door. The time period in which cardholders are able to
present their cards after a card with escort right was presented, can be configured per door.
Custodian The custodian feature enforces a card holder with custodian privilege to always be inside a room (door
group) when other card holders are inside.
The custodian must be the first to enter the room. Only if a custodian is in the room other cardholders
are allowed to enter. The cardholder with the custodian right will not be allowed to exit until all non-
custodian cards left the room.
Identifies this card holder as a custodian. The user with the custodian attribute has to be the first who
enters a door group which requires a custodian card holder and has to be the last that is leaving this
door group.

17.8.1.1 Unknown Devices

If an unknown device, such as a fob, PACE, or card, has been scanned but not assigned to a user, a
button is displayed in the relevant section of the edit user settings page.

« RF-FOB - Unknown Fob button or, if the device is assigned to the user, Delete FOB button
« Pace — Unknown Pace button or, if the device is assigned to the user, Delete Pace button
« Access Control — Unknown card button
To assign a fob, PACE or card to the user:
1. Click the Unknown button for the device. The User page displays the list of unknown devices.
2. Click Add to assign the device to the user.
Note: To assign a card to the user, the associated user profile must have the correct site code defined.
To unassign a fob or Pace from a user:
1. Click the Delete button.
The device is unassigned from the user and also deleted from the system.
2. Toadd the device again, you must rescanit.
To unassign a card from a user:
1. Change the card number to zero (0).
2. Click Save.
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The card is unassigned from the user and deleted from the system.

3. Toadd the card again, you must rescan it.

17.8.2 Adding/Editing User Profiles

NOTICE: Global user profiles cannot be edited in the browser and must be edited in SPC Manager.

To add or edit a user profile:
1. Select Users>User Profiles.

A list of configured profiles is displayed with the number of users assigned to each profile.

[STSR  UsersSMS  WielessFOB  WebPasswords  Engineer

S Delete n User Profie Name. User Count
i L 1 Standard user 4
ﬁ @ 2 Manager 5
V4 E 3 Limited user 0
i i 4 Access User ”

2. Click Add User Profile or click the Edit button of the required profile.
The following page is displayed with the configuration options categorized as follows:
- General Settings
- User/Panel Rights

- Access Control

User Profiles Users SMS Wireless FOB ‘Web Passwords Engineer

Add a new User Profile to the system

General Settings

user rte 0
User Profile Name: User Profile 5 Name of User Profile on system
Areas
@D 1 #ear 3 Area3 5 Area 5
2:Area2 4:pread
Calendar
Calendar: None | Daily time limits of user on system are specified by the selected calendar

User Rights - Intruder

Unset User can unset the system.

Partset A User can Partset A the system

Partset B User can Partset B the system.

Fuliset User can Fullset the system

Force Set User can override prevention from setting
Delay Auto Set User can delay automatic sefting
Restore User can restore alerts.

Inhibit User can Inhibit

Isolate User can Isolate.

General Settings

1. Enter a User Profile ID that is not currently being used. If you enter an ID that is already used, an
‘ID Unavailable’ message is displayed.

2. Provide a User Profile Name (maximum 16 characters and case sensitive).
Select all Areas that will be controlled by this user profile.

4. Select a Calendar to set the time limitations of this profile on the system.
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User/Panel Rights

« Select the required user rights that are to be assigned to this user profile.

User rights

User
Profile
Type
Default

Right

Description

User Rights - Intruder

Unset Limited
Standard
Manager

Partset A Standard
Manager

PartsetB  Standard
Manager

Fullset Limited
Standard
Manager

Forceset Standard
Manager

Delay Standard*
Auto Set  Manager

Restore Standard
Manager

Inhibit Standard
Manager

The UNSET operation unsets the alarm. This menu option is only presented on the
keypad after an Entry/Exit zone has been activated and a valid user code has been
entered.

The PARTSET A option provides perimeter protection to a building while allowing free
movement through the access areas.

Zones that have been classified as EXCLUDE A remain unprotected in this mode. By
default, there is no exit time; the system sets instantly on selection of this mode. An
exit timer can be applied to this mode by enabling the Partset A timed variable.

The PARTSET B option applies protection to all zones except those that have been
classified as EXCLUDE B.

By default there is no exit time; the system sets instantly on selection of this mode.
An exit timer can be applied to this mode by enabling the Partset B timed variable.

The FULLSET operation fully sets the alarm system and provides full protection to a
building (opening of any alarm zones activates the alarm).

On selecting FULLSET, the buzzer sounds and the keypad display counts down the
exit time period. Exit the building before this time period has expired.

When the exit time period has expired, the system is set and opening of entry/exit
zones starts the entry timer. If the system is not Unset before the entry timer expires,
the alarm is activated.

The FORCESET option is presented on the keypad display when an attempt is made
to set the system while an alarm zone is faulty or still open (the top line of the display
shows the open zone).

Selecting this option sets the alarm and inhibits the zone for that set period.

User can delay or cancel autosetting.

The RESTORE operation restores an alert condition on the system and clears the
alert message associated with that alert condition.

An alert condition can only be cleared after the zone(s) or fault(s) that triggered the
alert condition have been restored to their normal operating state and the CLEAR
ALERT option in user programming is selected for that zone.

Inhibiting a zone deactivates that zone for one alarm set period.

This is the preferred method of deactivating a faulty or open zone as the fault or open
condition is displayed on the keypad each time the system is being set to remind the
user to attend to that zone.
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User
. Profile o
Right Type Description
Default
Isolate Standard* Isolating a zone deactivates that zone until such time as the zone is de-isolated. All

Manager zone types on the controller can be isolated.

Use of this feature to deactivate faulty or open zones should be considered carefully;
once a zone is isolated, it is ignored by the system and could be overlooked when
setting the system in the future, compromising the security of the premises.

User Rights - System

Web Standard®*  User can access panel through web browser.
Access Manager

View Log Standard This menu option displays the most recent event on the keypad display. The event
Manager log (see Event Log on page 166) details the time and date of each logged event.

Users Manager User can create and edit other users on the panel but with only the same or less rights
than this user.

SMS Standard*  This feature allows users to set up the SMS messaging service if a modem is
Manager installed on the system.

SetDate  Standard Use this menu option to program the time and date on the system (see Set Date/Time
Manager on page 169).

Ensure the time and date information is accurate; these fields are presented in the
event log when reporting system events.

Change Standard This menu option allows users to change their user PINs (see Change Engineer Pin
PIN Manager on page 167).

Note: To comply with INCERT approvals, the user's PIN code must contain more

than 4 digits.
View Standard User can view video images via the web browser.
Video Manager Note: The Web Access right must also be enabled for this function.
Chime Standard All zones that have the CHIME attribute set generate a short burst of audible tone on

Manager the keypad buzzer when they are opened (while the system is unset).

This menu option allows for enabling or disabling of the chime feature on all zones.

Engineer Manager This option allows users to grant access to engineer programming.

For Swiss CAT 1 and CAT 2 regional requirements, when Engineer Access is
granted, all areas must be unset otherwise the engineer will be denied access.

Upgrade  Manager User can grant manufacturer access to panel to perform firmware upgrade.
User Rights - Control

Outputs Standard User can activate/deactivate configured outputs (mapping gates). See Editing an
Manager output on page 231.
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User
Profile
Type
Default

Right

Description

X-10 Standard
Manager
Access
Control

Door Standard*

Control Manager
Access
Control

RF Standard

Output Manager
Access
Control

User Rights - Test

Bell Test Standard
Manager

Walk Test Standard

Manager
WPA Standard
Test1 Manager

Set Users
[Master]

Set User
Profiles

Set
Calendars

Set Doors

User Rights — Service Engineer

User can activate/deactivate configured X-10 devices.
Note: X-10is in maintenance. The functionality remains in the system for backward
compatibility.

User can lock/unlock doors.

User can control RF output

User can perform a bell test to test the external bells, strobe, internal bells and buzzer
to ensure their correct operation.

User can perform a walk test to allow for testing of the operation of all alarm sensors
on a system.

User can test a WPA.

User can create and edit other users on the system with no restriction on user rights.

User can create and edit user profiles on the system.

User can configure calendars.

User can edit doors.

* Functions not enabled by default for this user but can be selected.
1A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

Access Control

Access Control

Site Code: 1] Site code of all cards using this user profile

Door Access List: Door ID Door Hame Access | Calendar
1 Door 1 Mo time limit V
z Door 2 Mo time limit v
2 Door 2 Mo time limit %
4 Door 4 No time limit +
Mo access
© Vanderbilt 2018 202 A6V10276959-d

11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the browser

3.

Enter a Site Code, if required, for all cards assigned to this user profile. See Supported card readers
and card formats on page 388.

Select the Access rights of this user profile for the doors configured on the system. Options are:
-No access

- No time limit (that is, 24 hour access)

- Calendar (if configured)

Users using this User Profile

A list of users assigned to this profile is displayed. Click a user to view or edit the user’s details.

You can create a new user profile based on an existing profile by clicking Replicate. A new User Profile
page is displayed.

See also

Adding/Editing User Profiles on page 199

Adding/Editing an area on page 270
17.8.3 Configuring SMS

The SPC system allows remote (SMS) messaging on systems with installed modems.

Prerequisites

[e]

[e]

1.

A modem is installed and identified by the system.
The function SMS Authentication is activated. (See Options on page 252.)
Select Users>Users SMS.

The Engineer SMS ID and a list of user SMS IDs with corresponding SMS details are displayed.

Engineer

SMS Number

Control Enabled

| u k| 2 User2 33863444031 Enabled

m

Click the Test button to test an SMS number.
Click Add to add a new SMS ID or click the Editicon beside the required SMS ID.
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Users

User Profiles Users SMS Wireless FOB Web Passwords Engineer

Add a new SMS number to the system

General Settings

SMS Events

SMSID 1

User [1: User 1

User i with this SMS number

Alarms

Alarm Restores
Confirmed alarms
Faults

Fault restore
Setting

Early / Late
Inhibits

Door events
Other

Wireless Lost Event

4. Configure the SMS details as follows:

Phone number SMS messages will be sent to / received from

Alarm activation

Reported alarms being restored

Alarms confirmed by multiple zones

Fault or Tamper activations

Fault or Tamper restores

Setting and Unsetting

Report if Setting/Unsetting is not according to schedule

Inhibit and Isolate

Access control door events

All other types of events

If checked Wireless Lost event will be sent over CID/SIA and FlexC

User

SMS

SMSID System generated ID.

cannot be deleted.

SMS Select the panel events which the user or engineer will receive via SMS.

Events

SMS Select the operations that the user or engineer can perform remotely on the panel
Control  through SMS. See SMS Commands below.

Select a new user for this SMS ID if required.

Enter the number to which the SMS will be sent (requires three-digit country code
Number prefix).
Note: Engineer SMS number can deleted by resetting it 0. User SMS numbers

NOTICE: HOLDUP alarm events are not transmitted via SMS.

i

If the phone line is connected to the PSTN network via a PBX, the appropriate line access digit
should be inserted before the called party number. Ensure that Calling Line Identity (CLI) is
enabled on the line selected to make the call to the SMS network. Consult the PBX administrator
for details.

17.8.4 SMS Commands

When the SMS setup and configuration is complete, SMS features may be activated. Commands,
depending on SMS configuration, are sent using a PIN or caller ID. The type of PIN depends on what is
set for SMS Authentication.

The table below provides all available SMS commands. Subsequent action and response are also
provided.

SMS Commands are sent as texts to the phone number of the SIM card on the controller.
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For commands using a PIN, the format of the text is:

*kkk *kkk

.command or command

where **** is the PIN and “command” is the command, that is, the PIN followed by either a space or a full
stop. For example, the command “FSET” is entered as: **** FSET or ****.FSET. The full version of the
command, where listed, can also be used. For example, ****.FULLSET.

If the user does not have sufficient rights to perform a command, the system returns ACCESS DENIED.

If Caller ID is enabled, and the sender's SMS number is configured, the PIN prefix is not required.

COMMANDS (**** = code)

Using Code ILIl)smg L Action Response
*** HELP HELP All available commands are displayed. All available commands
**** HELP
***FSET FSET Sets all areas the user has access to.  Time/date of system set. If
wkxt EQET FULLSET applicable, responds with
' open zones/force set zones
**** FULLSET
Allows Partset A of alarm by SMS. System set
e ASET It is also possible to specify the
ek AGET custom name defined in the
' PARTSET rename field of the
Options page. See Options on
page 252.
***BSET Allows Partset B of alarm by SMS. System set
= BSET Itis also possible to specify the
custom name defined in the
PARTSET rename field of the
Options page. See Options on
page 252.
For example:
*** ASET NIGHT
e USET USET Unsets all areas the user has access  System Unset
****.USET UNSET to.
= UNSET
= SSTA SSTA Retrieves the status of areas. Status of system and
*eex SSTA STATUS applicable areas
o STATUS « Forasingle area
' system, system and
mode are returned,
where mode is the set
status of the system.

« Foramulti-area system,
the status of each area
is returned.
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Using Code ILIl)smg Calsy Action Response
=% XA1.0N Where X10 device is identified as Status of “A1”
xirx YA ON “A17, it is triggered on.

e XA1.0FF
e XA1.0FF

*kkk LOG
** LOG

****ENGA.ON
**** ENGA.ON

**** ENGA.OFF
** ENGA.OFF

**** MANA.ON
*** MANA.ON

**** MANA.OFF
**** MANA.OFF

****(05.0N
**** 05.0N
e OUTPUT

=+ 05.0FF
=+ 05.0FF

****.CLR
*** RESTORE

Where X10 device is identified as Status of “A1”
“A17, it is triggered off.

Upto 10 recent events are displayed.  Recent events

ENGA.ON Enable Engineer access. Allow Engineer

ENGA.OFF Disable Engineer access. Revoke Engineer
Enable Manufacturer access. Manufacturer status
Disable Manufacturer access. Manufacturer status
Where output (mapping gate) is Status of “O5”

identified as “O5”, it is triggered on. For example:

o Output O5on.

« Output heating on
(where heating is the
name of the output).

Where output (mapping gate) is Status of “O5”

identified as “O5”, it is triggered off. For example: Output O5 off

Allows clear alerts by SMS.

[i

For SMS recognition, output (mapping gate) identification uses the format ONNN, where O stands
for output, and NNN are the numeric placeholders, of which not all are necessary.
(Example: O5 for output 5)

For SMS recognition, X-10 device uses the format: XYNN, where X stands for X-10; Y stands for
the alphabetic identity and NN are the available numeric placeholders. (Example: XA1)

The

SMS operates using a standard protocol that is used in SMS telephones. Note that some PSTN

operators do not provide the service of SMS over PSTN. For SMS to operate over PSTN, the following

crite

ria are required:

« Caller ID needs to be enabled on the telephone line.

« Direct telephone line — not through PABX or other communications equipment.

« Also note that most Service Providers only allow SMS to a telephone registered in the same

country. (This is due to billing issues.)
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17.8.5 Deleting Web Passwords

This page lists the engineer and any user and Engineer password that has been created for accessing the
Web browser.

1. Select Users>Web Passwords.

User Profiles 5 SMS Wireless FOB Web Passwords Engineer

Engineers Web Password
Delete D User Name

m 9999 Engineer

Users Web Passwords

Delere D User Name

2. Click the Delete button beside the Engineer or user to delete the password.

17.8.6 Configuring Engineer Settings

To configure engineer settings:

1. Select Users>Engineer.

Users User Profiles Users SMS Wireless FOB Web Passwords Engineer

Edit Engineer settings
User Setfings
User ID: 9999
User Name: ‘Eﬂgiﬂeer ‘ Name of User on system
User PIN: Change PIN PIN used by User for intrusion and access system. Use 0 if PIN is not required.
Language: ‘Eng\ish V‘ Language used by the user
User Alerts
None
User SMS
Add User SMS

2. Change the 'Engineer User Name if required.

Click the Change PIN button to change the Engineer PIN (see Changing Engineer PIN and web
password on the facing page).

Note: To comply with INCERT approvals, the user's PIN code must contain more than 4 digits.

4. Select the Language that will be used by the engineer. (Only displayed if multiple languages
available — see Upgrading Languages on page 340.)

Access Control

Attribute Description

Card Enter card number. Enter O to unassign the card.
Number

Void Card Check to temporarily disable the card.

Extended Extend door timers when the card is present.
Time
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Attribute Description

PIN Access a door without PIN on a door with PIN reader.
bypass
Priority Priority cards are stored locally in the door controllers and will grant access in case of a technical fault

where the door controller cannot communicate with the control panel.
The maximum number of priority users is:
o SPC4xxx —all users
o SPCbxxx—512
o SPC6xxx—512
Escort The escort feature enforces privileged card holders to escort other card holders through specific doors.
If this feature is enabled on a door, a card with the “escort” right has to be presented first, to allow other

cardholders without this right to open the door. The time period in which cardholders are able to
present their cards after a card with escort right was presented, can be configured per door.

Custodian The custodian feature enforces a card holder with custodian privilege to always be inside a room (door
group) when other card holders are inside.

The custodian must be the first to enter the room. Only if a custodian is in the room other cardholders
are allowed to enter. The cardholder with the custodian right will not be allowed to exit until all non-
custodian cards left the room.

Identifies this card holder as a custodian. The user with the custodian attribute has to be the first who
enters a door group which requires a custodian card holder and has to be the last that is leaving this
door group.

17.8.6.1 Changing Engineer PIN and web password

You can change the PIN for accessing the keypad and also the password for accessing the Web
browser for Engineer level only.

User Profiles Users SMS Wireless FOB Web Passwords Engineer

Change PIN

User PIN
Old PIN: | | 6 Numeric digits
New PIN: | | 6 Numeric digits
Confirm new PIN: | | 6 Numeric digits

Change PIN

Change Web Password (use a more secure password instead of PIN for user authentication)
New Password: | |

Confirm new Password: | |

Change Password
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1.

Change the PIN as follows:

Engineer programming via the browser

OIdPIN Enter the existing Engineer PIN code. (Numeric digits only)
New PIN Enter the new Engineer PIN code. (Numeric digits only)
Confirm New PIN Re-enter the New Engineer PIN code.

2. Click the Change PIN button to activate the new PIN.

setting of the system or on the selected length of the PIN Digits in the menu

E The minimum number of digits required for the code depends on the security
1 Panel Settings > System Settings > Options.

3. Change the Web password to a more secure password for accessing the Web browser.

New Password Enter the new web access password (alphabetic characters A-Z,
numeric digits 0-9).

Confirm New Re-enter the new web access password.
Password

4. Click the Change Password button to activate the new password.

[i]

The password is case sensitive —ensure that you enter the correct upper or lower case alphabetic
characters in your new password.

17.9 Wireless

Wireless sensor detection (868MHz) on the SPC panel is provided by wireless modules. There are two

types of wireless modules: one-way SiWay RF Kit (SPCW110, 111, 112, 114 ) and two-way SPCW120
Wireless Transceiver. The SiWay RF Kit is fitted in the controller, on the keypad, or by installing a wireless
expander. The SPC two-way wireless module is fitted into modem slot 2 of the control panel. See the table

below for information on which devices can be enrolled with each type of transceiver.

[t

For CE regulatory compliance, the SPCW120 product can only be fitted to the following products:

« SPC5330.320-L1
» SPC6330.320-L1
» SPC4320.320-L1
» SPC5320.320-L1
» SPC5350.320-L1
« SPC6350.320-L1
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Devices compatible with a one-way transceiver

Wireless sensors ADM-112W1 Wireless Fresnel PIR detector, 12m wide angle
IR160W6-10 Wireless PIR detector with black triplex mirror, 18m wide angle,
868MHz
IMKW6-10 Wireless magnet contact, 868MHz
IMKW6-10B Wireless magnet contact, 868MHz (brown)

OPZ-W1-RFM6 SiWay radio module (plug-in to smoke alarm)

IRCW6-11 Remote control FOB with 4 button control
IPAWG6-10 Personal transmitter
WPA Wireless personal alarm

Devices compatible with a two-way transceiver

Wireless sensors WPIR Wireless 12m PIR detector with pet immunity option
WPIR-CRT Wireless curtain PIR detector
WMAG Wireless magnetic contact (slim)
WMAG-I Magnetic contact with additional input

WRMT Remote control FOB with 4 button control

WPAN Wireless personal alarm button

e For instructional videos on wireless devices and transceivers please go to
l http://van.fyi?Link=Wireless_devices.

17.9.1 One-way wireless

The following devices can be enrolled on a one-way wireless transceiver:

« Wireless sensors

« WPA-Wireless Personal Alarm

« IPAWB-10

« IRCW6-11
Please note that you must disable two-way wireless before enrolling these devices.
To disable two-way wireless:

1. Select Configuration > Hardware > Wireless > Wireless Settings.

2. Disable Two Way Wireless.
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Hardware System Inputs Outputs Calendars Change own PIN Advanced

Controller X-BUS

Wireless Sertings
Two Way Wireless Enable if two way wireless transceiver is fitted.
Filter If checked then signals received with 0 signal strength wil be disregarded.
Detect RF JAM If checked then an alert is activated if RF interference is detected.

Wireless Lost Event If checked Wireless Lost event will be sent over CID/SIA and FlexC

- e
H
8

‘Supervision . Two way Wireless Supervision time interval in minutes.

Antenna External v Select which type of antenna is connecled to the wireless module.
Missing Supervision Tamper enabled ~ Select whether missing supervision for a sensor will raise a zone tamper.
RF FOB 50§ Select how the SOS buttons on the RF Fob should operate.

WPA Test Schedule Maximum period between WPA tests, days (0-365. 0 = WPA test disabled / not required).

™| [
S| &8 |F
@« |3,
2
<

Prevent Setting Time 1f sensor failed to report within this time, then Setting will be prevented for the area the wireless zone is in, minutes (0 - 720, 0 = checking is disabled)

Device Lost Time

=
=

If wireless device (sensor or WPA) failed to report within this ime, then it is reported as lost, minutes (20 - 720, 0 = checking is disabled).

17.9.1.1 Wireless sensors
Enrol a sensor

To enrol a new sensor:

1. Select Configuration > Hardware > Wireless Settings.

Hardware System Inputs QOutputs Doors L Calendars Change own FIN Advanced

Coniroller X-BUS

Wireless Settings
Wireless Settings

Two Way Wireless ‘) Enable if two way wireless transceiver is fitted.

2. Disable Two Way Wireless.

Select Configuration > Hardware > Wireless and click the Enrol New Sensor button.

Hardware Inpuls  Oupus  Aweas  Calendas  ChangeownPIN  Advanced

Conroller  X-BUS
Wireless
Wireless - Enrolled Sensors List

“Total Wireless Active 3

Sensor D Type Zone Banery Supervise signal version Log Ea Remove
1 2415084 PR 9pit ok ok Hon 9) SW.08201HW. 3] =1 2| |
2 241453 PIR 10PIR2 ok ok Hon @) SW.08201HW. [ =1 2| |
3 2418826 Magnetic contact 1 oK ok - SW.0.113HW. 13 &l 2| i]

Lo ] s T

Note: The sensor will not show in the Enrolled Sensors List until the Enrol New Sensor button is
clicked.

4. When the sensor is found, click the Add button.

Hardware System Inputs Outputs Doors A Calendars Change own PIN Advanced

Controller X-BUS

Wireless

Wireless - Discovering ...

Received Version Signal Receiver Add

15/05/2018 07:10:45 26229753 Tamper Magnefic contact 5 High {9) Controller |§I

5. Set the sensor attributes.
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Wireless - Sensor Configuration

Description: | |
Sensor [D: 26229753

Sensor Type: |Magnetic contact V|
Zone:

Zone Type: |Alarm V|
Area:

6. The sensor appears in the Enrolled Sensors List.

Hardware System Inputs Outputs Doors Areas Calendars Change own FIN Advanced

Controller X-BUS

Wireless

Wireless sensor enrolled as Zone 34
Wireless - Enrolled Sensors List

Total Wireless Active 1

Battery Supervise Signal Version Log Edit Remove

1 26229753 Maagnefic contact 34 Front Door OK OK - E E L] 'n'ﬂ

Enrol New Sensor o

Programmable attributes for wireless sensors

Description Text description of the sensor.

Sensor Type The type of wireless sensor detected (e.g. magnetic contact, PIR).
Zone The zone number to which the sensor has been enrolled.

Zone Type The type of zone (e.g. Alarm, Entry/Exit).

Area Areas to which the zone is assigned.

Edit a sensor

To edit a sensor:
1. Click the Edit button beside the sensor you want to edit.
2. Edit the sensor attributes.
3. Click Save to save your changes.
17.9.1.2 WPA

« You can only configure a WPA or check WPA status on the keypad if there is a wireless
i module fitted on the panel or any of the panel expanders.

o AWPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

A WPA is not assigned to a user. Usually, a WPA is shared by several people, for example, security
guards working in shifts. Alternatively a WPA may be permanently attached to a surface such as under
a desk or behind aftill.
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You can connect up to 128 WPAs per SPC panel.

Configure a WPA

Add a WPA

To configure a WPA from the browser, select Full Engineer mode and select Configuration > Hardware
> Wireless > WPA.

Calendars  Changeown PN Advanced

WPA1 0 oK Disabled 2| a8

The following items can be checked or configured:

. Battery Status

The panel receives the battery status from the WPA in every frame. The battery status can be either
OK or Low.

Battery monitoring requires a WPA fitted with the PCB revision E-PC138612 or later.
Supervise
The Supervise status can be any of the following:

— Fault
The panel has not received a supervision message from the WPA in the period configured in the
Wireless Settings page.

—Disabled
Supervision is not configured.

—-0OK

Supervision is transmitting normally.
Status

The Test Status can be any of the following:

— Overdue
The WPA has not been tested in the period configured in the Wireless Settings page.

—Disabled
Supervision is not configured.

- OK
The WPA test is ok.

To add a WPA to the system:

Select Configuration > Hardware > Wireless > WPA and click the Add button . The Configure
Wireless Personal Alarm (WPA) page appears.
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Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
‘Coniroller X-BUS
WPA

Configure Wireless Personal Alarm (WPA)

WPA added
WPA 2
Description WPA 2
Transmitter ID [ | [ Leamn | Press any button on WPA first, then select ‘Learn’.
Supervise O Check if WPA should be supervised. (Note: This requires the supervision link to be fitted on the WPA.)

Test

|

Check if the WPA requires a manual test according to test schedule.

Assignment of Functions fo Buttons

Red
Red + Green
Red + Yellow
Yellow + Green
Red + Yellow + Green

2. Configure the WPA using the following details:

Description Enter a description or name to uniquely identity a WPA.

Transmitter Enter the Transmitter ID that is printed on the casing of the WPA.

ID Alternatively, press any button on the WPA and click the Learn button.

The Transmitter ID field is automatically populated.

Supervise You can configure the WPA to send periodic supervision signals.
Supervision is enabled on the WPA with a jumper.

For correct supervision operation, enable the supervision function on the
panel for the particular WPA. If the panel does not get a supervision signal,
it raises an alarm that is shown in the keypad and logged.

If supervision is not enabled, the WPA transmits the battery status to the
panel about every 24 hours. The message is also randomized to decrease
the chances of collision with other WPAs.

Tick the Supervise box to enable supervision for the WPA.
Test Tick the Test box if a periodic WPA test is required. The timeframe for

periodic testing is configured on the Changing wireless settings page (see
Changing wireless settings on page 227).
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Assignment Use this section to assign functions to button combinations. Available

of functions are Panic, Panic silent, Holdup, Suspicion, RF User Output and
Functions Medical. More than one combination can be selected for the same function.
to Buttons

The defaults for a Financial installation are:
« Yellow - Suspicion
« Red + Green - Holdup

For Commercial or Domestic installations, the default is:
« Red+ Green - Panic

Note: If no function is assigned to a button combination, it is still possible to
use that combination by using a trigger. See Triggers on page 288.

3. Click the Save button to save the settings.
See Also
« Changing wireless settings on page 227

« Triggers on page 288
Edit a WPA

To edit a WPA:

1. Select Configuration > Hardware > Wireless > WPA and click the Edit button beside the WPA
you want to edit.

2. The Configure Wireless Personal Alarm (WPA) page is displayed for the WPA.

3. Edit the necessary fields.

4. Click the Save button to save the changes. Alternatively, click the Back button to return to the
previous without saving the changes.

WPA Log

The WPA log displays all the WPA events on the system. To view the WPA log, select Log > System
Log > WPA log.

17.9.1.3 IPAW6-10 personal alarm button

The IPAWG-10 personal alarm button is a device that is used to transmit Panic Alarm messages to the
SPC system.

The user can wear the IPAW6-10 in one or two ways:

« IPAWG6-10 can be worn as a wrist watch (by inserting the wrist band into the two slits of the
appropriate ring holder).

« IPAWG-10 can be worn as a pendant by removing the wrist ring holder and replacing it with the
pendant ring holder.

Enrol a IPAWG6-10 personal alarm button

To enrol the IPAW6-10:
1. Inthe SPC browser, select Users > Wireless FOB.
2. Onthe IPAWG6-10, press and hold the centre button.
The LED lights up for 1.5 seconds.
3. Click Refresh on the Wireless FOB page to display the IPAW6-10.
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) communications

4. Youcan now assign the IPAWG6-10 device to a system user.
To assign the IPAW6-10 to a user:

1. GotoUsers > Users and click the Edit button beside the user you want to assign the IPAW6-10
to.

2. Onthe Edit user settings page, click the Unknown Fob button.

A list of unassigned fobs is displayed.

uuuuuuuuuu

Click the Add button to assign the IPAW6-10 to the user.
4. Onthe Edit user settings page click Save.

Delete a IPAWG6-10 personal alarm button

To delete the IPAW6-10:

1. Goto Configuration > Hardware > Wireless > Transceiver list.

ssssss

‘‘‘‘‘‘

4

z
&
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File

2. Click the Delete button beside the IPAW6-10 you want to delete.
17.9.1.4 IRCW6-11 remote control
The IRCW6-11 4-button Remote is a device that allows a user to remotely operate the SPC system.

The device supports ARM, STAY, and DISARM functionality, as well as the operation of defined
outputs and an SOS feature.
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LED

Enrol a IRCW6-11 remote control

To enrol the IRCW6-11:

1. Inthe SPC browser, select Users > Wireless FOB.

nnnnnnnnnnnn

2. Onthe IRCW6-11, press and hold any button.
The LED lights.
3. Click Refresh on the Wireless FOB page to display the IRCW6-11.
4. You can now assign the discovered IRCW6-11 to a system user.
To assign the IRCW6-11 to a user:
1. GotoUsers > Users and click the Edit button beside the user you want to assign the IRCW®6-11 to.
2. Onthe Edit user settings page, click the Unknown Fob button.

A list of unassigned fobs is displayed.
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Time Count Number Add

1 1007201 1540 2 o

Lon 2 tsoTote 1616 . R [Add]

Click the Add button to assign the IRCW®6-11 to the user.
4. Onthe Edit user settings page click Save.

Delete a IRCW6-11 remote control

To delete a IRCW6-11:

1. Goto Configuration > Hardware > Wireless > Transceiver list.

i ] sttus Transceiver List
Transceiver List

RIModule: SW.46.167-HWO1

2w ot Deector 1

2staazs earotea [ - 3
| 2551249 o &
| 203930 o a

2. Click the Delete button beside the IRCW®6-11 that you want to delete.
17.9.1.5 Changing wireless settings

To change wireless settings, select Configuration > Hardware > Wireless > Wireless Settings.

Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
Controller XBUS
Wireless Settings

Wireless Settings

Two Way Wireless Enable if two way wireless fransceiver is fitted.

Filter If checked then signals received with 0 signal sirength will be disregarded
Detect RF JAM If checked then an alert is activated if R interference is detected.

Wireless Lost Event If checked Wireless Lost event will e sent over CID/SIA and FlexC

Supervision | Winutes Two way Wireless Supervision time interval in minutes.

Antenna External ~ Select which type of antenna is connected to the wireless module.
Missing Supervision Tamper enabled Select whether missing supervision for a sensor will raise a zone tamper.
RF FOB SOS Select how the SOS buttons on the RF Fob should operate.

WPA Test Schedule Maximum period between WPA lests, days (0-365, 0 = WPA test disabled / not required).

5| [@
S| 8 |2
&l |5
2
<

Prevent Setting Time If sensor failed to report within this time, then setting will be prevented for the area the wireless zone is in, minutes (0 - 720, 0 = checking is disabled).

Device Lost Time

=
I~}
s

If wireless device (sensor or WPA) failed to report within this time, then it is reported as lost, minutes (20 - 720, 0= checking is disabled).

See table below for further information.

Two Way Enable or disable two-way wireless depending on the transceiver you are using.
Wireless Enable two-way wireless if you are using SPCW120 Wireless Transceiver.

Disable two-way wireless if you are using SiwWay RF Kit (SPCW110, 111, 112, 114).
Filter Click to filter low strength RF signals.

Detect RF Click to activate an alert if RF interference is detected.
JAM
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Wireless Click to send Wireless Lost event over CID/SIA and FlexC.
Lost Event

Supervision Set the amount of time in minutes between occurrences of two way wireless signal supervision.

Antenna Select the type of antenna connected to the wireless module (internal or external) from the drop
down menu. The type of antenna required for the wireless module depends on the type of
wireless module fitted.

Missing Select whether a wireless sensor that is reported as missing registers a tamper condition on the
Supervision signet panel.

A wireless sensor is reported as missing when no supervision signal has been received from the
sensor for a period greater than the programmed Wireless Lost timer. See Timers on page 261.

RF FOB Select how the SOS buttons on the RF Fob should operate.:
SOs . Disable

« Enable

« Enabled Silent
« UserMedic

« User Holdup

« RF Output

WPA Test Enter a maximum period (in days) between WPA tests.
Schedule!

Prevent Enter a time in minutes after which, if the sensor fails to report, a setting is prevented for an area
Setting where the wireless zone is.
Time This setting applies to the following intrusion zones only:
o Alarm
« Entry/Exit
o Exit Term
« Panic
« Hold up
o Tamper
« Lock Supervision
« Seismic
« AlIOK
« Setting Authorisation

« Lock Element

Device Lost Enter a number of minutes after which the wireless device (sensor or WPA) device is reported
Time as lost.

1A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114) only.
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For CE regulatory compliance, the SPCW120 product is to be fitted to the following products only:
« SPC5330.320-L1
« SPC6330.320-L1
i . SPC4320.320-L1
« SPC5320.320-L1
« SPC5350.320-L1
« SPC6350.320-L1

17.9.2 Two-way wireless

The following devices can be enrolled on a two-way wireless transceiver:
« Wireless sensors
« WPAN personal alarm button
« WRMT remote control
Please note that you must enable two-way wireless before enrolling these devices.
To enable two-way wireless:
1. Select Configuration > Hardware > Wireless > Wireless Settings.

2. Enable Two Way Wireless.

Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
Controller XBUS

Wireless Settings

Wireless Settings
Two Way Wireless Enable if two way wireless transceiver is fitted
Filter If checked then signals received with 0 signal strength will be disregarded
Detect RF JAM If checked then an alert is aclivated if RF interference is detected.

Wireless Lost Event If checked Wireless Lost event will be sent over CID/SIA and FlexC

E
2
g

Supervision v Two way Wireless Supervision time interval in minutes.

Antenna External Select which type of antenna is connected to the wireless module.
Missing Supervision Select whether missing supervision for a sensor will aise a zone tamper.

RF FOB SOS Panic Select how the SOS buttons on the RF Fob should operate.

WPA Test Schedule

@
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Maximum period between WPA tests, days (0-365, 0 = WPA test disabled / not required)
Prevent Setting Time If sensor faled to report within this time, then setting will be prevented for the area the wireless zone is in, minutes (0 - 720, 0 = checking is disabled).

Device Lost Time

=
N}

If wireless device (sensor or WPA) failed to report within this time, then it is reported as lost, minutes (20 - 720, 0 = checking is disabled).

17.9.2.1 Wireless sensors
Enrol a sensor

To enrol a new sensor:

1. Select Configuration > Hardware > Wireless Settings.

Hardware System Inputs Outputs Doors Calendars Change own PIN Advanced

Controller X-BUS

Wireless Settings
Wireless Settings

Two Way Wireless ‘) Enable if two way wireless transceiver is fitted

2. Enable Two Way Wireless.

3. Select Configuration > Hardware > Wireless and click the Enrol New Sensor button.
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Haware | System  Iputs  Oupuls  Aeas  Calendars  ChangeownPIN  Advanced

Controller  X-BUS
Wircless
Wireless - Enrolled Sensors List

“Total Wireless Actve 3

Sensor » Type Zone Batery supenise Signal Version Log et Romov
1 2415084 PR 9pit ox oK Hgn 9) SW.10820]HW. 3 =i 2| |
2 2414536 PR 0PR2 ok oK Hon ) SW.[0.820]HW.[4 =i 2| |
3 2418526 Wagnetccontact LR oK oK - SW.0113IHW. B k=i 2| |
e [ ot towsrsr 1 1)

Note: The sensor will not show in the Enrolled Sensors List until the Enrol New Sensor button is
clicked.

4. When the sensor is found, click the Add button.

Hardware System Inputs Outputs Daoors A Calendars Change own PIN Advanced

Coniroller X-BUS

Wireless

Wireless - Discovering ...

Received Version Signal Receiver Add

15/05/2018 07:10:45 26229753 Tamper Magnetic contact - High (3) Controller E

5. Set the sensor attributes.

Wireless - Sensor Configuration

Description: | |
Sensor ID: 26229753

Sensor Type: | Magnetic contact V|
Zone:

Zone Type: |A1arm V|

Area: Area1Areal v

e [ e

6. The sensor appears in the Enrolled Sensors List.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Controller X-BUS

Wireless

Wireless sensor enrolled as Zone 34
Wireless - Enrolled Sensors List

Total Wireless Active 1

Bartery Supervise Signal Version log  Edit Remove

1 26229753 Magnetic contact 34 Front Door OK OK = - El i] j_]

Refresh Enrol New Sensor 0

Programmable attributes for wireless sensors

Description Text description of the sensor.
Sensor Type The type of wireless sensor detected (e.g. magnetic contact, PIR).
Zone The zone number to which the sensor has been enrolled.
Zone Type The type of zone (e.g. Alarm, Entry/Exit).
Area Areas to which the zone is assigned.
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Edit a sensor

To edit a sensor:
1. Click the Edit button beside the sensor you want to edit.
2. Edit the sensor attributes.
3. Click Save to save your changes.

17.9.2.2 Set additional two-way wireless attributes

Depending on the sensor type, additional two-way wireless attributes can be configured by clicking the
Edit button beside the sensor in the Enrolled Sensors List.

PIR
To program the attributes for a PIR:

1. Select Configuration > Hardware > Wireless Settings.

Wireless - Enrolled Sensors List

Total Wireless Active 3

1 2415084 PR 9pint oK ok High (9) SW. (08200 HW. (3]

2 2414536 PR 10PIR2 oK oK High 8) SW.[08.20] HW. [4)

SW.[0.1.13]HW.(3)

| || |l@
[EYEYRY £
[CRCAICY <

Hardware System Inputs Outputs & Calendars Change own PIN Advanced

Controller X-BUS

Wireless

Edit wireless sensor

Sensor: 2

Description:
Sensor Type: PIR

Zone: 35 v

Zone Type: Alarm

Area: Area 1 Area 1 v

LED: Disabled v

Pet Immune Filter: Disabled v

PIR Sensor Pulses Filter: |2 Pulse Count hd

PIR Sensitivity: Medium ~

E3ED

Programmable attributes for PIR

Sensor The number of the sensor as enrolled on the system (1 = first, 2 = second, etc).
Description Text description of the sensor.
Sensor Type The type of wireless sensor detected (e.g. magnetic contact, PIR).
Zone The zone number to which the sensor has been enrolled.
Zone Type The type of zone (e.g. Alarm, Entry/EXxit).
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Area

LED

PIR Sensor Pulses Filter

Pet Immunity Filter

PIR Sensitivity

Areas to which the zone is assigned.
When enabled, the LED will come on when the PIR is activated.

1 Pulse Count — 1 activation will cause an alarm
2 Pulse Count— 2 activations will cause an alarm
3 Pulse Count— 3 activations will cause an alarm

Time Filter Disabled — Any activation will cause an alarm, in particular, the
activation does not need to be present for a pulse duration.

When enabled, will cause the PIR to ignore the motion caused by small animals.

The PIR has 5 sensitivity settings. Select the lowest sensitivity when the
background light levels are changeable.

Magnetic contact

To program the attributes for a magnetic contact:

1. Select Configuration > Hardware > Wireless Settings.

WnPIN  Advanced

Wireless

Wireless - Enrolled Sensors List

“Total Wireless Active 3
‘Sensor D

1 2415084

Tye Zone Bartery Supervise. Signal Version

2
2

PIR 9pirt ok oK High 9) SW. (0820 HW.[3)

2 2414536

PIR 10PIR2 ok oK High 8) SW. (08201 HW.[4]

CACY -
NN :
o o [l

3 2418826

Magneic contact 11 ok oK - SW.[0113HW. 3]

e L ominensr 11

2. Click the Edit button beside the desired magnetic contact.

Hardware

System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Confroller X-BUS

Wireless

Edit wireless sensor

Sensor:
Description:
Sensor Type:

Zone:
Zone Type:
Area:

LED:
Internal Contact:

External Contact:

Side Window

I-‘

Magnetic contact

4 v
Alarm
Area 1 Area1 v

Disabled v

Enabled v

Disabled v

!

3. Program the attributes.

Programmable attributes for Magnetic contact

Sensor
Description

Sensor Type

The number of the sensor as enrolled on the system (1 = first, 2 = second, etc).

Text description of the sensor.

The type of wireless sensor detected (e.g. magnetic contact, PIR).
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Zone The zone number to which the sensor has been enrolled.

Zone Type The type of zone (e.g. Alarm, Entry/Exit).

Area Areas to which the zone is assigned.

LED When enabled, the LED will come on when the magnetic contact is activated.

Internal Contact When enabled, the intemal contact will contribute to activations.

External Contact When enabled, the external contact, connected via the sensor’s terminal block, will
contribute to activations.

17.9.2.3 WPAN personal alarm button

The WPAN personal alarm button is a device that is used to transmit Panic Alarm messages to the
SPC system.

The user can wear the WPAN in one or two ways:

« WPAN can be worn as a wrist watch (by inserting the wrist band into the two slits of the
appropriate ring holder).

« WPAN can be worn as a pendant by removing the wrist ring holder and replacing it with the
pendant ring holder.

Enrol a WPAN personal alarm button

To enrol the WPAN:
1. Inthe SPC browser, select Users > Wireless FOB.
2. Onthe WPAN, press and hold the centre button.

The LEDs on the fob light in the following pattern: Red lights for 3 seconds, then no LED, then
Red lights for 1 second, and then Green lights for 1 second.

3. Click Refresh on the Wireless FOB page to display the WPAN.

‘‘‘‘‘
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4. You can now assign the WPAN device to a system user.
To assign the WPAN to a user:
1. GotoUsers > Users and click the Edit button beside the user you want to assign the WPAN to.

2. Onthe Edit user settings page, click the Unknown Fob button.

A list of unassigned fobs is displayed.

nnnnnnnnnnn
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3. Click the Add button to assign the WPAN to the user.
4. Onthe Edit user settings page click Save.

Delete a WPAN personal alarm button

To delete the WPAN:

1. Goto Configuration > Hardware > Wireless > Transceiver list.

sssss

sssss
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2. Click the Delete button beside the WPAN you want to delete.
17.9.2.4 WRMT remote control

The WRMT 4-button Remote is a device which allows a user to remotely operate the SPC system. The
device supports UNSET, FULLSET, PARTSET functionality, as well as the operation of defined outputs
and an SOS feature.

6

1 Fullset
2 Partset
3 Unset
4 Output
5 Panic/SOS
6 LED
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Enrol a WRMT remote control

To enrol the WRMT:

1. Inthe SPC browser, select Users > Wireless FOB.

2. Onthe WRMT, press and hold both SOS buttons.
The LED blinks Red once and then Green.
3. Click Refresh on the Wireless FOB page to display the WRMT.
4. You can now assign the discovered WRMT to a system user.
To assign the WRMT to a user:
1. GotoUsers > Users and click the Edit button beside the user you want to assign the WRMT to.

2. Onthe Edit user settings page, click the Unknown Fob button.

A list of unassigned fobs is displayed.

@) communicatons

3. Click the Add button to assign the WRMT to the user.

4. Onthe Edit user settings page click Save.
Delete a WRMT remote control

To delete a WRMT:

1. Goto Configuration > Hardware > Wireless > Transceiver list.

ssssss
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2. Click the Delete button beside the WRMT that you want to delete.

When you delete a WRMT from your system, you must also clear the internal registration in the WRMT
before you can re-use the WRMT.
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To clear the internal registration:
o Onthe WRMT, press and hold the PARTSET and UNSET buttons.

The LED blinks Red and Orange to confirm that registration is cleared.
17.9.2.5 Changing wireless settings

To change wireless settings, select Configuration > Hardware > Wireless > Wireless Settings.

Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
Controller X-BUS
Wireless Settings

Wireless Settings

Two Way Wireless Enable if two way wireless transceiver is fitted.

Filter If checked then signals received with 0 signal strength will be disregarded
Detect RF JAM If checked then an alertis activated if RF interference is detected.
Wireless Lost Event I checked Wireless Lost event will be sent over CID/SIA and FlexC

Supervision ~

=
2
8

Two way Wireless Supervision time interval in minutes.

Antenna ‘Select which type of antenna is connected to the wirsless module

Missing Supervision Tamper enabled ‘Select whether missing supervision for a sensor will raise a zone tamper.
RF FOB SOS Select how the SOS buttons on the RF Fob should operate

'WPA Test Schedule

&

sl [g] 1P oy
SRS @
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Maximum period between WPA tests, days (0-365, 0 = WPA test disabled / not required).
Prevent Setting Time I sensor failed to report within this time, then setting will be prevented for the area the wireless zone is in, minutes (0 - 720, 0 = checking is disabled).

Device Lost Time

5
=
=

If wireless device (sensor or WPA) failed to report within this time, then it is reported as lost, minutes (20 - 720, 0 = checking is disabled).

See table below for further information.

Two Way Enable or disable two-way wireless depending on the transceiver you are using.

Wireless Enable two-way wireless if you are using SPCW120 Wireless Transceiver.

Disable two-way wireless if you are using SiWay RF Kit (SPCW110, 111, 112, 114).

Filter Click to filter low strength RF signals.

Detect RF Click to activate an alert if RF interference is detected.
JAM

Wireless Click to send Wireless Lost event over CID/SIA and FlexC.
Lost Event

Supervision Set the amount of time in minutes between occurrences of two way wireless signal supervision.

Antenna Select the type of antenna connected to the wireless module (internal or external) from the drop
down menu. The type of antenna required for the wireless module depends on the type of wireless
module fitted.

Missing Select whether a wireless sensor that is reported as missing registers a tamper condition on the
Supervision signet panel.

A wireless sensor is reported as missing when no supervision signal has been received from the
sensor for a period greater than the programmed Wireless Lost timer. See Timers on page 261.
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RF FOB Select how the SOS buttons on the RF Fob should operate.:
S0s « Disable
« Enable

« Enabled Silent
o User Medic

o UserHoldup

« RF Output
WPA Test Enter a maximum period (in days) between WPA tests.
Schedule'
Prevent Enter a time in minutes after which, if the sensor fails to report, a setting is prevented for an area
Setting where the wireless zone is.
Time This setting applies to the following intrusion zones only:
o Alarm
o Entry/Exit
o Exit Term
« Panic
« Holdup
o Tamper

« Lock Supervision

« Seismic

« AlIOK

« Setting Authorisation

« Lock Element

Device Lost Enter a number of minutes after which the wireless device (sensor or WPA) device is reported as
Time lost.

1A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114) only.

For CE regulatory compliance, the SPCW120 product is to be fitted to the following products only:
« SPC5330.320-L1
« SPC6330.320-L1
E « SPC4320.320-L1
« SPC5320.320-L1
« SPC5350.320-L1
« SPC6350.320-L1

17.10 Configuration

This section covers:

17.10.1 Configuring controller inputs and outputs ._..... .. ... ... 229
17.10.2 X-BUS L 238
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17.10.3 Changing system settings . ... ... . 252
17.10.4 Configuring zones, doors and areas ... ... ... ... ... .. ... 269
17.10.5 Calendars ... ... 284
17.10.6 Change owWn PIN L 287
17.10.7 Configuring advanced settings ... ... . ... ... . . 287

17.10.1 Configuring controller inputs and outputs

This section covers:

« Editing an input below
« Editing an output on page 231
« Configuring system latch and auto set outputs on page 236

« X10 Config - Settings on page 237

17.10.1.1 Editing an input

1. Select Configuration > Hardware > Controller.

The following page will be displayed.

Hardware System Inputs Qutputs Doors Areas Calendars Change own PIN Advanced
Controller X-BUS Wireless
Controller Input & Output
Input End of Line Zone Description Type Area Attributes
1 1 [Frant door | [Entry/Exct v llezzal
2 2 [Fire Ext | [Entrv/Exct v] il
3 3 Windiow 2 | [Alarm v sl
4 4 [PR1 | [Alarm vl sl
5 5 [PR2 | [Alam ] L]
8 6 [Fire Exit | [Fire Exi vl =
7 7 [Fire alam | [Fire V] =
8 ¢ [Panic Button | [Fanic v] (il
Qutput Description Type Change type Attributes Test
1 System - External Bell l:l l:l Cl:l
2 System - Internal Bell l:| l:l ‘3'|:|
3 System - Ext. Bell Strobe E I:l ‘?‘E
4 System - Fullset - _— o .|
. SySta Al | — o
[ System - Alarm Cenfirmed |:| l:l C'|:|
* 100%
2. Configure the fields as described in the table below.
Input The number is presented for reference and can not be programmed.
Endof Line Select the End of Line (EOL) for the zone input (default: 4K7).
Analyzed Displays if the sensor is an inertia/shock type sensor
Pulse Pulse count programmed on the panel that will trigger an alarm from an
count inertia/shock sensor.
Gross The Gross attack programmed on the panel that will trigger an alarm from an
Attack inertia/shock sensor
Zone Number of the zone on the panel
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Description Enter a text describing the input (max. 16 characters). This text will also appear
on the browser and keypad.

Type The type of zone (see Zone types on page 379).

Area Only if (multiple) Areas is activated in menu Panel Settings > System Settings
> Options. Select the areas to which this zone has been assigned.

Attributes  Aniconin this field indicates that attributes have been programmed for this zone
(see Input zones: attributes below).

Input zones: attributes

Each zone on the SPC can be assigned an attribute that determines the properties of that zone.

To assign an attribute to a zone:

1. Select Configuration > Hardware > Controller > Attributes.
The following page will be displayed:

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Controller X-BUS Wireless

Attributes - Zone 1

Attribute Description
O Exclude A If checked then an alarm will not be generated if that zone opens while the system is in the Pariset A mode.
O Exclude B If checked then an alarm will not be generated if that zone opens while the system is in the Partset B mode.
O Local If checked an alarm generated by the zone opening will MOT result in the reporting of the event.
O Chime If checked then opening that zone during the Unset mode will cause the internal buzzers to activate for a short period
il Inhibit If checked a user may inhibit this zone.
O Normal Open I checked the system expects that a connected defector/sensor is a Nermally Open device.
O Log If checked then all zone state changes are logged.
O Final Exit If checked then clesing that zone will terminate the exit fimer 6 seconds after all exit routes have been closed
O Shunt If checked then an active shunt zone will inhibit this zone.
O Frequent Zone must open within the ‘frequent time period’, for service purposes.
O Exit open If checked then zene will be indicated if open during setting
O Analyzed Select this option if Inertia sensor is used.
Pulse Count Pulse count trigger level for Analyzed inertia sensors
Gross attack Gross atiack trigger level for Analyzed inertia sensors
Calendar
Check if zone is limited by calendar
Verification
Check if input is to be included in a verification zone, and trigger audiofvideo verification.

2. Check the box beside the preferred attribute.

[

The attributes presented on this page will depend on the type of zone selected. For a list of
assignable attributes, see Applicable attributes to zone types on page 387.
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17.10.1.2 Editing an output

1. Select Configuration > Hardware > Controller.

Hardware

Controller

Input
1

L R T S )

=] [Z] [ ViR

E g

g
<1 1L €] €

Qutput

L

System

Inputs

X-BUS Wireless

Controller Input & Output

End of Line
Dusl 4K7 [ 4K7

Dual 4K7 [ 4K7
Dual 4K7 [ 4K7
Dual 4K7 | 4K7
Dual 4K7 [ 4K7
Dual 4K7 [ 4K7
Dual 4K7 [ 4K7
Dual 4K7 [ 4K7

xt. Bell

Strobe

larm

larm Confirmed

Outputs Doors Areas Calendars Change own PIN Advanced

Zone Description Type Area Attributes

1 |Frnnldnnr | [Entry/Exit v| l:l
2 |F\re Exit | [Entry/Exit v l:l
s [Window2 | e v i
. [PiR 1 | [Alam v sl
5 [FIRZ | [Alarm v ]
3 |F\re Exit | ‘F\re Exit V| l:l
7 |F\re alarm | [Fire v l:l
8 |Pan|c Button | [Panic V| l:l

Type Change type Attributes Test

System - External Bell l:l l:l Cl:l

System - Internal Bell l:| l:l @ |:|

System - Ext. Bell Strobe | — ® . ]

System - Fullset l:l l:l Cl:l

System - Alarm |:| l:l C|:|

System - Alarm Confirmed |:| l:l C|:|

#,100%

2. Configure the fields as described in the table below.

Output

Output

Description

Type

System Output: Select the type from the dropdown menu. (See Outputs
types and output ports on the facing page.)

Area Output: Only if (multiple) Areas is activated in menu Panel
Settings > System Settings > Options. Select an area and the type of
system output for this area. (See Outputs types and output ports on the
facing page.)

Zone Mapping: Select which zone should be mapped.
Mapping Gate: Select which mapping gate should be mapped.

Door Output: Select the door number and the type of system output for
the door. (See Outputs types and output ports on the facing page.)

Keyswitch: Select the node ID for the required keyswitch and the required
key position to map to this output.

Enter a text describing the output (max. 16 characters). This text will also

appear on the browser and keypad.

Configuration

Mode: Select the operational mode. Continuous follows output type;
Pulsed toggles on and off when output type is active; Momentary
generates a pulse when output type activates.

Retrigger: Tick the box to retrigger momentary outputs.

On Time: Enter the On time that applies to momentary and pulsed
outputs.

Off Time: Enter the Off time that applies to pulsed outputs.
Invert: Tick this box to invert the physical output.
Log: Tick this box to log the output state changes to the event log.

Calendar: Select if necessary the desired calendar. See Calendars on
page 284.
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See also
Calendars on page 284
Outputs types and output ports

Each output type can be assigned to one of the 6 physical output ports on the SPC controller or to an

output on one of the connected expanders. Output types that are not assigned to physical outputs act
as indicators of events on the system and may be logged and/or reported to remote central stations if
required.

The output ports on the expanders are all single pole relay type outputs (NO, COM, NC); therefore,
output devices may need external power sources to activate if they are wired to expander outputs.

The activation of a particular output type depends on the zone type (see Zone types on page 379) or
alert condition that triggered the activation. If multiple areas are defined on the system then the outputs
on the SPC are grouped into system outputs and area outputs; the system outputs are activated to
indicate a system wide event (for example, mains fault) whereas the area outputs indicate events
detected in one or more of the defined areas on the system. Each area has its own set of area outputs;
if the area is a common area for other areas, then its outputs will indicate the state of all the areas it is
common for, including its own state. For example, if Area 1 is common for Area 2 and 3, and Area 2
Ext. Bell is active, then the Area 1 Ext Bell output is also active.

(i

Some output types can only indicate system wide events (no specific area events). See the table
below for further information.

Output Type Description

External Be

External Be
Strobe

Internal Bell

Alarm

Alarm
Confirmed

Il This output type is used to activate the system external bell and is active when any Area External
Bell is active. By default, this output is assigned to the first output on the controller board (EXT+,
EXT-).

Note: An external bell output is automatically activated whenever a zone programmed as an
Alarm zone triggers an alarm in Fullset or Partset modes.

Il This output type is used to activate the strobe on the system external bell and is active when any
area strobe is active. By default, this output is assigned to the strobe relay output (Output 3) on
the Controller board (NO, COM, NC).

Note: An external bell strobe output is automatically activated whenever a zone programmed as
an alarm zone triggers an alarm in Fullset or Partset modes. The external bell strobe activates on
a 'Fail to Set’ condition if the strobe on the ’Fail to Set’ option is checked in system options.

This output type is used to activate the internal bell and is active when any area Internal Bell is
active. By default, this output is assigned to the second output on the controller board (INT+,
INT-).

Note: Aninternal bell output is automatically activated whenever a zone programmed as an Alarm
zone type triggers an alarm in Fullset or Partset modes. The internal Bell activates on a 'Fail to
Set’ condition if the Bell on the 'Fail to Set’ option is checked in system options.

This output turns on following alarm zone activation on the system or from any area defined on the
system.

This output turns on when an alarm has been confirmed. An alarm is confirmed when 2
independent zones on the system (or within the same Area) activate within a set time period).
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Battery Fault*

Partset A
Partset B
Fullset

Fail to set

Entry/Exit

Latch

Fire Exit
Chime

Smoke

Walk Test*

Auto Set

Output Type Description

Panic* This output turns on following activation of panic alarm zone types from any area. A panic alarm
output is also generated if a user duress event is generated or if the panic option for the keypad is
enabled.

Hold-up This output turns on whenever a zone programmed as a Hold-up type zone triggers an alarm from
any area.

Fire This output turns on following a fire zone activation on the system (or from any area).

Tamper This output turns on when a tamper condition is detected from any part of the system.
For a grade 3 system, if communication is lost to an XBUS device for greater than 100s, a tamper
is generated and SIA and CIR reported events will send a tamper.

Medical This output turns on when a medic zone is activated.

Fault This output turns on when a technical fault is detected.

Technical This output follows tech zone activity.

Mains Fault*  This output activates when Mains power is removed.

This output activates when there is a problem with the backup battery. If the battery voltage drops
below 11V this output activates. The 'Restore’ option for this fault is only presented when the
voltage level rises to above 11.8V.

This output is activated if the system or any area defined on the system is in Partset A mode.
This output is activated if the system or any area defined on the system is in Partset B mode.
This output is activated if the system is in Fullset mode.

This output activates if the system or any area defined on the system failed to set; it clears when
the alert is restored.

This output activates if an Entry/Exit type zone has been activated; that is, a system or area
Entry or Exit timeris running.

This output turns on as defined in the system latch output configuration (see Configuring system
latch and auto set outputs on page 236).

This output can be used to reset latching sensors as smoke or inertia sensors.
This output turns ON if any Fire-X zones on the system are activated.
This output turns on momentarily when any zone on the system with chime attribute opens.

This output turns on momentarily( 3 seconds) when a user unsets the system; it can be used to
reset smoke detectors .

The output will also activate when the zone is restored.

When using the zone to reset latched smoke detectors the first code entry will not activate the
smoke output but will silence bells, on the next code entry if the fire zone is in the open state the
smoke output will activate momentarily. This process is repeatable until the fire zone is closed.

This output turns on momentarily when a walk test is operational and a zone becomes active.
This output can be used, for example, to activate functional tests of connected detectors (if
available).

This output turns on if the Auto Set feature has been activated on the system.
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Output Type

Description

User Duress

PIR Masked

Zone Omitted

Fail to
Communicate

Man Down
Test

Unset

Alarm Abort

Seismic Test

Local Alarm
RF Output

Modem 1 Line
Fault

Modem 1
Failure

Modem 2 Line
Fault

Modem 2
Failure

Battery Low
Entry Status

Warning
Status

This output turns on if a user duress state has been activated (PIN code + 1 has been entered on
the keypad).

This output turns on if there are any masked PIR zones on the system. It generates a fault output
on the keypad led.

This output is latched so it will remain active until restored by a level 2 user.

PIR Masking is logged by default. The number of log entries do not exceed 8 between arming
periods.

This output turns on if there are any inhibited, isolated, or walk test zones on the system.

This output turns on if there is a failure to communicate to the central station.

This output turns on a ‘Man Down’ wireless device which is activated during a ‘Man Down’ test.

This output is activated if the system is in Unset mode.

This output activates if an alarm abort event occurs, that is, when a valid user code is entered via
the keypad after a confirmed or unconfirmed alarm. It is used, for example, with external dialers
(SIA, CID, FF).

This output is used to activate a manual or automatic test on a seismic zone. Seismic sensors
have a small vibrator that will be attached to the same wall as the sensor and is wired to an output
on the panel or one of its expanders. During the test, the panel waits up to 30 seconds for the
seismic zone to open. If it does not open, the test fails. If it opens within 30 seconds the panel
then waits for the zone to close within 10 seconds. If that doesn’t happen, the test fails. The panel
then waits a further 2 seconds before reporting the test result. The result of the test, either manual
or automatic, is stored in the system event log.

This output activates on alocal intrusion alarm.

This output activates when a Fob or WPA' button is pressed.

This output activates when there is a line fault on the primary modem.

This output activates when the primary modem fails.

This output activates when there is a line fault on the secondary modem.

This output activates when the secondary modem fails.

This output activates when the battery is low.

This output activates if an ‘All Okay’ entry procedure is implemented and there is no alarm
generated, that is, the ‘All Okay’ button is pressed within the configured time after the user code is
entered.

This output activates if an ‘All Okay’ entry procedure is implemented and a silent alarm generated,
that is, the ‘All Okay’ button is not pressed within the configured time after the user code is
entered.
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Blockschloss
1

Blockschloss
2

Lock Element

Unlock
Element

Code Tamper
Trouble
Ethernet Link
Network Fault

Glass Reset

Confirmed
holdup

Full Engineer

Output Type Description

Ready to Set  This output activates when an area is ready to set.

Setting ACK  This output signals the setting status. The output toggles for 3 seconds to signal that the setting
has failed. The output remains on for 3 seconds if setting is successful.

Fullset Done  This output activates for 3 seconds to signal that the system has been fullest.

Used for normal Blockschloss devices.

When all zones in an area are closed, and there are no pending faults, the ‘Blockschloss 1‘ output
is activated. If the lock on the Blockschloss is closed, a ‘Keyarm® input is activated, the relevant
area is set and the ‘Setting Ack’ output is activated for 3 seconds to signal that the setting was
successful. ‘Blockschloss 1‘is not deactivated.

If the Blockschloss is unlocked, the Blockschloss device deactivates the Keyarm input to the
unset state (closed) and the area is unset. ‘Blockschloss 1‘is then deactivated.

Used for Blockschloss device type - Bosch Blockschloss, Sigmalock Plus, E4.03.

When all zones in an area are closed, and there are no pending faults, the ‘Blockschloss 2‘ output
is activated. If the lock on the Blockschloss is closed, a ‘Keyarm* input is activated, the relevant
area is set and the ‘Setting Ack’ output is activated for 3 seconds to signal that the setting was
successful. ‘Blockschloss 2 is then deactivated.

If the Blockschloss is unlocked, the Keyarm zone is switched to unset (closed) and the area is
unset. ‘Blockschloss 2 is activated (if area is ready to set).

Activates if the Lock Element is in the ‘locked’ position.

Activates if the Lock Element is in the ‘unlocked’ position.

Activates if there is a code tamper in the area. Clears when state is reset.
Activates if any zone is in trouble state.

Activates if there is a fault on the Ethernet link.

Activates if there is an EDP communications fault.

Used to switch on the power for the glassbreak interface module and to remove power in order to
reset the device. The output is reset if a user enters their code, the zone is not in the closed state,
and the bells deactivated.

Activates in the following scenarios for PD6662 compliance:
« two hold-up zone activations more than two minutes apart
« ahold-up zone and a panic zone activation more than two minutes apart

« ahold-up zone and a tamper zone or a panic zone and a tamper zone activation occurs within
the two minute period

Activates if an engineer is on site and the system is in full engineer mode.

* This output type can only indicate system wide events (no area specific events).
1A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

See also

Configuring system latch and auto set outputs on the facing page
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17.10.1.3 Configuring system latch and auto set outputs
1. Under Policy, click the Edit button for the Output Configuration option in System Options.

The following page is displayed:

Hardware System Inputs QOutputs Doors Areas Calendars Change own PIN Advanced
System Options System Timers Identification Standards Clock Language

Latch Output Configuration

Entry Time Turns on at end of exit time and off at beginning of entry time

Fire Exit O Turns on if any Fire X zones are active

Unset O Turns on if user Unsets systems, momentary

Alarm Reset O Turns on when an alarm is reset , momentary

Resetting Alarm O Turns on during setting procedure if glass break fsmoke open and not in alarm

Engineer Exit O Turns on when engineer leaves engineer mode, momentary

Keypad valid PIN O Valid user code entered on keypad and fire zone active

Auto Set Output Configuration

Cn (@) Output will remain on if auto set active

Keypad () Output will follow keypad operation

Progressive (") Output will give progressive warning of auto set

Pulse Time 5 Duration Auto Set output will remain active when pulsed (in 100ms increments)

2. Select the condition under which the latch output is activated:

Entry Time Output turns on at the end of Exit time and off at the beginning of Entry
time.

Fire Exit Output turns on if any fire exit zones are active.

Unset Output turns on if any user unsets system momentary

Alarm Reset Output turns on if an alarm is reset momentary.

Resetting Output turns on during a setting procedure if glass break/smoke open and
Alarm not in alarm.

Engineer Exit ~ Output turns on when an engineer exits from Engineer mode momentary.

Keypad Valid  Output turns on when valid user PIN entered on keypad and fire zone is
PIN active

3. Select the behavior of the output.

On Output will remain on if auto set is active.
Keypad Output will follow keypad operation.
Progressive  Output will give progressive warning of auto set.

Pulse Time  Select the duration that the auto set output will remain active when pulsed.
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17.10.1.4 X10 Config - Settings

The X10 settings page allows you to configure the operation of X10 on the panel.

1.

o & w0 D

Select Configuration > Outputs > X-10.
The following page will be displayed:

Hardware Systemn Inputs Outputs Doors 5 Calendars Change own FIN Advanced

Outputs

X-10 Settings
Enable: [ cCheck to enable X-10
Log: [ Check to log X-10 commands

Activate the checkbox Enable to enable X10 operation on the panel.
Activate the checkbox Log to enable logging of all X10 events on the panel.
Click Save.

Click an alphabetic tab (A-P) to program X10 device triggers.

A list of programmable device triggers (1—16) will be presented for that alphabetic character.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Outputs

Select House |:|
Unit Active Description Triggers Quick Key Test
1 o L 1
2 O 1
3 a 1
4 ] L 1
5 a 1 Edit
8 | L 1
7 o I
8 ] L 1 Edit
9 a 1
10 ] L ]
i o ]
2 a L 1 Edit
Unit This is the number (1-16) that is assigned to the device.
number
Active This field indicates if the device is active or not.

Description This field displays a description that is used to help identify the device —for
example, downstairs light (16 characters max).

Quick key  This field indicates if the X10 device activation can be toggled by entering a code
from the keypad.
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To edit a X-10 device
1. Click Edit.
The following page will be displayed:

Hardware System Inputs QOutputs Doors Calendars Change own PIN Advanced
Outputs
® Trigger On 'Q'Tri gger Off
Trigger Edge Trigger Edge

2. For further programming, see Triggers on page 288.

17.10.2 X-BUS

This section covers:

« Expanders below

« Keypads on page 244

« Door Controllers on page 249

« Cable Map on page 251

« Settings on page 251
17.10.2.1 Expanders

1. Select Configuration > Hardware > X-Bus > Expanders.

The following page will be displayed:

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Controller Wireless.

Expanders

Configured Expanders

1D Description Status  Type SIN Version Reader Wireless PSU
1 IND1 Online  Indicator [1 Input] 223387801 1.03 [13MAR13] EM4100 Not Fitted Not Fitted
2 Ksw2 Online  Keyswitch [1 Output] 226593801 1.01 [11NOV10] Not Fitted Not Fitted Not Fitted
3 103 Online 10 [8 Output] 443907 1.1 [07TAUG13] Not Fitted Not Fitted Not Fitted
4 I0A4 Online  1/0 Analyzed [8 Input / 2 Outpuf] 185074801 2.00 [09Apr14] Not Fitted Not Fitted Not Fitted
5 WIR5 Online  Wireless 488907 1.1 [07TAUG13] Not Fitted Siway - V5 Not Fitted
6 AEXS6 Online  Audio [4 Input / 1 Outpuf] 37070907 1.03 [13MAR13] Not Fitted Not Fitted Not Fitted
7 AEX7 Online  Audio [4 Input] 1434900 1.03 [13MAR13] Not Fitted Not Fitted Not Fitted
8 og Online 11O [8 Input / 2 Output] 11327907 1.1 [07TAUG13] Not Fitted Mot Fitted Type 1-V4

For naming and identifying:

In loop configuration, each expander is numbered consecutively from the first
(expander connected to the 1A 1B on the controller) to the last (expander
connected to the 2A 2B on the controller).

L]

Example for SPC63xx: Expanders, when numbered 1 through 63, are
allocated zones (in groupings of 8) in subsequent identities of 1 to 512 (the
greatest number in zone identification is 512). Therefore, any expander named
or identified by a number greater than 63 has no allocated zones.

2. Click one of the expander identifying parameters to display the Expander Configuration page.
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Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Controller Wireless

Expanders

Expander Configuration
Expander ID 8
Type 1/0 [ Input/ 2 Output]
SIN 11327907
Description
Input End of Line Zone Description Type Area Attributes
: s \ [Unussd v [ibaring v [ ]
2 s \ = v [haieing > [ o]
3 N \ (nused v [Wereing ] [ ]
4 68 [ | [Unused v [T Marketing V| =
5 69 [ | [Unused v [1: Marketing — v/] ]
[ 70 [ | [Unused v [1:Marketing  v] ]
7 7 Unused v 1 Merketing ¥ ]
s 72 \ \ [Unused v i v ]
Output Description Type Change type Aftributes Test
1 L ] Disabied = sl e
2 ] Disatied = il [P
Configure the following fields:
Description  For appearance on device LEDs.
Volume Audio Expander Only: Speaker volume for the Audio Expander and satellites
Limit (WAC 11). They are all wired in parallel. Note that the speaker on WAC 11 has a

potentiometer for fine-tuning the volume. Range is 0 min — 7 max or disabled.

Auxillary Audio Expander Only: This option should be enabled if satellites (WAC11) are
Channnel connected to this expander.

Note: This option, if enabled, powers the satellite microphones. The satellite
speakers are always enabled regardless of this setting.

End Of Line  Select the correct End of Line (default: DEOL 4K7). This setting should match
the actual wiring of the input on the controller or expander. See Wiring the
system on page 75.

(Zone) Provide a description for allocated zone.
Description

(Zone) Type Select the zone type. See Zone attributes on page 384.

Area Select the area.

Attributes Assign attributes as desired. See Zone types on page 379.
Outputs/PSU outputs (Displayed for the SPCP355.300 Smart PSU ONLY)

Output The numbered output. The value in parentheses corresponds to the physical
output on the PSU board.

Description  Provide description for output.

Change Change the type of output as necessary.
type

Attributes Assign attributes to the output.

Test Test the output.
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Output Select which outputs are to be monitored.

monitor Note: The parallel resistor, diode and required load must be applied before

enabling this option. The SPCP355.300 must perform a calibration before
monitoring starts. See Supervised Outputs on page 59 for more information.

Primary Tick this box if there is no secondary battery connected to the PSU
battery only

When expanders are added or removed go to Configuration > Hardware > X-BUS > Cable Map &
Configuration.

Click Reconfigure to implement changes.

When you click Proceed Reconfiguration, the whole X-BUS is reconfigured. If an expander is
offline and the reconfigure button is pressed, the expander will disappear without notifying the
user.

| []

Reconfiguring the X-BUS

1. Select Configuration > Hardware > X-BUS > Cable Map & Configuration.
2. Click Reconfigure.
The X-Bus cable Map — Warning(s) page displays.

Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
Controller
Cable Map & Configuration

X-Bus cable Map - Warning(s)

Once ‘Proceed Reconfiguration® button is pressed ‘Unconfigured’ nodes will get configured automatically and any ‘Offline’ nodes will be removed from the list or if it
returns online it will get displayed as 'Active’ under CGable map list

Channel 1

Position D Status Type S/N Description

None

Channel 2

Position ()] Staws Type SIN Description
None

m Proceed Reconfiguration

3. Click Proceed Reconfiguration.
The X-BUS is reconfigured.

If an expander is offline and the reconfigure button is pressed, the expander will disappear
without notifying the user.

See also
« Wiring the system on page 75
« Zone attributes on page 384

« Zone types on page 379
Configuring an Indicator Expander

There are 2 possible configuration modes for the indication expander:
« Linked Mode
« Flexible Mode
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1. Select Configuration > Hardware > X-Bus > Expanders.

2. Click one of the indicator identifying parameters.

The following page is displayed for Linked Mode configuration.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Controller Wireless
Expanders
Expander Configuration
Expander ID 1
Type Indicator [1 Inpuf]
SIN 223357301
Description Enter description of module
Keypad Check if medule should be limited to a valid PIN entered on a keypad.
Key 1 Select the area that key should be operating.
Key 2 Select the area that key should be operating.
Key 3 Select the area that key should be operating
Key 4 Select the area that key should be operating.
LED Always O Check if LED indicators should be active when keys are deactivated.
Input End of Line Zone Description Type Area Attributes
1 E b |Zone 9 [Alarm b [1: Marketing ~ v] l:l
| Save || Back || Flexible mode |

Linked Mode
1. Enter a description.
2. Select if indicator module should be limited to a valid code entered on a keypad.
3. Select the areas that are to be controlled by the 4 functions keys.
4. Configure the input.
Flexible Mode
1. Click the Flexible Mode button.

2. Configure the fields described in the table below.

Function Keys

Area Select the area is to be controlled by the function key.

Function Select the function to be performed by this key in this area.

Area Select an area if the indicator module is located in a secure area.

Visual Indication

Indicator  There are 8 indicators/LEDs on the right and 8 indicators/LEDs on the left side.
Function The function that is indicated by this LED.

Function Select the colour and the state for every indicator if the selected function is ON.

On
Function Select the colour and the state for every indicator if the selected function is OFF.
Off
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Change Click this button to change the function for this indicator. The function can be
function enabled or used for a system, area, zone or keyswitch.

Audible Indications

Alarms Select if the alarms should be audible.

Entry/Exit  Select if entry/exit should be audible.

Key press  Select if keypress should be audible.

Deactivation

Calendar  Select if indicator expander should be limited by calendar.

Mapping Select if indicator module should be limited by a mapping gate.
gate

Keyswitch Select if indication module should be limited by a keyswitch.

Keypad Select if indicator module should be limited to a valid PIN entered on a keypad.
(see warning above)

Card Select if indicator module should not be activated until a valid card/fob is
reader presented to the built-in card reader.

3. Configure the input.

WARNING: Your system will not comply with EN standards if you enable a function key to set the
system without a valid PIN being required.

Configuring a Keyswitch Expander

1.

Select Settings > X-Bus > Expanders.

2. Click one of the keyswitch identifying parameters.
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The following dialog is displayed.

Hardware

System

Inputs

Controller Wireless

Outputs

Doors Areas Calendars Change own PIN Advanced

Expanders
Expander Configuration

Keyswitch Options

Mapping gate

output

Output Description

i L 1

Keyswitch Functions

Key Area

Center position | 1: Marketing N
Right Position | 1: Marketing ~
1: Marketing hd

Left Position

Expander ID 2

Type Keyswitch

S/N 226593801

Description Enter description of medule.

Latch O Check if key position should be latched
Latch Timer El Enter duration of latch in seconds. (0 - 9999, 0 = latch lasts until key reactivates same position or is turned to other position).
Areas
Location Select secured area where the keyswitch is located
Visual Indications
Indicator Function Function On Function OFff
Left Disabled
Right Disatled
Deactivation
Calendar Check if module should be limited by calendar.

Check if module should be limited by a mapping gate.

Type Change type Attributes Test
Disabled l:l l:l ﬂl:l
Function

Configure the fields described in the tables below.

Description
Key Options
Latch

Latch timer

Areas

Location

Visual Indications
Indicator/LED
Function

Function On

Function Off

Enter a description for the keyswitch expander.

Select if key position should be latched.

Enter duration of latch in seconds (0-9999, 0 means latch lasts until key is
turned the other way).

Select the area where the keyswitch is located.

There is 1 indicator/LED on the right and 1 indicator/LED on the left side.
The function for this indicator/LED.

Select the colour and the state for every indicator if the selected function is
ON.

Select the colour and the state for every indicator if the selected function is
OFF.
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Change function  Click this button to change the function for this indicator. The function can
be enabled or used for a system, area, zone or keyswitch.

Deactivation

Calendar Select if the keyswitch module should be limited by calendar.

Mapping gate Select if the keyswitch module should be limited by a mapping gate.
Output

Output x Configure and text the outputs for the keyswitch. See Editing an output on

page 231 for more details.
Keyswitch Functions

Centre, Right and  Select the Function that that this keyswitch position will perform and the
Left Positions relevant Area.

Keyswitch functions are:

« None

o Unset

o PartsetA

o PartsetB

« Fullset

« Toggle Unset / Fullset

« Toggle Unset / Partset A
« Toggle Unset/ Partset B
« All Okay

« Setting authorisation

o Shunt

\ WARNING: Your system will not comply with EN standards if you enable a keyswitch function to
set the system without a valid PIN being required.

17.10.2.2 Keypads
Editing a Standard Keypad

1. Select Configuration > Hardware > X-Bus > Keypads.

2. Click one of the standard keypad identifying parameters.
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Hardware System Inputs Qutputs Doors
Controller Wireless
Keypads
Keypad Configuration
Keypad ID 1
SiN 559907
Description

Function Keys (in idle state)

Calendars Advanced

Change own PIN

Enter keypad description.

Panic Disabled v Panic alarm by pressing the two Soft keys together.
Verification
Verification Verification will be triggered on keypad for duress or alert activated from keypad
Visual indications
Backlight On when key is pressed v Select keypad LCD backlight option.
Indicators i) Enable visible indicators (LED's).
Setting State ] Check if sefting state should be indicated in idle mode (LED).
Audible Indications
Buzzer =] Enable keypad buzzer
Partset buzzer O Enabling will sound exit fimer during Partset
Keypress O Check if keypress should be audible.
Deactivation
Calendar Check if keypad should be limited by calendar.
Mapping gate Check if keypad should be limited by a mapping gate.
Keyswitch Check if keypad should be limited by a keyswitch.
PACE Entry ] Disable keys during entry time.
Areas
Location 1: Marketing v Select secured area where the keypad is located.
Areas Select which areas can be controlled through keypad

[ 1: Marketing ] % Finance 5: Meeting Room

[+ 2: Reception W] 4: Cafeteria
Options
Delay Fullset O Will use exit timer across all area

3. Configure the fields as described in the table below.

Description Enter a unique description to identify the keypad.

Function Keys (in idle state)

Panic

Select Enable, Disable or Enabled Silent. If enabled, panic alarm is activated by

pressing the 2 soft keys together.

Verification

events are activated.
Visual Indications

Backlight
Always on; Always off.

Indicators

If you assign a verification zone to the keypad, when a panic alarm is triggered by
pressing 2 soft keys together or by entering a duress code, audio and video

Select when keypad backlight is on. Options are: On after key is pressed;

Enable or disable the LED’s on the keypad.
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Setting Select if setting state should be indicated in idle mode.
state

Audible Indications

Buzzer Enable or disable the buzzer on the keypad.
Partset Enable or disable buzzer during exit time on Partset.
Buzzer

Keypress Select if the speaker volume for the key presses should be activated.
Deactivation
Calendar Select if the keypad should be limited by calendar. See Calendars on page 284.

Mapping Select if keypad should be limited by a mapping gate.
gate

Keyswitch  Select if keypad should be limited by a keyswitch.

PACE Tick this box to disable the keys on the keypad during the entry time when a
Entry PACE is configured on the keypad.

Areas

Location Select the secured area where the keypad is located.

Areas Select which areas can be controlled through keypad.

Options

Delay Select to configure a delayed set across all keypads. The location of the keypad
Fullset is ignored and all areas will perform a full exit time count down.

NOTICE: An area should be assigned to a keypad only if the keypad is inside the assigned area,
o and if an entry/exit route is defined. If an area is assigned, when the particular area is set or unset
| l then entry and exit timers are used (if configured). Other features related to entry/exit routes also
become available. If no area is assigned, the area is set or unset immediately and other entry/exit
features are not available.

See also

Calendars on page 284
Editing a Comfort Keypad

1. Select Configuration > Hardware > X-Bus > Keypads.

2. Click one of the comfort keypad identifying parameters.
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Hardware Inputs Outputs Doors < Calendars

Change own PIN Advanced

Controller X-BUS Wireless
S Keypads
Keypad Configuration
Keypad ID
SIN
Description

Function Keys (in idle state)
Panic

Fire

Medical

Fullset

Partset A

Partset B

Verification

Verification

Visual Indications
Backlight

Backlight Intensity
Indicators

Setting State

Logo

Analog Clock
Emergency Keys

Direct Set

Audible Indications
Alarms

Entry/Exit

Chime

Keypress

Voice Annunciation

Partset buzzer

Deactivation

Calendar
Mapping gate
Keyswitch

PACE Entry

Areas

Location

Areas

Options

Delay Fullset

[§]

227361801

CKP 2

Enabled {Silent) v

Unassigned W

I Oooooao

[On when key is pressed V|

8 -High v

Centred v

Disabled v

None
None W

None

g O O raf fen) o) fon O & O 0«
i
H < < 1<l 1] 1«

<

N

Enter keypad descripfion

Panic alarm by pressing function keys F1 and F2 together
Fire alarm by pressing function keys F2 and F3 together.
Medical alarm by pressing function keys F3 and F4 togsther.
Fullset by pressing function key F2 twice.

Partset A by pressing function key F3 twice.

Partset B by pressing function key F4 twice.

Verification will be triggered on keypad for duress or alert activated from keypad

Select keypad LCD backlight option.

Select intensity of keypad backlight.

Enable visible indicators (LED's).

Check if setting state should be indicated in idle mode (LED).
Check if logo should be visible in idle mode.

Analog clock visible in idle mode.

Check if Panic / Fire f Medical function keys should be indicated.

Check if the Fullset/ Partset function keys should be indicated.

Select speaker volume for alarm indications
Select speaker volume for entry & exit indications.
Select speaker volume for chime.

Select speaker volume for key presses.

Select speaker volume for voice annunciation

Enabling will sound exit timer during Partset

Check if keypad should be limited by calendar.
Check if keypad should be limited by 8 mapping gate.
Check if keypad should be limited by a keyswitch.

Disable keys during entry time.

Select secured area where the keypad is located.

Select which areas can be controlled through keypad.

[l 1: Marketing
[¥ 2: Reception

|

] 3: Finance
] 4: Cafeteria

R 5: Meeting Room

Will use exit timer across all area
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3. Configure the fields as described in the table below.

Description  Enter a unique description to identify the keypad.
Function Keys (in idle state)

Panic Select Enable, Disable or Enabled Silent. If enabled, panic alarm is
activated by pressing F1 and F2 soft keys together.

Fire Enable to allow fire alarm to be activated by pressing F2 and F3 soft keys
together.

Medical Enable to allow medical alarm to be activated by pressing F3 and F4 soft
keys together.

Fullset Enable to allow Fullset to be activated by pressing F2 key twice.

Partset A Enable to allow Partset A to be activated by pressing F3 key twice.
Partset B Enable to allow Partset B to be activated by pressing F4 key twice.
Visual indications

Backlight Select when keypad backlight is on. Options are: On after key is pressed;
Always on; Always off.

Backlight Select the intensity of illumination of the backlight. Range 1-8 (High).
Intensity

Indicators Enable or disable the LED’s on the keypad.
Setting state  Enable if setting state should be indicated in idle mode. (LED)
Logo Enable if logo should be visible in idle mode.

Analog Clock Select position of clock if visible in idle mode. Options are Left Aligned,
Center Aligned, Right Aligned or Disabled.

Emergency  Enable if Panic, Fire and Medical function keys should be indicated in the
Keys LCD display.

Direct Set Enable if Fullset/Partset function keys should be indicated in the LCD
display.

HumanIcon Enable if Mapping Gate should be indicated.
Audible indications
Alarms Select speaker volume for alarm indications or disable sound.

Entry/Exit Range is 0—7 (Max volume)

Chime Select speaker volume for entry and exit indications or disable sound.
Keypress Range is 0—7 (Max volume)
Voice Select speaker volume for chime or disable sound.

Annunciation

Partset Range is 0—7 (Max volume)
Buzzer
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Quiet Mode  Enable this setting to disable the buzzer during entry and exit when the
keypad is in an armed area.

NOTE: Keypad only audible for entry/exit/setting/unsetting if the area is the
same as the keypad location, or if the keypad is performing the operation.

Deactivation

Calendar Select if the keypad should be limited by calendar. See Calendars on
page 284.

Mapping gate Select if keypad should be limited by a mapping gate.
Keyswitch Select if keypad should be limited by a keyswitch.

PACE Entry  Tick this box to disable the keys on the keypad during the entry time when a
PACE is configured on the keypad.

Areas

Location Select the secured area where the keypad is located.
Areas Select which areas can be controlled through keypad.
Options

Delay Fullset Select to configure a delayed set across all keypads. The location of the
keypad is ignored and all areas will perform a full exit time count down.

Keypad Select keypad access level (1 to 3).
Access Level 1 — All functions
Level

Level 2— Arm, disarm, and restore only

Level 3—View only

NOTICE: An area should be assigned to a keypad only if the keypad is inside the assigned area, and
. if an entry/exit route is defined. If an area is assigned, when the particular area is set or unset then
| 1 entry and exit timers are used (if configured). Other features related to entry/exit routes also become
available. If no area is assigned, the area is set or unset immediately and other entry/exit features are
not available.

17.10.2.3 Door Controllers
Editing a door controller

1. Select Configuration > Hardware > X-Bus > Door Controllers.

2. Click one of the blue marked data (for example, serial number).
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Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Controller Wireless
Door Controllers

Door controller configuration

Expander ID 1

Type DC-2 [4 Input / 2 Outpuf]

SIN 195309801

Description DC21

Door 101 )
Door 102 )
Reader 1 (**) ARE18X L
Reader 2 (*%) ARB18X b

(*) Selecting ‘Zones / Outputs' makes a door unassigned. Making door 2 of a door controller unassigned means it is now the exit reader for door 1.

(**) Defines the behaviour of the reader functienality and indicators. Profile 3 + 4 should be used with HID readers with PIN that sends the PIN with a pre-defined site code.

Save Back

3. Configure the fields as described in the table below.

[

For naming and identifying:

In loop configuration, each expander is numbered consecutively from the first (expander
connected to the 1A 1B on the controller) to the last (expander connected to the 2A 2B on the
controller).

Example for SPC63xx: Expanders, when numbered 1 through 63, are allocated zones (in
groupings of 8) in subsequent identities of 1 to 512 (the greatest number in zone identification is
512). Therefore, any expander named or identified by a number greater than 63 has no allocated
zones.

Expander
ID

Type
S/N
Description

Door /O 1

Door1/O 2

Profile 1
Profile 2
Profile 3

Profile 4

Profile 5

ID of the door controller set with the rotary switches.

Type of the door controller.
Serial number of the door controller.
Description of the door controller.

« Ifadooris assigned to the door I/O, select the corresponding door number. If the two inputs
and outputs are configurable, select Zones/Outputs.

« If adoor number is selected for the door I/O, the door settings can be changed by clicking on
the edit button. This is equal to Settings > Doors.

« If Zones/Options is selected, the two zones and the one output can be configured by
clicking the edit button.

For readers with a green and ared LED.
For VANDERBILT readers with a yellow LED (AR618X).

Profile 3 is used with HID readers that send a PIN to the panel as a card reading with a predefined
site code (0)

Profile 4 is used with HID readers that send a PIN to the panel as a card reading with a predefined
site code (255).

Select to enable Sesam readers. It is also recommended that you select the Override Reader
Profile option to provide feedback on the setting process.
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Editing Zones/Outputs for a Door I/0
1. Select a Zone/Output for the door I/0.
2. Click the Edit button.

3. The 2inputs and the output belonging to this door I/O can be configured as normal door inputs and
outputs. See Editing a door on page 278.

4. Inorderto use the inputs, they have to be assigned to a zone number.
17.10.2.4 Cable Map
For a list of the expanders/keypads in the order they are configured on the SPC system:
« Select Configuration > Hardware > X-BUS > Cable Map & Configuration.
The following page will be displayed:

Hardware System Inputs Quiputs Areas Calendars Change own PIN Advanced
Controller
Cable Map & Configuration

X-Bus Cable Map Summary

X-BUS Cable Map

Position 0] Status Type SIN Description

1 | 1 Active SPCK52x Keypad 387796907 52x 1

2 | 2 ‘ Active | VO [8 Input/ 2 Output] | 23657907 ‘ 102 |
. . . . . .
l For more detail on X-BUS interfacing, see Wiring the X-BUS interface on page 75.

17.10.2.5 Settings
To configure X-BUS connections:
1. Select Configuration > Hardware >X-BUS > X-Bus Settings.
The following page will be displayed.

Hardware System Inputs Ouiputs Areas Calendars Change own PIN Advanced

Controller
X-Bus Settings

X-BUS Serttings

Addressing Mode ® Manual - Use switches on expandersikeypads to assign Id
Automatic - 1D will be assigned automatically {required for expanders without Id switches)

X-BUS Type ® Loop
Spur

Retries 25 Number of attempted retransmissions in case of interference. (Defaultis 25).

Comms timer 10 Number of seconds that interconnect interference must be present before alert is triggered, (Defaultis 10).

Save

2. Configure the fields as described in the table below.

Addressing Select if expanders/keypads are either manually or automatically addressed on
Mode the X-BUS.
X-BUS Select Loop or Spur configuration.
Type
Retries The number of times the system attempts to re-transmit data on the X-BUS
interface before a communications fault is generated. (1-99: default is 25)
Comms The length of time before a communication fault is recorded.
Timer
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17.10.3 Changing system settings

This section covers:
« Options below
« Timers on page 261
« Identification on page 266
« Standards on page 266
« Clock on page 268
« Language on page 269
17.10.3.1 Options
1. Select Configuration > System > System Options.
2. Configure the fields as described in the table below.

System Options

| i The options displayed vary depending on the Security Grade of the system.

Restriction Sys_tem Description
Option
General Settings
Areas Select to enable multiple areas on the system.

Note: This option is displayed for the Domestic and Commercial installation
types, only.

Code Restore  Grade 3 only: A user, who does not have the right to restore an alarm, is able to
restore the alarm with this feature. On resetting an alarm, a 6 digit code is
required. The user must call the installer to generate a restore code, with which
the user is able to restore the alarm.

Offline Tamper  Enable this for offline expander zones to generate a zone tamper.
Keyfob Restore If enabled, key fob is enabled to restore alerts by pressing the Unset key.

Web only Audio Expander If enabled, audio expander will not turn on LED when microphone active.
LED

Report in Eng If enabled, the panel will always report alarm activations and panic alarms.
mode

Outputs inEng  If selected, the following are not deactivated in Full Engineer mode:
Mode « Controller outputs
« Expander outputs
« Indicator LEDs

« Keyswitch LEDs
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Reader Profile

Silence Audio
Verification

Watchdog
Output Mode

SPCP355

Bell on Fail to
Set (FTS)

Strobe on Fail
to Set (FTS)

Restriction Sys.t em Description
Option
Alarm on If a ‘Fail to Communicate® alert is raised, external bells will activate.
Reporting Fail
Retrigger If enabled, duress alarm will retrigger.
Duress
Retrigger Panic  If enabled, panic alarm will retrigger.
Override If enabled, the LED behavior of readers will be controlled by the panel.

If enabled, then the internal and external bells (system and area), the keypad
buzzers and annunciation messages on the Comfort Keypad will be silenced
during audio verification.

Enables output 6 on the SPC controller board to be used for monitoring
purposes. The following modes of operation of the watchdog output can be
selected:

« Disable — Output 6 is available as a general purpose output.

« Enabled — Output 6 is normally OFF but is turned ON when a watchdog
fault occurs.

o Pulsed — Output 6 is PULSED at 100ms intervals.

« Enabled Inverted — Output 6 is normally ON but is turned OFF when a
watchdog fault occurs.

The following options combine the Enabled option with hardware-fault reporting
in the event of a main microprocessor failure. If such a failure occurs, a SIA
event is sent to ARCA1.

Note: The ARC must be configured to use SIA and SIA Extended 1 or 2. CID
and FF are not supported by this reporting method.

« Enabled + Reporting (10s) — The failure event is sent to ARC1 10
seconds after the fault is detected. This option must be used to comply
with VdS 2252.

« Enabled +Reporting (60s) — The failure event is sent to ARC1 60 seconds
after the fault is detected.

The SIA event reported is HF and Extended SIA reports Hardware Fault.

Note: Hardware faults are not reported if the Engineer is logged in to the
system.

For more information on ARCs, see Alarm Reporting Centres (ARCs) on
page 324.

Enable VdS power supply.

For VdS installations, this option is automatically selected.

Enable to activate the internal bell if the system fails to set.

Enable to activate the strobe if the system fails to set.
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@

Web Only

Bell Retrigger

Alert Forbid Set

Restore on
Unset

Antimask Set

Restriction Sys.tem Description
Option
(L Hide bypass If enabled, the bypass messages will no longer be displayed on keypad.
Battery Total batteries capacity in AH, for panel only (3—100Ah). You must enter this
capacity value and Max current value to view the remaining battery time on the keypad
in the event of mains failure. This is indicated under the STATUS > BATTERY
> BATT TIME menu.
Max current The total current draw from batteries when mains fail occurs (30—20000mA).
You must enter this value and the Battery capacity value to view the remaining
battery time on the keypad in the event of mains failure. This is indicated under
the STATUS > BATTERY > BATT TIME menu.
Partset
Partset A Enter a new name for your PARTSET A mode (for example, Night Mode).
Rename
Partset B Enter a new name for your PARTSET B mode (for example, Floor 1 only).
Rename
Alarm
Bell on First Enable to activate relevant bells/sirens on an unconfirmed alarm. When this

option is disabled, the relevant bells/sirens will only activate on a confirmed
alarm or if the detector that caused the unconfirmed alarm is reactivated.

Enable to resound bells/sirens if a second zone activation is detected (after the
bell time has elapsed). If not checked then the external bells will only trigger
once.

If enabled, a user cannot set an area if there is an area or system alert present
on the system.

Note: This option is only available when the Standards > Region selected is
Switzerland or Security Grade selected is ‘Unrestricted’.

Enable for alerts to auto clear after 30 seconds in Unset mode.

Note: To comply with PD6662, you must disable this option.

Select the type of event reported resulting from antimask detection when panel
is Set. Options are Disabled, Tamper, Trouble or Alarm.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

o lreland - Alarm

« All other regions - Alarm
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System

Restriction Option

Description

(L Antimask Select the type of event reported resulting from antimask detection when panel
Unset is Unset. Options are Disabled, Tamper, Trouble or Alarm.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

« lIreland - Disabled

« All other regions - Tamper

(L) Out of bounds  Select the type of event reported resulting from Out of Bounds EOL detection
EOL unset when the panel is unset. Options are: Disabled, Tamper and Trouble.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

« Germany VDS — Tamper

« All other regions - Trouble

(L) Out of bounds  Select the type of event reported resulting from Out of Bounds EOL detection
EOL set when the panel is set. Options are: Disabled, Tamper and Trouble.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

« Germany VDS — Tamper

« All other regions — Trouble

(&) Zone Unstable  Select the type of event reported resulting from Zone Unstable detection when
unset the panel is unset. Options are: Disabled, Tamper and Trouble.

A zone is unstable if a valid sample cannot be obtained within 10 seconds.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

« Germany VDS — Tamper

« All other regions — Trouble

(&) Zone Unstable  Select the type of event reported resulting from Zone Unstable detection when
set the panel is set. Options are: Disabled, Tamper and Trouble.

A zone is unstable if a valid sample cannot be obtained within 10 seconds.

The option can only be configured when the panel is in ‘Unrestricted’ mode. In
Grade 2 or 3 mode, the type of event reported is in accordance with the
standards for the selected region:

« Germany VDS — Tamper

« All other regions — Trouble
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Confirmation

@ Confirmation

Restriction Sys.tem Description

Option

End Of Line Select the End Of Line termination resistors that will apply to either all zones on

(EOL the system or new zones added to the system. Select a value to enable the

RESISTANCE) appropriate feature.
To apply a new EOL setting to all existing zones, select the Update all zones
checkbox. If you change the End of Line value but do not select this checkbox,
the new setting applies only to zones added after changing the value.

(L EOL Wide If enabled, EOL wide bands are used.

Suspicion If enabled then WPA* Suspicion alerts have audible and visible indicators on
Audible the keypad (Financial mode only).

Seismic Test If enabled, all seismic sensors in any area that is being set will be tested before
on Set area or system set (Financial mode only).

(&) Auto Restore Enable this feature to automatically restore alerts on the system, that is, when
the open zone that triggered an alarm is closed, a manual restore operation on
the keypad/browser is not required. If disabled it prevents the user from
restoring alerts by resetting the input that triggered the alert.

(&) Alarm on Exit Enabled: If a non-entry/exit zone is activated during the exit timer countdown,
alocal alarm is raised by sounding the bells.

Disabled: If a non-entry/exit zone is activated during the exit timer countdown,
an alarm is not raised.

Note: This option only displays when the Unrestricted grade is selected as
enabling it is not in accordance with EN50131. When you choose the Swiss or
Belgium Region under Standard Compliance Settings, this option is
automatically enabled but it is not visible under Options.

(L) Alarm on Entry  Enabled: If a non-entry/exit zone is activated during the entry timer

countdown, a local alarm is raised by sounding the bells.

Disabled: If a non-entry/exit zone is activated during the entry timer
countdown, an alarm is not raised.

Note: This option only displays when the Unrestricted grade is selected as
enabling it is not in accordance with EN50131. When you choose the Swiss
Region under Standard Compliance Settings, this option is automatically
enabled but it is not visible under Options.

The Confirmation variable determines when an alarm is deemed to be a
confirmed alarm.

. BS8243:
This will enforce compliance with the UK Police requirements, and is a
specific requirement for UK Commercial installations. The requirement
stipulates that an alarm will only be deemed to be a confirmed alarm if it
meets the following condition:
After an initial zone alarm has been activated and before the alarm
confirmation time has expired, a second zone alarm is activated. The
alarm confirmation time must be between 30 and 60 minutes. (See Timers
on page 261.)
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System

Restriction Option

Description

Keypad

@ Always Show
State
(SHOW
STATE)

Show Open
Zones

CallARC
Message

If a second zone alarm is not activated within the Alarm confirmation time,
then the first zone alarm will be inhibited. The BS8243 confirmation option
is automatically set whenever the Standards > Region option is set to
UK.

« Garda:
This will enforce the policies for confirmed alarms required by the Irish
Garda. The requirement stipulates that an alarm will be deemed to be a
confirmed alarm as soon as a second zone alarm is activated on the
system within the one alarm set period. The Garda confirmation option is
automatically set whenever the Standards > Region option is set to
Ireland.

o EN-50131-9
This will enforce compliance with the EN-50131-9 standard and the
Spanish “INT/316/2011 Order of 1 February on the operation of alarm
systems in the field of private security”. This requirement stipulates that an
alarm will only be deemed to be a confirmed alarm if it meets the following
conditions:
- 3 zone activations in 30 minutes (default), whereby two activations may
come from the same device if the activations differ in type, that is,
alarm/tamper.
- 1 Alarm activation followed by an ATS[1] Fault within 30 minutes
(default).
- ATS fault followed by a tamper or alarm condition within 30 minutes
(default).
If the 30 minutes expires and the zone is restored to its normal physical
state, then the zone’s alerts will be restored if a level 2 user can restore
this alert. In this case, the zone will accept a new alert condition which will
cause a new activation.
Alternatively, if the zone has not been restored to its normal physical state
then that zone will be inhibited if that zone is allowed to be inhibited.
If an alert (ATS) reoccurs after the 30 minute window (default), then the 30
minute timer will restart.
The EN50131-9 confirmation option is automatically set whenever the
Standards > Region option is set to Spain.

. VDS
This will enforce compliance with the VDS standard.

If enabled, the setting status of the system (Fullset/Partset/Unset) is
permanently displayed in the bottom line of the keypad display. If unchecked
the setting status will disappear from the keypad display after 7 seconds.

If enabled, open zones will display on keypad in Unset mode.

If enabled, the ARC message will be displayed for 30 seconds after Unset, if
confirmed alarm has been reported.
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Restriction Sys.tem Description

Option

CallARC Line  ARC message in line 1 of display (16 chars).

1

Call ARC Line  ARC message in line 2 of display (16 chars).

2

Show Cameras If enabled, offline cameras will be displayed on the keypad in Unset mode.

Log Keypad Enable this option to log users' keypad access (successful and failed log-in

Access attempts).

Idle State Select the language displayed in idle state.

Language « System Language: Language in which menus and texts on the keypads,

the web interface and the event log will be displayed.
« Last Used: Last used language is displayed in idle state.
Use Simplified  Enable this option to use simplified set/unset menus on the 'Comfort' and
Menu 'Compact’ Keypads (for one area configuration only).
PIN

PIN Digits Enter the number of digits for user PINs (max. 8 digits). Increasing the number
of digits will add the relevant number of zeros to the front of an existing PIN, for
example, an existing user PIN of 2134 (4 digits) will change to 00002134 if the
PIN digits is set to 8. If you decrease the number of PIN digits, existing PINs
will have their leading digits removed, for example, an existing user PIN of
00002134 (8 digits) will change to 02134 if the PIN digits is set to 5.
Note: This option cannot be changed if an SPC Manager PIN digit mode is set.
See SPC Manager on page 336.
Note: To comply with INCERT approvals, the user's PIN code must contain
more than 4 digits.

PACE and PIN If enabled, both PACE and PIN are required.

User Duress Select one of the following Duress options to activate this function on the

system.
« PIN +1(system reserves the PIN before and after the user PIN for duress.

« PIN + 2 (system reserves two PINs before and after the user PIN for
duress.

Duress must be enabled for individual users. See section on Adding/Editing a
User.
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Restriction Sys.t em Description
Option
PIN Policy Click the Edit button to select options for PIN usage.

« Periodic changes required — enforces scheduled changes to the user’s
PIN. The period is defined in the PIN Valid field of Timers. See Timers on
page 261.

« Warn if changes required — generates a user alert if the user's PIN is about
to expire, or has expired. The warning period is defined in the PIN
Warning field of Timers. See Timers on page 261.

« Userselects the last digit — enables the user to select the last digit of their
pin. The preceding digits are automatically generated by the system.

« Userselects the 2 digits - enables the user to select the last two digits of
their PIN. The preceding digits are automatically generated by the system.

« Limit Changes — limits the number of changes possible within a valid PIN
period. This value is defined in the PIN Changes Limit field of Timers.
See Timers on page 261.

« Secure PIN - If enabled the PIN will be automatically generated by the
panel.
Door & Reader

Reset Cards If enabled, access cards passback state will be reset every day at midnight.

Ignore site code If enabled, the access system will ignore site codes. By ignoring the site code,
you only add the card number and increase the card users on the system from
100 to 2,500.

Card Formats Click the Edit button to select the card formats that will be allowed on this
panel.

See Supported card readers and card formats on page 388 for details of
currently supported card readers and card formats.

Note: Selecting Wiegand enables all Wiegand card formats.

WebOnly  Door Mode Set  Select the required user identification to unlock door when area is set. Options
are Default, Card and PIN, Card Or PIN.

WebOnly  Door Mode Select the required user identification to unlock door when area is unset.
Unset Options are Default, Card and PIN, Card Or PIN.
Override If enabled, Reader LEDs indicate setting confirmation and Card+PIN request.

Reader Profile

Engineer
(L Engineer (Impact only if Region "UK" is chosen): If this option is enabled, then the
Restore engineer has to restore the confirmed alarms. This option works together with
the function "Confirmation”.
Engineer Exit If enabled, the engineer is allowed to leave Full Engineer mode with alerts
active.
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Restriction Sys.tem Description
Option
(L Allow Engineer  Enable this feature to ensure that the engineer can only access the system if
the user allows it.
If disabled, ENABLE ENGINEER menu option on keypad is not available.
Note: Only available if Security Grade is ‘Unrestricted’. For Grade 2/3, user
control of engineer access to system is always available.
(&) Allow Enable this feature to ensure that the engineer can only access the system if
Manufacturer the user allows it.
If disabled, ENABLE MANUFACTURER menu option on keypad is not
available.
Note: Only available if Security Grade is ‘Unrestricted’. For Grade 2/3, user
control of engineer access to system is always available if user type is
‘Manager’.
SMS
SMS Select one of the following options:
Authentication « PIN Code Only: This is a valid user code.

« Caller ID Only: This is the phone number (including three-digit country
prefix code) as configured for user SMS control. SMS control will only be
available for configuration by the user when this option is selected.

« PIN and CallerID

« SMS PIN Code Only This is a valid PIN code configured for the user which
is different from the user’s login code. SMS controls will only be available
for configuration by the user when this option is selected.

« SMS PIN Code & Caller ID.

Policy

Web Only  System Policy  Configure engineer login and tamper reporting behavior for system.

Web Only  Timing Policy Display system timing policy.

Web Only  Output Click the Edit button to configure latch and autoset output settings (see
Configuration Configuring system latch and auto set outputs on page 236).

WebOnly  System Alert This programming option allows you to restrict the user and engineer’s ability to

) Policy restore, Isolate and inhibit alerts. The manner in which the system reacts to

alerts can also be programmed.

WebOnly  Zone Alarm Select whether particular zone alarms can be restored, inhibited or isolated by
Policy the user and engineer.

L

WebOnly  Zone Tamper Select whether particular zone tampers can be restored, inhibited or isolated by
Policy the user and engineer.

@

Web Only  Keypad Display Select events to be displayed on keypads in both Set and Unset modes.

® Policy
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@

Web Only

W

Web Only

General Policy

Confirmed
Alarms System
Alerts

1

Phone number
2

Restriction Sys.t em Description
Option
WebOnly  Keypad LED Select which LEDs will be displayed on keypads in both Set and Unset modes.
) Policy
Web Only  System Select options to manage remote control of the system and alarm and bell

settings from the following:

- No confirmed alarms if internally set
- Block remote restore

- Block remote isolates

- Block remote inhibits

- No external bell if internal set

- Delay reporting if entry active

- Confirmed alarm cancels delay

Select which system alerts cause a confirmed alarms when at least one alarm
is active, and which system alerts cause the panel to enter the tentative state.

Hold-up Data

Web Only  Hold-up Enter the first hold-up keyword to send to the CMS in a Holdup Information
keyword 1 (HD) event.

Web Only  Hold-up Enter the second hold-up keyword to send to the CMS in a Holdup Information
keyword 2 (HD) event.

Web Only  Phone number  Enter the first site phone number to send to the CMS in a Holdup Information

(HD) event.

Enter the second site phone number to send to the CMS in a Holdup
Information (HD) event.

*A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

See also

Adding/Editing an area on page 270
17.10.3.2 Timers

Engineer programming via the browser

This page gives an overview about identified timer defaults and their description.

These settings, which vary depending on the defined Security Grade of the system, should only be
programmed by an authorised installation engineer. Changing settings could render the SPC system
noncompliant with security standards. Setting the Security Grade back to EN 50131 Grade 2 or EN
50131 Grade 3 overwrites any changes made on this page.

[i]

1. Select Configuration > System > System Timers.
The System Timers page displays.
2. Configure the fields as described in the following table.
Timers

Designation of the functions in the following order:
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o 1strow: Web

o 2ndrow: Keypad

Timer Description Default
Audible
Internal Bells Duration that internal sounders will sound when alarm is activated. (0—999 15min.
INT BELL TIME minutes; 0 = never)
External Bells Duration that external sounders will sound when alarm is activated. (0-999 15min.
EXT BELL minutes; 0 = never)
TIME
External Bell This will cause a delayed activation of the external bell. (0—999 seconds) Osec.
Delay
EXT BELL
DELAY
Chime Number of seconds that a chime output will activate, when a zone with chime 2sec.
CHIME TIME attribute opens. (1-10 seconds)
Confirmation
Confirm Note: This option is only available for certain Grade and Confirmation option 30min.
CONFIRM combinations. (See Options on page 252 and Standards on page 266.)
TIME This timer applies to the alarm confirmation feature and is defined as the maximum
time between alarms from two different non overlapping zones that will cause a
confirmed alarm. (0—60 minutes)
Confirmed Note: This option is only available for certain Grade and Confirmation option 480min.
holdup combinations. (See Options on page 252 and Standards on page 266.)
This timer applies to the confirmed holdup feature and is defined as the maximum
time between alarms from two different non-overlapping zones that will cause a
confirmed alarm. (480—1200 minutes)
Dialer Delay When programmed, the dialler delay initiates a predefined delay period before the ~ 30sec.
DIALER system dials out to an Alarm Receiving Centre (ARC). This is specifically
DELAY designed to reduce unwarranted responses from Alarm Receiving Centres and the
constabulary. In the event of a subsequent zone being tripped the dialler delay
period is ignored and the dialler dials out immediately. (0-999 seconds)
Alarm abort Time after a reported alarm in which an alarm abort message can be reported. (0—  30sec.
ALARM ABORT 999 seconds)
Setting
Setting Period for which Setting Authorisation is valid. (10-250 seconds) 20secs
Authorisation
SETTING
AUTH
Final Exit The Final Exit time is the number of seconds that arming is delayed after a zone 7sec.
FINAL EXIT programmed with the final exit attribute is closed. (145 seconds)
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Timer Description Default
Bell on Fullset Activates the external bell momentarily to indicate a full set condition. (0—10 Osec.
FULLSETBELL S€60nds)
Fail To Set Number of seconds to display fail to set message on keypads (0 until valid PINis  10sec.
FAIL TOSET entered). (0999 seconds)
Strobe on Activates the strobe on the external bell momentarily to indicate a full set Osec.
Fullset condition. (0—10 seconds)
FULLSET
STROBE
Alarm
Double Knock The maximum delay between activation’s of zones with the double attribute, 10sec.
DKNOCK which will cause an alarm. (1-99 seconds)
DELAY
Soak The number of days a zone remains under soak test before it automatically returns 14 days
SOAK DAYS to normal operation. (1-99 days)
Seismic Test The average period between seismic sensor automatic tests. (12—240 hours) 168
Interval Note: To enable automatic testing, the Automatic Sensor Test attribute must be hours
SEISMIC enabled for a seismic zone.
AUTOTEST
Seismic Test Maximum time (in seconds) that a seismic sensor takes to trigger an alarm in 30sec.
Duration response to the 'Seismic Test' output. (3—120 seconds)
SEISMIC TEST
DUR
Auto Restore Time to delay auto restore after zone state returns to normal. (0—9999 seconds) Osec.
Delay
Lockout Post The duration of time after an alarm before the user can gain access. (1-120 Omin.
Alarm minutes)
LOCKOUT
POST ALARM
Access Time The duration of time the system can be accessed by an alarm access user after

the Lockout Time has elapsed. (10-240 minutes)
External Bell Duration that the strobe output will be active when an alarm is activated. (1-999 15min.
Strobe minutes; 0 = indefinitely)
STROBE TIME
Alerts
Mains Delay The time after a mains fault has been detected before an alert is activated by the Omin.
MAINS SIG system. (0—60 minutes)
DELAY
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Timer Description Default
RF Jamming The time after RF Jamming has been detected before an alert is activated by the Omin.
Delay system. (0-999 seconds)
Engineer
Engineer The timer for the Engineer access starts as soon as the user enables the Engineer  Omin.
Access Access. (0999 minutes; 0 indicates no time limitation for system access)
ENGINEER
ACCESS
Engineer auto Duration of inactivity after which the engineer will be automatically logged out. (0—  Omin.
log out 300 minutes)
ENGAUTO
LOGOUT
Keypad
Keypad Timeout The number of seconds that an RKD will wait for key entry before it leaves the 30sec.
KEYPAD current menu. (10-300 seconds)
TIMEOUT
Keypad The duration a keypad will wait in idle before switching language to default. (0— 10sec.
Language 9999 seconds; 0 = never)
KEYPAD
LANGUAGE
Fire
Fire Pre-alarm Number of seconds to wait before reporting fire alarm for zones with ‘Fire pre- 30sec.
FIRE PRE- alarm’ attribute set. See Editing a zone on page 270. (1-999 seconds)
ALARM
Fire recognition  Extra time to wait before reporting file alarm for zones with ‘Fire pre-alarm’ and 120sec.
FIRE ‘Fire Recognition’ attributes set. See Editing a zone on page 270. (1-999 seconds)
RECOGNITION
PIN
PIN Valid Period for which pinis valid. (1-330 days) 30 days
PIN VALID
PIN Changes Number of changes within a valid period. (1-50) 5
Limit
PIN CHANGES
LIMIT
PIN Warning Time before PIN expiry after which a warning will be displayed. (1-14 days) 5days
PIN WARN
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Timer Description Default

General Settings

RF Output Time The time that the RF output will remain active on the system. (0-999 seconds) Osec.

RF OUTPUT

Time Sync Limit  Time limit within which time synchronization will not take place. Time Osec.

TIME SYNC synchronization only takes place if system time and update time are outside this

LIMIT limit. (0—300 seconds)

Link Timeout Timeout for Ethernet link fault. (0—250 seconds; 0 = Disabled) Osec.

LINK TIMEOUT

Camera Offline  Time for camera to go offline. (10-9999 seconds) 10sec.

CAMERA

OFFLINE

Frequent This attribute only applies to remote services. The number of hours withinwhicha  336h (2

FREQUENT zone must open if the zone is programmed with the Frequent attribute. (1-9999 weeks)
hours)

Duress silent Time when duress will remain silent and not restorable from keypad. (0-999 Omin.
minutes)

Holdup/panic Number of minutes that a holdup/panic will remain silent and cannot be restored Omin.

silent from the keypad. (0—999 minutes)

Default times are dependent upon the Engineer configuration. The default times denoted may or may
| ® not be allowable and is dependent on the configuration by the engineer.

Valid settings/ranges may be dependent on the security grade specified under Configuration >
System > Standards.
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17.10.3.3 Identification
1. Select Configuration > System > Identification.
The following page will be displayed.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

System Options System Timers Identification Standards Clock Language

System Identification

Option Value Description
\nstallation ID [Ll?lsggglgggtl)ﬁcatlon number of the panel (used by FlexC and SPC Pro/SPC Safe).
Installation Name ‘ | Description of this installation.
Day Month Year

Installation Date f,' 2006 v
Installer Name l:l Mame of installer for support purposes.
Installer Phone I:l Phone number of installer for support purposes.
Display Installer O If checked installer details are displayed on keypads.
Engineer Lock O If checked the Engineer lock PIN is required to factory default the panel.
Engineer Lock PIN 1111 Four digit Engineer Lock PIN_

o

2. Configure the fields as described in the table below.

Installation Enter a unique number for each installation This number identifies the

ID installation (1-999999).

Installation Enter the name of the installation. An installation name must be entered before

Name the installation is saved on the system. The installation can be viewed from
the keypad.

Installation Select the date from the dropdown menu that the installation was completed.
Date

Installer Enter the name of the person who installed the system (for support purposes).
Name

Installer Enter the contact phone number of the person who installed the system (for
Phone support purposes).

Display Tick this box to display the installation details on the keypad connected to the
Installer panel when in the idle condition.

Engineer  Tick this box to require use of the engineer lock PIN to factory default the
Lock panel.

Engineer  Enter value for lock PIN (4 digits).
Lock PIN

17.10.3.4 Standards

o All alarm systems must comply with defined security standards. Each standard has specific
l security requirements that apply to the market/country in which the alarm system is installed.
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Select Configuration > System > Standards.

The following page will be displayed.

System Options

Continent

@ Europe Asia

Instaliation Type:
Domestic
® Commercial

Financial

United Kingdom

® lreland

Italy

(*) Sweden
(*) Switzerland
(*) Belgium
(*) Spain
(*) Germany
(*) France
Norway
Denmark
Poland
Netherlands
Finland
Portugal

Czech Republic

| Save

System Timers

Region Compliance:

Europe General (EN)

Idenfification Standards Clock Language

North South
America America

Oceania
Grade
O EN50131 Grade 2
EN50131 Grade 3

Unrestricted

(*) Selecting this regional standard will implement local or national requirements
which supersede ENS0131 requirements

Configure the fields as described in the following table.

Continent

Installation
Type

Region
Compliance

Grade

Select the appropriate location for the installation. Options are Europe, Asia,
North America, South America, or Oceania.

Select the type of installation. Options are Domestic, Commercial or Financial.

To change the region on your panel, it is strongly recommended that you default
your panel and select a new region as part of the start up wizard. Select the
region in which the installation is installed and the regional requirements it
complies with.

Some selections will implement local or national requirements which supersede
EN50131 requirements. The options in the Grade area will change depending on
your selection in the Region Compliance area.

Options are UK, Ireland, Europe General (EN), Italy, Sweden, Switzerland,
Belgium, Spain, Germany (VDS), France, Norway, Denmark, Poland,
Netherlands, Finland, Portugal, and Czech Republic.

Select the Security Grade that applies to the installation.

The options in the Grade area will change depending on your selection in the
Region Compliance area.
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Unrestricted Grade

A Security Grade setting of Unrestricted does not apply to any regionally approved security
restrictions of the installation. Instead, the Unrestricted setting enables an engineer to customize the
installation by changing security policy options and configuring additional options which do not comply
with the selected regional security compliance.

Unrestricted configuration options are denoted in this document by the following symbol: o

See System Options on page 252 for details of configuring system policies.
17.10.3.5 Clock

This page allows you to program the date and time on the panel. The controller contains a Real-Time
Clock (RTC) that is battery backed to preserve the time and date information in the event of power
failure.

1. Select Configuration > System > Clock.

The following page will be displayed.

Hardware System Inputs Outputs Doors Calendars Change own PIN Advanced

System Opfions System Timers Identification Standards Language

Current Time and Date

Hour Minute Second
Time: [15 v| : [18 v] - [18 V|

Day Month Year
Date: [7 S|/ [Jul w1 [2014 v|

Automatic Daylight Saving Time: [

Synchronize Time with Mains: )

Save

2. Select the Time and Date from the drop down menus.

3. Configure the following fields:

Automatic Daylight Saving If selected, the system will automatically switch to summer
Time time

Synchronize time with If selected, the RTC synchronizes itself with the sine wave in
Mains the power line

The selected time and date will be displayed on the keypad, the web interface and the event log.

|- [
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17.10.3.6 Language
1. Select Configuration > System > Language.

The following page is displayed:
Hardware System Inputs Qutpuls Doors Areas

Calendars Change own PIN

System Options

System Timers Identification ‘Standards Clock Language

Advanced

Language Option

Option Value

English ¥ session is initiated
Use system language | Select the display language Tor idle mode.

Description
Language

Idle language

Save

Select language used on the keypads, web interface and event log. The web interface language will be updated as soon as a new browser

2. Forthe Language option, select a language from the dropdown menu.

This option determines the system language in which the texts and menus on the keypads, the web

interface and the event log will be displayed.

3. Forthe Idle Language option, select either ‘Use System Language’ or ‘Last Used'.

Idle Language determines the language which is displayed on the keypads when the panel is in its
idle state. If ‘Last Used’ is selected, the language displayed is the language that is associated with

the last user login.

jmie

specified system language.

The language used in the keypads and browser depends on the language selection made for each
user. For example, if the system language is set to French, but the individual user’s language is set to
English, English is the language used in both keypads and browser for that user, regardless of the

See also

Options on page 113

17.10.4 Configuring zones, doors and areas

This section covers:
« Editing a zone on the facing page
« Adding/Editing an area on the facing page
« Editing a dooron page 278
« Adding an area group on page 283
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17.10.4.1 Editing a zone

Engineer and User actions include Log, Isolate/Deisolate and Soak/Desoak for each zone as allowable
by the Security Grade EN 50131 Grade 2 and EN 50131 Grade 3.

1. Select Configuration > Inputs > All Zones.

The following page will be displayed.

Hardware System Inputs Qutputs Doors Calendars Change own PIN Advanced

All Zones X-Bus Zones Wireless Zones

Zone Input Description Type Area Attributes
5 Controter - nput 5 =1
] Controller - Input 6 Fire Exit WV 1: Marketing hd l:l
7 Controller - Input 7 Fire WV 1: Marketing ol l:l
g Controller - Input & 1: Marketing v l:l
10 Door Controller 1 - Door O 1 1: Marketing M |:|
11 Door Controller 1 - Door /0 3 1 T Marketing ™ el
12 Door Controller 1 - Door 110 2 1: Marketing v l:l
12 Door Controller 1 - Door 10 4 l—‘ ’Unused—v| 1: Marketing v l:l

. You can select Configuration > Inputs > X-Bus Zones to configure wired
l zones only or Configuration > Inputs > Wireless Zones to configure
wireless zones only.

2. Configure the fields as described in the table below.

Zone The number is presented for reference and can not be programmed.

Description Enter a text (max. 16 characters) that serves to uniquely identify the zone.

Input The physical input is displayed for reference and is not programmable.
Type Select a type of zone from the drop down menu (see Zone types on page 379).
Area Only if (multiple) Areas is activated. Select an area to which the zone is

assigned from the drop down menu.

Calendar Select if necessary the desired calendar (see Calendars on page 284).

@ For Security Grade 2/3 a calendar can be assigned only to zones of type Exit
Terminator, Technical, Key Arm, Shunt and X-Shunt. For Security Grade
Unrestricted a zone of any type can be associated with a calendar.

Attributes  Tick the relevant checkbox for the zone. Only attributes that apply that type of
zone will be presented (see Zone attributes on page 384).

17.10.4.2 Adding/Editing an area
Prerequisite

o Only if (multiple) Areas is activated.
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1. Select Configuration > Areas > Areas.

The following page will be displayed:

Hardware System Inputs Outputs Doors Calendars Change own PIN Advanced

Area groups

Area Description Delete

1 |Marketing

2 | Reception

4 | Cafeteria

HEEEE:
HEEE

|
|
3 |Finanoe |
|
|

5 | Meeting Room

2. Click Edit to edit an existing area.

Click Add to add a new area. If the Installation Type is Domestic or Commercial, an area is
automatically added and the Edit Area Settings page is displayed.

Note that the area type for the new area is automatically set to Standard.

If the Installation Type is Financial, the following page is displayed and the area must be added

manually.
Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Areas Area groups
Add area
Description Description of area.
Area Type Standard Select the type of Area.
ATM
Vault
Advanced

4. Enter a description for the new area and select an area type from one of the following:
- Standard — Suitable for most areas.
- ATM — Provides settings and defaults relevant to ATMs.
- Vault — Provides settings and defaults relevant to vaults.
- Advanced — Provides all area settings (Standard, ATM and Vault).
5. Click the Add button to add the area.

Configure the settings for each installation type as per the following sections.
Entry/Exit

Configure the following Entry/Exit settings:

Entry time The time period (in seconds) allowed for the user to UNSET the alarm after opening an entry/exit
zone of an armed system. The entry time applies to all entry/exit zones in that area (default: 45
seconds).

Exit time The time (in seconds) allowed for a user to leave a protected area before setting is complete. The
exit time will be counted down at the keypad as the buzzer beeps to indicate to the user that the
system will arm when the exit timer reaches zero. The exit time applies to all entry/exit zones in
that area (default: 45 seconds).
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Disable Exit
Time

Fob Unset
Entry

Access
Denied on
Alarm

Prevent
Setting

Prevent
Unsetting

Setting

Select if no exit timer is required and setting is activated by ‘Exit term’ zone or ‘Entry exit’ zone with
‘Final exit’ attribute. See Timers on page 261.

FOB will only unset when entry timer is running. Default is enabled.

Access is temporarily denied to the area for the amount of time specified in the Lockout Post Alarm
timer.

If enabled, setting prevented from keypad

If enabled, unsetting prevented from the keypad.

Used for configuring Blocking Lock operation. Options are:

Authorisation . Disabled

o Set
o Unset
« Setand Unset

If the Disabled option is selected (default) then the system will set and unset normally with no
change of operation.

If the Set option is selected, a “Setting Authorisation” signal is required to set this area which can
be received from keypads or a zone input (see Authorised Setting of the Blocking Lock) The user
cannot set the system from the keypad. Any area that requires setting authorisation will appear as
locked on the comfort keypad and will not appear on the standard keypad when setting.

If the Unset option is selected, the user cannot unset the area from keypads but can use the
keypad to generate the setting authorization signal.

For the set and unset options, the user will be unable to change the state of the area at any stage
from the keypad.

A timer for setting authorisation can be configured. See Timers on page 261.

Partset Options
Configure the operation of particular zones for both Partset A and Partset B modes as detailed below:
Partset Enable PartSet for A and B operation as required.
Enable
Partset Tick the relevant checkbox (Partset A or B) to apply the exit timer to the Partset A or B mode.
Timed
Partset Tick the relevant checkbox to change access zones into entry/exit type zones for either Partset A
Access or B operation. This feature is useful for a domestic installation where a Passive Infrared (PIR)
sensor is located in the hallway. If the user partsets the system at night and returns downstairs
during the night, he/she may unintentionally activate the PIR sensor in the hallway and trigger the
alarm. By setting the partset access option, the buzzer will sound for the entry time period when the
PIR sensor is activated thereby warning the user that the alarm will activate if no action is taken.
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Partset Tick the relevant checkbox to change the behaviour of entry/exit zones to alarm zones when in

Exit/Entry Partset A or B mode. This feature is useful for a domestic installation when the system has been
set in partset mode. If the user partsets the system at night he/she may wish the alarm to activate
immediately if the front or back door is opened during the night.

Partset Tick the relevant checkbox to restrict the reporting of alarms in Partset Mode to local reporting only
Local (No remote reporting).

NoBells If ticked, no bells will be activated for partset A or B.

Linked Areas

This section enables you to link areas for setting and unsetting purposes:

Fullset Fullset this area when all linked areas are Fullset.
Fullset All Fullset all areas when this area is Fullset.
Prevent Fullset Prevent this area from Fullset if all linked areas are Fullset.

Prevent Fullset All  Prevent linked areas from Fullset if this area is not Fullset.

Unset Unset this area when all linked areas are Unset.
Unset All Unset all areas when this area is Unset.
Prevent Unset Prevent this area from Unset if any linked areas are Fullset.

Prevent Unset All Prevent linked areas from Unset if this area is Fullset.

Authorise Setting Enable authorised setting for linked areas. Refer Authorised Setting of the Blocking Lock.

Linked Areas Click the areas that you wish to link to this area.

Schedule

Configure scheduling with the following settings:

Calendar Select a calendar to control scheduling.
Unset Select if area should automatically Unset as per the time specified in the selected calendar.

Fullset Select this option to Fullset the area as per the time specified in the selected Calendar. The area will
also set when the Unset Duration or Delay Interval has elapsed (see Setting/Unsetting on page 275). If
the Unset Duration overlaps the scheduled time, the area will use the calendar settings.

Time Select this option to time lock the area as per the selected Calendar. (Vault type area in Financial mode
Locked  only)

Vault Enter the number of minutes (0—120) to activate this timer at the end of a Time Locked Unset period. If
Access theareais not unset after this timer expires, the area cannot be unset until the start of the next Time
Locked Unset period. (Vault type area in Financial mode only)

Reporting

L The Reporting configuration settings are applicable for Standard Areas in Commercial and Financial
1 installations only and are only relevant if a calendar has been selected. (See Schedule above.)
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These settings enable a report to be sent to the Control Centre or nominated personnel if the panel is
Set or Unset outside scheduled calendar times.

Earlyto  Enables areport to be sent if the panel is manually Fullset before a scheduled Set and before the
Set number of minutes entered in the Timer field.

Late to Enables a report to be sent if the panel is manually Fullset after a scheduled Set and after the
Set number of minutes entered in the Timer field.

Earlyto  Enables a report to be sent if the panel is manually Unset before a scheduled Unset and before the
Unset number of minutes entered in the Timer field.

Lateto Enables a report to be sent if the panel is manually Unset before a scheduled Unset and before the
Unset number of minutes entered in the Timer field.

Reporting is done via SMS or to the ARC via SIA and Contact ID. An event is also stored in the system
log.

Only events configured for late or early reporting for the area will be reported.

Event reporting must also be enabled for an ARC or SMS, as described in the following sections.

Enabling Reporting of Unusual Setting/Unsetting for an ARC

To configure event reporting for an ARC configured to communicate over SIA or CID, select
Communications > Reporting > Analog ARC > Edit >Filter to display the Event Filter page for an

ARC.
Communications Reporting PC Tools
Analog ARC CEI-ABI
Event Filter
Alarms [ Alarm activation
Alarm Restores | Reported alarms being restored
Confirmed alarms Wl Alarms confirmed by multiple zones
Alarm Abort ] Report Alarm Abort event if valid PIN is entered on keypad after alarm report
Faults | Fault or Tamper activations
Fault restore ] Fault or Tamper restores
Setting ] Setiing and Unsetting
Early / Late ] Report if Setting/Unsetting is not according to schedule
Inhibits ] Inhibit and |zolate
Door events | Access control door events
Other ] All other types of events
Network ] Report IP Network Polling Up/Down events
— [«] 1: Marketing |1 3: Finance [w] &: Meeting Room
[v] 2: Reception k] 4: Cafeteria [v] &: Finance
| Save || Back |
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The Early/Late parameter is enabled to report any setting or unsetting which differs from the schedule.

Enable Reporting of Unusual Setting/Unsetting for SMS

SMS Events can be configured using both Engineer and User configuration pages.

For Engineer configuration, select Users > Users SMS > Engineer SMS > Edit.

Users User Profiles Users SMS

Wireless FOB

Web Passwords Engineer

Add a new SMS number to the system

General Settings

SMSID 1

User [1: User1

User i with this SMS number

SMS Number

1

SMS Events

Alarms.

Alarm Restores

Confirmed alarms

Faults

Fault restore

Setting

Early / Late

Inhibits

Door events

Other

Wireless Lost Event

Phone number SMS messages will be sent to / received from

Alarm activation

Reported alarms being restored

Alarms confirmed by multiple zones

Fault or Tamper activations

Fault or Tamper restores

Sefting and Unsetting

Report if Setting/Unsetting is not according to schedule
Inhibit and Isolate

Access control door events

All other types of events

If checked Wireless Lost event will be sent over CID/SIA and FlexC

Enable Early/Late to report any setting and unsetting which is not according to schedule.

Setting/Unsetting

The following parameters (with the exception of the Interlock parameter) are only relevant in the following
cases:

« A Calendaris selected (see Schedule on page 273), or

« Unset Duration is enabled (has a value greater than zero), or

« Both of the above conditions are met.

Auto Set
Warning

Auto Set
Cancel

Auto Set
Delay

Keyswitch

Delay
Interval

Delay
Counter

Delay
Unset

Enter the number of minutes to display a warning before Auto Setting. (0-30)

Note that the panel sets either at the scheduled time or at the time defined by the Delay Unset
parameter. The first warning is displayed at the configured time before the scheduled time. There are
further warnings starting at one minute before setting time.

Enables the user to cancel Auto Setting by entering a code in the keypad.

Enables a user to delay Auto Setting by entering a code in the keypad.

Enables Auto Setting to be delayed using Keyswitch Expander.

Enter the number of minutes by which to delay Auto Set. (1-300)

Enter the number of times that Auto Setting can be delayed. (0-99: 0 = unlimited)

Enter the number of minutes by which to delay an Unset. (0 = no delay)

© Vanderbilt 2018

275

ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the browser

Interlock Select an Interlock Group to assign to this area. Interlocking only allows one area within the group to

Group be Unset at any time. Typically used in ATM areas.
Unset If area is Unset for longer than this it will Set automatically. (Range 0-120 mins: 0 = not active).
Duration

Dual PIN  If this option is enabled, two PINs are required to Set or Unset the area with the keypad. Both PINs
must belong to users who have the required user right for the operation (Setting or Unsetting).

If the second PIN is not entered within 30 seconds, or it is wrong, then the area cannot be Set or
Unset.

Force Set  Area options for Force-set operation (Normal or Blocked).

Mode

Auto Check this option to auto-restore closed zones during force-set. If this option is selected, if an alert is
Restore active or a zone needs to be restored, then it will be automatically restored.

on Force

Set

Late Working Support

An example of using the setting and unsetting parameters is for late working situations where a
calendar has been configured for automatic setting of a premises at a particular time but staff may need
to work late on occasion and the automatic setting needs to be delayed.

Each delay is determined by the amount configured in the Delay Interval parameter, and the Delay
Counter parameter determines the number of times that setting can be delayed. A user needs the
correct value in the Auto Set Delay in order to use this feature.

There are three ways to delay setting:

1.

Entering the PIN on the keypad.

DELAY is a menu option on the standard keypad. The buttons at the top of the comfort keypad
are used to operate the delay feature

Using the keyswitch.

Turning the key to the right delays setting the system by the configured delay if the maximum
number of times that setting can be delayed (Delay Counter) has not been exceeded. Tuming
the key to the left sets the delay to three minutes (non-configurable). This can be done regardless
of how many times setting was delayed.

3. Using a FOB, WPA or button which activates a Delay Autoset trigger action.

Temporary Unset

To allow a system to be temporarily unset in a time period specified by a calendar, the following three
parameters need to be configured:

1.

Calendar
A calendar needs to be configured and selected for this area.
Time Locked

This box needs to be ticked so that the area can be unset only when allowed as per the
configured calendar.

Unset Duration

This parameter needs to be set to a value greater than zero to set an upper limit on the time the
area will be unset.
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All Okay

All Okay If selected, user must confirm ‘All okay’ input or silent alarm is generated. See Editing a zone on
Required page 270 for details on configuring an ‘All Okay’ zone input.

All Okay Time (in seconds) in which ‘All okay’ must be confirmed before alarm is raised. (Range: 1-999
Time seconds)

All Okay Select the event type to be sent when the ‘All okay’ timer expires. Options are Panic (Silent), Panic
Event and Duress.

RF Output

RF Output Time Enter the number of seconds that the RF Output will remain on for.

0 seconds will toggle the output on and off.

Fire Exit Route

" ] Doors which will open when fire occurs in this area
Fire exit route 2

1 Entry v
2DOOR 2 O
Fire exit Select the doors which will open when fire occurs in this area. This option does not display in
route domestic mode.
Area Triggers

The Triggers section is only displayed if triggers have been defined previously. (See Triggers on page 288.)
Click the Edit button to add, edit or delete trigger conditions for the area.

The following page is displayed:

Hardware System Inputs Outputs Doors Calendars Change own PIN Advanced

Area groups

Area 1: Triggers

Trigger Edge Action

[1w] [Positve “||Unset V|

Configure the trigger for the area using the following parameters:

Trigger Select a trigger from the drop down list.

Edge The trigger can activate from either the positive or negative edge of the activation signal.
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Action This is the action that is performed when the trigger is activated. Options are:
o Unset
o PartsetA
« PartsetB
« Fullset
« Delay autoset

This action will delay alarm setting when the autoset timer is running. The trigger will only add time if
the Delay Limit has not been exceeded and each trigger activation will delay setting by the time
defined in Delay Interval (see Setting/Unsetting on page 275).

o Restore alarms

This action will clear all alarms in the configured zone.

Note: Triggers cannot be configured from a keypad.
See also

Triggers on page 288
17.10.4.3 Editing a door

1. Select Configuration > Doors.
A list of configured doors is displayed.
2. Click the Edit button.
3. Configure the fields as described in the tables below.
Door inputs

Each door has 2 inputs with predefined functionality. These two inputs, the door position sensor and the
door release switch can be configured.

Name Description

Zone The door position sensor input can be used for the intrusion part as well. If the door position
sensor input is used also for the intrusion part, the zone number it is assigned to has to be
selected. If the door position sensor is used only for the access part, the option “UNASSIGNED”
has to be selected.

If the door position sensor is assigned to an intrusion zone, it can be configured like a normal zone
but only with limited functionality (for example, not all zone types are selectable).

If an area or the system is set with the card reader, the door position sensor input has to be
assigned to a zone number and to the area or the system which have to be set.

Description Description of the zone the door position sensor is assigned to.

(Web only)

Zone Type Zone type of the zone the door position sensor is assigned to (not all zones types are available).

(Web only)

Zone The attributes for the zone the door position sensor is assigned to can be modified.
attributes
(Web only)
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Name Description

Area The area the zone and the card reader are assigned to. (If the card reader is used for setting and
(Web only) unsetting, this area will be set/unset).

Door The resistor used with the door position sensor. Choose the used resistor value/combination.
Position
(Web)

DPS End
Of Line
(keypads)

DPS Select if the door release switch is to be a normally open or normally closed input.
Normal
Open

Door The resistor used with the door release switch. Choose the used resistor value/combination.
Release
(Web)

DRS END
OF LINE
(Keypads)

DRS Select if the door release switch is a normally open input or not.
Normal
Open

No DRS Select toignore DRS.
(Webonly) IfaDC2is used on the door, this option MUST be selected. If not selected, the door will open.

Reader Select the location of the entry and exit readers.
Location
(Entry/Exit)

(Web only)

Reader Displays format of last card used with each configured reader.
formats
(Web)

READER
INFO
(Keypads)

Each free zone number can be assigned to the zones but the assignment is not fixed. If the number ‘9’
8 is assigned to a zone, the zone and an input expander with the address ‘1’ is connected to the X-Bus
1 (which is using the zone numbers 9-16). The assigned zone from the two door controller will be
moved to the next free zone number. Configuration will be adapted accordingly.

Door attributes

If no attribute is activated, a valid card can be used.

e
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Attribute Description

Void The card is temporarily blocked.

Door Group Used when multiple doors are assigned to the same area and/or anti passback, custodian, or
interlock functionality is required.

Card and Card and PIN are required to gain entry.
PIN

PIN Only PIN is required. No card will be accepted.

PIN Code  PIN orcard are required to gain entry
or Card

PIN to Exit PIN is required on exit reader. Door with entry and exit reader is required.

PIN to PIN is required to set and unset the linked area. The card has to be presented before the PIN is
Set/Unset  entered.

Unset Panel/area will unset, when card is presented at entry reader.
outside
(Browser)

Unset Panel/area will unset, when card is presented at exit reader.
inside
(Browser)

Bypass Access is granted if an area is set and the door is an alarm or an entry zone type.
alarm

Fullset Panel/area will fullest, when card is presented twice at entry reader.
outside
(Browser)

Fullset Panel/area will fullest, when card is presented twice at exit reader.
inside

Force If the user has rights, they can force set from entry reader.
Fullset

Emergency Door lock opens if a fire alarm is detected within the assigned area.

Emergency Fire in any area will unlock the door.

any
Escort The escort feature enforces privileged card holders to escort other card holders through specific
doors. If this feature is assigned to a door, a card with the “escort right” has to be presented first,
to allow other cardholders without this right to open the door. The time period in which cardholders
are able to present their cards after a card with escort right was presented, can be configured per
door.
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Attribute Description

Prevent Anti-passback should be enforced on the door. All doors must have entry and exit readers and
Passback* must be assigned to a door group.

In this mode, cardholders must use their access card to gain entry into and exit from a defined
door group. If a valid cardholder has presented his access card to enter a door group and not
presented the card to exit it, the cardholder is in breach of the anti-passback rules. Next time the
cardholder attempts to enter the same door group, a hard anti-passback alarm will be raised and
the cardholder will not be permitted entry to the door group.

Soft Anti-passback violations are only logged. All doors must have entry and exit readers and must be
Passback* assigned to a door group.

In this mode, cardholders must use their access card to gain entry to and exit from a defined door
group. If a valid cardholder has presented his access card to enter a door group and not presented
the card to exit it, the cardholder is in breach of the anti-passback rules. Next time the cardholder
attempts to enter the same door group, a soft anti-passback alarm will be raised. However, the
cardholder will still be permitted entry to the door group.

Custodian* The custodian feature allows a card holder with custodian right (the custodian) to give other
cardholders (non-custodians) access to the room.

The custodian must be the first to enter the room. The non-custodians are only allowed to enter if
the custodian is in the room. The custodian will not be allowed to exit until all non-custodians have
left the room.

Door Door controller PCB mounted sounder sounds on door alarms.
Sounder

Ignore Door forced open is not processed.

Forced

Interlock™ Only one door in an area will be allowed open at a time. Requires Door Group.
(Browser)

Setting Authorisation with prefix (A,B,* or #) key to set system
Prefix
* Require door group
Door timers
Timer Min. Max. Description
Access 1s  255s The time the lock will remain open after granting access.
granted
Access 1s  255s The duration after which the controller will be ready to read the next event after a
deny invalid event.

Door open 1s  255s Duration within which the door must be closed to prevent a “door open too long”
alarm.

Door left 1 180 Duration within which the door must be closed to prevent a “door left open” alarm.
open min  min

Extended 1s 255s Additional time after granting access to a card with extended time attribute.

Escort 1s 30s Time period after presenting a card with escort attribute within a user without escort
right can access the door.
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Door calendar

Door Select a calendar which should lock the door during the configured time. No card/pin will be
locked accepted during this time.

Door Select a calendar which should unlock the door. The door will be unlocked during the configured
locked time.

Door triggers

Trigger

Description

door

Triggers that will
Momentarily Unlock  again.

Trigger that will lock  If the assigned trigger is activated, the door will get locked. No card/PIN will be

the door accepted.

Trigger that will If the assigned trigger is activated, the door will get unlocked. No card/PIN will be
unlock the door needed to open the door.

Trigger that will set If the assigned trigger is activated, the door will get back to normal operation. This is to
the door to normal undo locking/unlocking of the door. A card/will be is needed to open the door.

If the assigned trigger is activated, the door will unlock for a defined period, then lock

Door Interlock

Door interlock is feature that prevents the remaining doors in an interlock group from opening if any one
door in the group is open.

The following are example of how this feature is used:

« Intwo-doors entry systems used in some banks and other buildings. Usually push buttons or

card readers are used to gain entrance, and red and green LEDs show if the door can be opened
or not.

« In ATM technical areas connecting ATM doors. Typically all the ATM doors in addition to the

door that gives access to the area would be interlocked.

To create a door lock:

1.
2.
3.

Create a Door Group. See Editing a door on page 278.
Set the Interlock attribute for the required doors in the group. See Editing a door on page 278.

Configure a door output for door interlock operation. This output becomes active for all the doors
of the interlock group whenever a door belonging to the group is open, including the open door
itself.

This output could be connected, for example, to a red LED or light to indicate that the door could
not be opened, and if inverted could be connected to a green LED or light.

To configure an output for door interlock.

1.
2
3.
4

. Select the required door and Interlocked as the output type.

In Full Engineer mode, select Configuration > Hardware > X-BUS > Expanders.
In the Expander Configuration page, click the Change Type button for the required output.

Select Door as the output type.
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Hardware Inputs

Outputs

Output Type

() Disabled

) System
|External Bell v
() Area
|'I: Marketing V|
|External Bell v|
() Zone
1Frontdoor W
® Door

[Door 1Entry  W|

Interlocked '

Qutputs

Doors

Calendars

Change own PIN Advanced

17.10.4.4 Adding an area group

You can use area groups for configuring multiple areas. So the configuration must not be done for every

single area.

Prerequisite

o Only if the option (multiple) Areas is activated.

1. Select Settings > Areas > Area groups.

Hardware System

Area groups

Add area group

Description

Areas

Inputs

Outputs

Area Group 1

[] 1: Marketing
[] 2: Reception

Doors

Areas

[] 3: Finance
[] 4: Cafeteria

Calendars

Change own PIN Advanced

[] &: Meeting Room
[] &: Finance

Click the Add button.

o~ w0 D

Click Add.

Enter a description for the group.

Select the areas that are to be assigned to this group.

jmie

NOTICE: To use the area groups for the Comfort Keypad, activate all Areas in the Areas field under
Configuration > Hardware > X-BUS > Keypads > Type: Comfort Keypad.
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17.10.5 Calendars

Calendars are used for scheduling time-based control for multiple panel operations as follows:

« Automatic setting and/or unsetting of areas

« Automatic setting and/or unsetting of other panel operations including triggers, enabling of users,
zones, physical outputs, etc.

At any particular time, any schedule within the calendar can be ‘active’ if its time conditions are
satisfied.

Each week of the year is assigned an ordinal number. Depending on the fall of days within a month,
there may be 52 or 53 weeks in one year. The SPC calendar implementation conforms to the
ISO8601international standard.

Configuring calendars
« Select Configuration > Calendars.

A list of configured calendars is displayed.

Calendar Listing

D Description Edit Delete
Calendar_1 4‘ E‘

2 Calendar_2 2| |

3 Calendar_3 I &

[ Add

Performable actions

Add Add a new calendar.

Exceptions Configure setting schedules for exceptional circumstances outside of the normal weekly
schedules

Edit/View Edit or view the selected calendar.

Delete Delete the selected calendar.

The calendar cannot be deleted if it is currently assigned to an SPC configuration item, that is,
zone, area, user profile, output, trigger, door or X-Bus component. A message is displayed
indicating the assigned item.

Global calendars created using SPC Manager cannot be deleted.

[
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17.10.5.1 Adding/Editing a calendar

1.

2.

Select Configuration > Calendars > Add.

The following page will be displayed:

TN cxceonon Days
Calendar Added

Configure Calendar 1

Description
Today's Date

Colendar_1
Mon, 27 Feb 2017 11:17:54

Assign week type to week number

Start Day - End Day. Start Day - £nd Day week Type
o 7

7-26

271022017 - 05032017 Type 1 v Type 1

017 Typel ¥ Type 1%
Type 1w
Type 1 v

Type 1%

Type 1t
Type i
Type 1 v

Type 1 ¥

Type 1 v
Typet v
Type 1 v

Type 1 v

Type 17
Type 1 v
Type 1 v

Type 1 ¥

Type 1 v

Provide a Description for the calendar (max. 16 characters).

Copying a Calendar

To make a copy of this calendar structure, click the Replicate button.

A new calendar is created with the same configuration as the original calendar. You can provide a new
description for the new calendar and edit the calendar configuration as required.

Week Types

Calendars are configured by assigning an optional Week Type for each calendar week. Up to three Week
Types may be defined for each calendar. Not all weeks must have a Week Type (that is, a Week Type
may be ‘None’). There is a system maximum number of 64 calendar configurations.

To configure a week type

1.
2.

5.
6.

Click Week Types.

Enter the desired times for setting/unsetting or for triggers. Use time guidelines for Automatic
Setting/Unsetting of Areas (see Automatic setting/unsetting of areas on the facing page), or for
Automatic Setting/Unsetting of other Panel Operations (see Automatic setting/unsetting of other

panel operations on page 287).
Up to three week types may be configured.
Click Save and then Back.

Select the desired week type from the drop down menu for each of the required scheduled weeks in

the calendar.
Click Save.
Click Back.

See also

Automatic setting/unsetting of areas on the facing page

Automatic setting/unsetting of other panel operations on page 287
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Exceptions

Exceptions or exception days are used to configure automatic setting schedules for exceptional
circumstances outside of the normal weekly schedules defined in the calendars. Exceptions are
defined with a start and end date (day/month/year) and up to four on/off timing periods for different panel
operations including automatic setting/unsetting of areas or the switching on/off of triggers or outputs.
A maximum of 64 exceptions can be configured on the system.

Exceptions are generic entities that can be assigned to one or more calendars. When an exception is
assigned to a calendar, the exception settings override any calendar configuration for that start and end
date period with both dates inclusive.

Configuring Exception Days
1. Select Configuration > Calendars > Exception Days > Add.

The following page will be displayed.

Calendar Exceptions

Description

Day Month Year
Start date: 01r t |Jdan ¥ 2017 *
End date: 01w I [dan ¥ i [2017 v

Off Time 1 (Sey On Time 2 (Unsey Off Tame 2 (Set) On Time 3 (Unset) Off Time 3 (Set) On Time 4 (Unsey
hh:mm hh:mm hh:mm -} hh:mm hh:mm

Off Time 4 (Set)
hh:mm

1: Calendar_1

2. Configure the fields as described in the table below.

Description Enter a name for the exception (16 characters max).

Start Select the start and end date.

Date/End

Date

On Select the desired times for setting/unsetting or for triggers. Use time

Time/Off guidelines for Automatic Setting/Unsetting of Areas (see Automatic

Time setting/unsetting of areas below), or for Automatic Setting/Unsetting of other
Panel Operations (see Automatic setting/unsetting of other panel operations
on the next page).

Calendars  Select the desired calendar(s) for effect.

NOTICE: Global exception days created remotely using the SPC Manager tool cannot be deleted
or removed.

17.10.5.2 Automatic setting/unsetting of areas
A calendar can be configured for area auto-sets or auto-unsets.

For any day of the week, a configuration can have a maximum of 4 set times and 4 unset times.
Configured times use the 24 hour clock (hh:mm). If the hour is 24, then minutes must be 00, such as
midnight is 24:00. It is possible to define a set time without an unset and vice-versa. Configured times
trigger the area to either set or unset (provided all conditions are satisfied). Times entered are not
considered as a duration of time, rather they are a point in time that said action (set/unset) will occur. If
the controller is powered up or reset, the set/unset status is kept and subsequent set or unset times
occur according to configuration.

ABV10276959-d
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17.10.5.3 Automatic setting/unsetting of other panel operations

Panel operations including triggers, enabling of users, zones, physical outputs can be automatically set or
unset using On/Off, True/False or Active/lnactive state configurations.

On/Off, True/False or Active/lnactive states can be assigned to an output that effectively turns on or off
and can be configured for any day of the week. State configurations have a maximum of 4 set times and 4
unset times. Configured times use the 24 hour clock (hh:mm). If the hour is 24, then minutes must be 00,
such as midnight is 24:00. Each configuration consists of a pairing of settings for On/Off, True/False,
Active/lnactive states. Any one setting without a respective corresponding setting is disregarded.

17.10.6 Change own PIN
To change a PIN, see Changing Engineer PIN and web password on page 208.

17.10.7 Configuring advanced settings

This section covers:
» Cause and Effect below
o Mapping Gates below
« Triggers on the facing page
« Audio/Video Verification on page 291
« Updating SPC Licenses on page 294
17.10.7.1 Cause and Effect
1. Select Configuration > Advanced > Cause and Effect.

The following page will be displayed.

Cause & Effect Configuration
Select the device type fo tigger, can be either fo trigger a physical output through a mapping gate, tigger an area action, such as fullset or door action such as deor close

Type AreafDoor DESCRIPTION

Output R = :’T“E\tg‘g:errnapplng gate to an output on one of the connected expanders. When the mapping gate is switched ON the mapped expander output

Area Hone - Assign Assign Trigger(s) to an Area for automatic Setting\Unsetting, Delay Autoset, Restare Alarms, Cancel Delayed Unset

Door None ~ Assign Assign trigger(s) to door for automatic door lnck/ unlock, Normal , Momentary Access

2. Click an Assign button to perform one of the following actions:

« Output: Assign a mapping gate (virtual output) to trigger a physical output. Select this option to
display the Mapping Gate - List page. For more information see Mapping Gates below.

« Area: Assign a trigger(virtual input) to trigger an area action. Choose an Area from the drop-
down list before you click the Assign button. For more information see Triggers on the facing

page.
« Door: Assign a trigger (virtual input) to trigger door action. Choose a Door from the drop-down
list before you click the Assign button.

To display the list of configured triggers and actions, select Configuration > Advanced > Cause &
Effect > Cause & Effect List.

The Cause & Effect List page displays only fully functioning cause & effects. For example, if a mapping
gate is not assigned to a trigger or to a quick key, it is not displayed in the list.

WARNING: Your system will not comply with EN standards if you enable a trigger to set the system
without a valid PIN being required.

17.10.7.2 Mapping Gates

Triggers are used with Mapping Gates, which are virtual outputs defined by the user that can be mapped to
a physical output. There can be a maximum of 512 Mapping Gates.
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[

For continuous output, when the trigger is a valid user code, both states must be the same, either
both negative or both positive.

7.
8.

. Select Configuration > Advanced > Cause & Effect > Mapping Gates.

The following page displays.

Hardware System Inputs Outputs Areas Calendars Change own PIN Advanced
Verification License
Mapping Gates

Configuration saved OK

Mapping Gate - List

Gate Description Local Quick Key Timer Assign Trigger(s) Assign output Delete
1 MG1 None ¥ 0 * 100ms I None v )
2 MG2 | None ¥ (] * 100ms ﬁ None v E

Save || Add

Enter a Description for the gate. This is important as no mapping gate number, only the
description, is displayed on the Outputs user page for turning on and off gates.

Tick the Local check box if you do not want to allow users to turn on and off this gate, even if
they have the right to do so. A local gate is not visible remotely.

Select desired Quick Key.

A quick key is a ‘# followed by a single digit pressed at the keypad. If a shortcut is configured
and is pressed at the keypad, the user is prompted to turn the output on or off.

i There may be many outputs activated by one shortcut, both X-10 and Mapping
Gates.

Add a Timer for the gate. Time quantity used is 1/10 of a second.

Click the Triggers button to configure triggers for tuming the output on and turning it off. In both
cases, a positive or negative edge of the trigger needs to be defined. See Triggers below for
details of configuring triggers.

Select an output from the drop-down list.

Click Add to add a new gate or Save to save the new settings for an existing gate.

See also

Triggers below

17.10.7.3 Triggers

A trigger is a system state (for example, zone closing/time/system event (alarm), etc.) that can be used
as inputs to the Cause & Effects. The triggers can be logically assigned together using the logical
operators AND/OR to create user outputs. The system supports up to a maximum of 1024 triggers
across all its Cause & Effects system.
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1. Select Configuration > Advanced > Triggers.

The following page will be displayed.

Triggers

Trigger added

Trigger 2: Configuration

Description

Calendar None v Check if trigger should be limited by a calendar.

Time Limit: 00 ¥ |:|00¥|-|00¥| |00v¥| Checkiftriggershould be limitad by time.

Timer 0 Number of seconds trigger conditions must be true before trigger will activate.

Trigger Al v Choose "All’ trigger will become only active if all conditions are met, while choosing 'Any’ trigger will become active if any of its conditions
Operation are met

aad conaivion  [JEXER
e iy

2. Configure the fields as described in the table below.

Trigger System generated number for new trigger.

Trigger will only become active if one of the 2 optional steps (calendar/time
limitation) is configured

Description Enter a text description for the trigger.

Calendar Select a calendar, if required. If selected, the trigger will only be in effect during
this calendar period. See Calendars on page 284.

Time limit Select a time period between 00:00 and 24:00 during which the trigger will only be
in effect. The Start time is inclusive, the end time is exclusive.

Note: This parameter delays a trigger transition from ON to OFF only; from OFF
to ON is immediate.

Timer Enter the number of seconds that the trigger conditions must be true before the
trigger will activate.

Trigger « All All trigger conditions must be active for the system to activate the
Operation trigger.

« Any Any trigger condition that is active enables the system to activate the
trigger.

Performable actions

Add

Exceptions
Edit/View

Delete

Add conditions for the trigger. Click this button to add one or more conditions for the selected trigger.
See Trigger conditions on the facing page.

Configure setting schedules for exceptional circumstances outside of the normal weekly schedules.
Edit or view the selected calendar.

Delete the selected calendar.

The calendar cannot be deleted if it is currently assigned to an SPC configuration item, i.e. zone,
area, user profile, output, trigger, door or X-Bus component. A message is displayed indicating the
assigned item.
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Trigger conditions

The following table lists the trigger conditions and the associated States, Outputs, Events, or
Communication.

Trigger
condition

States, Outputs, Events, or Communications

Zone

Door

Output

System

User

Profile

Expander

The trigger is ON if the following conditions are satisfied (i.e. a logical AND operation is
performed): The trigger is ON if the configured zone is in one of the following states - Open,
Close, Short, or Disconnected.

The trigger is ON if the any of the following door options are configured: Entry granted, Entry
denied, Exit granted, Exit denied, Door open too long, Door left open, Door forced
open, Door normal, Door Locked, Door unlocked.

The trigger is ON if the system output is in the configured state, which can be On or Off:
System Output, Mapping gate, Area Output.

The trigger is ON for the chosen system event and ID. IDs are: System Reboot, Overcurrent,
Engineer Access, Manufact. Access, XBUS cable fault, Xbus faults.

Time Trigger — the trigger is on at the specific time entered in the box provided, in the format
hh:mm.

Wireless Fob - this condition can be configured for a particular user or for any user. With this
configuration, if the configured user (or any user) presses the * key on the FOB, it will cause an
instantaneous pulse OFF/ON/OFF. This only applies for FOBs that have been registered with
the system.

Wireless Fob Panic — this condition can be configured for a particular user or for any user. With
this configuration, if the configured user (or any user) presses the *’ key on the FOB Panic, it
will cause an instantaneous pulse OFF/ON/OFF. This only applies for FOB Panics that have
been registered with the system.

Keypad Pin — this condition can be configured for a particular user or for any user. With this
configuration, if the configured user (or any user) enters a valid PIN, or presents a configured
PACE, it will cause an instantaneous pulse OFF/ON/OFF.

Access card —the trigger is activated when the selected user logs in using an access card.
Web Access —the trigger is activated when the selected user logs in through the web browser.

WPA* —the trigger is activated if a button or combination of buttons is pressed. It is possible to
assign a trigger condition to all WPAs or just to one specific WPA. When a trigger with a WPA
trigger condition is defined, it can be assigned to a mapping gate for many purposes including
arming a system, turning on lights or opening a door.

Keypad Access — the trigger is activated when any user logs into the selected keypad.

Keypad Pin —if a user with the configured user profile enters a valid PIN, or presents a
configured PACE, it will cause an instantaneous pulse OFF/ON/OFF.

Access card — the trigger is activated when a user with the configured user profile logs in using
an access card.

Web Access —the trigger is activated when a user with the configured user profile logs in
through the web browser.

Keyswitch — the trigger can be configured for a specific key position on the keyswitch.

Indicator — the trigger can be configured for a specific function key.
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Trigger

eee States, Outputs, Events, or Communications
condition

Communication FlexC ATP —the trigger activated by the selected ATS and ATP configuration.

FlexC ATS —the trigger activated by the selected ATS configuration.

*A WPA is compatible with SiWay RF Kit (SPCW110, 111, 112, 114 ) only.

\ WARNING: Your system will not comply with EN standards if you enable a trigger to set the system
without a valid PIN being required.

17.10.7.4 Audio/Video Verification

To set up Audio/Video Verification on an SPC system:

1. Install and configure Audio Expander(s).

Install and configure Video Camera(s).
Install and configure Audio Equipment.
Configure Verification Zone(s).
Test audio playback from verification zones.
Assign Verification Zone(s) to physical zone(s).

Configure Verification Settings.

©® N o o bk~ w0 D

View images from verification zones in web browser.

\ NOTICE: Keypads and access control may be disabled for several minutes while sending an audio
file to the panel, depending on the size of the file.

Configuring Video

Overview

Cameras are used for video verification. The SPC panel supports a maximum of four cameras. Only IP
cameras are supported and the panel must have an Ethernet port.

| @
1 NOTICE: Cameras must not be shared with other CCTV applications.

Cameras can only be configured with the web browser. Configuration with the keypad is not supported.
The panel supports two camera resolutions:

o 320X240

This setting is recommended if you want to view images on the browser)

o 640X480 (with some restrictions).
The following cameras are supported in addition to other generic cameras:

« Vanderbilt CCIC1410 (1/4” VGA IP Colour Camera)

« Vanderbilt CFMC1315 (1/3” 1.3 MP Indoor Dome Colour Camera)
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A command string is available as a default to access configuration details for the above cameras
directly. Other generic IP cameras require a command string to be entered manually.

Adding Camera

1. Select Configuration > Advanced > Verification > Video.

A list of any previously configured cameras is displayed and their online or offline status. A
camera is online if an image was obtained from the camera in the previous 10 seconds.

Hardware System Inputs Outputs Doors Areas Calendars change own PIN || Advanced
Triggers Mapping Gates License
Video
Camera Added
Camera Description Type Status Edit Delete
1 Siemens CMFC1315 Online =] =
2 Siemens CCIC1410 Offline ] ]
3 Siemens CCIC1410 Offline [zl sl
4 Siemens CCIC1410 Offiing l:l |:|
Add

2. Click the Add button to add a new camera or the Edit button to edit an existing camera.

The following page is displayed.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Triggers Mapping Gates License
Video
Camera Configuration

Camera 1D 1
Description Description of camera
Type
Camera IP Camera TCP/IP address.
Camera Port TCP/P Port of camera
Usemame Usemame for camera login (Added to command string)
Password |uu- ‘ ‘ Update Cmd. strm| Password for camera login (Added to command string)

Command String Command to send to camera to get images

2

Pre-Event Images Number of pre-event images to record (0 - 16).

Pre-Event Interval Interval befween pre-event images. in seconds (1 - 10).
Post-Event Images Number of post-event images to record (0 - 16).

Post-Event Interval Interval between post-event images, in seconds (1 - 10).

= y =
o
=
E
e
S
©
It
=~}
5
G
i
3
8
3
o

3. Configure the camera with the following parameters:

CameralD System generated Camera ID.
Description Enter a description to identify this camera.

Type Select from one of the following camera types:
« Generic
« Vanderbilt CCIC1410
« Vanderbilt CFMC1315

CameralP  Enter the IP address of the camera.

Camera Enter the TCP port the camera listens on. Default is 80.

Port Note: The CCIC1410 camera can only be used over port 80 only.
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Username  Vanderbilt CCIC1410 and CFMC1315 cameras only.

Enter a login username for the camera which will be added to the command
string below when the Update Cmd. String button is clicked.

Password  Vanderbilt CCIC1410 and CFMC1315 cameras only.

Enter a login password for the camera which will be added to the command
string below when the Update Cmd. String button is clicked.

Command Enter the command string to be sent to the HTTP server on the camera in

String order to obtain images. This string should include the user name and
password for the camera. Consult the camera documentation for the specific
string required for the camera type selected.

The default command string for a Vanderbilt CC1C1410 or CFMC 1315
camera with no password is "/cgi-bin/stilljpeg".

Pre-event  Enter the number of pre-event images to record (0—16). Default is 8.
images

Pre-event  Enter the time interval, in seconds, between pre-event images (1-10). Default
interval is 1 second.

Post-event Enter the number of post-event images to record (0-16). Default is 8.
images

Post-event Enter the time interval, in seconds, between post-event images, in seconds
interval (1-10). Default is 1 second.

Configuring Verification Zones

To create a verification zone
1. Goto Configuration > Advanced > Verification > Verification zones.

A list of any existing verification zones is displayed.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced
Triggers Mapping Gates License
Verification zones
V-Zone Description Audio Video Delete
' r=|
2 =)
: ===
. =
2. Click the Add button.
3. Enter a Description for the zone.
4. Select an Audio expander from the drop down list.
5. Select a Video from the drop down list.
6. Click the Save button.
7. Assign this verification zone to a physical zone on the SPC system. (See Editing a zone on
page 270.)
See also

Editing a zone on page 270
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Configuring Verification Settings
Note: The following settings apply to all verification zones (see Configuring Verification Zones on the
previous page).
1. Select Configuration > Advanced > Verification > Audio.

The following page is displayed.

Hardware System Inputs Outputs Doors Areas Calendars Change own PIN Advanced

Triggers Mapping Gates License
Audio

Verification settings

Audio Settings

Pre_Event Recording Seconds (Dgr_aﬁi;g )of pre-event recording in seconds.
Post.Event Recording Seconds ([Jg(aﬁigg )of post-event recording in seconds.

2. Configure the following settings.
Pre-event Enter a required duration of pre-event audio recording, in seconds (0—
recording 120). Default is 10.
Post-event Enter a required duration of post-event audio recording, in seconds (0-
recording 120). Default is 30.

Viewing Video Images

Video images from the configured cameras can be viewed in the web browser in Full or Soft Engineer
modes. This functionality is also available to users that have the View Video right in their profile. (See
Adding/Editing a User on page 196.) The Web Access right must also be enabled for this functionality.

The View Video right can also be set on the keypad (‘Video in Browser' setting).
To view images, go to SPC Home > Video. See Viewing Video on page 178.
See also
Adding/Editing a User on page 196
Configuring Video on page 291

17.10.7.5 Updating SPC Licenses

The License Options feature provides a mechanism for the user to update or add functionality to the
SPC system, for example, for migrations, where installed peripherals, which are not licensed for SPC,
need to be supported by an SPC controller.

1. Select Configuration > Advanced > License.

Hardware System Inputs Cutputs Doors Areas Calendars Change own PIN Advanced

Triggers Mapping Gates Verification License

License Options

S/N 13548280
Current License Key: WIFATQKBTF2ZLTOA

2. Contact technical support with the requested functionality and quote current license key as
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displayed.

If request is approved, a new license key is issued.

3. Enterthe new key in the field provided.

17.11 Configuring Communications

This section covers:

17.11.1 Communications Settings ...................
1711.2F1exC® ... ..
1711.3 Reporting ... ... ...
1711.4PCTools .. ... ... ... ... ...

17.11.1 Communications Settings

This section covers:

« Configuring the networking services of the panel below

o Ethemet on the facing page
» Configuring Modems on page 297
« Serial ports on page 303
17.11.1.1 Configuring the networking services of the panel

1. Select Communications > Communications > Services.

The following page will be displayed.

Communications FlexC ® Reporting PC Tools

Services Ethemet Modems Serial ports

Network Services

HTTP Enabled
HTTP Port 80

TLS Enabled (]
Telnet Enabled (]
Telnet Port 23
SNMP Enabled (]
SNMP Community public
ENMP Enabled Enabled M
ENMP Port 1287
ENMP Password siemens
ENMP Change Enabled

2. Configure the fields as described in the table below.

Check to enable web server
Port web server is listening on

Check to enable the encrypted web server

Check this to enable telnet server

Port telnet server is listening on

Check to enable Simple Network Management Protocol

Community ID for SNMP protocol

Enhanced Network Management Protocol Enable/Disable/Enable in Engineer Mode
Port ENMP is listening on

Password used to encrypt ENMP packets

Check to enable network config changes through ENMP

HTTP Tick this box to enable the embedded web server on the panel.
Enabled
HTTP Port  Enter the Port number that the web server is 'listening' on. By default this is set
to 443.
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TLS
Enabled

Telnet
Enabled

Telnet Port

SNMP
Enabled

SNMP
Community

ENMP
Enabled

ENMP Port

ENMP
password

ENMP
change
enabled

Tick this box to enable encryption operation on embedded web server. By default
this is enabled. With TLS enabled, web pages can only be accessed by using
‘https://’ prefix before typing the IP address.

Tick this box to enable the Telnet server. (Default: Enabled)

Note: Using Telnet without a comprehensive knowledge can damage the
controller configuration; this should only be used if the user has sufficient
knowledge or is being instructed by someone with such knowledge.

Enter the number of the Telnet port.

Tick this box to enable Simple Network Management Protocol (SNMP). (Default:
Disabled)

Enter the Community ID for the SNMP protocol. (Default : Public)

Tick this box to enable Enhanced Network Management Protocol (ENMP).
(Default : Enabled in Full Engineer)

Enter the ENMP port number (default: 1287).

Enter the password for the ENMP protocaol.

Check this box to enable network changes to be made with ENMP protocol.

17.11.1.2 Ethernet

The Ethemet port on the controller can be configured from both the browser and keypad interfaces. An
Ethernet connection with the SPC controller can be established using a direct connection or a LAN

connection.

1. Select Communications > Communications > Ethernet.

The following page will be displayed.

Communications

FlexC Reporting PC Tools

Ethernet Modems. Serial poris

Ethernet Settings

Panel IP Address
Netmask
Gateway

DNS Server

10.100.82.181 Static IP address
55.255.0.0 Static IP Netmask

Static IP Address of Gateway

S| 3] [
h =
£ =

=

0.0.0 IP Address of DNS server

| save || Enable DHCP |

2. Configure the fields as described in the table below.

address

IP Enter the IP address of the panel.
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IP Enter the subnet mask that defines the type of network address structure
Network implemented on the Local Area Network (LAN).

Gateway Enterthe IP address of the IP gateway if one exists. This is the address that IP
IP packets will be routed through when accessing external IP addresses on the
Address internet.

Enable Click this Button to enable dynamic address assignment on the panel.
DHCP

DNS Enter the IP address of the DNS server.
Server

17.11.1.3 Configuring Modems

The SPC panel provides two on-board modem interface connectors (primary and backup) that allow you to
install GSM and/or PSTN modules onto the system.

After a factory default, during the process of initial setup of the system with the keypad, the panel
detects if it has a primary or backup modem fitted, and if so, it displays the modem type and
automatically enables it (or them) with the default configuration. No other modem configuration is
allowed at this stage.

L)

To program the modem(s):
Note: A modem must be installed and identified. (See section Installing plug-in modules on page 90.)

1. Select Communications > Communications > Modems.

‘Communications FlexC @ Reporting PC Tools
Services Ethemet Modems Serial ports
Modem 1 Primary Modem 2 Backup
Status: Ready Status: Ready
Type: IntelliModem GSM Type: IntelliModem PSTN
Firmware Version: 4.00 Firmware Version: 2.00 [28MAR 14]
 Configure | Disable | Configure | Disable

2. Click Enable.
3. Click Configure.
« If you have installed a GSM Modem, the GSM Modem settings page displays.
For more information, see GSM modem on page 299.
« Ifyou have installed a PSTN modem, the PSTN Modem settings page displays.

For more information, see PSTN modem on page 301.

SMS detection and configuration is not available unless modems that are configured and enabled.

jmie
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SMS test
Once the SIM feature is enabled for a modem, a test may be preformed to desired recipient number with
a composed message.

1. Enter the mobile phone number (including 3-digit country prefix) in the number field and a short
text message in the message box.

2. Click Send SMS and verify the message is received on the mobile phone.

The SMS test is provided only for the purpose of ensuring the SMS feature is operating correctly. A
short text message using alphabetic characters (A-Z) should be used to test this feature.

e

The SMS operates using a standard protocol that is used in SMS telephones. Note that some PSTN
operators do not provide the service of SMS over PSTN. For SMS to operate over PSTN the following
criteria is required:

« Caller ID needs to be enabled on the telephone line.

« Direct telephone line — not through PABX or other comms equipment.

« Also note that most Service Providers only allow SMS to a telephone registered in the same

country (this is due to billing issues).
SMS feature

The SPC controller allows remote (SMS) messaging on systems with installed modems. Once a
modem is installed, the following configurations are necessary for SMS:

o SMS-enabled modem

o SMS Authentication

« Engineer SMS Control

« User SMS Control
Depending on configurations, features include these SMS abilities:

« Event notification

« Remote Commands (users may be assigned select remote commands)

SMS system options

Once a modem is installed and the SMS feature enabled, for SMS operations the SPC system must
apply the SMS Authentication.

1. Select Configuration > System > System Options.

2. Select the desired option from the drop-down menu SMS Authentication:
« PIN Only: This is a valid user code. See Creating system users on page 108.

o Caller ID Only: This is the phone number (including 3-digit country prefix code) as
configured for User SMS Control. Only when this option is selected will the SMS Control be
available for configuration by the user.

« PIN and Caller ID

o SMS PIN Code Only: This is a valid PIN code configured for the user which different from
the user’s login code. Only when this option is selected will the SMS Controls be available
for configuration by the user.

« SMS PIN Code & Caller ID
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SMS commands

See SMS Commands on page 204 for more information.

GSM modem

Prerequisite

1.
2.

SGM

A GSM modem must be properly installed and functioning correctly.
Select Communications > Communications > Modems.

Click Configure.

Configure the following fields.

Modem settings

Country
SIMPIN

Wireless
Technology

Operator
Survey

Allow
Roaming

USSD

Select the country that the SPC systemis installed in.
Enter the PIN for the SIM card installed in the GSM module.
GSM only

Select the signal type that you wish to the modem to use:
e 2G Only
This option enables connection to 2G networks only.
o 3G Only (Default)
This option enables connection to 3G networks only.
« Search 2G First

This option forces the modem to connect to 2G networks where available. If 2G is not
available, the modem connects to 3G.

o Search 3G First

This option forces the modem to connect to 3G networks where available. If 3G is not
available, the modem connects to 2G.

Multi-network SIMs only

Enable this option for the modem to search for all available networks and to connect to the
strongest available signal.

Select to enable GSM roaming.

Warning: If this option is enabled, the modem can connect to a network in a different country.

Note: Changing this setting resets the modem.

Note: Supported on GSM modems v3.08 or higher.

Pay-As-You-Go SIM only

Enter the code that the modem can use to query the network for the credit balance of the SIM.

This code is network-dependent, please check with your service provider.
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Incoming
Calls

Line
Monitoring

Monitoring
Timer

Modem Fault
Time

SMS Enable

Automated
SMS

Automated
SMS Number

Start
Date/Time

Note: Vanderbilt recommend that these options are not enabled for current systems.
The modem can be programmed to answer calls based on the following conditions:

« Don’t answer incoming calls: The modem never answers calls.

« Answer incoming calls: The modem answers incoming calls.

« Only answer when ‘Engineer Access’ is granted: The modem only answers the call while
engineer access is granted to the system.

« Disabled
« Enable
o Fullset

Enable this feature to monitor the signal level from the GSM mast connected to the modem.
The Fullset option only enables this feature while the system is Fullset.

Note: EN 50131-9 Confirmation configuration — In order for EN50131-9 Confirmation to operate
correctly, line monitoring must be enabled. (See Options on page 252.)

Enter the time period in seconds for which the signal level must drop to Low before the SPC
system registers a fault. 0 to 9999 seconds range.

Enter the time delay in seconds before the SPC system sends an alert. 0 to 9999 seconds range.

Tick this checkbox to enable the transmission and reception of SMS messages and command
control.

» Disabled
« 1 hour

e 24 Hours
« 48 Hours
o 7 Days
« 30 Days

Select the timing for automated SMS messages.

Enter SMS number to receive automated SMS messages. Only one device can receive these
messages.

Enter the start date and time from when the system will send automated SMS messages.

Mobile Data Configuration

Access Point
(APN)

Access Point
User Name

Access Point
Password

Enter Access Point details to enable any IP communications. These details are service provider-
dependent.

Enter Access Point details to enable any IP communications. These details are service provider-
dependent.

Enter Access Point details to enable any IP communications. These details are service provider-
dependent.
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Dial Up Internet Configuration

Dial Up Select this option to enable the modem to gain internet access through a dial-up connection
Internet

Enable

Phone Enter the phone number for the dial-up connection.

Number

Username Enter the dial-up connection Username.

Password Enter the dial-up connection Password.

Click the Test SMS button to send a short text message for the purposes of testing the system.

] The SMS test is provided only for the purpose of ensuring the SMS feature is operating correctly. A
1 short text message using alphabetic characters (A-Z) should be used to test this feature.

PSTN modem

1. Select Communications > Communications > Modems.
2. Click Configure.
3. Configure the fields as described in the table below.

PSTN Modem settings

Country Select the country that the SPC is installed in.

Incoming  The modem can be programmed to answer calls based on the following conditions:

alls . .
c « Don’t answer incoming calls Modem never answers calls.

« Answer after ‘X’ rings Select the number of rings (1 to 8) after which the modem answers the
incoming call.

« Answer when after one ring phone is hung up, then immediately dialled again If the
calling party calls the modem, hangs up after 1 ring burst only, and then immediately re-calls the
modem. The SPC system knows to automatically answer the call in this condition.

« Only answer when engineer access is granted The modem only answers the call while
engineer access is granted to the system.

Prefix Enter the number required to access a line (for example, if connected to a PBX).
Line Enable this feature to monitor the voltage of the line connected to the modem.
Monitoring

Note: EN 50131-9 Confirmation configuration — In order for EN50131-9 Confirmation to operate
correctly, line monitoring must be enabled. (See Options on page 252.)

Monitoring  Select the period (in seconds) for which the line voltage must be seen as being incorrect before the
Timer line is deemed by the SPC to be faulty.

Modem Time delay for a system alert (09999 seconds). Default 60 seconds.
Fault Time
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SMS Tick this checkbox to enable the SMS feature on the system.

Enable Note: The SMS operates using a standard protocol that is used in SMS telephones. Note that some

PSTN operators do not provide the service of SMS over PSTN. For SMS to operate over PSTN the
following criteria is required:

Caller ID needs to be enabled on the telephone line.
Direct telephone line — not through PABX or other comms equipment.

Also note that most Service Providers only allow SMS to a telephone registered in the same country
(this is due to billing issues).

Note: SMS over PSTN is no longer supported. The functionality remains in the product for backward

compatibility.
SMS Only for PSTN. This number automatically displays the default number for SMS for the country
Server selected. Enter an appropriate phone number of the SMS service provider that is accessible in your
Number location.

Automated Select the timing for automated SMS messages.
SMS

Automated Enter SMS number to receive automated SMS messages.
SMS
Number

Dial Up Internet Configuration

Dial Up Select this option to enable the modem to gain internet access through a dial-up connection.
Internet

Enable

Phone Enter the phone number for the dial-up connection.

Number

Username Enter the dial-up connection Username.

Password  Enter the dial-up connection Password.

Click the Test SMS button to send a short text message for the purposes of testing the system.

o The SMS test is provided only for the purpose of ensuring the SMS feature is operating correctly. A
l short text message using alphabetic characters (A-Z) should be used to test this feature.

When using the SMS message feature over a PSTN line, it is necessary to program the phone number
of the SMS service provider that services the area in which the SPC is installed. The SPC system
automatically dials this number to contact the SMS server whenever the SMS feature is activated.
Calling line identity MUST be enabled on the PSTN line for this feature to operate. Each country will
have its own SMS service provider with a unique phone number.

e This feature is not released in all countries. Contact your local supplier for more information
l (support of feature, recommended service provider).
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17.11.1.4 Serial ports
The SPC controller provides 2 serial ports (RS232) that offer the following functionality:

« X10: Serial port 1 is a dedicated interface that supports the X10 protocol. This protocol allows for
use of the existing power cables of a building to transport control information to X10 devices
providing the ability to trigger and monitor these devices via the SPC Controller programming
interface.

« Logging of Events: The Serial port 2 interface provides the ability to connect to a serial port on a
PC or a printer. With this connection, a terminal program can be configured to receive a log of
System Events or Access Events from the SPC controller.

« System Information: Serial port 2 also provides an interface via a terminal program that allows for
the execution of a set of commands to interrogate the controller for specific system information.
This facility is available only as a tool for debug and information purposes and should only be used
by experienced installers.
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To configure the serial ports:
« Select Communications > Communications > Serial Ports.

The following page will be displayed:

Communications FlexC ® Reporting PC Tools
Services Ethemet Modems Serial ports
Serial Port 1 Serial Port 2
Type: Teminal ¥ Serial port in use by Backup modem
Print Event Log: v
Print Access Log:
Bits per Second: 115200 +
Data Bits: 8r
Parity: None ¥
Stop Bits: 1v
Flow Control: RTSICTS v
Save

The settings displayed will depend on the type of connection that the ports are used for. The
settings are described in the following sections.

17.11.2 FlexC®

The SPC Flexible Secure Communications Protocol (FlexC) enables communications for an Internet
Protocol (IP) based single or multiple path Alarm Transmission System (ATS). An ATS is areliable
communications link between a Supervised Premises Transceiver (SPT, for example, Ethernet
integrated onto the SPC panel) and a Receiving Centre Transceiver (RCT, for example, SPC Com XT
or the SPC Connect server, www.spcconnect.com). A FlexC ATS consists of a primary Alarm
Transmission Path (ATP) and up to nine backup Alarm Transmission Paths (ATPs). It enables:

« Two-way transfer of data between the SPT, for example the SPC panel over Ethemnet, and the
RCT, for example, the SPC Com XT server or the SPC Connect server, www.spcconnect.com.

« Communication monitoring of a complete ATS and individual ATPs.
SPC intrusion panels support FlexC over IP with any of the following interfaces:
« Ethernet
« GSM modem with GPRS enabled
o PSTN modem
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Supervised Premises (SP)

Alarm Receiving Centre {ARC)

See also

Quick Start ATP Configuration for EN50136 ATS below
Configuring Event Profiles on page 319

Supervised Premises
Transceiver (SPT)

!

Network Equipment on
Site

Network Equipment on
Site

!

Receiving Centre
Transceiver (RCT)

¢

s

==

Annunciation Equipment (AE)

Alarm
Transmission
Path (ATP)

Event Exception Definition on page 320

Configuring Command Profiles on page 322

FlexC Status on page 192

Configuring an EN50136-1 ATS or Custom ATS on page 307

17.11.2.1 Operation Mode

The system uses the store-and-forward method when communicating events.

The SPC Alarm System sends events to SPC Com XT and requires an acknowledgment from SPC Com
XT before the SPC Alarm System considers the event to have been successfully transmitted. SPC Com
XT only acknowledges the event after it has successfully written the event to the SQL database. SPC

Com XT then forwards the event to the SPC Com XT Client and Sur-Gard interfaces.
17.11.2.2 Quick Start ATP Configuration for EN50136 ATS

FlexC provides the following out of the box features that enable you to get FlexC up and running quickly:

» Quick start configuration page for an EN50136 Single Path ATS, Dual Path ATS and Dual Path
Dual Server ATS

« Default Event Profile
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« Default Command Profile (this does not support audio video verification)

« Default FlexC Command User Name (FlexC) and Command Password (FlexC) for
controlling the panel from the RCT (for example, SPC Com XT)

« Auto Encryption with no password

1. Toquickly configure a FlexC connection between a panel and an RCT (for example, SPC Com
XT), goto Communications > FlexC > FlexC ATS.

2. Under Add EN50136-1 ATS, choose one of the following to display the ATP Configuration :
« Add Single Path ATS - primary ATP only
« Add Dual Path ATS - primary and backup ATPs
« Add Dual Path Dual Server ATS - primary and backup ATPs, primary and backup servers

Communications FlexC Reporting PC Tools

FlexC ATS Event Profiles Command Profile FlexC Help
ATP Configuration - EN50136 ATS

Panel Identification

ATS Name [aTs3 | The name of the ATS

SPT Account Code |D | The number that uniquely defines the panel to the RCT (1-98999999, 0 = Aut
RCT Identification

RCTID |1 | The unique ID of the RCT (e.g. RCT ID of SPC ComXT) (1-99999999)

RCT URL or IP Address |D.B.0.0 | URL or IP address of the RCT (e.g. SPC ComXT)

RCT TCP Port |52000 | The TCP Port of the RCT (e.g. The TCP Port that SPC ComXT is listening on
Backup RCT Identification

RCTID |'I | The unique ID of the RCT (e.g. RCT ID of SPC ComXT) (1-89999939)

RCT URL or IP Address |D.D.0.0 | URL or IP address of the RCT (e.g. SPC ComXT)

RCT TCP Port |52|}DG | The TCP Port of the RCT (e.g. The TCP Port that SPC ComXT is listening on
ATP Interface

EN50136 ATS Category |Dua| Path ATS: DP3 V| Select the ATS Category as defined in the EN50136-1:2012 specification

Primary Interface |E1hemet V| Interface used by Primary ATP for communication

Backup Interface |D\a\ Up Internet: Modem 1 V| Interface used by Backup ATP for communication

3. Complete the fields on the ATP Configuration - EN50136 ATS page shown in the table below.
At a minimum, you must complete the field RCT URL or IP Address to save. If you do not enter
an SPT Account Code, you can commission the panel using the ATS Registration ID which is
automatically generated when you save. The RCT operator must enter this ATS Registration
ID, for example, in SPC Com XT.

4. Click Save. The ATS Configuration page displays showing the ATS Registration ID and the
configured primary ATP or primary and backup ATPs in the Event Sequence Table.

5. Onthe ATS Configuration page, click Save to accept the default settings, for example, the
Default Event Profile, the Default Command Profile (including the FlexC Command User
Name and FlexC Command Password), and Auto Encryption with no password. To change
the settings, see Configuring an EN50136-1 ATS or Custom ATS on the next page.

6. Click Back. The ATS displays in the Configured ATS table.

Panel Identification

ATS Enter the name of the ATS. If you do not enter a value, the ATS name defaults to ATS 1, ATS 2,
Name etc.
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SPT The number that uniquely identifies the panel to the RCT. Enter 0 if you do not have the SPT
Account  Account Code. In this case, you can commission the panel using the ATS Registration ID. For an
Code EN50136 ATS, the ATS Registration ID is automatically generated when you click Save. The

RCT can send the SPT Account Code to the panel wheniit is available.
RCT Identification & Backup RCT Identification (Dual Path Dual Server Only)

RCTID Enter the RCT ID that uniquely identifies the RCT (for example, SPC Com XT) to the panel. This
must match the value entered in the SPC Com XT Server Configuration Manager tool in the Server
RCT ID field in the Server Details tab. See the SPC Com XT Installation & Configuration Manual.

RCTURL Enterthe RCT URL or IP Address forthe RCT server location (for example, SPC Com XT
orlP server).
Address

RCT TCP Enterthe TCP port for the RCT (for example, SPC Com XT). This must be the same value entered
Port for the field Server FlexC Portin the SPC Com XT Server Configuration Manager tool.

ATP Interface

EN50136 Select the EN50136 ATS Category (SP1-SP6, DP1-DP4). For a description of categories, see
ATS ATS Category Timings on page 397.
Category

Primary Select the Primary Interface to apply to the primary communications path from the following:
Interface o Ethemet

o GPRS: Modem 1

o GPRS: Modem 2

o Dial Up Internet: Modem 1

« Dial Up Internet: Modem 2

Backup For a Dual Path ATS, select the Backup Interface to use for the backup communications path
Interface  from the following:

o Ethemet

« GPRS: Modem 1

« GPRS: Modem 2

« Dial Up Internet: Modem 1
« Dial Up Internet: Modem 2

17.11.2.3 Configuring an EN50136-1 ATS or Custom ATS

An ATS comprises an alarm panel, network paths and an RCT (for example, SPC Com XT). It combines
one or multiple paths between an SPC panel and an RCT. You can add up to 10 ATPs to an ATS.

NOTICE: Foran EN50136-1 ATS, the ATS set up sequence starts with configuring an ATP for an
ATS. This provides you with a quick set up feature. See Quick Start ATP Configuration for EN50136
ATS on page 305.

g,

1. Toconfigure an ATS, go to Communications > FlexC > FlexC ATS.
2. Choose from one of the following options:

« Add Single Path ATS

« Add Dual Path ATS
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3.

4.

o Add Dual Path Dual Server ATS
o Add Custom ATS

Foran EN50136 ATS, you must configure the settings on the ATP Configuration - EN50136
page first. See Quick Start ATP Configuration for EN50136 ATS on page 305.

The ATS Configuration page displays. An EN50136-1 ATS will display a primary or primary
and backup ATP in the Event Sequence Table.

Communications FlexC Reporting PC Tools

FlexC ATS Event Profiles Command Profile FlexC Help
ATS Configuration [ATS 3]

Identification

ATS Name ATS 3 The name of the ATS
ATS Registration ID TTS9-TY45-X2YP-SS56 The unique registration ID of the ATS allows the panel to be uniquely identified at the RCT.

Event Sequence Table

" Move Move Seq Communications Active Polling Event
Edit | Delete | " | pown | No SELE Imerface clfpEniinn S Timeout (s)  Timeou (s)
| AddATPw0FlexCRCT | |  Add ATPtoAnalog ARC |
ATS Profiles
Event Profile Default Event Profile | Select the Event Prafile which defines how and which events are transmitted on this ATS
Command Profile Default Command Profile | Select the Command Profile which defines the commands that are allowed on this ATS
ATS Faults
ATS Polling Timeout D Seconds An ATS Polling Timeout is raised if no Poll message has been successfully acknowledged on any ATP within this period. (0 =
Auto Calculate)
ATS Event Timeout Seconds An ATS Event Timeout is raised if an event has not been successfully acknowledged on any ATP within this period
Generate FTC =] Selects whether the system generates an FTC on an ATS Event Timeout or an ATS Poling Timeout
Re-gueue Events [ Select what happens to events after an ATS Timeout
Re-queue Event Delay Seconds Delay after an ATS Event Timeout before the re-queued event is attempted again
Re-gueue Event Duration 86400 Seconds Amount of time that the event will be re-queued before the event is deleted
Instaliation Details
Installation Details Edit Installation Details The following installation details are passed to the RCT to help the Operator at the RCT fo identiy the panel.

Enter an ATS Name to identify the ATS. If you do not enter a value, the ATS name defaults to
ATS 1, ATS 2, etc.

To add 1 primary and up to 9 backup ATPs to an ATS, click Add ATP to FlexC RCT (see Add
ATP to FlexC RCT on the next page) or click Add ATP to Analog ARC (see Add ATP to
Analog ARC on page 314).

Select an Event Profile from the dropdown menu. To customise how events are transmitted on
an ATS, see Configuring Event Profiles on page 319.

Select a Command Profile from the dropdown menu. To customise the commands enabled for
an RCT to control a panel, see Configuring Command Profiles on page 322.

Complete the ATS Faults fields as shown in the table below.

ATS This field is automatically calculated by adding the values of the Active Polling

Polling Timeout column in the Event Sequence Table, that is, for all ATPs inan ATS.

Timeout  You can manually overwrite this field. For example, CAT 2 [Modem] has an
Active Polling Timeout of 24 hours 10 minutes (87000 seconds). To allow a
shorter reaction time, enter a lower value.

ATS The amount of time after an event has been raised and not successfully
Event transmitted before the ATS gives up. Default: 300 seconds.
Timeout
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10.

11.

12.

Generate Select whether the system generates a FTC on an ATS event timeout.
FTC

Re- Select this to re-queue events after an ATS Timeout.

queue

Events

Re- Delay after an ATS Event Timeout before the re-queued event is attempted
queue again. Default: 300 seconds.

Event

Delay

Re- Amount of time that the event will be re-queued before the event is deleted.
queue Default: 86400 seconds.

Event

Duration

Click the Edit Installation Details button to complete the settings to identify the panel to the RCT

operator. See Edit Installation Details on page 316.

Click Save and Back to return to the ATS Configuration page. The new ATS displays in the

Configured ATS table.

For multiple ATPs, you can use the up and down arrows in the Event Sequence Table to reorder

the ATP sequence.

NOTICE: The ATS Registration ID is automatically generated for an ATS. It uniquely identifies the
panel to the RCT. If you do not know the SPT Account Code, you can commission the panel using
this ATS Registration ID. The CMS operator must also enter this ATS Registration ID at the RCT (for

example, SPC Com XT). See the SPC Com XT Installation & Configuration Manual.

See also

ATS Category Timings on page 397

Add ATP to FlexC RCT

Add ATP to FlexC RCT allows you to configure an ATP between the SPC panel and the RCT (for

example, SPC Com XT). You can configure up to 10 ATPs for each ATS.

1.

Click the button Add ATP to FlexC RCT.

Communications FlexC Reporting PC Tools
FlexC ATS Event Profiles Command Profile FlexC Help
ATP Configuration - FlexC RCT
Panel Identification
ATP Sequence No 1 Seguence number of ATP in the ATS configuration (1 is Primary, 2-10 s Backup)
ATP Name Primary ATP 1 The name of the ATP
SPT Account Code [o ] Thenumberthat uniquely defines the panel to the RCT (199999999, 01 = Auto assign)
RCT Identification
RCTID The unique ID of the RCT (e.0. RCT ID of SPC ComXT) (1-99999999)
RCT URL or IP Address [ 7] urvoriPadoress ofhe RCT (2.0, SPC ComXT)
RCT TCP Port 52000 The TCP Port of the RCT (e.g. The TCP Port that SPC ComXT is listening on)
ATP Interface
C ions Interface Ethernet | Interface used by ATP for communication
ATP Category Cat 5 [Ethernet] v Select the The ATP category
Advanced
. Advanced Settings should only be used by expert users who understand the impacts of what they are changing. Itis not
Advanced ATP Settings Advanced ATP Seltings to change advanced sefiings
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2. Complete the ATP fields described in the table below.

Panel Identification

ATP Sequence  This field displays the sequence number of the ATP in the ATS
No. configuration. Number 1 is primary, numbers 2—10 are backup.

ATP Unique ID When you save an ATP, the system assigns a unique ID to an ATP.
This is the unique ID of the ATP so it can be recognised by the RCT.

ATP Name Enter a name for the ATP.

SPT Account Enter a number to uniquely identify the panel to the RCT.
Code

RCT Identification

RCTID Enter the number that uniquely identifies the RCT (for example, SPC
Com XT) to the panel. This must match the number entered in the field
Server RCT ID in the SPC Com XT Server Configuration Manager tool.

RCTURLorIP Enter the URL or IP address of the RCT (for example, SPC Com XT).
Address

RCT TCP Port Enter the TCP Port that the RCT (for example, SPC Com XT) listens
on. The default is 52000. This must match the value in the field Server
FlexC Portin the Server Configuration Manager tool. See the SPC
Com XT Installation & Configuration Manual.

ATP Interface

Communications From the dropdown list, select the interface this ATP uses for
Interface communication.

o Ethernet

« GPRS: Modem 1

« GPRS: Modem 2

« Dial Up Internet: Modem 1
« Dial Up Internet: Modem 2

ATP Category Select the category to apply to this ATP. For information on ATP
Categories, see ATP Category Timings on page 398.

Advanced

Advanced ATP It is not recommended to change advanced settings. Changes must
Settings only be made by expert users.

3. Ifrequired, click Advanced ATP Settings, for example, if you are using auto encryption you can
optionally enter a password in the Encryption Password field. See Configure Advanced ATP
Settings on the next page.

4. Click Save.
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Configure Advanced ATP Settings

WARNING: Itis not recommended to change Advanced ATP Settings. Changes must only be
made by expert users.

1. Click the Advanced ATP Settings button.

Communications FlexC Reporting PC Tools
FlexC ATS Event Profiles Command Profile FlexC Help

ATP Configuration - Advanced Sertings

ATP Connections

Active ATP Connection |Permanent Stay Connected | Select the ATP connection type when the ATP is the active ATP (operating as the primary communication pati

Non-Active ATP Connection [Permanent: Stay Connected | Select the ATP connection type when the ATF is not the active ATP (operating as a backup communication e
Test Calls

Test call Mode (Non Active ATP) |Tesl calls Disabled v‘ Select the mode for sending testcalls when the ATP is acting as the Non-Active ATP

Test call Mode (Active ATP) |Tesl calls Disabled V‘ Select the mode for sending testcalls when the AT is acting as the Active ATP

Encryption (256-bit AES with CBC)

Encryption Key Mode [Auto Encryption | Select how the encryption key gets updated
Optianal Encryption Password used to provide increased security during initial ATP commissioning. The passt
Encryption Password [ must be entered at the SPT and RCT independently
Reset Encryption | Reset Encryption ‘ Reset the Encrytion Key and Password to the default values
ATP Profiles
Event Profile |Use ATS Setting V‘ Select the Event Profile which defines how and which events are transmitted on this ATS
Command Profile |USE ATS Setting v‘ Select the Command Profile which defines the commands that are allowed on this ATS
ATP Fauits
ATP Monitoring Fault O Generate an ATP fault if the ATP monitoring fails or an Event fails to transmit on ATP
i The amount of time that the ATP will keep trying to iransmit the event until the event fails on the ATP and is
Event Timeout [30s | passed o the next ATP

Minimum Message Lengths

Poll Message [0 Bytes V| Minimum length of a Poll Message
Event Message [0Bytes | Minimum length of a Event and Testcall Messages
Other Message |D Byles v‘ Minimum length of connection and encryption key update messages

2. Configure the fields described in the table below.

ATP Connections

Active ATP  Select the ATP connection type when the ATP is operating as the primary
Connection  communication path.

« Permanent: Stay Connected

« Temporary: Hangup 1second

« Temporary: Hangup 20 second
« Temporary: Hangup 80 second
« Temporary: Hangup 3 minutes

« Temporary: Hangup 10 minutes

« Temporary: Hangup 30 minutes
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Non-active Select the ATP connection type when the ATP is operating as a backup
ATP communication path.

Connection « Permanent: Stay Connected

« Temporary: Hangup 1second

« Temporary: Hangup 20 seconds
« Temporary: Hangup 80 seconds
« Temporary: Hangup 3 minutes

« Temporary: Hangup 10 minutes

« Temporary: Hangup 30 minutes

Test Calls
Test Call Select the mode for sending test calls when the ATP is the non-active ATP.
X;?\/ee(x'(l)'rlg) « Test calls Disabled

o Test call every 10 minutes

« Test call every 1 hour

« Test call every 4 hours

« Test call every 24 hours

« Test call every 48 hours

o Test call every 7 days

« Test call every 30 days
Test Call Select the mode for sending test calls when the ATP is the active ATP.
XI'I?I?’? (Active « Test calls Disabled

o Test call every 10 minutes
o Test call every 1 hour

« Test call every 4 hours

« Test call every 24 hours

« Test call every 48 hours

« Test call every 7 days

« Test call every 30 days

Encryption (256-bit AES with CBC)

Encryption Select how the encryption gets updated.

Key Mode « Auto Encryption
« Auto Encryption with Updates
« Fixed Encryption
Note: Auto Encryption uses the default key and updates it once. Auto
Encryption with Updates changes the encryption key every 50,000 messages
or once per week, whichever comes first.
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Encryption Optional password used to provide increased security during initial ATP

Password commissioning. The password must be entered at the SPT or RCT
independently.

Reset Reset the Encryption Key and password to the default values.

Encryption

ATP Profiles

Event Profile  Select the Event Profile which defines how and which events are transmitted
on this ATS.

« UseATS Setting

o Default Event Profile

« Allevents
Command Select the Command Profile which defines the commands that are allowed on
Profile this ATS.

« UseATS Setting
o Default Command Profile

« Custom Command Profile

ATP Faults

ATP Select to generate an ATP fault if the ATP monitoring fails or an event fails to
Monitoring transmit on the ATP.

Fault

Event The amount of time that the ATP will keep trying to transmit the event until the
Timeout event fails on the ATP and is passed to the next ATP.

« 30seconds
« 60seconds
« 90 seconds
e 2minutes
« 3 minutes
« 5 minutes

« 10 minutes
Minimum Message Lengths

Poll Minimum length of a poll message.
Message . OBytes

« 64 Bytes

« 128 Bytes

« 256 Bytes

« 512 Bytes
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Event Minimum length of an event and test call message.
Message . 0Bytes
« 64 Bytes

« 128 Bytes
« 256 Bytes

« 512Bytes

Other Minimum length of connection and encryption key and update messages.
Message . 0Bytes
« 64 Bytes

« 128 Bytes
« 256 Bytes

« 512Bytes

3. Click Save.
Add ATP to Analog ARC

If a connection between the SPC panel and RCT (for example, SPC Com XT) goes down, FlexC has
the ability to switch to a backup ATP connection between the SPC panel and an Analog ARC. You can
configure up to 10 ATPs for each ATS.

1. To configure an ATP between an SPC panel and an Analog ARC, click the button Add ATP to
Analog ARC.

2. Complete the ATP fields described in the table below.

Panel Identification

ATP Sequence This field displays the sequence number of the ATP in the ATS
No. configuration. Number 1 is primary, numbers 2—-10 are backup

ATP Unique ID  This ID uniquely identifies the ATP to the RCT
ATP Name Enter a name for the ATP

SPT Account Enter a number to uniquely identify the panel to the RCT (1-999999)
Code

ARC Connection
Number 1 Phone number 1
Number 2 Phone number 2

Modem Select  Select the modem to be used.
« Modem 1
« Modem 2
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Test Calls

Test Call Mode Select the mode for sending test calls when the ATP is in non-active
(Non-active mode. Default: 24 hours.

ATP) » Test calls disabled

o Test call every 10 minutes
o Testcall every 1 hour

o Test call every 24 hours

« Test call every 48 hours

o Testcall every 7 days

o Testcall every 30 days

Test Call Mode Select the mode for sending test calls when the ATP is an active ATP.

(Active ATP) Default: 24 hours.
o Test calls disabled
o Test call every 10 minutes
o Test call every 1 hour
o Test call every 24 hours
« Test call every 48 hours
« Testcall every 7 days

« Test call every 30 days

Time of first Time of first test call after reset or ATS initialization.

test call o Send Immediately (default)
or

« Select a half hour interval between 00:00 and 23:30
Event Protocol

Protocol Protocol used in communication.
« SIA
« SIA Extended 1
« SIA Extended 2
« Contact ID

Event Profile Select the Event Profile which defines how and which events are
transmitted on this ATS.

o UseATS Setting

« Default Event Profile

« Default Portal Event Profile
« Allevents

o Custom Event Profile
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ATP Faults

30 seconds
60 seconds
90 seconds
2 minutes
3 minutes
5 minutes

10 minutes

ATP Monitoring Select to generate an ATP fault if the ATP monitoring fails or an event
Fault fails to transmit on the ATP.

Event Timeout The amount of time that the ATP will keep trying to transmit the event
until the event fails on the ATP and is passed to the next ATP. Default: 2
minutes.

3. Click Save.

Edit Installation Details

The installation details are passed to the RCT to help the operator to identify the panel.

1. Click the Edit Installation Details button.

Communications FlexC

Installation Details

ATS Installation 1D
Company ID

Company Name

ATS Installation Address

GPS Coordinates
ATS Installer Name
Installer Phone Number 1

Installer Phone Number 2

Notes

FlexC ATS Event Profiles

Reporting

PC Tools

Command Profile

The following installation details are passed to the RCT to help the Operator at the RCT to idenfify the panel.

o

| The ID of the ATS Installation (1-299999999)

o

| ID of the Company

| Mame of the Company

The address of the ATS Installation

| The GPS Coordinates of the installation.

| The name of the installer of the ATS

| The phone number of the installer of the ATS

| The phone number of the installer of the ATS

Any additional information for the RCT
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2. Complete the fields in the table below.

ATS Installation ID The ID of the ATS Installation (1-999999999).
Company ID For future use.
Company Name Name of the company.
ATS Installation Address The address of the ATS installation.
GPS Coordinates The GPS coordinates of the installation.
ATS Installer Name The name of the installer of the ATS.
Installer Phone Number 1 The phone number of the installer of the ATS.
Installer Phone Number 2 The phone number of the installer of the ATS.
Notes Any additional information for the RCT.

3. Click Save.

17.11.2.4 Configuring an SPC Connect ATS

The Add SPC Connect ATS functionality opens a communication between the panel (SPT) and the SPC
Connect server (RCT), www.spcconnect.com. Using the generated SPC Connect ATS Registration ID, a
panel user can register a user account and panel with the SPC Connect website to access their panel
remotely.

1. To configure an SPC Connect ATS, go to Communications > FlexC > FlexC ATS.

2. Onthe ATS Configuration page, click Add SPC Connect to open a communication path with the
SPC Connect server.

An SPC Connect ATS is added to the Event Sequence Table with the following attributes:
o SPC Connect ATS Registration ID

o Default ATP over Ethernet. For information on ATP fields, see AJd ATP to FlexC RCT on
page 309.

« Default Events Profile for SPC Connect

« Default Commands Profile for SPC Connect

o Default RCT URL is www.spcconnect.com

« The SPT Account Code for the ATP is populated.

« Make a note of the SPC Connect ATS Registration ID and provide this to the customer along
with the SPC Connect System User Guide.
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Communications FlexC Reporting PC Tools
FlexC ATS Event Profiles ‘Command Profile FlexC Help
ATS Configuration
Configured ATS
ATS
: Export & “ ATP 5 ATS Event  Generate
Edit  Delete ATS il ATS Name ATS Registration 1D Count Event / Command Profiles Euﬂmg Timeout TC
Timeout
@ | [@] | 1 |s;ccome TST3-GERIGIG-SP2G | 1 | Dt Events ISEC Comnect ey | 96400 300 No
@ | [ | 2 |aTsouarpan KePGKaTYTaceassy | 2 |- DERUEwents o 360 200 Yes
Add SPC Connect
Add an ATS to the SPC Connect Server Add SPC Connect
Add EN50136-1 ATS
Add an ENSD126-1:2012 single path ATS to the system. [ Add Single Path ATS |
‘Add an EN50136-1:2012 dual path ATS to the system | Add Dual Path ATS ‘
Add an EN50136-1:2012 dual path and dual Server ATS to the system | Add Dual Path Dual Server ATS ‘
Add Custom ATS
Add a custom ATS to the system. Up to 10 ATPs may be added to the ATS. | Add Custom ATS ‘
Import ATS
Import an ATS to the system Brawse... Impart ATS

17.11.2.5 Exporting and Importing an ATS

ATS files have a .cxml extension. You must create the ATS in the SPC browser and export it before
you can import it to a system.

1. Toexport an ATS, go to Communications > FlexC > FlexC ATS.

2. Inthe Configured ATS table, locate the ATS to export and click the Export ATS button (green
arrow).

Communications FlexC Reporting PC Tools

FlexC ATS Event Profiles ‘Command Profile FlexC Help

ATS Configuration

Configured ATS
ATS
= Export ) = ATP 2 ATS Event  Generate
Edit  Delete ATS i) ATS Name ATS Registration 1D Count Event / Command Profiles #;:gggr iy TC
- - Default Evenis
@ | [@ | 2z |atsouaipan KEPGKETY-Tage-388Y | 2 |IDEautbvents o 360 300 Yes
- - Default Events
& E 3| ATS Single Path TTSG-7Y45-X2YP-5856 T L Yer e 180 200 Yes
Add SPC Connect
Add an ATS to the S8PC Connect Server ‘ Add SPC Connect ‘
Add EN50136-1 ATS
Add an EN50136-1:2012 single path ATS to the system. ‘ Add Single Path ATS ‘
‘Add an EN50136-1:2012 dual path ATS to the system ‘ Add Dual Path ATS ‘
Add an EN50136-1:2012 dual path and dual Server ATS to the system. ‘ Add Dual Path Dual Server ATS ‘
Add Custom ATS
Add a custom ATS fo the system. Up to 10 ATPs may be added to the ATS. ‘ Add Custom ATS ‘

R e
Save the file with the default filename export_flexc.cxml or rename the file.
To view the file, open in Notepad.
Toimport an ATS into the system, go to Communications > FlexC > FlexC ATS.
Scroll down to Import ATS.
Click the Browse button and select an ATS to import (.cxml file extension).
Click Import ATS.
The ATS displays in the Configured ATS table with the next available ID.

© N o g k~ w
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When you export an ATS, the SPT Account Code changes to 0. This prevents an ATS being exported
and then imported and replicating an existing ATS.

17.11.2.6 Configuring Event Profiles

The event profile defines which events are transmitted on an ATS, the reporting status for an event and
event exceptions. Event exceptions allow you to remap default values for events to customised values.
For more information, see Event Exception Definition on the facing page.

To see alist of all events, go to Communications > FlexC > Event Profiles. Click the Edit icon for
an event profile. Scroll to the end of the page and click Show Complete Event Table.

jmie

To quickly create a new event profile, go to Communications > FlexC > Event Profiles. In the
Event Profiles table, select an event profile and click the Editicon. Scroll to the bottom of the page
and click Replicate. You can now make the changes you require.

1. To configure FlexC event profiles step by step, go to Communications > FlexC > Event Profiles.

2. Click Add. The Event Profiles page displays.

Enter a Name to identify the event profile.
Select the event filter groups to report for this profile by ticking the Report Event checkboxes.

5. To prevent reporting of certain events or addresses within an event, select the event from the
corresponding Add Event Exception dropdown list.

6. Click Add to view the Event Exception Definition page. See Event Exception Definition on the
facing page.

7. Click Back to return to the Event Profiles page.
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8. Toapply an event profile to an area, select the area under Area Filter.

9. Click Save and Back. The new profile displays in the Event Profiles table.

You can view a list of all event exceptions for an event profile under Event Exceptions on the
Event Profiles page.

L]

You cannot delete the Default Event Profile, the Default Portal Event Profile or an event profile
that is assigned to an ATS. If you try to delete an event profile that is in use, you will get an error.

Event Exception Definition

Event exceptions allow you to change the following settings for a range of addresses within an event:
« Report Event
« SIACode
« CID Code
« Event Address (for example, Zone IDs, Area IDs, User IDs)

For example, in the Filter Group Intruder Alarms you could define an event exception for a range of
Zone IDs in the Burglary Alarm (BA) event as follows:

« Do not report BA events for Zone ID 1-9

« Remap the SIA Code from BAtoYZ

« Remap the CID from 130/1 to 230/1

« Remap the Zone ID 1-9 to Zone ID 101-109

Communic: 5 Reporting PC Tools

FlexC ATS Event Profiles Command Profile FlexC Help

Event Exception Definition
Configuration saved OK
Identification
Name |Burg|arly Alarm | Name of the Event Exception
Event ID 1000 Event |D of the event on the system
Event Description Burglary Alarm [Alarm Zone] Description of the event
Event Filter
Report Event v Check if the event is normally reported
Filter Exception Enable Check to enable the filter exception
DISABLED="disabled"
v ([ Jezmensp )
then [Don't Report Event v
Event Format
SIA Event Code BA S1A event code that is transmitted to represent the event
Contact ID Event Code / Qualifier 130 11 Contact ID Event Code / Qualifier transmitted o represent the event
Remap Exception Enable Check to enable the remap exception
1 Jezoens )
then Remap SIA Event Code fo
and Remap Contact ID Event Code / Qualifier to ! EI
and Remap Event Address to 101 -
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1. To configure an Event Exception Definition, complete the fields described in the table below.

Identification

Name Enter the name of the Event Exception.

Event ID Event ID of the event on the system. This is display only.
Event Description of the event. This is display only.

Description

Event Filter

Report Event  Check to report the event. This overrides the reporting value set for the event
Filter Group. For example, if the Filter Group Intruder Alarms is set to report,
you can exclude the BA event or by disabling this setting.

Filter Check to exclude a range of addresses, for example Zone IDs, from the
Exception Report Event field setting.
Enable

if 0<ZoneID Enterarange of addresses to exclude from the Report Event setting. For
<9999) example, if you choose to report the event type BA, you may choose not to

then Report report Zone ID 1 - 9 for that event.

Event/Don't Alternatively, if you choose not to report the event type BA, you may choose
Report Event  to report Zone ID 1- 9for that event.

Event Format

SIA Event Default SIA event code that is transmitted to represent the event. This field is
Code display only.

Contact ID Default Contact ID Event Code/Qualifier transmitted to represent the event.
Event This field is display only.

Code/Qualifier

Remap Check to remap the default SIA, CID code/Qualifier and Event Address to
Exception customised values, for example, to remap Zone ID 1-9to Zone ID 101 - 109.
Enable When enabled, the fields below display.

if (0<ZoneID Enterthe range of addresses to remap for an event, for example, if you want

<9999) toremap Zone ID 1-9to Zone ID 101 - 109, enter 1 and 9. The quantity of
addresses in the range must be equal to the quantity of addresses defined in
the field Remap Event Address below.

then Remap Remap the default SIA code to a customised SIA code.
SIA Event
Code to BA

and Remap Remap the default CID Event Code/Qualifier to a customised CID Event
Contact ID Code/Qualifier.

Event

Code/Qualifier

to
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and Remap Enter the new range of addresses, for example, if you are remapping Zone ID
Event Address 1-9to Zone ID 101 - 109, enter 101 and 109.
to

2. Click Save.

3. Click Back to return to the Event Profiles page.

The name of each exception displays in the Event Exceptions table at the bottom of the page.
The table shows the settings for the fields Report Event, Filter Exception, Event Code
(SIA/CID) and Remap Exception for the event.

Area Filter
[ 1 Area1
Event Exceptions
Fdit Delete  Event Exception Name Report Event Filter Exception Er;‘::;g?gf Remap Exception
Event ID 1000 :Burgiary Alarm [Alarm Zone]
., ‘ 'n'ﬁ Burglary Alarm ‘ Yes ‘ Don't Report Event [1-9] ‘ BA 130 ‘ [1-9] — YZ230 [101-109]
| Back | | Save | | Replicate ‘ | Show Complete Event Table |

Click the Edit icon to make changes or the Delete icon to remove an Event Exception.

To apply the event profile to an area, select the area checkbox.

o o &

Click Save to save the event profile.
7. Click Back to view the profile in the Event Profiles table.
17.11.2.7 Configuring Command Profiles

The command profile defines the commands that are allowed on an ATS. This profile determines how a
CMS can control a panel. The default command profile does not support video verification.

NOTICE: To quickly create a new command profile, go to Communications > FlexC >
Command Profiles. Inthe Command Profiles table, select acommand profile and click the edit
button (blue pencil), Scroll to the bottom of the page and click Replicate. You can now make the
changes you require.

1. Toadd acommand profile step by step, go to Communications > FlexC > Command
Profiles.

Communic ations FlexC Reporting PC Tools

FlexC ATS Event Profiles Command Profile FlexC Help

Command Profiles
Edit  Delete /2] Command Profile Name Commands Enabled Commands Logged
1 Defaul: Commands 49 0
E - 2 Default Commands [SPC Connect] 75 40
2| | ® 3| command Profile 2 3 @
2| | & 4 |command Profile 4 38 a7
Add
2. Click Add.
© Vanderbilt 2018 322 ABV10276959-d

11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the browser

3.
4.

9.
10.
11.
12.

Communications FlexC Reporting PC Tools

FlexC ATS Event Profiles Command Profile FlexC Help

Command Profiles

Identification

Name |Cummand Profile 5 | Name of the Command Profile
Command Profile Authentication
Authentication Mode |Cqmmand User or Panel User V| Mode used to authenticate the rights of the user using the Command Profile
Command User Name |FIexC | Name of the Command Profile user
Command Password ||"u | Password of the Command Profile user

Live streaming
Live Streaming Mode |Disabled v| Select Live Streaming privacy options

Command Filter

Command Enable Log Command
System Commands
Get Panel Summary 1
Set the System Time and Date
Grant Engineer Access
Grant Manufacturing Access

Enter a Name to identify the command profile.

Select an Authentication Mode (Command User or Panel User, Command User Only, or Any
Panel User) from the dropdown menu.

NOTICE: The default Command User Name provides an out of the box user that
quickly and easily enables control of the panel from SPC Com XT. It enables a
broad range of commands. For example, the default command user can set all
areas or control all zones. For tighter control, for example to only allow setting of
certain areas, you can set up a customised command profile with a defined set of
rights. You cannot delete the Default Command Profile, the Default Portal
Command Profile or a command profile that is assigned to an ATS.

Enter the name of the command profile user in the Command User Name field. This must match
the Authentication User Name field in SPC Com XT.

Enter the password of the command profile user in the Command Password field. This must
match the authentication User PIN or Password field in SPC Com XT.

Select the Live Streaming Mode (Disabled, Only after alarm event, Always available, System is
fullset) to determine the streaming privacy options. Always Available generates the highest
volume of data.

Under Command Filter, select the commands to enable. For a full list of commands, see FlexC
Commands on page 394.

Select the commands to log.
Click Save.
Click Back to view the command profile in the Command Profiles table.

To change a command profile, click the Edit button (pencil icon) next to a command profile.

17.11.3 Reporting

This section covers:

« Alarm Reporting Centres (ARCs) on the facing page
o EDP Setup on page 327
o CEI-ABI Protocol Settings on page 335
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17.11.3.1 Alarm Reporting Centres (ARCs)

The SPC panel has the facility to communicate information to a remote receiving station when a
specific alarm event on the panel has occurred.

These Alarm Reporting Centres must be configured on the panel to allow this remote communication to
operate.

Adding/Editing an ARC using SIA or CID

Prerequisite
o PSTN or GSM modem is installed and functioning correctly.

1. Select Communications > Reporting > Analog ARC.

The following page will be displayed:

Communications xC Reporling PC Tools

Analog ARC CEW-ABI
ID Account Description Last Dial Last Dial Status Test Calls Test Call Time Log Edit Delete
11 ABC 03/07/2014 175831 Modem Fauit . =] [ [=]
2 2 oms 07/07/2014 15:24:09 Modem Fault = i = =
32 xvz 03/07/2014 17:50:31 Modem Fault — B _ I B

2. Click the Modem1/2 button to make a test call to the ARC from the either modem 1 or modem 2.

3. Click the Log button to receive alog file. A page with the logs from all automatic and manual test
calls will be displayed.

4. Toadd oredit an ARC, click Add.
—OR-
Click Edit.

The following page will be displayed.

Communications FlexC Reporting PC Tools
Analog ARC EDP CEI-ABI
Add Alarm Receiving Center
Description I:I |dentification of Alarm Receiving Center
Account Account number
Protocol SIA A% Protocol used in communication
Priority Priority of ARC
Number 1 |:| Phone number 1
Number 2 I:I Phone number 2
Dial Attempts Mumber of dial attempts to connect to receiver
. Mumber of seconds to delay between failed dial attempis.
ot Bk b ] (0- 999)
Test Calls Disabled v Interval between automatic test calls
O Check if all modems should be tested
Add
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5. Configure the fields as described in the table below.

Description

Account

Protocol

Priority

Number 1

Number 2

Dial
Attempts

Dial Delay

Dial
Interval

Test Calls

Test All

Enter a description of the remote Alarm Receiving Centre.

Enter your account number. This information should be available from the
receiving station and is used to identify you each time you make a call to the
ARC.

For a Contact ID account, a maximum of 6 characters is allowed.

Enter the communication protocol that you intend to use (SIA, SIA Extended,
Contact ID, Fast Format).

Note: SPC supports the extended SIA protocol. Select this protocol to support
additional textual descriptions of the SIA events being sent to the Alarm
Receiving Station.

Select the priority for the ARC in terms of primary or back-up reporting.

Enter the first number to be dialled to contact the ARC. This system will always
attempt to contact the ARC on this number before attempting another number.

Enter the second number to be dialled to contact the ARC. The system will only
attempt to contact the ARC on this number if the first contact number did not
successfully establish a call.

Enter the number of times that the system will attempt to make a call to the
receiver. (Default is 8)

Number of seconds to delay between failed dial attempts (0-999).

Enter the number of seconds to delay between failed dial attempts. (0-999)

Enable the test call by choosing a time interval. This will send out an automatic
test call from modem 1 to the primary ARC.

Check this box if you want to initiate also an automatic test call from modem 2 to
the backup ARC.

6. Click the Add button to enter those details on the system.

A list of the configured ARC accounts will be displayed in the browser along with the account
information, description, protocol, dial-up status and time and date of the last call to the ARC.
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Editing an ARC filter using SIA or CID

To configure the events on the SPC that will trigger the call to the ARC:

1. Select Select Communications > Reporting > Analog ARC > Edit > Filter.

The following page will be displayed:

Communications Reporting PC Tools
Analog ARC CEI-AEI
Event Filter
Alarms [ Alarm activation
Alarm Restores ™ Reported alarms being restored
Confirmed alarms [ Alarms confirmed by multiple zones
Alarm Abort O Report Alarm Abort event if valid PIN is entered on keypad after alarm report
Faults [w1 Fault or Tamper activations
Fault restore [w1 Fault or Tamper restores
Setting O Setfing and Unsetting
Early / Late O Report if Setting/Unsetting is not according to schedule
Inhibits O Inhibit and Isolate
Door events O Access control door events
Other [l All other types of events
Network O Report IP Netwerk Pelling Up/Down events
o [ 1: Marketing ] 3: Finance [v] 5: Meeting Room
& 2: Reception K 4: Cafeteria & 6: Finance
Save Back

2. Configure the following fields:

Check any of the following boxes if you want to initiate a remote call to the ARC to notify it of the
particular event.

Alarms Alarms are activated.
Alarm System alarms are restored.
Restores

Confirmed  Alarms confirmed by multiple zones

Alarms

Alarm Alarm Abort events. Alarms are aborted after a valid user code is entered via
Abort the keypad after a confirmed or unconfirmed alarm,

Faults Faults and tampers are activated.

Fault Fault or tamper alarms are restored.

Restores

Settings System is Set and Unset.

Early/Late Unscheduled setting and unsetting of the system.
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Inhibits Inhibit and isolate operations are performed on the system.
Door Door events are activated. Only works with SIA protocol.
Events

Other All other types of events are detected on the system.

Network Report IP Network Polling Up/Down events.

Areas Select specific areas to which above events apply.

[i]

By adding a separate Alarm Receiving Centre (ARC) for each area defined on the system and
programming each area to report it’'s own separate ARC receiver, the system can approximate a
multi-tenanted system in that a high degree of autonomy is assigned to each area.

Editing an ARC Filter using Fast Format

To configure the events on the SPC that will trigger the call to the ARC when Fast Format is the selected
protocol:

1. Select Communications > Reporting > Analog ARC > Edit > Filter.

A list of the eight channels is displayed along with the alarm conditions that can be programmed for
each channel.

2. Select the alarm conditions for each channel as required. For a description of each, see Outputs
types and output ports on page 232.

From the Scope dropdown menu, select System or a specific area to apply your selected settings.
4. Click the Test button located next to the first channel to test the alarm activation.
The light bulb icon is switched on.

5. Wait approximately five seconds and click the Test button again for the same channel. This sends a
channel restore to the ARC and the light bulb icon is switched off.

6. Continue to test the other channels.

17.11.3.2 EDP Setup

The system has the facility to communicate information to the SPC Com server remotely using
Vanderbilt’s own protocol, the EDP (Enhanced Datagram Protocol). By correctly configuring an EDP
receiver on the system, it can be programmed to automatically make data calls to the SPC Com serverin
a remote location whenever events such as alarm activations, tampers, or arming/disarming occur. The
engineer can configure the system to make calls to the remote server via the following routes:

o PSTN (PSTN modem required)
o GSM (GSM modem required)
« Internet (Ethernet interface)

If using the PSTN network, ensure the PSTN modem is properly installed and functioning correctly and
that a functioning PSTN line is connected to the A, B terminals on the PSTN modem.

If using the GSM network, ensure the GSM module is properly installed and functioning correctly. An IP
connection can be made across the internet to a server with a fixed public IP address.

If an IP connection is required, ensure the Ethemnet interface is correctly configured (see Ethernet interface
on page 172) and that internet access is enabled at the router.
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Adding an EDP Receiver

1. Select Communications > Reporting > EDP.

The following page will be displayed:

Communications FlexC Reporting PC Tools

Analog ARC CEI-ABI
D Receiver Description Network Status Dial-up status Last Dial Test Edit Delete
1 1 EDP Fault NiA None | (= [
L ] .
l Max. 8 receivers can be added to the SPC system.

2. Click the Add button.
The following page will be displayed.

Communica Reporting
Analog ARC CEI-ABI
Add receiver
Description Description of receiver.
Receiver Id Unique identification number of EDF receiver used by this panel.

3. See table below for further information.

Description  Enter a text description of the receiver.

Receiver ID Enter a unique number which will be used by the EDP to identify the receiver.

See also

Editing EDP Receiver Settings on the next page
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Editing EDP Receiver Settings

1. Select Communications > Reporting > EDP > Edit.

The following page will be displayed.

Communications FlexC

Reporting PC Tools

Edit Receiver

Description
Receiver Id

Protocol version

Security
Commands Enable
Change user PINs
Virtual Keypad

Live streaming

Encryption Enabled

Network

Network Enable

Dial-up

Dial-up Enable

Events
Primary Receiver
Re-queue Events
Verification

Event Filter

2. Configure the fields as described in the table below.

DP

II

]
O
O

Cnly after alarm event v
O

It
|
O

Descriplion of receiver.

Unique identification number of EDP receiver used by this panel.
(1-999997)

Select version of EDP protocol to use with this receiver

Check if incoming commands are allowed from this receiver.
Check if changing user PINs is allowed from this EDP receiver.
Check to allow virtual keypad access from this EDP receiver

Select Live Streaming privacy options

Check if data to and from this receiver is encrypted.

Check if events can be reported through Network

Check if events can be reported through dial-up

Check if primary, clear for backup
Check if events that fail to report are to be regueued for fransmission.
Check if Audio/Video verification should be sent to this receiver.

Configure which events are reported to this receiver

Description

Receiver ID

Protocol Version

Edit the name of the EDP receiver. Maximum 16 characters.

Edit the EDP receiver ID. Range is 1 to 999997 (999998 and 999999
are reserved for special purposes)

Select the EDP protocol version to use with this EDP receiver. Options
are Version 1 or Version 2. Version 2 is recommended if supported by
the receiver, as it is a more secure protocol.
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VdS 2471
Compatible

Security
Commands Enable

Change User PINs

Encryption Enable
Encryption Key

Virtual Keypad

Live
Streaming/Streaming
Mode

(Vds standard only)

If this option is selected then the EDP receiver will enforce the
following settings for that receiver:

« 8s pallinginterval
« TCP protocol enforced
o TCP retries will fail before 10s (9s approx)

« EDP event retries are set to 1 independent of the global “Retry
Count” setting in “EDP Settings”

« FTC will be generated within 20s of network failure.

Check this box to allow commands to be accepted from the receiver.

Check this box to allow user PINs to be changed from a remote
location. This feature is applicable only if commands are enabled from
the receiver.

Check this box to enable encryption on data to and from the receiver.

Enter a hexadecimal key (max. 32 digits) that will be used to encrypt
the data.

Note: The same key will need to be used at the receiver.

Enables access to the panel with a virtual keypad, that is, a PC
software module that looks and behaves like an SPC keypad. It is
available with the SPC Com client.

Specifies when live streaming of audio and video is available. Options
are Never, Always or Only after an alarm event. Default is ‘Only after
an alarm event’.

Note: This setting has obvious privacy implications and therefore
should be enabled only where appropriate and subject to local laws and
regulations.

Network (Applies to the Ethernet connection only)

Network Enable

Network Protocol

Receiver ID Address

Receiver IP Port

Always Connected

Panel Master

Polling Interval

Check this box to allow events to be reported through the network.

Select the type of network protocol for the receiver. Options are UDP
and TCP. TCP is recommended if supported by the receiver.

Enter the IP address of the receiver.
Enter the IP port that the EDP receiver is listening on.

If enabled the panel will keep a permanent connection to the receiver. If
disabled, the panel will only connect to the receiver after an alarm
event.

If enabled the panel is master of polling messages. Only applicable to
UDP connections.

Enter the number of seconds between polls.
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Polling Trigger

Generate a Network
Fault

Dial-up (Applies to the GPRS modem connection only)

Dial-up Enable
Call type
GPRS protocol

GPRS address

GPRS port

GPRS Hangup
Timeout

GPRS Autoconnect

Dial-up on Net Fault

Dial-up Interval 1*

Dial-up Interval 2*

Network Address*

Phone Number*

Phone Number 2*

Events

Primary Receiver

Re-queue Events

Verification

Event Filter

Enter the number of missing polls before a network connection fail is
registered. Only applicable to UDP connections.

If polling fails, a network fault alert is generated.

Check this box to report events through a dial-up connection.
Select type of call to use when dial up is enabled. Select GPRS.

Select the transport layer protocol used over the GPRS connection.
Options are UDP or TCP. Only applicable if Call Type is GPRS.

Enter the IP address of EDP receiver for GPRS connections. Only
applicable if Call Type is GPRS.

Enter the port that the EDP receiver is listening on for GPRS
connections Options are UDP or TCP. Only applicable if Call Type is
GPRS. Default is 50000.

Enter the time in seconds after which the GPRS call will hang up.
(0 = stay connected until IP connection is up)

Check this box to automatically trigger a GPRS call to the server if an
IP network fault occurs.

Check this box to report network faults on a dial-up test call.

Enter the number of minutes between dial-up test calls when network
link is up.

Enter number of minutes between dial-up test calls when network link
is down.

Enter the IP address of the receiver. This is only required if the
connection to the EDP receiver is being made over the Ethernet
interface. If using one of the on-board modems then leave this field
blank.

Enter the first phone number that the modem(s) will dial to contact the
receiver.

Enter a second phone number that the modem(s) will dial in the event
that the first number dialled did not result in a call being successfully
established.

Check this box to indicate that this is the primary receiver. If
unchecked, this is a backup receiver.

Check this box if events that failed to report are to be re-queued for
transmission

Check this box if Audio/Video verification is to be sent to this receiver.

Click this button to edit the filter events that will trigger an EDP call.
See Editing Event Filter Settings on the facing page.

© Vanderbilt 2018

331 ABV10276959-d
11.2018



SPC4xxx/5xxx/6xxx — Installation & Configuration Manual Engineer programming via the browser

* EDP dial-up over PSTN is not supported in this release.

[

See also

Configuring SMS on page 203
Editing Event Filter Settings

1. Select Communications > Reporting > EDP > Edit > Filter.

The following page will be displayed.

Communications

Analog ARC

Event Filter

Alarms

Alarm Restores
Confirmed alarms.
Alarm Abort
Faults

Fault restore
Zone state

Setting

Early / Late
Inhibits

Door events
Other

Other {(Non Standard}

Network

Areas

Reporting PC Tools

Alarm activation

Reported alarms being restored

Alarms confirmed by multiple zones

Report Alarm Abort event if valid PIN is entered on keypad after alarm report
Fault or Tamper activations

Fault or Tamper restores

Report all state changes of inputs

Setting and Unsetting

Report if Setting/Unsetting is not according to schedule
Inhibit and Isolate

Access control door events

All other types of events

Mon Standard S1A codes

O O0oO0o0o0o0OdoROR & &

Report IP Network Polling Up/Down events

[ 1: Marketing 3: Finance [+ 5: Meeting Room
& 2: Reception 4: Cafeteria [+ 6: Finance

2. Configure the fields as described in the table below.

Check any of the following boxes if you want to initiate a remote call to an EDP Receiver to
notify it of the particular event.

Alarms Alarms are activated.
Alarm System alarms are restored.
Restores

Confirmed  Alarms confirmed by multiple zones
Alarms
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Faults

Fault
Restores

Zone state
Settings
Early/Late
Inhibits

Door
Events

Other

Other (Non
standard)

Network

Areas

Alarm Abort  Alarm Abort events. Alarms are aborted after a valid user code is entered via

the keypad after a confirmed or unconfirmed alarm,
Faults and tampers are activated.

Fault or tamper alarms are restored.

Report all zone input state changes.

System is Set and Unset.

Unscheduled setting and unsetting of the system.

Inhibit and isolate operations are performed on the system.

Door events are activated. Only works with SIA protocol.

All other types of events are detected on the system.

Non supported SIA codes used with SPC COM XT including Camera
Online/Offline events.

Report IP Network Polling Up/Down events.

Select specific areas to which above events apply.

Editing EDP settings

1. Select Communications > Reporting > EDP > Settings.

The following page will be displayed.
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Communications

EDP Settings (Panel)

Enable

EDP Panel ID

Panel Port

Packet Size Limit

Event Timeout

Retry Count

Dial Attempts

Dial Delay

Dial Lockout

Event Logging Options

Comms Status
EDP Commands
AN Events

AN Streaming

Keypad Use

Check this to enable EDP.

Unigue identification number used by EDP receiver for this panel.

0oo (1-999997 )

IP port for receiving IP packets (Default is 50000).
(1-65535)

240 Maximum number of bytes in an EDP packet for transmission.
{500 -1440)

Number of seconds between refrar ions of unackr events

(1-199)

Max number of event refransmissions.
(D-199)

Max number of failed dial attempts before Modem lockout.
(1-199)

Seconds to wait before redialling after a failed dial attempt,
(1-199)

Seconds to suspend dialling when max number of failed dial attempts are reached (0 = don't suspend dialing).
(0-9993999)

Log all changes to communication availability.
Log all commands executed through EDP.
Log when AudiofVideo verification events are sent to receiver.

Log when Audio/Video live streaming begins.

o iiiiililD
= =
=

Log when remote keypad is activated.

2. Configure the fields as described in the table below.

Enable

EDP
Panel ID

Panel
Port

Packet
Size
Limit
Event
timeout

Retry
Count
Dial
Attempts

Dial
Delay

Dial
Lockout

Tick this checkbox to enable EDP operation on the system.

Enter a numeric identifier that is used by the EDP Receiver to identify the panel
uniquely.

Select the IP port for receiving IP packets. Default is 50000.

Enter the maximum number of bytes in an EDP packet for transmission.

Enter the timeout period (in seconds) between retransmissions of
unacknowledged events.

Enter the maximum number or event retransmissions allowed by the system.

Enter the maximum number of failed dial attempts accepted by the system
before the modem is locked out (prevented from making further attempts to dial).
The lockout period is defined in the option Dial Lockout.

Enter the time period (in seconds) that the system will wait before redialling after
a dial attempt has failed.

Enter the time period (in seconds) that the system will suspend dialling when the
maximum number of failed dial attempts is reached. Enter a value of ‘0’ to
continually attempt dialling.
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Event Logging Options

Comms Status Log all communication availability.

EDP Commands Log all commands executed through EDP.

A/V Events Log when Audio/Video verification events are sent to Receiver.
A/V Streaming Log when Audio/Video live streaming begins.

Keypad Use Log when remote keypad is activated.

17.11.3.3 CEI-ABI Protocol Settings
1. Select Communications > Reporting > CEI-ABI.

The following page will be displayed:

Communic ations FlexC ® Reporting PC Tools
Analog ARC EDP CEI-ABI
CEI-ABI Protocol Settings

Enable Check to enable CEI-ABI support.

Connection mode Client - The panel will connect to the CEI-ABI receiver,
® Server - The panel will listen for connections.

Server IP 0.0.0.0 TCP/NP Address of CEI-ABI receiver. (Only reguired in client mode).
Server Port 4001 IP Port

Physical address 1 The control panels physical CEI-ABI address.

Logical address 1 The control panels logical CEI-AB| address.

Save

2. Configure the fields as described in the table below.

Enable Tick this box to enable CEI-ABI support.
Connection « Select Client to connect the panel to the CEI-ABI receiver.
mode

« Select Server to enable the panel to listen for connections.

Server IP If you select Client for Connection mode, enter the TCP/IP address of the
CEI-ABI receiver.

Server Port Enter the IP port for the server.

Physical Enter a physical address for the CEI-ABI on the panel.
address

Logical Enter a logical address for the CEI-ABI on the panel.
address

17.11.4 PC Tools
This section covers:
« SPC Connect PRO below
o SPC Manager on the facing page
17.11.4.1 SPC Connect PRO

SPC Connect PRO is a desktop application designed to support the installation and maintenance of SPC
systems. Using SPC Connect PRO, you can create installations and configure them prior to arriving at
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site. The tool can also be used in conjunction with the SPC cloud service SPC Connect to remotely
connect to customer sites and support them.

1. Select Communications > PC Tools > SPC Connect PRO.

2. Configure the fields as described in the table below then click Save.

SPC Tick this box to enable SPC Connect PRO to connect to the panel.
Connect
PRO

Ethernet Tick this box to allow SPC Connect PRO to connect over Ethernet.

TCP Enter the TCP port on which the panel listens to incoming connections from SPC
Port Connect PRO.

USB Tick this box to allow SPC Connect PRO to connect over USB.

Serial 1 Tick this box to allow SPC Connect PRO to connect over Serial 1 (X10).
(X10)

Modem Tick this box to allow SPC Connect PRO to connect over Modem 1.
1

17.11.4.2 SPC Manager

The SPC manager mode setting determines the number of digits for user PINs and therefore the
number of available PINs on a global system controlled by SPC Manager.

Mode41: 4-digit PIN enables 1,000 global users
Mode51: 5-digit PIN enables 10,000 global users
Mode61: 6-digit PIN enables 100,000 global users
Mode71: 7-digit PIN enables 1000,000 global users
Mode81: 8-digit PIN enables 10,000,000 global users

When you set an SPC Manager mode, additional zeros are added to the front of existing 4 or 5 digits
user PINs which modify the PIN for global use. For example, if Mode71: 7-PIN Digitis selected, 3
zeros are added to existing 4 digit PINs — 2222 will become 0002222.

To set the SPC Manager Mode:

1. Select Communications > PC Tools > SPC Manager.

Communications FlexC Reporting PC Tools
SPC Pro/SPC Safe SPC Manager Remote Maintenance
SPC Manager
Mode SPC Manager global-user mode

Mode 41: 4-PIN Digits
Mode 51: 5-PIN Digits

Mode 61: 6-PIN Digits
Mode 71: 7-PIN Digits

Mode 81: 8-PIN Digits

2. Select the SPC Manager global user mode from the drop down list.
3. Click the Save button.

The mode cannot be saved if a conflict exists between a local existing user PIN and another user
PIN on the global system. An ‘Invalid PIN’ error is displayed.

4. Click the appropriate button to delete the PIN and save the new mode or change the PIN to the
randomly generated new PIN displayed and then save the new mode.
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NOTICE: SPC Manager modes cannot be changed if global users exist on the system.

17.12 File Operations

To perform operations on the panel files and configuration:

o Select File.

The following tabs are displayed:

Upgrade

File
Manager

Audio

Default

Reset

Policy
Text

Options for upgrading the controller and peripheral firmware, and languages on the
panel. See File Upgrade Operations below.

Options for managing the system configuration file and uploading and downloading
users data to and from the panel. See File Manager Operations on page 341.

Upload an audio file to the SPC. Click Browse and click Upload to add the audio
file to the SPC. After upload, click the Test button to validate the audio file.

Restores the SPC system to factory defaults.

NOTICE! The IP address is maintained for connecting to the web interface
after a factory default from the web page.

Restarts the panel.

This tab summarises the configuration for your SPC product settings based on
selected Region, Grade and Type.

17.12.1 File Upgrade Operations

To upgrade firmware and languages on the system:

« Select File > Upgrade.

The following page is displayed:

Upgrade

Panel Upgrade Operations

Current Version: 3.6.0 - RB.31.18242

SPC Controller Firmware Upgrade

Upgrade File: Browse...

Peripheral Firmware Upgrade

Upgrade File: Browse...

Language File Upgrade

Upgrade File: Browse...

File Manager ‘Web page Manager Audio Fast Programmer Default

See also

Options on page 252
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17.12.1.1 Upgrading Firmware

. NOTICE: Manufacturer Access is required for firmware upgrade operations and when enabled, is
1 available for the completion of both controller and peripheral firmware upgrades. See Options on
page 252.

Firmware for SPC is contained in two separate files:
« Controller Firmware File
Contains the firmware for the controller's CPUs only. Filename has the extension *.fw.
« Peripheral Firmware File

Contains the firmware for the X-BUS nodes, plus PSTN and GSM modems. Filename has the
extension *.pfw.

The two files are upgraded separately.

NOTICE: It is recommended that all peripheral firmware is upgraded after a new controller
firmware upgrade.

Note: Firmware can also be upgraded using the keypad.
Controller Firmware
To upgrade controller firmware on the system:
1. Select the Panel Upgrade Operations option from the File page.

The following page is displayed:

Upgrade File Manager Web page Manager Audio Fast Programmer Default

Panel Upgrade Operations

Current Version: 3.6.0 - RB.31.18242

SPC Controller Firmware Upgrade

Upgrade File: Browse...

Peripheral Firmware Upgrade

Upgrade File: Browse...

Language File Upgrade

Upgrade File: Browse...

2. Select the firmware file to upgrade by clicking the Browse button for the appropriate option,
selecting the required firmware file and then clicking on the appropriate Upgrade button.

A confirmation page is displayed.
3. Click the Confirm button to confirm the upgrade to the new version of the controller firmware.

When the controller firmware is upgraded, the system will display a message to indicate that the
system is resetting. You must login to the system again to continue operation.

WARNING: If you downgrade the controller firmware (that is, install an older version of firmware),
the system defaults all current configuration settings. Also, when downgrading firmware, it is
important to downgrade the corresponding peripheral firmware otherwise zones may appear
disconnected, opened or closed.
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WARNING: If upgrading from a firmware version prior to version 3.3, note the following:
- The Engineer web password, if configured, is deleted and must be reentered after upgrade.

- All existing users will be assigned to new user profiles corresponding to their previous user access
levels. If max. number of user profiles is exceeded, no profile is assigned (see Adding/Editing User
Profiles on page 199). Review all user configuration after a firmware upgrade.

- The default Engineer ID is changed from 513 to 9999.

Peripheral Firmware Upgrade
Upgrade the peripheral firmware using the same procedure as for the controller firmware.

The peripheral firmware file is only stored temporarily in the file system. When a new peripheral firmware
file is uploaded, the current and new versions of the firmware for each peripheral and modem is displayed
as shown:

Upgrade File Manager Web page Manager Audio Fast Programmer Default Reset
Peripheral Upgrade
X-BUS Expander Upgrade
D Type SIN Current Version Upgrade Version Action
8 110 [8 Input / 2 Output] 11327907 1.1 [07AUG13] 1.11 [07AUG13] Identical
7 Audio [4 Input] 1434200 1.03 [13MAR13] 1.03 [13MAR13] Identical
6 Audio [4 Input / 1 Output] 37070907 1.03 [13MAR13] 1.03 [13MAR13] Identical
5 Wireless 489907 1.11[0TAUG13] 1.11 [07AUG13] Identical
4 110 Analyzed [8 Input / 2 Output] 165074801 2.00 [09Apr14] 2.00 [09Apri4] |dentical
1 DC-2 [4 Input/ 2 Output] 195309801 2.00 [07APR14] 2.00 [07APR14] Identical
3 1/0 8 Output] 443907 1.11 [07TAUG13] 1.11 [07AUG13] Identical
2 Keyswitch [1 Output] 226503801 1.01 [11NOV10] 1.01 [1INOV10] Identical
1 Indicator [1 Input] 223387801 1.03 [13MAR13] 1.03 [13MAR13] Identical
2 Comfort Keypad 227351801 1.02 [13MAR13] 1.02[13MAR13] Identical
1 Keypad 559907 2.09 [13MAR13] 209[13MAR13] Identical
Modem Upgrade
Modem Slot Type Current Version Upgrade Version Action
Modem Siot 1 InteliModem PSTN 209 [28MAR14] 209 [28MAR14] Identical
Modem Siot 2 IntelliModem GSM 3.08[13NOV13] 3.09[23Jan14] Upgrade
Back Upgrade All

« Click the Upgrade button for the peripherals that require upgrading or click the Upgrade All button
to upgrade all peripherals.

If the firmware for a peripheral device in the pfw file is older than the existing firmware of that device,
a Downgrade button is available.

During upgrade, the panel checks if the firmware in the peripheral file supports the particular hardware
versions of the installed peripherals and does not allow an upgrade for those peripherals which are not
supported.

If the pfw file version differs from the controller version, a warning message is displayed

If the major version number of the firmware available for a device differs from the existing major number of
a device, a warning message is also displayed.

Upgrading the SPCP355.300 Smart PSU Firmware
To upgrade the SPCP355.300 Smart PSU you must ensure the following:

« The mains power must be connected.

jmie

The SPCP355.300 Smart PSU firmware can only be updated through the browser.

jmie

The upgrade procedure can take up to 2 minutes to complete. Do not perform any actions within the
browser, restart or shut down the system until the upgrade completes. A message will be displayed
when the process is complete.
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See also

Adding/Editing User Profiles on page 199
17.12.1.2 Upgrading Languages

A custom language file (*.cIng) can be uploaded to the panel.

NOTICE: The panel must be licensed for use of custom languages and other languages.

To upgrade languages on the system:
1. Select File > Upgrade.
The Panel Upgrade Operations page is displayed.

Upgrade File Manager Web page Manager Audio Fast Programmer Default

Panel Upgrade Operations

Current Version: 3.6.0 - RB.31.18242

SPC Controller Firmware Upgrade

Upgrade File: Browse...

Peripheral Firmware Upgrade

Upgrade File: Browse...

Language File Upgrade

Upgrade File: Browse...

2. Select the language file to upgrade by clicking the Browse button for the Language File
Upgrade option, selecting the required language file and then clicking on th